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2 Getting Started

DbVisualizer is a feature rich, intuitive multi-database tool for developers and database administrators, providing
a single powerful interface across a wide variety of operating systems. With its easy-to-use and clean interface,
DbVisualizer has proven to be one of the most cost effective database tools available, yet to mention that it runs
on all major operating systems and supports all major RDBMS that are available. Users only need to learn and
master one application. DbVisualizer integrates transparently with the operating system being used.

The screenshots throughout the users guide are produced on Windows 7 using the Windows Look and Feel, but
DbVisualizer lets you choose among other Look and Feels as well.

In addition to this Users Guide, the following online resources may be be useful:

1. The home of DbVisualizer (http://www.dbvis.com/),

2. The FAQ (http://confluence.dbvis.com/display/FAQ) which is regularly updated with frequently asked
questions and known problems,

3. The Databases and JDBC Drivers (http://www.dbvis.com/doc/database-drivers/) online page. This page gives
information about supported databases and JDBC drivers,

4. The DbVisualizer forums (http://www.dbvis.com/forum/).

2.1 Downloading

DbVisualizer installers are available on our web site at http://www.dbvis.com/download/.
Download the installer for your operating system that fits your needs:

® Without Java VM if you already have Java installed,

* With Java VM if you do not have Java installed, or if you want to use the recommended Java version for
DbVisualizer and another Java version for other applications,

® An Installer unless you must use an archive format for some reason.

2.2 Installing

There are two ways to install DbVisualizer: using an Installer or extracting files from an archive file.

® |nstalling with an Installer (see page 14)
® |nstallation from an archive file (see page 14)
® |nstallation Notes for ZIP archives (Windows) (see page 14)
® |nstallation Notes for TAR archives (Unix) (see page 14)
® |nstallation Notes for RPM archives (Linux) (see page 14)
® |nstallation Notes for DEB archives (Linux) (see page 14)
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2.2.1 Installing with an Installer

To install DbVisualizer, just execute the Installer you have downloaded and follow the instructions in the screens

2.2.2 Installation from an archive file

Installation Notes for ZIP archives (Windows)

All files are contained in an enclosing folder named DbVisualizer.
Unpack the distribution file with the built-in zip archive extraction utility in Windows or with the winzip utility.

The ZIP archive installer will not add any entries to the Start menu, add desktop launchers or even register the
software in the Windows registry.

Start DbVisualizer by clicking the dbvis.exe file in the installation directory for DbVisualizer.

To uninstall DbVisualizer installed via a ZIP archive, simply delete the complete DbVisualizer directory.

Installation Notes for TAR archives (Unix)

All files are contained in an enclosing folder named DbVisualizer.
Unpack the distribution file with:

gunzip dbvis_unix_9_1.tar.gz
tar xf dbvis_unix_9_1.tar

Start DbVisualizer by executing the shell script in the installation directory, e.g

To uninstall DbVisualizer installed via a TAR archive, simply delete the complete DbVisualizer directory.

Installation Notes for RPM archives (Linux)

Install the rpm with rpm -i <download_filename> or your favorite rpm tool.
Start DbVisualizer by executing the shell script in the installation directory, e.g. DbVisualizer/dbvis.

To uninstall DbVisualizer installed via an RPM archive, use the rpm utilities.

Installation Notes for DEB archives (Linux)

Install the package with sudo dpkg -i <download_filename>.deb or your favorite Debian package manager tool.
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Start DbVisualizer by executing the shell script in the installation directory, e.qg. DbVisualizer/dbvis.

To uninstall DbVisualizer installed via an DEB archive, use dpkg --remove .

2.3 Starting DbVisualizer

How to start DbVisualizer depends on the operating system you are using.

* Windows

In the Start menu, select the DbVisualizer menu item.
® Linux/Unix

Open a shell and change directory to the DbVisualizer installation directory. Execute the dbvis program
® Mac OS X

Double click on the DbVisualizer application or the DbVisualizer.app application bundle.

You can also start DbVisualizer with the bundled script files, please see the GUI Command Line Arguments (see
page 408) page for details. For tasks that do not require a GUI, such as tasks scheduled via the operating
system's scheduling tool, you can also use the pure command line interface (see page 311).

2.4 Evaluating the Pro Edition

The DbVisualizer Pro edition offers far more features than the Free edition. If you are using the Free edition, it is
easy to activate a Pro edition evaluation to see if suits your needs:

1. Open Help->Evaluate Pro Edition

Online Users Guide...

Online Support Resources...

('}

Contact Support...
edt

2]

CENT OB

License Key...

Evaluate Pro Edition... *—F‘

Check for Update...

] .,

=
.
1 ]|
oy

About...

2. Enter your email address and click Evaluate,
3. Click Restart when prompted after the activation of the evaluation.

. If you start DbVisualizer with one of the bundled scripts rather than with the launcher, you need to
manually restart DbVisualizer after the activation.

Page 15 of 428



;\./\ DbVisualizer 9.2 Users Guide

2.5 Installing a Pro Edition License

To enable the Pro edition features, you need to install the License Key String or License Key File that you
received after purchasing the license.

® |nstalling a License Key String (see page 16)
® |Installing a License Key File (see page 16)
® Uninstalling the license key (see page 16)

2.5.1 Installing a License Key String

Select and copy the License Key String included in the email,

Start DbVisualizer and select the Help->License Key main menu choice,
Select License Key String as the License Type,

Paste the key string into the text area,

Click Install License,

Restart DbVisualizer when prompted to do so.

2 N

The DbVisualizer main window should now say DbVisualizer Pro in the window title. You're ready to go.

2.5.2 Installing a License Key File

Save the dbvis.license file attached to the email to disk,

Start DbVisualizer and select the Help->License Key main menu choice,

Select License Key File as the License Type,

In the License Key File field, enter the path to the newly saved dbvis.license file or click the button to the
right of the field to open a file browser to locate the file,

5. Click Install License,

6. Restart DbVisualizer when prompted to do so.

A w D

&  An option to saving the dbvis.license file to disk is to drag it from you mail application (or elsewhere)
into the License Key File field in the Help->License Key window.

The DbVisualizer main window should now say DbVisualizer Pro in the window title. You're ready to go.

2.5.3 Uninstalling the license key

If you ever need to uninstall the license key, you can do so by removing (or renaming) the following file:
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Operating System

Windows
UNIX/Linux

Mac OS X

Filename

C:\Documents and Settings\<user>\.dbvis\dbvis.license
/home/<user>/.dbvis/dbvis.license

/Users/<user>/.dbvis/dbvis.license

2.6 Creating a Connection - basics

To access a database with DbVisualizer, you must first create and setup a Database Connection. The easiest
way to set up a connection is to use the Connection Wizard, but you can also do it manually.

® Using the Connection Wizard (see page 17)
® Setting Up a Connection Manually (see page 21)

2.6.1 Using the Connection Wizard

1. Launch the wizard from Database->Create Database Connection and click Use Wizard when prompted

2. Enter a name for the connection on the first Wizard page and click Next,
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| & New Connection Wizard

X

New Connection Wizard

This Connection Wizard will guide you through the steps to setup a
database connection, Make sure you have access to the reguired JDBC
driver file(s) for the database you are going to access.

Information about supported databases and links to download sites for JDBC
drivers are available at http: ffwww. dbvis. com,

CRM Ahoa

Enter the connection alias for the new database connection. This is the
name yaou will use to refer this database connection throughout the application.

3. Select an installed JDBC driver (marked with a green checkmark) on the second wizard page (see
Installing a JDBC Driver (see page 409) for how to install a JDBC driver manually),
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o

| & New Connection Wizard

Select Database Driver

g Oracle Thin

Select the appropriate database driver from the list above.

< Back ][ Mext = ] [ Cancel

*» The JDBC-ODBC bridge driver is not intended for production use and is known to be limited and

unreliable. Use it only if there is no pure JDBC driver for your database.

4. Enter information about the database server on the third wizard page (see below for details),
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' It

[i Mew Connection Wizard @

CRM Ahoa
(Oracle Thin)

-

- Connection =
Connection Type Service

Database Server localhost

Database Port 1521

Service ORCL

m

Database Userid

Database Password

-, Use SSH Tunnel
Auto Commit

Save Database Password I
Connection Mode Development

[ W Ping Server

Press the Finish button to create and connect the new database
connection.

5. Verify that a network connection can be established to the specified address and port by clicking the Ping
Server button,
6. If Ping Server shows that the server can be reached, click the Finish button to create the connection.

/2. See Fixing Connection Issues (see page 402) for some tips if you have problems connecting to the
database.

The information about the database server that needs to be entered depends on the which JDBC driver you use.
For most drivers, you need to specify:

Field Description

Database Server The IP address or DNS name for the server where the database runs.
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Field Description
Database Port The TCP/IP port used by the database.
Database Userid The database user account name. Enter (nul | ) to not send an account name.

Database Password The database user account password. Enter (nul | ) to not send a password.

For some database such as Oracle, you may use a TNS name (see page 297) instead of specifying the server
and port. Other drivers may add more fields that are driver specific.

You may also optionally specify SSH tunneling information (see page 294) and Options, such as:

Option Description

Auto Commit Check if you want to enable auto commit in the SQL Commander by default for the
connection.

Save Database Check if you want the password to be saved (encrypted) between sessions.

Password

Connection Mode One of Development, Test or or Production to select which set of Permissions (see
page 282) to use.

Additional options are available for some JDBC drivers, such as Authentication Method (see page 298) for the
SQL Server jTDS driver.

See the Configuring Connection Properties (see page 282) page for related topics.

2.6.2 Setting Up a Connection Manually

1. Create a new connection from Database->Create Database Connection and click No Wizard when
prompted. An Object View tab for the new connection is opened,
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fa ™

| & DbVisualizer Personal - Untitled =E]==]

File Edit View Database Scripts SQL Tools Window Help

YSHE R g« Q0 X@

o | «Drop your favorite objects here >

| L Seripts |= [ object view [® 501 Commander

‘ S Databases | =
# - Database Connection: CRM Ahoa
0P| eSS @

Connections
i bR Production 47 Connection | [E| Pmpaﬁml i oatzbase dnfo | § 0at= Types | nSearch|

HR. Production DBA

Disconnectad

HR Test Data Settings Format: Server Info (7) Database URL
L e
MName CRM Ahoa

Database Type Oracle

Driver (JDBC) 2 Oracle Thin

Connection Type Senice

Database Semver 192.168.1.21

Database Port 1521

Senvice XE

4 Authentication

Database Userid hans

Database Password o900 00®

. Use SSH Tunnel

Auto Commit

Save Database Password

Connection Mode Development

5YS Role

Connect ] | Disconnect | [ Ping Server
Connection Message
Disconnected.

Enter a name for the connection in the Name field,

Leave the Database Type as Auto Detect,

Select an installed JDBC driver (marked with a green checkmark) from the Driver (JDBC) list (see
Installing a JDBC Driver (see page 409) for how to install a JDBC driver manually),

Enter information about the database server in the remaining fields (see below for details),

Verify that a network connection can be established to the specified address and port by clicking the Ping
Server button,

. If Ping Server shows that the server can be reached, click Connect to actually connect to the database

server.

See Fixing Connection Issues (see page 402) for some tips if you have problems connecting to the
database.
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Alternatively, you can set the Settings Format to Database URL (this is the only choice for some custom JDBC
drivers). This replaces the fields for information about the database server with a single Database URL field,
where you can enter the JDBC URL.

The information about the database server that needs to be entered depends on the which JDBC driver you use.
For most drivers, you need to specify:

Field Description

Database Server The IP address or DNS name for the server where the database runs.
Database Port The TCP/IP port used by the database.

Database Userid The database user account name. Enter (nul | ) to not send an account name.

Database Password The database user account password. Enter ( nul | ) to not send a password.

For some database such as Oracle, you may use a TNS name (see page 297) instead of specifying the server
and port. Other drivers may add more fields that are driver specific.

You may also optionally specify SSH tunneling information (see page 294) and Options, such as:

Option Description

Auto Commit Check if you want to enable auto commit in the SQL Commander by default for the
connection.

Save Database Check if you want the password to be saved (encrypted) between sessions.

Password

Connection Mode One of Development, Test or or Production to select which set of Permissions (see
page 282) to use.

Additional options are available for some JDBC drivers, such as Authentication Method (see page 298) for the
SQL Server jTDS driver.

See the Configuring Connection Properties (see page 282) page for related topics.

2.7 Creating a Table - basics

(1) Only in DbVisualizer Pro

This feature is only available in the Pro edition. In the Free edition, please execute the corresponding
SQL in the SQL Commander (see page 155).
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To create a new table:

1. Expand nodes in the Databases tab tree under the connection node until you reach the Tables node,
2. Select the Tables node and launch the Create Table dialog from the right-click menu:

-

y

| 8 Create Table

=

»

Object Details =
Database Connection: |HR Test Data

Database:
Schema: :HF‘. -

Table: EMPLOYEES

m

Storage Area:

Columns | Primary Key I Foreign Keys | Unigue Constraints | Check Cnnstraints|

Mame Data Type Size Scale Mullable Default
E INTEGER

DEPARTMEMT... INTEGER

MAME VARCHARZ 30

EMAIL VARCHARZ 30

ROMM VARCHARZ 30

SALARY NUMBER 7 2
PHOTC BLOB

M| € > EE
|

=

EEEEEEO

[¥/] show SQL [ Execute ][ Cancel ]

S0L Preview

1|;REATE TABLE -
2 HR . EMPLOYEES 3
{

EMPLOYEE_ID INTEGER MOT MNULL,

DEPARTMENT_ID INTEGER,

MAME VARCHAR2(3@),

EMATIL VARCHARZ2(3@),

ROMM VARCHAR2(3@),

SALARY NUMBER(7,2),

PHOTO BLOB

m

=
= @ WDed =l m o B

=

3. Add columns and constraints in the different tabs,
4. Click the Execute button to create the table.

You can learn more about the Create Table dialog in the Creating a Table (see page 58) page.

2.8 Viewing a Table - basics

To view details about a database table:

1. Expand nodes in the Databases tab tree under the connection node until you find the table,
2. Double-click on the table node to open its Object View tab.
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CRM Ahoa(HR/TABLE/EMPLOYEES

[f] columns |@ Data "ﬁ Row Count " ‘,3@ Primary Key " < mdexes][g Grants ”? Row Id ” =5 References H ,ﬁl Mavigator l

Y 1Y A
TABLE_CAT TABLE_SCHEM TABLE_MNAME COLUMMN_MAME DATA_TYPE TYPE_MNAME COLUMN_SIZE BUFFER_LENGTH DECIM m
(nl.lll) HR. EMPLOYEES EMPLOYEE_ID 3 MUMBER. =} 4] -~
(ull) HR. EMPLOYEES FIRST_MAME 12 VARCHARZ 20 W}
(rwally HR. EMPLOYEES LAST_MAME 12 VARCHARZ2 25 4]
(null) HR. EMPLOYEES EMAIL 12 VARCHARZ 25 i)
[nl.lll) HR. EMPLOYEES PHOME_MUMBER. 12 VARCHARZ 20 i)
(ull) HR. EMPLOYEES HIRE_DATE 93 DATE 7 W}
(null) HR. EMPLOYEES JOB_ID 12 VARCHARZ 10 i)
(nl.lll) HR. EMPLOYEES SALARY 3 MUMBER. 8 1]
(ull) HR. EMPLOYEES COMMISSION_PCT 3 MUMBER. 2 0
(null) HR. EMPLOYEES MAMAGER._ID 3 MUMBER a 4]
(null) HR. EMPLOYEES DEPARTMENT _ID 3 MUMBER 4 i)
4 1 ol &

| 0.000/0.000 sec || 11/18 || 1-11

The Object View has a number of sub tabs. Exactly which sub tabs are available depends on the database type,
but these are common:

Subtab
Info
Columns
Data

Row Count

Primary
Keys

Indexes
Grants
DDL

References

Navigator

Description

Brief information about the table.

Information about all table columns, e.g. data types and sizes.

Then table data. Here you can view (see page 80) and edit (see page 92) the data.
The number of rows in the table.

Information about the table's primary key columns, if any.

Information about the table's indexes, if any.
Information about granted privileges for the table.
Shows the CREATE statement for the table.

Shows declared primary/foreign key relationships to other tables. Please read more in Viewing
Table Relationships (see page 122).

Navigate through the declared relationships. Please read more in Navigating Table
Relationships (see page 123).
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2.9

Editing a Table - basics

@

Only in DbVisualizer Pro

This feature is only available in the Pro edition. In the Free edition, please execute the corresponding
SQL in the SQL Commander (see page 155).

To edit table data:

1.
2.
3.

Expand nodes in the Databases tab tree under the connection node until you find the table,
Double-click on the table node to open its Object View tab,
Open the Data sub tab

§# Table: EMPLOYEES

CRM Ahoa/HR/TAELE/EMPLOYEES

{3 Info m Columns @ Data Fﬂ Row Count " @Q Primary Key H@ Indexes " g Grants "ﬁ Row Id H EE References " ,qﬁ Navigator ]
BOS$D - wEEHEE e -n» EE |

+ f EMPLOYEE_ID FIRST_MAME LAST_MAME EMAIL PHOME _MUMBER HIRE_DATE JOB_ID SALARY m

1 100 Steven King SKING 515.123.4567 1987-06-17 00:00:00 AD_PRES 249000 »

2 101 Meena Kochhar NKOCHHAR.  515.123.4563 1939-09-21 00:00:00  AD_VP l?OUCE

3 102 Lex De Haan LDEHAAN 515.123.4569 1953-01-13 00:00:00 AD_VP 17000

4 103 Alexander Huriold AHUMOLD 590.423.4567 1990-01-03 00:00:00  IT_PROG Q0oC

5 104 Bruce Ernst BERMST 590.423.4568 1991-05-21 00:00:00 IT_PROG &00C

6 105 David Austin DALSTIN 3590.423.4569 1997-06-25 00:00:00 IT_PROG 4300

7 106 Valli Pataballa VPATABAL 590.423.4560 1998-02-05 00:00:00 IT_PROG 4300

3 107 Diana Lorentz DLORENTZ  590.423.5567 1999-02-07 00:00:00  IT_PROG 420C

L) 108 Mancy Greenberg NGREEMBE  515.124.4569 1994-08-17 00:00:00 FI_MGR 1200C

10 109 Daniel Faviet DFAVIET 515.124.4169 1994-08-16 00:00:00  FI_ACCOUNT Q00C

11 110 John Chen JCHEM 515.124.4265 1997-09-28 00:00:00 FI_ACCOUNT 320C

12 111 Ismael Sciarra ISCIARRA 515.124.436% 1997-09-30 00:00:00 FI_ACCOUNT F7oc

13 112 Jose Manuel Urman IMURMAN 515.124.44969 1998-03-07 00:00:00  FI_ACCOUNT 7300

14 113 Luis Popp LPOPP 515.124.4567 1999-12-07 00:00:00  FI_ACCOUNT 590C

15 114 Den Raphaely DRAPHEAL  515.127.4561 1994-12-07 00:00:00  PU_MAM 1100C

ol m | bo-

Max Rows: 1000 Max Chars: -1 | |0.000/0.016 sec || 107/11 || 1-16 |

Edit column values directly in the grid, add and remove rows by clicking on the buttons in the toolbar,
Save the edited data by clicking on the Save button in the toolbar.

Note that if the table does not have any declared Primary Key, you will be prompted to select the
column(s) that uniquely identify a row.

You can learn more about the editing features in Editing Table Data (see page 92).
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2.10 Executing SQL - basics

To execute SQL statements:

1. Open an SQL Commander window from SQL Commander->New SQL Commander or by clicking the
New SQL Commander button in the main toolbar,

5.

SQAL editor

Result area

-

File

atabases

B

=

~
\ w |2 select EMPLOYEE_ID, FIRST_MNAME, LAST_NAME, EMAIL from HR.EMPLOYEES; B @
\Q“iselect * from HR.JOB_HISTORY; E| 5
A =
[P||5 --setect * from HR.JOBS; £
b --select * from HR.LOCATIONS; T E
6:30 [182] INS Auto Commit: O Untited™
©o
£ | | /5] Log | {ig DBMS Output |[] 1: select = from HR.DEPARTMENTS X | [7] 2: select EMPLOYE 4 » B
o
=
= o T = F =
Lt PSP -GEHEEE e - B
~| . £ EMPLOYEEID FIRST NAME  LAST NAME  EMAI
"'--.* 1 100 Steven King SKING -
2 101 Neena Kochhar MNKOCHHAR e
3 102 Lex De Haan LDEHAAN
4 103 Alexander Hunold AHUNOLD
5 104 Bruce Ernst BERMNST
105 M il Aochn DLALISTTIR ke

| & DbVisualizer Pro 90 - Untitled* [=][= ][ =]

IgEBea D O0R

[] cOUNTRIES [ EMPLOYEES % ADD_JOB_HISTORY (5} Locks || Computers per Employee.sal

Edit View Database 50QL Commander Tools Window Help

[ 1: CRM Ahoa Untitled* x
POAROGERE FIR¢C> VR -[E0E
[l Sticky Database Schema Mas Rows Mas Chars

[ cRM Ahoa - 4R - 1 -1
1 select * from HR.DEPARTMENTS;

7
i
g
!

un
]
=
m
=5
=
=}

0.031/0.000 sec | 107/4 || 16

= 116M of 494 T

Select the database connection, catalog and schema to use,
Enter the SQL statements in the editor area,
Execute the statements by clicking the Execute button in the toolbar or choosing SQL Commander->

Execute,

The execution log and possible result sets are shown as tabs in the results area below the editor.

You can learn more about editing, saving and executing SQL statements in the Working with SQL (see page
155) section.

2.11 Checking for Updates

By default, DbVisualizer checks for new versions on a weekly basis. To change the interval or manually check

for updates:
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1. Open Help->Check for Updates,

Check For Updates

DbVisualizer can automatically chedk for new w
Internet connection.

Chedk for updates: :Weeldy

Indude Beta versions: [

Current version: 9.1

Last check for updates: 2013-08-02 12:54:35

o

Ersions using your

- Chedk Mow

Proxy Settings ] [ 8.4

] [ Cancel

2. Change the interval to one of Every Start-U

p, Daily, Weekly, Monthly or Never, or click the Check Now

button to see if there is a new versions available right now.

. If you are interested in getting information about Beta versions to help us fine tune upcoming versions,

check the corresponding checkbox. By defa

ult, Beta versions are not considered when checking for

updates (unless you are already running a Beta version).

If a newer version is available, a dialog is displayed from where you can install the new version, read release
notes, or in case your license is not valid for the new version, open our purchase page in your web browser.

-

Available Versions @

The following new version is available as a free upgrade:

9.2: Upgrade or read the Release Motes

"

Upgrading the currently used version is done by clicking the Upgrade link in the above dialog and then follow

the instructions.
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i 1

‘a Updater - DbVisualizer

HNew Version Available _-I
A new version of DbVisualizer is available, please check the details below.

Current version: 9.1

New version: 9.2

In the next step, the installer will be downloaded. You wil be prompted before the installer is
executed. If you do not wish to download the installer, dick Cancel now.

Download to: C:\Usersijohndoe

Download size: 51,3 MB

Mext = J l Canicel

@ Insome organizations, decisions about about software versions and installation is handled as a
centralized process and individual users not allowed to upgrade or install software. The Check for
Update feature and auto-update of new versions can be disabled by adding the following row in the
DBVIS-HOME/resources/dbvis-custom.prefs:

dbvis.url.checkforupdate=

With this setting, no entry for Check for Update will appear in the Help menu.

2.12 Printing

DbVisualizer supports printing of grids, graphs, charts and plain text, such as the content of an SQL Editor. The
print dialog looks somewhat different depending on what is printed. In all cases, you launch the print dialog by
clicking on the Print button in the toolbar for the object you want to print, or by choosing Print from the
right-click menu. The right-click menu also contains a Print Preview choice, if you want to see what the printout
will look like before you actually print.

® Printer Setup (see page 30)

® Printing a Grid, a Chart and Plain Text (see page 30)
® Printing a Graph (see page 30)

® Print Preview (see page 30)
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2.12.1 Printer Setup

If you want to set the page orientation (e.g., portrait or landscape) and paper size, you must launch the Printer
Setup dialog, using the File->Printer Setup main menu option, before you print. Printing varies widely between
platforms, so even though the Print dialog (as opposed to the Printer Setup dialog) on some platforms also lets
you choose a page orientation and other options, they may be ignored if specified in that dialog. The only
supported way to specify the page orientation and other options is via the Printer Setup dialog.

2.12.2 Printing a Grid, a Chart and Plain Text

For a grid, chart and plain text, DbVisualizer launches the platform's native Print dialog, so it looks different on
different platforms. The two options available on all platforms are a choice of printer and the page range. On
some platforms, the dialog may offer additional options, but they may be ignored by DbVisualizer. Use the
Printer Setup dialog to set other options besides which printer to use and the page range, as described above

When you print a grid in DbVisualizer, the grid is printed as it is shown on the screen, i.e., with the table headers
, sort and primary key indicator, etc. It is printed as a screenshot that may span several pages, depending on the
number of rows and columns that are printed. For a grid, the right-click menu contains a Print Selection choice

that you can use if you just want to print selected rows and columns.

» An alternative to printing a grid as a screenshot is to export the grid to HTML and then use a web
browser to print it.

Printing a chart scales the chart to the size of the paper. Plain text is printed as-is and may span multiple pages,
both in height and width.

2.12.3 Printing a Graph

Printing a graph adds a custom dialog before the native Print dialog is displayed. You can specify the number of
rows (pages) and columns (pages) that the complete image will be split into. You can also select whether the
view as it appears on the screen or the complete graph should be printed. When you click Ok, the native Print
dialog is displayed, where you can select the printer.

2.12.4 Print Preview

Use the File->Print Preview feature to preview what the printout will look like before you actually print it.
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Grid

Graph

P

| & Print Preview

[
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3

4

T

m

[ Print H Close ]

25 %o

-

P

| & Print Preview

[ Page... H Print... H Zoom In ]E
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3 Getting the Most Out of the GUI

DbVisualizer has a tab-based user interface that gives you a lot of control over the layout and how to work with
your database objects. This section describes how you can open as many tabs as you need, arrange them to
focus on what is important to you, and more.

3.1 Main Window Layout

The DbVisualizer GUI main window contains a navigation area to the left and an area for working with database
objects and scripts to the right.

e

| & DbVisualizer Pro 90 - HR Production/Schemas/HR/Tables/COUNTRIES == =]
File Edit View Database SQL Commander Tools Window Help
i O — — | P -
GGHBeaax 10 OPR
J - 3 Fauorites] J [] HR Production COUNTRIES x | [B 1: HR Production Untitled
B E% P Q[- -Tahle:COUNTRIES
ﬁ_ Connections =
= % E; SP;od " L g nfo [ (] columns | ] Data Fﬁ Row Count H 47 Primary Key ”{,ﬁ Indexes] R4 »HE
EMas
¥l & ANONYMOUS VO S P - MEEHEE e -u» Q-
- ) cTHsYs E
g DESNMP + ¢ COUNTRY_ID  COUNTRY_NAME REGION_ID [Ei|
- ) DCR_GERMANY_WORK2 1 AR Argentina 2 -
g DIP Ll 2 Ad Australia 3
[ 5} FLOWS_020100 3 BE Belgium 1
[ £} FLOWS_FILES 4 BR Brazil 2
G- HANS 5 CA Canada 2 =
- i MR (Default) 6 CH Switzerland 1
=[] Tables 7 CN China 3
D & DE Germany 1
D DEPARTMEMTS 9 DK Denmark 1 b
-7 EMP 10 EG Eaypt 4
-] EMPLOYEES 11 FR France 1
-7 EMPLOYESS_REAL 12 HK HongKong 5
&[] J0B_HISTORY 13 1L Israel 4
-7 1083 14 IN India 2
D LOCATIONS 45 __IT Italy 4 &
P ~ | Max Rows: [1000 | Max Chars: |-1 | 0.062/0.000 sec || 25/3 || 1-15 |
|:||:|__fa3fu1 of 4944 T

At the top of the window, you find the main menus and a toolbar.

Tooltips are used to provide more details about a component throughout the GUI. They are also used to express
status information. An example is the grid column header tooltip that shows information about the column. To
see a tooltip, let the mouse hover over an area of the user interface, e.g., a button or grid header. If there is a
tooltip for the area, it will pop up in about a second.
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FIRST_NAME VARCHAR2 (20)

Allow MNULL

JOBC: VARCHAR (type: 12), Java: String
Column®: 2

3.2 Tab Types

There are three main types of tabs in DbVisualizer:

® Navigation Tabs (see page 33)
® Object View Tabs (see page 34)
® SQL Commander Tabs (see page 35)

3.2.1 Navigation Tabs

The left part of the DbVisualizer window holds a navigation area with three tabs: Databases, Scripts and
Favorites. They all contain an object tree where you can select the objects you want to work with.

The Databases tab tree contains you database connections at the top and, when connected, the database
objects they contain. If you have many database connections, you can also create folder objects in this tree to
organize them.

The Scripts tab tree contains Bookmarks and Monitors, see the Managing Frequently Used SQL (see page 185
) and the Monitoring Data Changes (see page 264) pages for detalils.

Finally, the Favorites tab tree contains objects that you want to have easy access to, either database objects (
such as tables, views, or procedures) or scripts. You can read more about Favorites in the Favorites (see page
272) page.
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J i Databases |.';?j Scripts " 7 4 Fa'uuritesl

BER PO M-

L3

ﬁ Connections
& [ HR Production
98 Schemas
- ) ANONYMOUS
- i} cTxsys
- &} DBSNMP
- &} DCR_GERMANY_WORK2
Q‘ DIP |
- &} FLOWS_020100
- &} FLOWS_FILES
8 HANS
-4} HR (Default)

E}D Tables
B counTries
(-] DEPARTMENTS
oo
&[] EMPLOYEES
-] EMPLOYESS_REAL
-7 J0B_HISTORY
w7 J08BS
&[] LOCATIONS
-7 ORDFRS

m

3.2.2 Object View Tabs

An Object View tab shows information about a database object, such as the data and DDL for a table, or the
source code for a stored procedure. The different types of information are shown as sub tabs within the Object

View tab.
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| [ HR Production COUNTRIES x| [ 1: HR Production Untitied X

8 Table: COUNTRIES

HR Production/Schemas/HR/ Tables/ COUNTRIES

| L Info | [T Columns | 7] Data | Row Count || &2 Primary Key | <7 Indexes | Row Id | =B References | 37 Navigator | &2 Grar 4 » B

PO S P - wEEEHE e -n/» [a- |
= 4 COUNTRY ID  COUNTRY_NAME REGION_ID El
1 AR Argentina 2 -
2 AU Australia 3 B
3 BE Belgium 1
4 BR Brazil 2
r CA Canada 2 E
6 CH Switzerland 1
7 CHN China 3
& DE Germany 1
g DK Denmark 1 I
10 EG Egypt 4
11 FR France 1
12 HK HongKong 3
12 IL Israel 4
14 IN India 3
15 T Italy 1 i
Max Rows: |1000 | Max Chars: -1 | 0.062/0.000 sec || 25/3 || 1-15 |

3.2.3 SQL Commander Tabs

An SQL Commander tab contains an editor for editing SQL scripts, controls for executing the script and a results
area with a Log tab and possibly Result Set tabs and a DMBS Output tab.
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[ | HR Production COUNTRIES 3 | [#» 1: HR Production Untitled* x

PORROERE B¢ B E-[Z0E

Database Connection [7] sticky Database Schema Mz Rows Max Chars
[# HR Production - H Hr -~ -1 -1

L
ol
—
m
=t
=
[=]

1 select * from HR.COUNTRIES;

2 select * from HR.REGIONS; @
c
i
L
m
c
=
o

2:26 [54] INS Auto Commit: OM Untitled™

/=] Log | {ig DBMS Output | [[7] 1: select = from HR.COUNTRIES X | [] 2: select * from HR.REGIONS X

DO 3 P -wEEEE >y - » EE &

& REGION_ID  REGION_MNAME

1 1 Europe
2 2 Americas
3 3 Asia

4

4 Middle East and Africa

0.031/0.000 sec || 4/2 || 14

3.3 Opening a Tab

You can open an object by double-clicking on the object node, or by pressing Enter with the node selected, in
all navigation tab trees. This opens either an Object View tab or an SQL Commander tab, depending on the
object type: database object or script.

By default, a database object is opened in an Object View tab that is "available," meaning it is not pinned, busy
running a task, or contains pending edits. The current tab is choosen if it is available, otherwise any other
available tab is used. If none of the tabs is available, a new tab is created for the object. You can change this
behavior in the General/Tabs category in Tools->Tool Properties, so that a new tab is always used instead of
using an available tab.

If a tab is already open for the object, it is made the active tab. An alternative to double-clicking a database
object is to use the Open in Tab choice from the node's right-click menu. Open in Tab is also available in the
Open Object drop-down menu button in the Databases tab toolbar.

If you want to open a database object in a new tab instead of an available tab, hold down the Alt key when you
double-click the node, use the Open in New Tab choice from the node's right-click menu or from the Open
Object drop-down menu button in the Databases tab toolbar. The drop-down button keeps the last choice as
the default, so once you have choosed Open in New Tab once, you only need to click the button to do the
same.
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Both Open in Tab and Open in New Tab can also be used when multiple nodes are selected in the tree to
open multiple tabs in one go.

To replace the content in a specific Object View tab with information for another object, drag the node for the
new object from the object tree and drop it on the Object View tab header.

Scripts (Bookmarks and Monitors) are always opened in a new SQL Commander tab unless the script is
already opened in a tab. If so, that tab is activated instead. An alternative to double-clicking the node is to use
Open in SQL Commander in the right-click menu or the corresponding button in the Scripts tab toolbar. The
righ-click menu also holds an Open in SQL Commander and Execute choice.

A new, empty SQL Commander tab is created by clicking the Create SQL Commander button in the main
toolbar or using the corresponding File menu item. You can use this kind of SQL Commander tab for ad-hoc
statement execution or to create a new script.

SQL Commander tabs can also be opened for files in the file system. Click the Open File button in the main
toolbar or choose File->Open to open the file chooser window and select one of more files. Alternatively, you
can drag files from your platform's file browser and drop them in the main toolbar area.

@ Only in DbVisualizer Pro

Multiple SQL Commander tabs are only available in the DbVisualizer Pro edition.

3.4 Pinning a Tab

To prevent an Object View tab to be reused for another object or to prevent any tab to be removed unless you
explicitly asks for it, you can "pin" it. In the right-click menu for a tab you find a Pin Tab toggle to accomplish this

You can also click on the icon in the tab header as a shortcut for toggling between the "pinned" and "unpinned"”
states.

3.5 Closing a Tab

A top level tab and a Result Set tab in an SQL Commander tab can be closed by clicking the cross to the right
of the tab label, or clicking the tab header with the middle mouse button.

If you want to close a humber of tabs at the same time, you can use the tab header menu choices:

Close Tab Close just the current tab.

Close all tabs except the current tab.
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Close Other
Tabs

Close Close all tabs that are in a state where they can be closed with no action required by the
Closeable user, e.g. not pinned and no pending edits.
Tabs

Close All Close all pinned tabs.
Pinned Tabs

Close All Tabs Close all tabs, regardless of state

You can also hide Object View sub tabs that you are not interested in. Use the Close Tab right-click menu
choice to do so. To see the hidden tabs again, use Restore Hidden Tabs in the right-click menu.

3.6 Listing Open Tabs

If you have many tabs opened, there may not be room enough to show them all at the same time. In this case,
you can scroll through them using the arrow buttons that appear to the right of the tabs. It is, however, often
faster to locate the tab you want to work with by clicking the list icon next to the arrow buttons. This brings up a
list of all open tabs so you can select the one you want directly.

77| HR Production EMPLOYEES x 4 » B

[7] HR Production COUNTRIES

4w 1: HR Production Untiled™
7] HR: Production k 10N

£ Primary K| || HR Production EMPLOYEES

3.7 Maximizing and Minimizing a Tab

The three Navigation tabs can be minimized either by double-clicking on the tab header or using Minimize Tab
in the tab's right-click menu. Clicking on a minimized tab brings it back to its regular place and size again.

All other tabs can be maximized by double-clicking on the tab header or using Maximize Tab in the tab's

right-click menu. When you maximize a tab, the Navigation tabs are minimized to make as much room as
possible available and the tab you maximized fills all available space. Double-clicking on the the tab again
restores all tabs back to their original size.
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(o} :
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11 FR France 1
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16 JP Japan 3 - R
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\0.000!0.0005&: 25/3 | 1-18
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An icon in the main status bar indicates when a tab is maximized. An alternative for restoring the original size of
all tabs is to double-click on this icon.

3.8 Floating a Tab

Sometimes it is handy to break up the user interface in multiple freestanding windows. Every tab in DbVisualizer
can be placed in a separate window by "floating" the tab. Use the Floating menu choice in the tab header
right-click menu to float the tab in a separate window.

When you close a floating tab, a dialog is displayed where you can choose to really close the tab or restore it
back into the main window.

3.9 Rearranging Tabs

You can move the tabs around by drag and drop. This allows you to see the content of multiple tabs at the same
time
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When you drag a tab, and outline of the tab borders shows what will happen when you drop it: place it in above,
below or next to another tab, or simply move it to another location among its siblings.

, ==
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File Edit View Database 5QL Commander Toocls Window Help
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w
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ipoanoEEFaR¢ B E-[EFe0 [
a Database Connection ———— [ | Sticky Database Schema Max Rows Max Chars ﬁ
/[ @ Hr Production = | <[4 i
—| 1 select * from HR.COUNTRIES;

@ 2 select * from HR.REGIONS; @
= =
ot =
l‘"m 1:1[1)] ms Auto Commit: ON| Encoding: Cp1252 Untited &
| [[7] HR Production COUNTRIES X | [7] HR Production REGIONS X

Table: COUNTRIES - Table: REGIONS
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The tab header right-click menu also has a couple of choices for arranging all tabs at the same level as either "
tiled" (the content of all tabs visible side-by-side) or "collapsed"” (only the content of the active tab visible).
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You can save your rearranged layout of an Object View tab so that it is applied for all objects of the the same
type for the same database type. In the sub tab header right-click menu, just select Save as Default Layout. To
restore the default layout, use Reset to Factory Layout.

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

3.10 Changing the Tab Label

The tab labels are set based on a pattern that you can change in Tools->Tool Properties, in the Appearance/
Tabs category.

You can select one of the predefined patterns or create your own by editing the pattern. The variables available
for these patterns are:
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Variable Available For Description

${connectionname All Connection name

}

${filename} SQL Commander Script filename, or "Untitled" if no file is loaded
Tabs

${index} All A unigue index

${longfilename} SQL Commander Absolute path for the script, or "Untitled" if no file is loaded
Tabs

${objectname} Object View Tabs Object name

${objecttype} Object View Tabs Object type, e.g. Table, View etc.

${catalog} Object View Tabs The database (if any) for the currently open object

${schema} Object View Tabs The schema (if any) for the currently open object

${rows} Result Set Tabs Number of rows in the result set

${sql} Result Set Tabs Part of the SQL statement that produced the result set

${table} Result Set Tabs Name of the table (first if more than one) the result set comes

from

${time} Result Set Tabs Time when the result set was produced

${userid} All Userid used for the connection

${vendor} Result Set Tabs Database vendor name

You can also manually change the label for Object View, SQL Commander and Result Set tabs, using the
Rename menu choice in the tab right-click menu.

3.11 Selecting a Node for a Tab

To quickly navigate to and select the node in the Databases tab tree that an Object View tab belongs to, you
can click on the object path in the Object View header area. Alternatively, you can use Select in Databases
Tab in the tab right-click menu.

Similarly, you can navigate to the object represented by a Favorite object using its Select Target Object
right-click menu choice. It selects the object in the Databases or Scripts tab, depending on the Favorite type.
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For an SQL Commander tab that is associated with a connection, you can use Select in Databases Tab in the
tab right-click menu to select the connection node.

3.12 Preserving Tabs Between Sessions

If you often work with the same objects and a few scripts, you can ensure that the Object View and SQL
Commander tabs for these objects remain open between DbVisualizer sessions.

1. Open Tools->Tool Properties,

2. Select the Appearance/Tabs category,

3. Enable one or both of Preserve SQL Commander tabs between Sessions and Preserve Object View
tabs between Sessions,

4. Click Apply or OK to apply the new settings.

This feature is enabled by default for SQL Commander tabs but not for Object View tabs.

The content of the SQL Commander tabs is saved at regular intervals so when you restart DbVisualizer, the
content is the same as where you left off.

For Object View tabs, you can also enable Preserve Object View tabs at Disconnect. By default, Object View
tabs for objects that belong to a connection are closed when it is disconnected.

3.13 Using Tab Colors and Borders

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

If you like to distinguish tabs and other GUI components for a specific connection from those of others, you can
specify a tab background color and/or border to use for a connection. If you set these in the Tool Properties
window, they apply to all connections with the corresponding database type. Therefore these properties are
typically set in the Properties tab for a specific connection instead.

For the border, you can either select one of the predefined styles or specify a small image file to use for the
border.

The selected color and border are also shown in the connection tab node in the Databases tab and in the
Database Connection list in the SQL Commander.
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3.14 Changing the GUI Apperance

To change how the DbVisualizer GUI is displayed:

1. Open Tools->Tool Properties,
2. Select the Appearance category under the General tab.

Here you can select a different Look and Feel and adjust the size and use of icons.

In the subcategories Fonts and Colors you can adjust the fonts used for different parts of the GUI and the
colors used to highlight grid elements.

The main View menu also contains a number of toggle controls for showing or hiding GUI elements, such as
toolbars and status bars.

3.15 Changing Keyboard Shortcuts

You can define key bindings for almost all operations and editor commands in DbVisualizer. Key bindings are
grouped in Key Maps. DbVisualizer includes a set of predefined key maps targeted for the supported operating
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systems. These key maps cannot be deleted or modified. To customize key bindings, copy an existing key map
and make your changes.

Key Bindings

Use these settings to define the key bindings in DbVisualizer, You must make a copy of an existing
key map to alter key bindings. The active indicator highlights the current key map.

Keymaps

Default (active, read-onby)

Set Active
Linux-UNIX (read-only) il
Mac 05 X (read-only) £ Make Copy

S0L Query Analyzer (read-only)

AN (read-nnld - Remove

Keymap Settings
Keymap: |Default (read-onhy)

Action Key Bindings

All Bindings -
., Editor Commands
=k~ [y Main Menu

o

m

Ctrl O
Clrl+Alt O

Ctrl 5

-] Save As Ctri+Skift S —
----- Create SQL Editor Ctrl T

----- :;( Close Current SQL Editor Ctrl F4

----- 3¢ Close All SQL Editors Ctrl+Alt W

----- Close All But Current

{3 Close Ctrl W

----- Mew Window Ctrl+Alt M

----- Exit Ctrl & -

key Bindings:
Add Key Binding. ..

Edit Key Binding...

Remowve

All user defined key maps are stored in your $HOME/.dbvis/config70/keymaps directory. A key map file contain
only the differences between the copied key map and the current.

To create a new key map, select the map you want to copy and click the Make Copy button. Set a name on the
new key map and activate it with the Set Active button. The newly created key map now has the exact same
key bindings as the parent key map.
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Key Bindings

Use these settings to define the key bindings in DbVisualizer, You must make a copy of an existing
key map to alter key bindings. The active indicator highlights the current key map.

Keymaps
CIRUX-JMIE (read-only) Set Active
Mac 05 X (read-only)

Make Copy

13

SQL Query Analyzer (read-only)
DAD (read-only)
My Keys (active)

A |om |

Keymap Settings
Keymap: My Keys Based on: Default

The action list is organized in folders. The Editor Commands folder lists all actions available in the SQL
Commander editor and their current key bindings. The Main Menu folder contains subfolders, each representing
a main window menu. The other folders group feature specific actions, such as actions to control the references
graph, form editor, etc.

To modify the key bindings for an action, select the action from the action list. The current key bindings are listed
in the Key Bindings list.

(] Key Stroke(s) [ 23 |
First Keystroke

CtrlD

Second Keystroke

Conflicts

Assigned to [Set Default Values]
[Duplicate Row(s)]

[ Ok H Cancel H Clear ]

The keystroke dialog controls whether a key binding is already assigned somewhere else. If there is a conflict
with another binding, the Conflicts area shows the names of the actions that are conflicting. The modifier keys
Shift, Alt, Ctrl and Command can be used to form the final key binding.

Y, Menu items and tooltips shows the first defined key binding in the list.
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4 Managing Database Objects

4.1 Opening a Database Object

To open an Object View tab with the details for a database connection or for a specific database object, the
simplest way is to double-click the object node in the Databases tab. For more information about tabs check the
Opening a Tab (see page 36) section.

4.2 Perform Actions on Multiple Database Objects

The actions menu for a database object in the Databases tab consists of actions that are available for the
selected object type. Some of the operations are common for any currently selected object while others are only
available for the current object. Sometimes it is convenient to run a single action on multiple nodes at once. To
do this, select the nodes (make sure all are of the same object type) and then right-click in the object list. The
menu will now highlight those actions that are valid to use.
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30 cans
iR COUNTRIES
R DEPARTMENTS

{7 EMPLOYEES
-] JOB_HISTORY &
@[] J08s
-] LOCATIONS
-] REGIONS

© Hs

B @ & &%

9

®

LD @YV ¥

Open in New Tab
Open in Tab

Ctri+Alt+L
Ctrl+L

ST S T N

Alter Table...
Rename Table...
Empty Table...
Drop Table...
Copy Table...
Comment Table...
Grant Privilege...
Import Table Data...
Export Table...
Create Index...
Create Trigger...
Analyze Table...

Script Table...
s
Refresh Objects Tree F5

Add to Favorites...

Database Objects Filters 3
Show/Hide Table Row Count
Copy Name

Copy Object Path

Toggle Visited State

Ctrl+C

Choosing for example the Drop Table action shows the following window in which the drop can then be
performed on multiple tables.
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E 4 Drop Table ﬂ

EI Drop Table in Database Connection: CRM Ahoa

Database Connection Schema Table
CRM Ahoa HR COUNTRIES
CRM Ahoa HR DEPARTMENTS

Drop Referential Integrity Constraints: | |

Purge Space: ]

4.3 Filtering Database Objects

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

® Object Filtering (see page 51)
® Inline Objects Filtering (see page 52)
® Object Type Visibility (see page 53)
® Temporarily Disable Filtering (see page 55)
® Filter Sets (see page 56)
® Switching Filter Set (see page 57)
® Show Only Default Database/Schema filter (see page 57)

Managing what database objects are listed in the Databases tab is done at two levels:

1. Objects Filtering
Defines what individual object nodes are listed for a specific object type. This allows filtering on for
example Table objects so that only tables matching a condition are listed.

2. Object Type Visibility
Defines what object types such as views, tables, indexes, procedures, etc. are listed. Every database in
DbVisualizer supports all sorts of database objects. Having the ability to hide some object types makes it
easier to locate the database objects that are of primary interest.
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The Filter Editor is used to manage both object type visibility and object filters. The Filter Editor is opened from
one of:

® Database main menu and the Database Objects Filters->Open Filter Editor

® Right-click in the Databases tab and chose Database Objects Filters->Open Filter Editor

® Click the drop-down button on the funnel icon in the Databases tab toolbar and chose Open Filter
Editor.

(1) Managing filters and opening the filter editor requires that a node is selected in the Databases tab tree
and that the related database connection is connected.

. Database Objects Filters for CRM Ahoa

ﬁ % » P |Fi|ter set: :defﬁult [2] for CRM Ahoa v: Show: Labelz

Object Type Filter (s)
g Oracle
= 4} Schemas
=] 3 Schema @ Mame [TABLE_SCHEM] beginWith HR.; Mame [TABLE_SCHEM] beginiy...
[ Tables
@ Views
& synonyms
& Indexes
Eﬂ Sequences
Ea MaterializedViews |
= @ Functions
@ Labelin [UPD_CAL;INS_CAL;DEL_CAL:]
Eﬁ' Procedures
Eg Packages
Eﬂ PackageBodies
& JavaSources
5 JavaClasses
@ Triggers
& 3 ObiectTvpes

HEE A

[ Field Condition Value
7] Label isin UPD_CAL:INS_CAL:DEL_CAL:

L3

m

g!!!!!!!!!!!!!n!
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The upper list shows all available object types for the actual database connection. The leading check mark
controls whether the object type should be visible in the Databases tab. Read more in the Object Type Visibility (
see page ) section. The Filter(s) column shows any filters defined for each object type. A green symbol
indicate that at least one filter is active while a yellow symbol indicate that filters are defined but all are
deactivated.

Selecting an object type enables the objects filtering area in the lower part of the window. Here individual filters
are defined for an object type.

4.3.1 Object Filtering

Obiject filtering can be made on any database object (Table, Function, Procedure, User) except for grouping
objects such as Tables, Functions, Procedures, Users. Grouping objects in DbVisualizer are often labeled
with the related object type name in plural. To setup a filter, select the object type in the objects list and in the
filter area, click the button with a plus sign to insert a new row.

| ®

Field Condition Value

Label isin 5Y5;5YSBACKUR;SYSDG;SYSKM;SYSTEM
is anything

is

doesn't equal
isin______|
ism'tin

—  |isempty

is not empty
begins with
ends with
contains
doesn't contain

A filter entry consists of a field (e.g Label), a condition and a value to match against. Click the condition field to
select the condition to use. In the Value field, enter the value that should be matched. For multi value conditions
, such asis in and isn't in, the list of values are separated with a semicolon or edited in separate window.

Each individual filter can be deactivated using the check mark. Uncheck it and the corresponding filter will not
be used unless reactivated. The currently defined filters are listed in the upper object type list for each object
type. The leading symbol shows either a green check mark which indicates that some of its filters are active or a
yellow symbol that shows that no filter is active.

You can define more than one filter. Just click the plus or double plus (to duplicate an existing row) buttons. If
you have more than one active filter, you must also select if the filter should match Any or All filter entries.
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Inline Objects Filtering

The filter area can also be displayed just below the objects tree in the Databases tab. This is convenient as you
can then quickly manage and verify the effect of certain filters. To toggle the display of the filtering area, either
click the left part of the funnel icon in the Databases tab toolbar or right-click and select Database Objects
Filter->Show/Hide Filter Area.

(1) Managing filters and opening the filter editor requires that a node is selected in the Databases tab tree
and that the related database connection is connected.

g Databases _f Saipts || <. Favorites

eePem-

&) Connections o
---['_] Oradle servers

o 7 CRM Ahoa

E} Schemas (27 of 36 filtered)
-3} op

-4} DVF M
DVSYS

-4} svs

-4} SYSBACKUP

-4} SYSDG

- &) SYSKM

- &) SYSTEM (Default) -

m

e

Filters for Schema objects (filter set: default)
HEE P9 ALL

Field Conditon  Value

Label is in SY5:;5YSBACKUP;SYSDG; 5YSKM; SYSTEM
Label begins with D

In this example, the filter area is displayed with the filters for the Schema object type listed. When filters have
been modified, you need to manually apply the filters using one of the reload buttons in the filter area toolbar or
in the Databases tab toolbar. If a filter results in all object nodes being filtered, " (all filtered) " is displayed next
to the parent object node in the tree. Since the filtered object type is now invisible as a result of the current filter,
you need to disable the filter to refine it. Do this by selecting the parent node with the " (all filtered) " label and
then click the " Disable Filters " link just below the objects tree:
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g Databases '__f Scripts | <. Favorites

eeP[ex-

13

@ Connections

-] Orade servers
= J» crRM Ahoa /
L -8 (all filtered)

Session Properties
. [ (5} DBA Views

- DB2 LUW

11

g JavalB/Derby

g Mimer - mimer_store

- [ Mimer - sysadm
o 8w -

m

Disable Filtersl_

Ohject type cannot be filtered

EHEE P o ANY] ALL

[[] Field Condition Value

Clicking " Disable Filters" deactivates all filters for the object type and you are now able to modify the filter to get

the matches you want.

4.3.2 Object Type Visibility

Object type visibility is the functionality used to define what object types in the Databases tab should be visible.
For some databases the tree of object types can be really long and many objects are rarely used or of any
interest. By hiding object types, the tree is compressed to only show what you are really interested in. To control

the visibility of object types, open the Filter Editor.
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ﬁ h ’ P |Hter5et:|defadt[ﬁ]fnrﬂradesl3ge (¥

[a] Object Type Filter(s)
S Oracle
= 4 Schemas
= 8l schema
[7] Tables
E GlobalTempTables
@ Views
& Synonyms
<7 Indexes
Sequences
m MaterializedViews
{&} Functions
@ Procedures
B Packages
a PackageBodies
& JavaSources
. JavaClasses
= (@) Triggers
@' ObjectTypes
5} objectTypeBodies
&) RecycleBin
@ {2 Jobs
&F scheduler
2l Databaselinks
# /1, InvalidObjects

OO00O00Odde OO0 OOO0 O« «

Select an object to setup filters

The previous image shows the object types available under a Schema in Oracle. As you can see, there are
plenty of them. (Their sub object types are collapsed in the example for better illustration). The following
example shows the database tree in the Databases tab before and after the visibility has been set based on the
previous screenshot.
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All Schema objects displayed With hidden Schema objects

=- % ? Oracle stage

E}%? Oracle stage
B} Schemas (43 of 44 filtered)

B4} Schemas (43 of 44 filtered)

= 4 HR = 5 HR
-] Tables -] Tables
G Global Temp Tables &ﬂ Views
&ﬂ Views ,:a;ﬁ Functions

-5 Synonyms
(-7 Indexes

\,ﬁ Procedures
- (3) Triggers

{-_7;1 Sequences
@ Materialized Views
:a:; Functions
v_{ﬁ' Procedures
{g Packages
{{? Package Bodies
--ﬁ Java Sources
g Java Classes
@ Triggers
@ Dbject Types
@- Dbject Type Bodies
@ Recycle Bin
L% Jobs
f Scheduler
gﬁ] Database Links
-/, Invalid Objects
@ Session Properties
EEI---|5 DBA Views

4.3.3 Temporarily Disable Filtering

While browsing the objects in the Databases tab, it may be convenient to quickly toggle between the standard
non filtered view and the filtered view of objects and types. This is easily accomplished with the Disable
Filtering action in the funnel drop-down menu. While filtering is disabled, the funnel symbol in the toolbar shows
a red indicator and text in the inline filtering area shows the current status.
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BEY RO Q

R T< 1 Jes|

E} Globa! Temp Tables
{'_q] Views

ﬁl Synonyms

«.J' Indexes

L:_;i Sequences

[ Materialized Views: |
‘ 1% Functions g

-G Proced:

¢ Prpdiages | .
Filtering is Dlsahled
HEE » ® [Any] A

[] Field Condition Value /

/s

While filtering is disabled it is not possible to manage filters at all and the related actions are disabled.

@ Disabling filters is applied per database connection. This means that if you disable the current filter set
on a MySQL connection it wont affect any other database connections.

4.3.4 Filter Sets

When you apply an object filter or hide an object type, that configuration is saved in a Filter Set that is saved
between sessions. For every database connection, there is always a default filter set. If you are happy with the
basic filtering capability you can stop reading here. If you however are interested in having multiple filter sets
that can optionally be shared between multiple database connections and easily be switched between, keep on
reading.

Filter sets are managed in the filter editor. Here you can create and delete filter sets and merge from another.
Filter sets are either associated with a specific database connection, its name is then default for <database
connection name> or a custom filter set that can be enabled for many connections, named as you like. A
custom filter set is always associated with the database type currently being used for your database connection.

Page 56 of 428



- |
=

A DbVisualizer 9.2 Users Guide

The latter means that you are able to share filters sets that are all associated with the same database type. If
you create a filter set for MySQL then this will never show if you are working with an Oracle database.

The Filter Set drop-down in the filter editor shows the currently used filter set, and when clicked, the available
filter sets that you may switch to.

The merge functionality can merge not only from custom filter sets but also from the default filter sets associated
with other database connections with the same database type.

Switching Filter Set

In the filter editor, you switch filter set by selecting one from the Filter Set drop-down. In the Databases tab,
there is the funnel symbol which when clicked is used to toggle the display of the inline filter area. Clicking on
the funnel drop-down symbol opens a menu:

BPHeE -

default [6] for Oracle stage

Dev [7]

Prod [8] .

Lo
Disable Filtering Ctrl+Alt+B
Show Only Default Database/Schema

Al

=T Emr oa |
¥V e <]

Show/Hide Filter Area Ctrl+Alt+)
Open Filter Editor...

&

{

At the top of the menu, the default filter set for the database connection is displayed first with any custom filter
sets below it. An entry that is check marked indicates that it is active.

4.3.5 Show Only Default Database/Schema filter

There is a special filter used to filter any database and schema objects to show only the default for the session.
Itis listed as Show Only Default Database/Schema in the filter menu. When selected, a special filter is applied
on the corresponding Database and/or Schema object type and the effect is what its name implies.
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5 Working with Tables

DbVisualizer provides many ways to work with tables.

5.1 Creating a Table

(1) Only in DbVisualizer Pro

This feature is only available in the Pro edition. In the Free edition, please execute the corresponding
SQL in the SQL Commander (see page 155).

The Create Table dialog helps you create a table without writing SQL.

® Opening the Create Table Dialog (see page 58)
® Columns Tab (see page 60)

®* Primary Key Tab (see page 62)

®* Foreign Keys Tab (see page 62)

® Unique Constraints Tab (see page 64)

® Check Constraints Tab (see page 65)

® Indexes Tab (see page 65)

® SQL Preview (see page 66)

® Execute (see page 67)

5.1.1 Opening the Create Table Dialog
To create a new table:

1. Expand nodes in the tree under the connection node in the Databases tab tree until you reach the
Tables node,
2. Select the Tables node and open the Create Table dialog from the right-click menu.
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| g Create Table

5

|3

Ohject Details
Database Connection: |HR Test Data

Database:
Schema: :HF‘. -

Table: EMPLOYEES

m

Storage Area:

Columns | Primary Key | Foreign Keys | Unique Constraints | Chedk Cnnstraints|

Mame Data Type Size Scale Mullable Default
INTEGER

DEPARTMEMT... INTEGER

MNAME VARCHAR2 30

EMAIL VARCHARZ2 30

ROMM VARCHAR2 30

SALARY MUMBER T 2
PHOTO BLOB

e € > EH
|

E

NEEEEEO

Show SQL [ Execute ][ Cancel ]

Preview

[REATE TABLE ~
HR.EMPLOYEES
(
EMPLOYEE_ID INTEGER NOT NULL,
DEPARTMENT_ID INTEGER,
NAME VARCHAR2(38),
EMAIL VARCHARZ(3®@),
ROMM VARCHAR2(38),
SALARY NUMBER(7,2),
PHOTO BLOB

m

The Create Table dialog is organized in three areas from the top:

General Table Info

Specifies the owning database connection, database and/or schema. These are picked up from the
selection in the tree when the dialog is opened. Table name is set to a default name that you should
change to the real table name.

Table Details

A number of tabs where you specify information about the columns and, optionally, various constraints.
The Columns, Primary Key and Foreign Key tabs are available for all databases. The remaining tabs
are database-specific and depends on the features supported by the database engine.

SQL Preview

The SQL previewer shows the SQL statement for creating the table based on your input.
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5.1.2 Columns Tab

The Columns tab lists all table columns along with their attributes.

Columns | Primary key | Foreign Keys | Unique Constraints | Check Constraints|

Mame Data Type Size Scale Mullable Default Eﬁ
EMPLOYEE_ID [U=&a;] ' ' =N .
DEPARTMENT_... INTEGER A
MAME VARCHARZ 30
EMAIL YARCHAR2 30 hd
ROMM YARCHARZ2 a0 £y
SALARY MUMBER T 2
PHOTO BLOB

To add a column:

1. Click the Add button,

2. Enter the name of the column in the first field and select a data type from a drop down list in the second
field, or start typing the data type name to find it and select it with the Enter key. The list contains the
names of all data types the database supports,

3. For some data types, such as character types, you may also specify a size, i.e., the maximal length of the
value. For others, like the decimal types, you can may specify both a size and a scale (the maximal
number of decimals),

4. In the last two fields, specify if the table is nullable and a default value to use for rows inserted into the
table without specifying a value for the column.

Below the column list, you may find additional fields depending on the features supported by the database you
create the table for and the data type for the current column. The Collation field is shown for character columns
if the database supports the declaration of a collation for textual data.
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| € ¥ EE

2
Columns | Primary Key | Foreign Keys | Indexes |
Mame Diata Type Sizre Scale Mullable Drefault

EMPLOYEE_ID INTEGER [}
DEPARTMENT_... INTEGER
MAME YARCHAR 30
EMAIL YARCHAR 30
ROOM YARCHAR 30
SALARY MUMERIC T 2
PHOTO BLOB
Collation: :Iaﬁn?_qeneral_cs -

The Auto Increment field, and possibly Start With and Increment By fields, are shown for numeric fields if the
database supports automatically inserting the next available sequence number in a numeric column.

| € > EE

Columns | Primary Key | Foreign Keys | Unigue Constraints | Chedk Cunstraints|
Mame Data Type Size Scale Mullable Default

m INTEGER ' | B |
DEPARTMENT_... INTEGER

MNAME VARCHAR 20

EMAIL VARCHAR 30

ROOM VARCHAR 30

SALARY MUMERIC T 2

PHOTO BLOB

Auto Increment: [ Start With: Increment By:

The Create Table dialog uses database metadata to try to enable only the fields that apply to the selected data
type, but please note that it is not always possible. For instance, there is no metadata available to tell if a data
type requires, or allows, a size. If you don't enter a required attribute or enter an attribute that is unsupported for
a data type, you will get an error message when you click Execute to create the table.

To remove a column;
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1. Select a cell in the column row,
2. Click the Remove button.

To move a column to another location:

1. Select a cell in the column row,
2. Click the Up or Down buttons.

5.1.3 Primary Key Tab

The Primary Key tab contains information about an optional primary key for the table. A primary key is a column
, or a combination of columns, that uniquely identifies a row in a table.

Columns | Primary Key | Foreign Keys I Unique Constraints | Check Cunsh’aints|

Constraint Mame:

Column Include
EMPLOYEE_ID i
DEPARTMENT_ID
MAME
EMAIL
ROOM
SALARY
PHOTO

9!)

OO0 0O OOE

To declare a Primary Key:

1. Optionally enter a constraint name for the primary key constraint in the Constraint Name field,
2. Select the columns to be part of the primary key by clicking the checkboxes in the Include field in the
columns list.

5.1.4 Foreign Keys Tab

In the Foreign Keys tab, you can declare one or more foreign keys for the table. A foreign key is a column, or a
combination of columns, that refer to the primary key of another table. Foreign keys are used by the database to
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enforce integrity, i.e., that there is a row in the referenced table with a primary key that matches the foreign key
value when a new row is inserted or updated, and you can optionally declare rules for what to do when a
referenced primary key is removed or updated in the referenced table.

| Columns | Primary Key | Fareign Keys | Unigue Constraints | Chedk Constraints|

Constraints

Caonstraint Mame Caolumns On Delete Action On Update Action

[ © ]
DEPARTMENT_ID

Referenced Table
Dztzbase Schema Takle
HR +  DEPARTMENTS v
Constraint Columns
Column Include Referenced Column F.
EMPLOYEE_ID I -
DEPARTMENT_ID DEPARTMENT_ID |:|
NAME ]
EMAIL [ o

The tab has the following sections:

® A list of foreign keys,

® Controls for selecting the table the currently selected foreign key refers to, including the database (
catalog) and/or schema for the table,

® Alist of all columns for the table being created.

To declare a new foreign key constraint:

1. Click the Add button next to the list of foreign keys,

2. Optionally enter a name for the foreign key in the first field in the list,

3. Select On Delete and On Update actions from the pull-down menus. The pull-down lists include all
actions that the database support, typically CASCADE, RESTRICT, NO ACTION and SET NULL. The
Columns field is read-only and gets its value automatically when you select which columns to include in
the key later,

4. Use the Referenced Table controls to select the table that the foreign key refers to,

5. Check the Include checkbox for all columns in the column list that should be part of the foreign key and
then select the corresponding column in the referenced table from the pull-down menu in the Referenced
Column field.

You can change the column order for the key with the Up and Down buttons.

To remove an existing foreign key:
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1. Select the foreign key in the list in the top section,
2. Click the Remove button.

5.1.5 Unique Constraints Tab

The Unique Constraints tab is only available for databases that support this constraint type. A unique
constraint declares that the columns in the constraint must have unique values in the table.

| Columns | Primary Key | Foreign Keys| Unique Constraints | Chedk C:mstraintsl

Constraints

Canstraint Mame Columns
IX_DEPT DEPARTMEMT_ID

Constraint Columns

Column Include
EMPLOYEE_ID
MAME
EMAIL
ROOM
SALARY
FPHOTO

DDDDDHD
b/l e

The top portion of the tab holds a list of all unique constraints, and the lower portion holds a list of all table
columns.

To create a constraint:

=

Click the Add button,

Optionally enter a constraint name in the Constraint Name field. The Columns field in the constraints list
is read-only, filled automatically as you include columns in the constraint,

3. Select the columns to be part of the constraint by clicking the checkboxes in the Include field in the
columns list.

n

You can change the column order for the constraint with the Up and Down buttons.
To remove an existing constraint:

1. Select the constraint in the list in the top section,
2. Click the Remove button.
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5.1.6 Check Constraints Tab

The Check Constraints tab is only available for databases that support this constraint type. A check constraint
declares that a column value fulfills a certain condition when a row is inserted or updated. Some databases uses
check constraints to enforce nullability rules, so when you alter a table, you may see auto-generated check
constraints for columns that you marked as not allowing null values in the Columns tab.

| Columnns | Primary Key | Foreign Keys | Unigque Cnnstraints| Check Constraints

Caonstraint Mame Caondition

ok

To create a check constraint:

1. Click the Add button,

2. Optionally enter a constraint name in the Constraint Name field.

3. Enter the condition for the column in the Condition field. You can use the same type of conditions as you
use in a SELECT WHERE clause.

To remove an existing constraint:

1. Select the constraint in the list,
2. Click the Remove button.

5.1.7 Indexes Tab

The Indexes tab is only used for the MySQL database, as a replacement for the Unique Constraints tab. The
reason is that for MySQL, the CREATE TABLE statement can be used to declare both unique and non-unique
indexes. MySQL also does not make a clear distinction between a unique constraint (a rule, most often enforced
and implemented as an index by the database) and a unique index (primarily a database structure for speeding
up queries, with the side-effect of ensuring unigue column values), as most other databases do.
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| Columns | Frimary Key | Foreign Keys| Indexes |

Constraints
Caonstraint Mame Caolumns Lnique ﬁ
X_DEPT DEPARTMENT_ID E
Constraint Columns
Column | Include Fs
EMPLOYEE_ID [
DEPARTHENT_D
NAME W
EMAIL [l
ROOM [
SALARY [
PHOTO W

The top portion of the tab holds a list of all indexes, and the lower portion holds a list of all table columns.

To create an index:

=

Click the Add button,

Optionally enter a name in the Constraint Name field. The Columns field in the constraints list is

read-only, filled automatically as you include columns in the constraint,

3. If you want the index columns to have unique values for all rows in the table, click the checkbox in the
Unique field,

4. Select the columns to be part of the index by clicking the checkboxes in the Include field in the columns

list.

n

You can change the column order for the index with the Up and Down buttons.To remove an existing index:

1. Select the index in the list in the top section,
2. Click the Remove button.

5.1.8 SQL Preview

The SQL Preview area is updated automatically to match the edits made in the assistant. The preview is read
only, but you can copy the SQL to the SQL Commander and flip between formatted and unformatted views
using the corresponding choices in the preview area right-click menu.
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5.1.9 Execute

When you are satisfied with the table declaration, click the Execute button to create it.

5.2 Altering a Table

@ Only in DbVisualizer Pro

This feature is only available in the Pro edition. In the Free edition, please execute the corresponding
SQL in the SQL Commander (see page 155).

The Alter Table dialog helps you alter a table without writing SQL.

® Opening the Alter Table Dialog (see page 67)
® Columns Tab (see page 69)

® Primary Key Tab (see page 71)

®* Foreign Keys Tab (see page 72)

® Unique Constraints Tab (see page 73)

® Check Constraints Tab (see page 74)

® |ndexes Tab (see page 75)

® SQL Preview (see page 76)

® Execute (see page 76)

5.2.1 Opening the Alter Table Dialog
To create a new table:

1. Locate the table node in the Databases tab tree,
2. Select the table node and open the Alter Table dialog from the right-click menu.
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- N
| & Alter Table 22 |
Ohiject Details

Database Connection: |HR Test Data

Database:
Schema: HR
Table: EMPLOYEES
Storage Area:
Columns Primary Key | Foreign Keys | Unigue Constraints | Chedk Cunstraints|
Mame Data Type Size Scale Mullable Default @
E EMPLOYEE_ID INTEGER ] ﬁ
DEPARTMEMT... INTEGER
MAME VARCHAR2 30 £
EMAIL VARCHARZ 20
ROCM VARCHARZ 30
SALARY NUMBER R 2
PHOTO BLOB
Show 50L Execute ] [ Cancel
SOL Preview

1LTER TABLE
2 HR.EMPLOYEES MODIFY (SALARY NUMBER(S,2))

The Alter Table dialog is organized in three areas from the top:

® General Table Info
Specifies the owning database connection, database and/or schema, and table name. These are picked
up from the selection in the tree when the assistant is started.

® Table Details
A number of tabs where you specify information about the columns and, optionally, various constraints.
The Columns, Primary Key and Foreign Key tabs are available for all databases. The remaining tabs
are database-specific and depends on the features supported by the database engine.

® SQL Preview
The SQL previewer shows the SQL statements for altering the table based on your input.
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The controls, such as the fields, pull-down menus and buttons, in the assistant are only enabled if the
ALTER TABLE statement for the database holding the table provides a way to alter the corresponding
table attribute. For instance, for a database that only allows the size of a VARCHAR column to be
altered, the Size field in the Columns tab is disabled for all columns with other data types. If you find
that you can not make the change you want, it is because the ALTER TABLE statement does not allow
that change to be made.

5.2.2 Columns Tab

The Columns tab lists all table columns along with their attributes.

Columns | Primary key | Foreign Keys | Unigue Constraints | Check Cunstraints|

Mame Data Type Size Scale Mullable Drefault E‘_ﬂ
= [ e = = [ INTEGER. [ @
DEPARTMENT_... INTEGER A
MAME YARCHARZ 30
EMAIL YVARCHARZ 30 hd
RORMM VARCHARZ 30 =
SALARY MUMBER 7 2
PHOTO BLOB

To add a column:

1. Click the Add button,

2. Enter the name of the column in the first field and select a data type from a drop down list in the second
field, or start typing the data type name to find it and select it with the Enter key. The list contains the
names of all data types the database supports,

3. For some data types, such as character types, you may also specify a size, i.e., the maximal length of the
value. For others, like the decimal types, you can may specify both a size and a scale (the maximal
number of decimals),

4. In the last two fields, specify if the table is nullable and a default value to use for rows inserted into the
table without specifying a value for the column.
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Below the column list, you may find additional fields depending on the features supported by the database you
create the table for and the data type for the current column. The Collation field is shown for character columns

if the database supports the declaration of a collation for textual data.

| € » & E

Columns | Primary Key | Foreign Keys | Indexes|
Mame Diata Type Sizre Scale Mullable Drefault
EMPLOYEE_ID  INTEGER B
DEPARTMENT_... INTEGER
MNAME VARCHAR 30
EMAIL WVARCHAR 30
ROCM VARCHAR 30
SALARY MUMERIC 7
PHOTO BLOB
Collation: :Iaﬁn?_qeneral_cs v:

The Auto Increment field, and possibly Start With and Increment By fields, are shown for numeric fields if the
database supports automatically inserting the next available sequence number in a numeric column.

Columns | Primary Key | Foreign Keys | IUnigue Constraints | Chedk Constraints|

Mame

DEPARTMENT_...
NAME

EMAIL

ROOM

SALARY

PHOTO

Data Type
INTEGER
INTEGER
WVARCHAR
WVARCHAR
VARCHAR
MUMERIC
BLOB

Size

30
30
30

Scale

| Mullable |

NEEEEEO

Default

| € » EEE

Auto Increment: [ Start With:

Increment By:
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The Create Table dialog uses database metadata to try to enable only the fields that apply to the selected data
type, but please note that it is not always possible. For instance, there is no metadata available to tell if a data
type requires, or allows, a size. If you don't enter a required attribute or enter an attribute that is unsupported for
a data type, you will get an error message when you click Execute to create the table.

To remove a column:

1. Select a cell in the column row,
2. Click the Remove button.

To move a column to another location:

1. Select a cell in the column row,
2. Click the Up or Down buttons.

5.2.3 Primary Key Tab

The Primary Key tab contains information about an optional primary key for the table. A primary key is a column
, Oor a combination of columns, that uniquely identifies a row in a table.

Columns | Primary Key | Foreign Keys I Unigue Constraints | Chedk Cnnstraints|

Constraint Mame:

Column Include
EMPLOYEE_ID J
DEPARTMENT_ID
MAME
EMAIL
ROOM
SALARY
PHOTO

9!)

15 o O =

To declare a Primary Key:

1. Optionally enter a constraint name for the primary key constraint in the Constraint Name field,
2. Select the columns to be part of the primary key by clicking the checkboxes in the Include field in the
columns list.
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5.2.4 Foreign Keys Tab

In the Foreign Keys tab, you can declare one or more foreign keys for the table. A foreign key is a column, or a
combination of columns, that refer to the primary key of another table. Foreign keys are used by the database to
enforce integrity, i.e., that there is a row in the referenced table with a primary key that matches the foreign key
value when a new row is inserted or updated, and you can optionally declare rules for what to do when a
referenced primary key is removed or updated in the referenced table.

| Colurnns | Primary Key | Foreign Keys | Unigue Constraints | Check Constraints|

Caonstraints

Constraint Mame Columns 0n Delete Action On Update Action

1]
DEPARTMENT_ID

Referenced Table
Databass Schema Tzble
HR ~  DEPARTMENTS -
Constraint Columns
Column Include Referenced Column Fs
EMPLOYEE_ID [ -
DEPARTMENT_ID DEPARTMENT_ID [
MAME [
EMAIL [ 57

The tab has the following sections:

® A list of foreign keys,
® Controls for selecting the table the currently selected foreign key refers to, including the database (

catalog) and/or schema for the table,

® A list of all columns for the table being created.

To declare a new foreign key constraint:

1.
2.
3.

Click the Add button next to the list of foreign keys,

Optionally enter a name for the foreign key in the first field in the list,

Select On Delete and On Update actions from the pull-down menus. The pull-down lists include all
actions that the database support, typically CASCADE, RESTRICT, NO ACTION and SET NULL. The
Columns field is read-only and gets its value automatically when you select which columns to include in
the key later,

Use the Referenced Table controls to select the table that the foreign key refers to,

Check the Include checkbox for all columns in the column list that should be part of the foreign key and
then select the corresponding column in the referenced table from the pull-down menu in the Referenced
Column field.
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You can change the column order for the key with the Up and Down buttons.
To remove an existing foreign key:

1. Select the foreign key in the list in the top section,
2. Click the Remove button.

5.2.5 Unique Constraints Tab

The Unique Constraints tab is only available for databases that support this constraint type. A unique
constraint declares that the columns in the constraint must have unique values in the table.

| Columns | Primary Key | Foreign Keys| Unique Constraints | Chedk C:mstraintsl

Constraints

Canstraint Mame Columns
IX_DEPT DEPARTMEMT_ID

Constraint Columns

Column Include
EMPLOYEE_ID
MAME
EMAIL
ROOM
SALARY
FPHOTO

b/l e

DDDDDHD

The top portion of the tab holds a list of all unique constraints, and the lower portion holds a list of all table
columns.

To create a constraint:

=

Click the Add button,

Optionally enter a constraint name in the Constraint Name field. The Columns field in the constraints list
is read-only, filled automatically as you include columns in the constraint,

3. Select the columns to be part of the constraint by clicking the checkboxes in the Include field in the
columns list.

n

You can change the column order for the constraint with the Up and Down buttons.

To remove an existing constraint:
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1. Select the constraint in the list in the top section,
2. Click the Remove button.

5.2.6 Check Constraints Tab

The Check Constraints tab is only available for databases that support this constraint type. A check constraint
declares that a column value fulfills a certain condition when a row is inserted or updated. Some databases uses
check constraints to enforce nullability rules, so when you alter a table, you may see auto-generated check
constraints for columns that you marked as not allowing null values in the Columns tab.

| Columnns | Primary Key | Foreign Keys | Unigue Constraints| Check Constraints

Constraint Mame Caondition

o

To create a check constraint:

1. Click the Add button,

2. Optionally enter a constraint name in the Constraint Name field.

3. Enter the condition for the column in the Condition field. You can use the same type of conditions as you
use in a SELECT WHERE clause.

To remove an existing constraint:

1. Select the constraint in the list,
2. Click the Remove button.
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5.2.7 Indexes Tab

The Indexes tab is only used for the MySQL database, as a replacement for the Unique Constraints tab. The
reason is that for MySQL, the CREATE TABLE statement can be used to declare both unique and non-unique
indexes. MySQL also does not make a clear distinction between a unique constraint (a rule, most often enforced
and implemented as an index by the database) and a unique index (primarily a database structure for speeding
up queries, with the side-effect of ensuring unique column values), as most other databases do.

| Columnns | Primary Key | Foreign Keys| Indexes |

Constraints

Constraint Mame Columns Unigue
[X_DEPT DEFPARTMENT_ID

o

Constraint Columns

Column | Include FY
EMPLOYEE_ID ]
MNAME ]
EMAIL [
ROOM ]
SALARY ]
PHOTO ]

The top portion of the tab holds a list of all indexes, and the lower portion holds a list of all table columns.

To create an index:

=

Click the Add button,

Optionally enter a name in the Constraint Name field. The Columns field in the constraints list is

read-only, filled automatically as you include columns in the constraint,

3. If you want the index columns to have unique values for all rows in the table, click the checkbox in the
Unique field,

4. Select the columns to be part of the index by clicking the checkboxes in the Include field in the columns

list.

N

You can change the column order for the index with the Up and Down buttons.To remove an existing index:

1. Select the index in the list in the top section,
2. Click the Remove button.
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5.2.8 SQL Preview

The SQL Preview area is updated automatically to match the edits made in the assistant. The preview is read
only, but you can copy the SQL to the SQL Commander and flip between formatted and unformatted views
using the corresponding choices in the preview area right-click menu.

5.2.9 Execute

When you are satisfied with the alterations, click the Execute button to create it.

5.3 Creating a Trigger

@ Only in DbVisualizer Pro

This feature is only available in the Pro edition. In the Free edition, please execute the corresponding
SQL in the SQL Commander (see page 155).

The Create Trigger dialog helps you create a trigger for a table.

® Opening the Create Trigger Dialog (see page 76)
® Trigger Editor (see page 78)

5.3.1 Opening the Create Trigger Dialog
To create a trigger for a table:

1. Locate the table in the Databases tab tree,
2. Select the table node and open the Create Trigger dialog from the right-click menu,

Page 76 of 428



1\

DbVisualizer 9.2 Users Guide

-~

| & Create Trigger

EI Create Trigger in Database Connection: HR. Production

Schema: HR.
Trigger: MyTrigger
Trigger Time: () BEFORE (@ AFTER. () INSTEAD OF

Trigger Event: [ | DELETE [¥f] INSERT || UPDATE

Trigger Type: (@ STATEMENT () ROW

Table: COUNTRIES
Source
1--
2 -- Insert your own trigger code here
3 --
4 DBMS_OUTPUT.PUT_LINE( 'Sample output'};
[¥] Show 5L
S0L Prewview
1 CREATE TRIGGER "MyTrigger" AFTER
2 INSERT
30N
4 "HR™."COUNTRIES" BEGIN
5 -
B -- Insert your own trigger code here
7 -
B DBMS_OUTPUT.PUT_LINE
9 (
1@ 'Sample output®
11 1s
12 END;

o

Execute ][ Cancel

3. Enter the required info in the fields, e.g. trigger name. The fields are database dependent so the figure is
just an example,

4. The Source area contains stub code that you can later edit in the Trigger Editor (see page 78). For most
databases you can leave it as is, but for some databases, you must adjust the stub code to match your
database objects.

5. Click the Execute button to create the trigger
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5.3.2 Trigger Editor

To edit the trigger code:

Expand the Trigger node for the table in the Databases tab tree,

Double-click the trigger node to open its Object View tab,

Open the Trigger Editor tab and edit the code (see page 142) in the editor,

Click the Save toolbar button to save (and for some databases, compile) the trigger.

A w e

If the database reports any errors, the location of the errors are highlighted with curly red underlines in the editor
for most databases. Hovering the mouse over such an underline shows the error message.

The Log tab in the results area also lists all errors. Clicking on the icon next to an error message selects the
corresponding line and positions the caret at the error location, if the database reports error locations.

5.4 Creating an Index

@ Only in DbVisualizer Pro

This feature is only available in the Pro edition. In the Free edition, please execute the corresponding
SQL in the SQL Commander (see page 155).

The Create Index dialog helps you create an index for a table without writing SQL.
To create an index for a table:

1. Locate the table in the Databases tab tree,
2. Select the table node and open the Create Index dialog from the right-click menu,

Page 78 of 428



DbVisualizer 9.2 Users Guide

Wi
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| & Create Index @

EI Create Index in Database Connection: HR. Praduction
Schema: HR
Table: COUNTRIES

Index Mame: MyIndex
Unique:

Columns

Column Mame Sort Order

COUNTRY_NAME © ASC @ DESC @ Default

o

[7] Show SQL Exeaste | | Cancel
SOL Preview

1 CREATE UNIQUE INDEX A
2 "HR™ . "My Tndex"

30N

4 "HR" . "COUNTRIES"

5 (

6 “COUNTRY_NAME" ASC

7 )

3. Enter the required info in the fields, e.g. index name. The fields are database dependent so for some
databases there are additional fields compared to the figure,

Click the Add button in the Columns area to add an index column,

Select the column to index from the Column Name drop down list,

Select the sort order for the index column from the Sort Order radio buttons,

Click the Execute button to create the index.

N o a k&

To remove an index column:

1. Select the column row,
2. Click the Remove button.

To move an index column

1. Select the column row,
2. Click the Up and Down button to move it.
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5.5 Viewing Table Data

A table's data can be viewed in in various ways in the Data tab in its Object View tab.

® Opening the Data tab (see page 80)

® Sorting (see page 82)

® Where Filter (see page 82)

® Quick Filter (see page 83)

® Max Rows/Max Chars (see page 85)

® Max Rows at First Display (see page 86)

® Column Header Tooltips (see page 87)

® Highlight Primary Key Columns (see page 87)
® Show Only Some Columns (see page 87)

® Auto Resize Columns (see page 88)

® Right-Click Menu Operations (see page 88)

® Creating Monitors (see page 91)

® Aggregation Data for Selection (see page 91)

5.5.1 Opening the Data tab
To open the Data tab for a table:

1. Locate the table in the Databases tab tree,
2. Double-click the table node to open its Object View tab,
3. Open the Data sub tab.
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88 Table: COUNTRIES

HR Production/Schemas/HR, Tables/ COUNTRIES
I‘I:d Info "m Columns] @ Data @ Row Count " é@ Primary Key "ﬁ Row Id "EE References "ﬁ' Mavigator H‘é@ Grants "E 1 ¢ B

VO S P -wEHEHEE »e -s» o |
= @@ COUNTRY_ID COUNTRY_MAME REGION_ID m
1 AR Argentina 2 -
2 AU Australia 3 ]
3 BE Belgium i
4 BR Brazil 2
5 CA Canada 2
& CH Switzerland 1
7 CN China 3
8 DE Germany 1
o DK Denmark 1
o EG Egypt 4
11 FR France 1
12 HK HongKong 3 g
13 I Israel 4
14 1IN India 3
15 IT Italy 1
1w/ IR Japan 3
17 KW Kuwait 4
18 M Mexico 2
19 NG Migeria 4
20 ML Metherlands 1
21 5G Singapore 3
22 UK United Kingdom 1 —
23 Us United States of America pr
24 M Zambia 4 i

VaxRows: -1 |MaxChars:|-1 | 0.109/0.000 sec || 25/3 | 1-24

Each column width is automatically resized to match the column width, including the column header, by default.
You can disable this behavior in the the Tool Properties dialog, in the Grid category under the General tab.

If Auto Resize Column Widths is enabled, the Max Column Width setting can be used to limit the column
width so that an extremely wide column does not take up all space.

In the same Tool Properties category, you can also disable Show Grid Row Header, i.e. the row number shown
to the left of the data rows, for read-only grids such as the Data tab in the DbVisualizer Free edition and result
sets from joined tables.

The column headers corresponds to the column names by default, but you can specify in the Tool Properties
dialog, in the Grid category under the General tab, that you like to use the column alias instead. This is mostly
useful for grids representing SQL Commander result sets, but may also be useful in the Data tab grid for some
databases.

The Data tab contains a number of features for locating and focusing on just the data of interest as described in
the following sections.
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5.5.2 Sorting

You can sort the data grid based on the values in one or more columns:

1. Click on a column header to sort the grid in ascending order on the values in that column, indicated by an
up-arrow in the column header.

2. Click the same column header again to sort in descending order, indicated by a down-arrow in the
column header.

3. Click a third time to show the data in the order it was received from the database. This removes the sort
indicator.

To sort on more than one column, Ctrl-click (keep the Ctrl key pressed when clicking) on additional columns.
The grid is then sorted on the values in the first column you clicked on (indicated with a 1 next to the arrow), and
then all rows with the same value in the first column are sorted on the values in the second sort column (
indicated with a 2 next to the arrow), and so on.

5.5.3 Where Filter

You can use the filter capability in the Data tab to limit the number of rows shown in the grid, using the same
syntax as for an SQL WHERE clause. The Filter menu button in the grid toolbar contains all operations related
to using a filter.

rl o | O B BN | B |_“|$| v'q
1[v] wHERE REGION_ID > 2

Lse Mo Filter
Clear Filter List

Show/Hide Filter (inlined)

Configure Filter...

The top entries in the menu are previously used filters for the table, if any. The checkbox is selected for the filter
that is currently in use. The filters are saved between DbVisualizer sessions, and you can toggle between them
by selecting them from the menu. The maximum number of filters to save is specified in the Tool Properties
dialog, in the Table Data category under the General tab.

You use the Use No Filter choice to disable all filters for the table, and the Clear Filter List to permanently
remove all filters for the table.

To create a new filter:

1. Select Configure Filter to launch the Filter Configuration dialog,
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s )

| @l Filter & Sort =]
Filter
(COUNTRY ID | |> - Ao |[ o |

1 REGION_ID > 2

Sort

COUNTRY ID  + | [Ascending  + |

1

| UseFiter || UseNoFiter ||  Cose |

2. Select a column name, an operation and the value for the condition using the controls in the Filter area,

3. Add the condition to the filter by clicking the AND or OR button, and create additional conditions in the
same way if needed,

4. Click the Use Filter button to apply the filter, save it and close the dialog, or close the dialog without
applying and saving the filter by clicking the Close button.

You can use Ctrl-Enter while editing the value field to reload the grid with that single condition applied, or in the
editor to reload the grid based on all filter conditions created so far.

The Sort area is similar to the Filter area. You can select column names and sort order from the two lists, and
click the Add button to add the sort criteria for the single column to the complete criteria.

If you often need to tweak the filter conditions and want a more compact user interface, you can use the inline
filter view. Use the Show/Hide Inline Filter choice in the Filter menu to toggle the visibility of the inline filter.

H# Table: COUNTRIES

HR Production/Schemas/HR/ Tables/ COUNTRIES
[é__é Info "I]] Columns] @ Data ﬁ Row Count " é@ Primary Key "ﬁ Row Id "EE References ",;?' Mavigator "f Grants "E 4 ¢ B

RO ISP uEEHEE e -n[» o |
§ Filter: \WHERE REGION_ID > 2 M- X<
= ¢ COUNTRYID COUNTRY_NAME  REGION_ID Bl
ALl Australia g -
7 CN China 3

5.5.4 Quick Filter
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@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

The Quick Filter acts on the data that is already loaded in the grid, as opposed of a Where Filter (see page 82
) which is used to limit the number of rows fetched from the database. With a Quick Filter, you can easily list
only those rows in the grid that match the entered search string.

O S P - uHEER

=

e -n N

o Mk

S TS N

4 EMPLOYEE_ID

FIRST_MAME

110 John

112 Jose Manuel
138 John

140 Joshua

LAST_MAME  HIRE_DATE

Chen 1887-09-28 . |
Urman 1998-03-07 .. |
Seo 1998-02-12 ... |
Patel 1998-04-06 ... |

null
null
null
null

All

EMPLOYEE_ID
FIRST_MAME
LAST_MAME
EMAIL
PHOME_MUMBER
HIRE_DATE
JOB_ID

SALARY
COMMISSION_PCT
MAMNAGER_ID
DEPARTMENT_ID
PHOTO

RESUME

Case sensitive
Case insensitive
Use wild cards
Match from start

Match exactly
Match anywhere

Use the Quick Filter pull-down menu (click on the down arrow next to the magnifying glass) to choose if the filter
should match cells in all columns or just one selected column, case or case insensitive matching, and where in
the cell the value must match.

For the Use wild cards option the following characters have special meaning:

? - The question mark indicates there is zero or one of the preceding element. For example, colou?r matches

both "color" and "colour".
* - The asterisk indicates there are zero or more of the preceding element. For example, ab*c matches "ac",

abc", "abbc", "abbbc", and so on.
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+ - The plus sign indicates that there is one or more of the preceding element. For example, ab+c matches "abc"
, "abbc", "abbbc", and so on, but not "ac".

5.5.5 Max Rows/Max Chars

DbVisualizer limits the number of rows shown in the Data tab to 1000 rows, by default. This is done to conserve
memory. If this limit prevents you from seeing the data of interest, you should first consider:

1. Using a Where Filter (see page 82) to only retrieve the rows of interest instead of all rows in the table,
2. Exporting the table (see page 107) to a file

If you really need to look at more than 1000 rows, you can change the value in the Max Rows field in the grid
status bar. Use a value of 0 or -1 to get all rows, or a specific number (e.g. 5000) to set a new limit.

Character data columns may contain very large values that use up lots of memory. If you are only interested in
seeing a few characters, you can set the Max Chars field in the grid status bar to the number of characters you
want to see.

You can define how to deal with columns that have more characters than the specified maximum in the Tool
Properties dialog, in the Grid category under the General tab. You have two choices: Truncate Values or
Truncate Values Visually.

®* Truncate Values truncates the original value for the grid cell to be less then the setting of Max Chars.

. This affects any subsequent edits and SQL operations that use the value since it's truncated. This
setting is only useful to save memory when viewing very large text columns.

®* Truncate Values Visually truncates the visible value only and leave the original value intact. This is the
preferred setting since it will not harm the original value. The disadvantage is that more memory is
needed when dealing with large text columns.

When the grid data is limited due to either the Max Rows or Max Chars value, you get an indication about this
in the rows/columns field in the grid status bar and in the corresponding limit field.
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HR. ProductionSchemas/HR, Tables/EMPLOYEES

| L Info | [F] Columns | [ Data | Row Count | 2 primary Key | # Row 1d | =8 References | .37 Navigator | Grants [ 2 ¢ 4 » B

VO 4P - uEFEHEE v -n|» o |
% Fiter: | K- XI=JE

4 EMPLOYEE_ID  FIRST_NAME  LAST_NAME  EMAIL PHOME_MUMBER.  HIRE_DATE JOB_ID SALARY m

w0Steven  King  SKING 1987-06-17 00:00:00 AD_PRES 24 &
101Neena  Kochhar NKOCHHAR 1959-09-21 00:00:00  AD_VP 17
102lex ~ DeHaan  LDEHAAN 1993-01-13 00:00:00  AD_VP
103 Alexander  Humold  AHUNOLD  §90.423.45  1990-01-0300:00:00 IT_PROG
104Bruce  Emst  BERNST 1991-05-21 00:00:00 IT_PROG
105David  Ausn  DAUSTIN 1997-06-25 00:00:00 IT_PROG
weVali  Patsballa  VPATABAL 590.423.45  1998-02-0500:00:00 IT_PROG
590.423.55  1993-02-0700:00:00 IT_PROG
51512445  1994-08-1700:00:00 FI_MGR
51512441  1994-08-1500:00:00 FI_ACCOUNT

1997-09-28 00:00:00 FI_ACCOUMNT
1997-09-30 00:00:00 FI_ACCOUMNT

51512444  1998-03-0700:00:00 FI_ACCOUNT
51512445  1993-12-0700:00:00 FI_ACCOUNT
515.127.45  1994-12-0700:00:00 PU_MAN

1995-05-18 00:00:00 PU_CLERK
1997-12-24 00:00:00 PU_CLERK
1997-07-24 00:00:00 PU_CLERK
1998-11-15 00:00:00 PU_CLERK

R I I N -

NNENEBEBEESREEGREERB o wo o s wme #

/1, Text data truncated by Max Chars

Ex Rows: - 5 - 0.000/0.000 sec 1-21

Along with the highlighted field, a warning pops up close to the field. You can disable this behavior in the Tool
Properties dialog, in the Grid category under the General tab.

5.5.6 Max Rows at First Display

By default, opening the Data tab for a table loads all rows, unless there is a Max Rows limit. If you have very
large tables and don't want to risk memory issues if you accidentally open the Data tab and have no Max Rows
limit, you can specify a Max Rows at First Display limit. You do this in the Tool Properties dialog, in the Table
Data category under the General tab.

The default is -1, which means no limit. If you set it to a positive number, only the specified number of rows are
loaded when the Data tab is first opened for a table. To load more rows, click the Reload button in the Data tab
toolbar.
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5.5.7 Column Header Tooltips

The column header tooltip shows data type information about the column. To see the tooltip, let the mouse
hover over the column header. The tooltip pops up in about a second.

FIRST_MAME VARCHARZ (20)

Allow MULL

JDBC: VARCHAR. (type: 12), Java: String
Column#: 2

5.5.8 Highlight Primary Key Columns

By default, a Primary Key column is shown with an icon in the column header. You can disable this in the Tool
Properties dialog, in the Table Data category under the General tab.

5.5.9 Show Only Some Columns

The Grid Column Chooser dialog controls which columns you want to appear in a grid. Open the dialog by
clicking the button above the vertical scrollbar in the grid.

| & Grid Column Chooser [=2 |
Criginal Visible Key Calumn .
Index Column Mame
1 & EMPLOYEE_ID
2 FIRST_MAME
3 LAST_MNAME
f HIRE_DATE
~2 m | pHoTO
13 RESUME
5 PHONE_NUMBER
4 EMAIL
7 JOB_ID
a SALARY
4 COMMISSION_PCT
10 MAMAGER_ID
11 DEPARTMENT _ID

The Grid Column Chooser dialog shows all columns that are available in the grid. The checkmark in front of a
column name indicates that the column is visible in the grid, while an unchecked box indicates that it is excluded
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from the grid. Click the checkmark to change the visibility of a column. You can change the visibility for all
columns at once using the two visibility buttons in the dialog.

The order of the columns can also be adjusted in this dialog. Just select a row and use the Up and Down
buttons to move it up (left in grid) or down (right in grid).

If you want to revert your changes, you can click on the Default Layout button to reset the grid, i.e., making all
column visible and put them in their default locations.

. Maodifications of column visibility, size and order are saved between invocations of DbVisualizer for all
grids in the various Object View tabs except for the Data tab.

If you modify the column visibility in the Data tab, the changes persists throughout the session. For
instance, if you remove the Name column in the Data tab for the table EMPLOYEE, the Name column
remains excluded when you reload the table or come back to the Data tab for that table later in the
same session. You must manually make it visible again to bring it back. The changes are, however,
reset when you restart the application.

5.5.10 Auto Resize Columns

The column header right-click menu contains a number of options for automatic resizing of column widths.

| Auto Resize * | All Columns (consider Header)
ﬂf Sort Column Ascending | All Columns (ignore Header) A |
% Sort Column Descending Current Column (consider Header)
Reset Sorting Current Column (ignore Header)
& Find Column... Ctrl+Alt+F Default Column Widths
[#] Select Column Ctrl+)
3 Copy Marne

5.5.11 Right-Click Menu Operations

The right-click menu for the grid contains a lot of operations for working with the data without changing it. In

addition to the common select, copy, and print operations, some operations that may require a bit of an
explanation are:

Operation Description

Copy Selection Copy all selected cells onto the system clipboard
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Operation

Copy Selection
with Column
Header

Copy Selection as
Formatted Text

Copy Selection as
Comma List

Copy Selection as
IN Clause

Save Selected Cell
Compare

Compare Selected
Cells

Browse Row in
Window

Browse Cell in
Window

Show in Navigator
Describe Data

Aggregation Data
for Selection

Generate Filter &
Sort

Create Row Count
Data Monitor

Create Row Count
DIff Data Monitor

Description

Copy all selected cells including column header onto the system clipboard.

Copy all selected cells including column header in fixed width columns onto the
system clipboard.

Copy all selected cells, with cells from the same column formatted as comma
separated values

Copy all selected cells, with cells from the same column as formatted as an IN clause,
eg.coll IN('vall, 'val2', 'val3)

Save the value of the selected cell to a file, selected with a file chooser dialog
Compare (see page 121) the data in this grid to the data in other open grids.

Compare the data in the two cells as text

Display all data for the selected row in a separate window.
Note: for a read/write grid, this entry is named Edit Row in Window.

Display the cell value in a separate window. This is especially useful for BLOB/CLOB
data.
Note: for a read/write grid, this entry is named Edit Cell in Window.

Open the Navigator (see page 123) tab with the current selections and sorting.
Show detailed information about the columns in the grid.

Displays aggregation data for the current selection. Read more in Aggregation Data for
Selection (see page 91) below.

The operations in this submenu helps you create common \Where Filters (see page
82).

Creates a monitor (see page 91) for tracking the row count in the table over time.

Creates a monitor (see page 91) for tracking the number of added or removed rows
in the table over time.
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There are also a set of operations for generating SQL statements based on the current selection. Choosing any
of these creates the appropriate SQL and then switches the view to a new SQL Commander tab. You must use
these operations to edit table data in the DbVisualizer Free edition. With the DbVisualizer Pro edition, you can
instead use inline and form based editing (see page 92).

Operation SQL Example

Script: SELECT ALL sel ect *
from HR. COUNTRI ES

Script: SELECT ALL WHERE sel ect *
from HR. COUNTRI ES
where COUNTRY_NAME = 'Brazil'

Script: SELECT ALL WITH sel ect *
FILTER from HR. COUNTRI ES
where REGON ID =1 // If thisis the filter, see above

Script: INSERT INTO TABLE insert into HR COUNTRI ES
(COUNTRY_I D, COUNTRY_NAME, REGQ ON_I D)
values ("', "', )

Script: INSERT COPY INTO insert into HR COUNTRI ES

TABLE (COUNTRY_I D, COUNTRY_NAME, REGQ ON_I D)
values ('BR, 'Brazil', 2)

Script: UPDATE WHERE updat e HR COUNTRI ES

set COUNTRY_ID = 'BR,
COUNTRY_NAME = 'Brazil"',

REG ON_ID = 2

where COUNTRY_NAME = 'Brazil'

Script: DELETE WHERE del ete from HR COUNTRI ES
where COUNTRY_NAME = 'Brazil'

You can generate SQL with either static values as they appear in the grid, or with DbVisualizer variables (see
page 221). A variable is essentially a placeholder for a value in an SQL statement. When the statement is
executed, DbVisualizer locates all variables and presents them in a dialog where you can enter or modify values
for the variables. DbVisualizer replaces the variable placeholders with the new values before executing the
statement.

Variables are used in the generated SQL statements by default. You can disable the Include Variables in SQL
setting in the Tool Properties dialog, in the Table Data category under the General tab, to use literal values are
instead.
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Here is an example of the SQL generated for Script: SELECT ALL WHERE with the Include Variables in SQL
setting enabled, assuming the table is named HR.COUNTRIES and has a column named COUNTRY_NAME
with the value 'Brazil' on the selected row:

sel ect *
from HR COUNTRI ES
wher e COUNTRY_NAME = ${ COUNTRY_NAME (where)||Brazil||String||where nullable ds=40 dt =VARCHAR }$

And here is the same example with the Include Variables in SQL setting disabled:

sel ect *
from HR COUNTRI ES
where COUNTRY_NAME = 'Brazil'

5.5.12 Creating Monitors

A monitor in DbVisualizer is an SQL query executed at a specified frequency so you can track changes in data
over time. The result can be viewed either as a grid or a graph. The right-click menu for the grid in the Data tab
contains operations for creating two common types of monitors for the table: a Row Count Data monitor or a
Row Count Diff Data monitor. The first tracks the number of rows in the table over time and the second tracks
the number of added or removed rows over time. Please read more about monitors in Monitoring Data Changes

(see page 264).

5.5.13 Aggregation Data for Selection

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

The Aggregation Data for Selection feature presents aggregation data organized per data type on the current
selection in a grid. It provides information about cells holding numbers, text, date/time information and more.
The following is an example of what it shows:
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| & Aggregation Data for Selection |E|
Selected Cells Count 1339
HH Rows 103
@ Columns 13
S Mulls 275
Text Count 618
& Shortest 2
&3 Avg Length 7
&2 Longest 18
¢, Total Length 4171
S Nulls 70
Number Count 412
& Min 10
€3 Avg 170529
) Median 132
&3 Max 24000
% sum 700 875
X Std Deviation 339149
S Mulls 1
Timestamp Count 103
@M 1987-06-17 00:00:00.0
@Aug 1997-06-09 06:22:08.155
@ Median 1997-10-30 00:00:00.0
L2 Last 2000-04-21 00:00:00.0
Binary/BLOB Count 103
S Mulls 102
CLOB Count 103
S Mulls 102
[] Handle Mumber Values in Text Types as Mumbers
[¥] Auto Update
[ Update ] [ Close

With Auto Update checked, the data is updated automatically when you change the selection in the grid. For
very large selections, you may prefer to disable this feature and instead click Update when you want to refresh
the data. Click a link (blue underlined text) in the aggregation table to locate and highlight the actual value in the
source data grid. The Handle Number Values in Text Types as Numbers setting simply treats all valid
numbers in text data types as numbers and include them in the Number Count summary.

5.6 Editing Table Data

@ Only in DbVisualizer Pro
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This feature is only available in the Pro edition. In the Free edition, please execute the corresponding
SQL in the SQL Commander (see page 155).

With the DbVisualizer Pro edition, you can edit table data in the Data tab grid; just click a cell value and edit.
Edits are saved in a single database transaction which ensures that all or no changes are committed. The
editing feature supports saving binary and large text data and it even presents common data formats in their
respective viewers, such as image viewer, PDF, XML, HEX, etc.

® Opening the Data tab (see page 93)

® Editing Data in the Grid (see page 94)

® Copy/Paste (see page 95)

® Updates and Deletes Must Match Only One Table Row (see page 97)
® Key Column(s) Chooser (see page 98)

® Editing Multiple Rows (see page 99)

® Data Type checking (see page 99)

® New Line and Carriage Return (see page 99)

® Using the Cell Editor/Viewer (see page 100)

® Using the Form Editor/Viewer (see page 101)

® Preview Changes (see page 103)

® Editing Binary/BLOB and CLOB Data (see page 104)

5.6.1 Opening the Data tab

To open the Data tab for a table:

1. Locate the table in the Databases tab tree,
2. Double-click the table node to open its Object View tab,
3. Open the Data sub tab.
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88 Table: COUNTRIES

HR Production/Schemas/HR, Tables/ COUNTRIES
Ilt_d Info "m Columns] @ Data @ Row Count " é@ Primary Key "ﬁ Row Id "Eg References ";ﬁl Mavigator Hé@ Grants "E 1 ¢ B

VO S P -wEHEHEE »e -s» o |
+ & COUNTRY_ID  COUNTRY_MAME REGION_ID |
1 AR Argentina 2 s
2 AU Australia 3 ]
3 BE Belgium i
4 BR Brazil 2
5 CA Canada 2
& CH Switzerland 1
7 CM China 3
8 DE Germany 1
o DK Denmark 1
o EG Egypt 4
11 FR France 1
12 HK HongKong 3 g
13 I Israel 4
14 1IN India 3
15 IT Italy 1
1w/ IR Japan 3
17 KW Kuwait 4
18 M Mexico 2
19 NG Migeria 4
20 ML Metherlands 1
21 56 Singapore 3
22 UK United Kingdom 1 —
23 Us United States of America 2
24 M Zambia 4 i

VaxRows: -1 |MaxChars:|-1 | 0.109/0.000 sec || 25/3 | 1-24

Each column width is automatically resized to match the column width, including the column header, by default.
You can disable this behavior in the the Tool Properties dialog, in the Grid category under the General tab.

If Auto Resize Column Widths is enabled, the Max Column Width setting can be used to limit the column
width so that an extremely wide column does not take up all space.

5.6.2 Editing Data in the Grid

To edit a column value:

1. Select the column cell,
2. Type the new value, or double click to edit the current value,
3. Click the Save toolbar button to update the database.

You can also use the Set Selected Cells drop down menu to set a number of column values to things like null
or the current date or time.
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To add a new row:

Select the row above where you want to insert the new row,
Click the Add Row toolbar button,

Enter values for the columns,

Click the Save toolbar button to update the database.

P wbh e

To duplicate a row:

Select the row you want to duplicate,

Click the Duplicate Row toolbar button,

Edit at least the key column(s) value(s),

Click the Save toolbar button to update the database.

AP wnh e

To delete one or more rows:

1. Select the rows to delete,
2. Click the Delete Rows toolbar button,
3. Click the Save toolbar button to update the database.

If you change your mind, you easily can undo edits:

1. Select the cell(s) you want to revert,
2. Click the Undo toolbar button.

Reverting all cells in a row that are marked as Insert or Duplicate removes the complete row from the grid while
a Delete marked row is cleared from its delete state. Undoing updated cells simply reverts the changes to the
original values.

5.6.3 Copy/Paste

You can copy selected cell values with the Copy Selection right-click menu choice or the corresponding key
binding (Ctrl-C or Command-C by default). The data on the clipboard may then be pasted either into
DbVisualizer or any external application. The column and newline delimiter used for copy and paste operations
in the grid editor are defined by the Copy Grid Cells in CSV Format settings in the Grid category in the Tool
Properties dialog, under the General tab. The default setting are sufficient for most uses.

The grid editor supports pasting data from the major spreadsheet applications, such as Excel and OpenOffice.
The grid editor supports pasting single data as well as block of data. Copy/paste of binary data is transparent
between grids or in the same grid. Binary files may also be copied in an external application and pasted in a cell
in DbVisualizer (target cell must be a binary type).
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Copy from spreadsheet

A single cell is copied

A B C D
1 200 Jennifer Whalen 515.123.4444
2 | 201 Michael Hartstein 515.123.5555
3 EGBMavris 215.123.7777
4 | 204 Hermann Baer 515.123 8888
5 | 205 Shelley Higgins 515.,123.8080
6 | 206 William Gietz 515.123.8181
7 | 100 Steven King 515.123.4567
2 |101 Neena Kochhar 515.123.4568
9 102 Lex De Haan 515.123.4569

A single cell is copied

A B C D
1 | 200 Jennifer Whalen 515.123.4444
2 | 201 Michael Hartstein 515.123.5355
3 203Mavri5 515.123.7777
4 204 Hermann Baer 515.123.8888
5 | 205 Shelley Higgins 515.123.8080
6 | 206 William Gietz 515.123.8181
7 | 100 Steven King 515.123.4567
8 101 Neena Kochhar 515.123.4568
9 102 Lex De Haan 515.123.4569

Multiple cells in a single row is copied

A B i D
1 | 200 Jennifer Whalen 515.123.4444
2 | 201 Michael Hartstein 515.123.5555
3 | 203})5usan Mavris 4315.123.7777
4 | 204 Hermann Baer 515.123.8888
5 | 205 Shelley Higgins 515.123.8080
6 | 206 William Gietz 515.123.8181
7 | 100 Steven King 515.123.4567
8 |101 Neena Kochhar 515.123.4568
9 102 Lex De Haan 515.123.4569

A block of cells is copied

Paste into DbVisualizer grid

Paste into selected target cell

4* EMPLOYEE_ID FIRST_MAME LAST_MAME
7 100 Steven King '
3 101 Meena Kochhar
g 102 Lex
10 108 Mancy Greenberg
11 108 Daniel Faviet
12 110 John Chen
13 111 Ismael Sciarra
14 112 Jose Manuel Urman
15 113 Luis Popp
16 114 Den Raphaely

Paste and fill the single column target selection

£ EMPLOYEE_ID FIRST_MNAME LAST_NAME
7 100 Steven King '
2 101 Meena Kochhar
g 7 102 EMEE D= Haan
10 & 108 EMEELI Greenberg
1 7 109 Faviet
12 7 110 Chen
13 111 Ismael Sciarra
14 112 Jose Manuel Urman
15 113 Luis Popp
16 114 Den Raphaely

Paste and fill the target selection

£ EMPLOYEE_ID FIRST_NAME LAST_NAME

7 100 Steven King |

2 101 Meena Kochhar
9/ Wlpdsusan  [Mavis |
10 7 108
17 109
12 7 110
13 111 Ismael Sciarra

14 112 Jose Manuel Urman

15 113 Luis Popp

16 114 Den Raphaely

The block is pasted into the selected region
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Copy from spreadsheet

Paste into DbVisualizer grid

£ EMPLOYEE_ID FIRST_MNAME LAST_NAME

7 100 Steven King '

2 101 Meena Kochhar
9/ 102
10 7 108
17 109
12 7 lfwiiam  |Gietz |
13 111 Ismael Sciarra

14 112 Jose Manuel Urman

15 113 Luis Popp

16 114 Den Raphaely

A B C D
1 | 200 Jennifer Whalen 515.123.4444
2 | 201 Michael Hartstein 515.123.5555
3 | 203jSusan Mavris 515.123.7777
4 ZMEHermann Baer 515.123.88588
5 2I:|','5:Shelle1,|r Higgins 515.123.8080
7] Zﬂﬁ:WiIIiam Gietz 4515.123.8181
7 | 100 Steven King 515.123.4567
8 101 Meena Kochhar 515.123.4568
9 102 Lex De Haan 515.123.4569
A block of cells is copied
A B C D
1 | 200 Jennifer Whalen 515.123.4444
2 | 201 Michael Hartstein 515.123.5555
3 | 203}Susan Mavris 515.123.7777
= EMEHermann Baer 515.123.8888
3 2I:r5:5helle1yr Higgins 515.123.8080
& EDE:WiIIiam Gietz 1515.123.8181
7 | 100 Steven King 515.123.4567
8 | 101 Neena Kochhar 515.123.4568
9 102 Lex De Haan 515.123.4569

The block is pasted into a non equal number of targe

4 EMPLOYEE_ID FIRST_MNAME LAST_MNAME
7 100 Steven King '
8 101 Meena Kachhar
9 Pllex  |peHaan
10 M8Nancy [Greenberg
11 102 Daniel Faviet
12 110 John Chen

1 Motification Alert

| Al

You have requested to paste 4 rows into the seles
Do yvou want to Add Rows in the grid so that all r

[ "Add Rows | |Don't Add Rows | [

5.6.4 Updates and Deletes Must Match Only One Table Row

When you update or delete rows, DbVisualizer ensures that only one row in the table will be affected. This is to
prevent changes in one row to silently affect data in other rows. DbVisualizer uses the following strategies to
determine the uniqueness of the edited row:

1. Primary Key,
2. Unique Index,
3. Manually Selected Columns.

The Primary Key concept is widely used in databases to uniquely identify the key columns in tables. If the table
has a primary key, DbVisualizer uses it. There are situations when primary keys are not supported by a
database or when primary keys are supported but not used. If no primary key is defined, DbVisualizer checks if
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there is a unique index. If there are several unique indexes, DbVisualizer picks one of them. If there is no
primary key or any unique indexes defined for the table, you need to manually choose what columns to use. The
Key Column Chooser is automatically displayed if the key columns can't be determined automatically.

5.6.5 Key Column(s) Chooser

Normally database tables have a primary key or at least one unique index. If this is the case, editing is no
problem. If there is no way to uniquely identify rows in the table, you need to manually define what columns
DbVisualizer should use. While saving the changes, DbVisualizer checks that there is a way to identify unique
rows in the table. If it cannot be accomplished, the following window is displayed.

£ EMPLOYEE_ID FIRST_NAME LAST_MAME PHOME_MNUMBER  EMAIL
[ 204 Hermann Baer 515.123.8888 HBAER 2
8 205 Shelley Higgins 515.123.8080 SHIGGINS 2
9 206 William Gietz 515.123.8181 WGIETZ 2
10 & 100 TS King 515.123.4567 SKING 2
11 101 Meena Kochhar 515.123.4568 MEKOCHH... 2
12 | & Key Column(s) Chooser @ N2
13 o 2
14 Select the colurmn(s) that will be used to form the where dause for 2
15 update and delete edits. This is used by DbVisualizer to ensure that only T
16 one row in the target database table will be affected by each edited row. L o
(If there is a primary key or unique index for the table then the Key

17 Column is automatically set). ITZ 2
18 HBE 2
19 Key Column Column Name Data Type 2
20 EMPLOYEE_ID MNUMBER - 7
21 [l FIRST_MAME VARCHARZ e
22 o LAST_MAME VARCHARZ = M 2
23 [E EMAIL VARCHARZ 3
24 0 PHOME_MUMBER VARCHARZ 4 AL 3
25 [l HIRE_DATE DATE 2
26 o JOB_ID VARCHARZ 5
2? =1 ol AW kI IRADC D il 2
28 Ensble Al | | Dissble Al || Close o 2
28 MA 2
a0 120 Matthew Weiss 650.123.1234 MWEISS Z

The key column chooser can also be manually opened via the Edit Table Data->Key Column Chooser
right-click menu choice.

If the database request to save the edits cannot uniquely identify the single row that should be changed, an error
dialog is displayed and the editing state is kept for that row in the grid editor.
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5.6.6 Editing Multiple Rows

The grid editor supports editing multiple rows and saving all changes in one database transaction. Edited rows
are indicated with an icon in the row header:

# Cell(s) in the row has been edited

+ Row is new

% Row is duplicated from another row

* Row is marked for deletion (edit is not allowed)

5.6.7 Data Type checking

When leaving an edited cell, the new value is validated with the data type for the column. If there is an error, the
following dialog is displayed.

HIRE_DATE £ EMPLOYEE_ID FIRST_NAME LAST_MNAME EM:
1 1991-05-21 00:00:00 104 Bruce Ernst BERM
2 1998-02-05 00:00:00 106 Valli Pataballa VPATA
3 |1993-02-03a | 102 Lex DeHaan  LDEH.
4 |1899-p=—==ss=sss e = = E—
5 19874 Error Alert [ 2 |
6 1897- I-"' _."'-I The entered value doesn't match the format for the column,
[ 1994+ y f
o 1994- a Value: "1993-02-03a00:00:00" I
g 1994 Valid Timestamp/Datetime Format: yyyy-MM-dd HH:mm:ss ¢
10 [1994- Correct the value or press ESC key to revert the edit. 1
11 |19884
13 |198974

5.6.8 New Line and Carriage Return

If a cell in the grid editor or form editor contains new line, carriage return or tab characters, these are not visually
represented in the grid. Instead a warning will be displayed whenever you try to edit such value:
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10:00:00 102 [MEU N ET g De Haan LDEHAAM 515.123.4569 AD_VP

10:00:00 198 Donald OConnell DOCOM... 6505079833 SH_CL
Confirmation Alert | 22 :

The data in this cell contains formatting characters (newline, carriage return or tah).
It is not recommended to edit this data in the inline editor as it automatically removes any
formatting characters. Instead you should use the designated multilined Cell Editor,

Edit in Cell Editor | | EditAnyway | |  Cancel |

10700 T3 AIEXaNaeET FOTOTT AAONUCD o9 3Z3 3507 MT_FRL

You may chose to edit the value in the Cell Editor (see page 100), which we recommend, as the control
characters will then be preserved. Alternatively, you can edit the value in the grid anyway but you then risk
loosing the control characters.

5.6.9 Using the Cell Editor/Viewer

The Cell Viewer is available in the right-click menu for all grids in DbVisualizer. It presents the data for a single
cell (column in a row) in a window. If the data is of a recognized type, it is presented by a corresponding viewer:

®* Image viewer

* XML viewer

® Serialized Java object viewer
® Hex viewer

® Text viewer

The Cell Viewer also allow you to save the data to a file and to print it.

The Cell Editor adds editing capability to the cell viewer. You may import data from a file or manually change
the text in a text editor.
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- y

| & Cell Form (Editable) - "FIRST_MAME"

G ld R >R

[] Use Wrapped Editor {automatic word wrap)

g

1 Lex
2 Adwvisor

FIRST_NAME VARCHAR?Z (20)
Allow MULL
Text, 11 Bytes, text/plain

Close

5.6.10 Using the Form Editor/Viewer

The Form Viewer is available in the right-click menu (Browse Row in Form) for all grids in DbVisualizer. It is
used to browse information and to present binary data in viewers.

The Form Editor adds editing capability to the form viewer. This editor is useful when inserting new rows and
when it is important to get a more balanced overview of all the data.

The form editor "rotate” the data in one row and presents it as a vertical form with the column name as a label.
All edits made in the form editor are reflected in the grid with the edited state icon being updated along with new
values. Saving edits in the database is always done with the Save button in the grid editor toolbar, just as for
data edited directly in the grid.

Open the form editor via the Edit Row in Form right-click menu choice, via the corresponding button in the
toolbar or by double-clicking the row number header.
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L3
£ EMPLOYEE_ID FIRST_NAME LAST NAME EMAIL  PHONE_NUMBER PHOTO

1 104 Bruce Ermnst BERNST  500.423 4568 (null)

2 106 Vall Pataballa  VPATABAL 590.423.45G0 (null)

3 102 Lexe DeHaan  LDEHAAN 515.123.45G9 &% BINARY, 5 888 Bytes
4 ) 98[Donald  [OConnell  |[DOCON... [650507.9833 |  BINARY, 10 630 Bytes|
5 200 Jennifer Whalen JWHALEM 515123 4444 [nul}

5 202 Pat Fay PFAY 603.123 6666 (null)

7 203 Susan Mavris SMAVRIS 5151237777 &% BINARY, 8 620 Bytes
3 204 Hermann  Baer HBAER  515.123.3288 & BINARY, 8 719 Bytes
a ANAR Shallaw Hinninc SHICCZIMNS RAR 4972 Qnan frolly

The same row looks like this in the row form window:

-

| & Row Form (Editable)

Sl RE e -8

™y

[=]

Key Mame

£ EMPLOYEE_ID
FIRST_NAME
LAST_NAME
EMAIL
PHONE_NUMBER
HIRE_DATE
JOB_ID
SALARY
COMMISSION_PCT
MANAGER_ID
DEPARTMENT_ID

PHOTO

RESUME

Value

108

Donald

OConnell
DOCOMNMEL
650.507.9833
19899-06-21 00:00:00
SH_CLERK

2600

(null}

124

50

BIMARY, 10 630 Bytes, image/gif
[null)

Close

The Key field contains an icon for primary key columns and the Name field corresponds to the column name in
the grid. None of Key or the Name fields can be edited. You can edit the values in the form in the same way as
you edit values in the grid editor.
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The form viewer presents images as thumbnails. The size of these is controlled by the Image Thumbnail Size
setting in the Tool Properties dialog, in the Form Viewer category under the General tab. To see the original
size of an image, open the cell in the cell viewer either by selecting Edit in Cell Window in the grid right-click
menu, the toolbar button or by double-clicking on the image.

If you want numbers to be right-aligned in the Form Viewer, enable Right Aligned Numbers in the Tool
Properties dialog, in the Form Viewer category under the General tab.

5.6.11 Preview Changes

You may preview the SQL statements that will be executed when choosing to Save the edits via the Edit Table
Data->SQL Preview right-click menu choice.

& EMPLOYEE_ID FIRST_NAME LAST_NAME PHONE_NUMBER EMAIL HIRE_DATE  JOB_ID  SALARY

204 Hermann  Baer 515.123.8888 HBAER  2002-06-07 00:00:00 PR_REP 1000¢

8 205 Shelley Higgins £15.123.8080 SHIGGINS  2002-06-07 00:00:00 AC_MGR 12008

a 206 William Gieftz 515.123.3181 WGIETZ ~ 2002-06-07 00:00:00 AC_ACCOUNT  830C

10 & 100 Luke King 515123 4567 SKING 2003-06-17 00:00:00 AD_PRES 24000

17 101 Kahaar [GET I 5715 123 4568 MKOCHH. . 2005-09-21 00:00:00 AD_VP 1700C

12 102 Lex DeHaan  515.123.4539 LOEHAAM  2001-01-13 00:00:00 AD_VP 1700¢

134 102 Lex DeHaan  515.123.4559 LDEHAAM  2004-01-13 00:00:00 AD_VP 1700¢

14 102 Alexander  Hunold 590.423.4567 AHUMOLD  2006-04-03 00:00:00 IT_PROG a0ac

15 X 04Bruce  [Emst  [5904234568  |BERNST  2007-05-2100:00:00 [T PROG 600

16 X 05David ____ [Austin___ 5904234569 |DAUSTIN _[2005-06-25 00:00:00 [T PROG _____ 480d

| &l SQL Preview E

This is a preview of the SQL that will be executed when the table data edit(s) are saved. g

1update "HR"."EMPLOYEES" set "FIRST_NAME" = 'Luke' where "EMPLOYEE_ID" = 198; ~ E
2 update "HR"."EMPLOYEES" set "FIRST_NAME" = 'Kohaar' where "EMPLOYEE_ID" = 181;

3insert into "HR"."EMPLOYEES" ("EMPLOYEE_ID", "FIRST_NAME", "LAST_NAME", "EMAIL", "PHONE_NUMBER", ¢

4 delete from "HR"."EMPLOYEES" where "EMPLOYEE_ID" = 184, C

5 delete from "HR"."EMPLOYEES" where "EMPLOYEE_ID" = 185 -1 He

' 1 | r ¢

C

:

C

0 1 440 T Hirmnira F4AR 4797 ARRR [ WY TR =Ta JNNE 44 AR AnN-An-nn oL o CoR T=TaTy

v The listed SQL statements may not be 100% identical to what is sent to the database, as the save
process uses variable binding to pass values to the database.
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5.6.12 Editing Binary/BLOB and CLOB Data

Due to the nature of binary/BLOB and CLOB data, cells of these types can only be fully modified and viewed in
the Cell Editor (see page ). (There is partial support in the Form Editor (see page 101) to view image data
and to load from file).

In the grid, Binary/BLOB and CLOB data is by default presented by an icon and the size of the value. You can
select another presentation format in the Tools Properties dialog, in the Grid / Binary/BLOB and CLOB Data
category under the General tab. Selecting By Value results in performance penalties and the memory
consumption increases dramatically.

In the same Tool Properties category, you can also specify how to handle Copy/Paste and Drag and Drop
when pasting binary data in a target component that doesn't support binary data.

Editing binary data can be done by importing from a file or via the text editor in the Cell Editor. You can also
copy the file in the operating system's file browser and paste it into a BLOB/CLOB cell.

Binary data in DbVisualizer is the generic term for several common binary database types:

* LONGVARBINARY
®* BINARY

* VARBINARY

* BLOB

The Image Viewer supports displaying full size images for the following formats:

* GIF

* JPG
* PNG
* TIFF
* BMP
* PDF

5.7 Working with Binary and BLOB Data

DbVisualizer provides special support for working with Binary/BLOB data in a number of areas, such as:

® Viewing and Editing Binary/BLOB data (see page 104),
® Exporting Binary/BLOB data (see page 109),
®* Importing Binary/BLOB data (see page )
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5.8 Working with Large Text/CLOB Data

DbVisualizer provides special support for working with Large Text/CLOB data in a number of areas, such as:

® Viewing and Editing Large Text/CLOB data (see page 104),
® Exporting Large Text/CLOB data (see page 109),
®* Importing Large Text/CLOB data (see page )

5.9 Using Max Rows and Max Chars for a Table

DbVisualizer limits the number of rows shown in the Data tab to 1000 rows, by default. This is done to conserve
memory. If this limit prevents you from seeing the data of interest, you should first consider:

1. Using a Where Filter (see page 82) to only retrieve the rows of interest instead of all rows in the table,
2. Exporting the table (see page 107) to afile

If you really need to look at more than 1000 rows, you can change the value in the Max Rows field in the grid
status bar. Use a value of 0 or -1 to get all rows, or a specific number (e.g. 5000) to set a new limit.

Character data columns may contain very large values that use up lots of memory. If you are only interested in
seeing a few characters, you can set the Max Chars field in the grid status bar to the number of characters you
want to see.

You can define how to deal with columns that have more characters than the specified maximum in the Tool
Properties dialog, in the Grid category under the General tab. You have two choices: Truncate Values or
Truncate Values Visually.

® Truncate Values truncates the original value for the grid cell to be less then the setting of Max Chars.

»  This affects any subsequent edits and SQL operations that use the value since it's truncated. This
setting is only useful to save memory when viewing very large text columns.

®* Truncate Values Visually truncates the visible value only and leave the original value intact. This is the
preferred setting since it will not harm the original value. The disadvantage is that more memory is
needed when dealing with large text columns.

When the grid data is limited due to either the Max Rows or Max Chars value, you get an indication about this
in the rows/columns field in the grid status bar and in the corresponding limit field.
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i Table: EMPLOYEES

HR Production/Schemas/HR/ Tzbles/ EMPLOYEES

| L Info | [F] Columns | [ Data | Row Count | 2 primary Key | # Row 1d | =8 References | .37 Navigator | Grants [ 2 ¢ 4 » B

Y IEIERLTET T NIRRT Q| |
% Fiter: | K -8
a@ EMPLOYEE_ID FIRST_MNAME LAST_MNAME EMAIL PHOME _NUMBER. HIRE_DATE JOB_ID SALARYE]

w0Steven  King  SKING 1987-06-17 00:00:00 AD_PRES 24 -
101Neena  Kochhar NKOCHHAR 1959-09-21 00:00:00  AD_VP 17
102lex ~ DeHaan  LDEHAAN 1993-01-1300:00:00 AD_VP 17
103 Alexander  Humold  AHUNOLD  §90.423.45  1990-01-0300:00:00 IT_PROG Ei
104Bruce  Emst  BERNST 1991-05-21 00:00:00 IT_PROG &l
105David  Ausn  DAUSTIN 1997-06-25 00:00:00 IT_PROG %
_— VPATABAL  590.423.45  1998-02-0500:00:00 IT_PROG 4
590.423.55  1993-02-0700:00:00 IT_PROG 4
51512445  1994-08-1700:00:00 FI_MGR 120
51512441  1994-08-1500:00:00 FI_ACCOUNT 9

1997-09-28 00:00:00 FI_ACCOUMNT 3:
1997-09-30 00:00:00 FI_ACCOUMNT T

51512444  1998-03-0700:00:00 FI_ACCOUNT 7
51512445  1993-12-0700:00:00 FI_ACCOUNT B¢
515.127.45  1994-12-0700:00:00 PU_MAN 11¢

1995-05-18 00:00:00 PU_CLERK
1997-12-24 00:00:00 PU_CLERK
1997-07-24 00:00:00 PU_CLERK
1998-11-15 00:00:00 PU_CLERK

RN AN AN AR

NNENEBEBEESREEGREERB o wo o s wme #

/1, Text data truncated by Max Chars
]

Max Rows: |10 Max Chars: |10 | 0.000/0.000 sec _ 121

Along with the highlighted field, a warning pops up close to the field. You can disable this behavior in the Tool
Properties dialog, in the Grid category under the General tab.

5.10 Changing the Data Display Format

Some data, like numeric and date/time data, can be displayed in many different ways.
To define how to display and enter data in grids and forms in DbVisualizer:

1. Open Tools->Tool Properties,
2. Select the Data Formats node under the General tab,
3. Select or enter your preferred format for the different data types.
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5.10.1 Date, Time and Timestamp formats

The lists for date, time and timestamp format contain collections of standard formats. If these formats are not
suitable, you can enter your own format in the appropriate field. The tokens used to define the format are listed
in the right-click menu when the field has focus.

G - Era Designator

y - Year

M - Month in year

w - Week in year

W - Week in month

D - Day in year

d - Day in month

F - Day of week in month
E - Day in week

a - AM/PM marker

H - Hour in day (0-23]

k- Hour in day (1-24)

K - Hour in AM/PM (0-11)
h - Hour in AM/PM (1-12)
m - Minute in hour

s - Second in minute

5 - Millisecond

z- Time zone

Z - Time zone

The complete documentation for these tokens is available at the following web page: SimpleDateFormat (http://

docs.oracle.com/javase/6/docs/api/java/text/SimpleDateFormat.html) .

5.10.2 Number formats

The lists for number and decimal number contain collections of standard formats. If these formats are not
suitable, you can enter your own format in the appropriate field. The tokens used to define the format are listed
in the right-click menu when the field has focus, and complete documentation for these tokens is available at the
following web page: DecimalFormat (http://docs.oracle.com/javase/6/docs/api/java/text/DecimalFormat.html).

5.11 Exporting a Table
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(1] Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

You can export an individual table using the Export Table assistant.

® Qutput Format (see page 108)

® Qutput Destination (see page 108)

® Options (see page 109)

® Using Variables in Fields (see page 109)

® Exporting Binary/BLOB and CLOB Data (see page 109)
® Saving And Loading Settings (see page 110)

® Other Ways to Export Table Data (see page 110)

To export a table:

Select the table node in the Databases tab tree,

Open the Export Table dialog from the right-click menu,
Select an Output Format, Output Destination, and Options,
Click Export.

P wn e

5.11.1 Output Format
You can export tables in one of these formats: CSV, HTML, SQL, XML, XLS (Excel), or JSON.

For the SQL and XML formats, you can choose to export the DDL and the table data; the other formats only
export table data.

You can control whether to use delimited identifiers and/or qualified names (see page 276) by default in the DDL
and INSERT statements generated for the SQL format, and you can override the defaults in the Export dialog for
a single export operation.

5.11.2 Output Destination

The destination can be one of:

® afile,

® an open or new SQL Commander tab, with options for where in an open SQL Commander to insert the
result,

® to the system clipboard.
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5.11.3 Options

The options depend on the selected Output Format.

For the SQL and XML formats, you can choose to export the DDL, DDL for the indexes, and the table data: as
INSERT statements for the SQL statement or in one of three XML formats.

For the XLS format, you can choose export the data as either regular Binary Excel or OOXML for Excel 2007
and later.

Most formats also let you specify other options, such as delimiters, title and descriptions. Just select an Output
Format to see which options are available.

You can also adjust the Data Formats specifically for the exported data. By default, the formats defined in Tool
Properties are used, but sometimes you need to export dates and numbers in a different format because you
intend to import the data into a different type of database.

In the Data Format Settings dialog you can also specify how to quote text data and how to handle quotes
within the text value.

5.11.4 Using Variables in Fields

You can use some of the pre-defined DbVisualizer variables (see page 221) (${ dbvi s- dat e} $, ${

dbvi s-tinme}$, ${dbvi s-ti nest anp}$, ${dbvi s-connecti on}$, ${dbvi s- dat abase-t ype}$ and ${
dbvi s- obj ect } $) in all fields that hold free text (e.g. title and description fields) and as part of the file name
field.

5.11.5 Exporting Binary/BLOB and CLOB Data

You can use the export assistant to export Binary/BLOB and CLOB data. You enable this by choosing File as
the data format for Binary/BLOB and/or CLOB data. Optionally, you can specify the directory for the data files.
If you do not specify a directory, the operating system's default directory for temporary files (e.g. C:\TEMP or /
tmp) is used.

Binary /BLOB: File w | Dir: C:YWUsersthansiblobs |_|

CLOB: File i w | Dir:|C:\Usersthans'plobs El

The data for each individual value of this type is then exported to a separate file and a DbVisualizer variable
referencing the file is inserted in the main export file.
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5.11.6 Saving And Loading Settings

If you often use the same settings, you can save them as the default settings for this assistant. If you use a
number of common settings, you can save them to individual files that you can load as needed. Use the Settings
button menu to accomplish this:

® Save as Default Settings
Saves all format settings as default. These are then loaded automatically when open an Export Schema
dialog
® Use Default Settings
Use this choice to initialize the settings with default values
®* Remove Default Settings
Removes the saved defaults and restores the regular defaults
* Load
Use this choice to open the file chooser dialog, in which you can select a settings file
® Save As
Use this choice to save the settings to a file

® Copy Settings to Clipboard
Use this choice to copy all settings to the system clipboard. These can then be pasted into the SQL
Commander to define the settings for the @export editor commands.

5.11.7 Other Ways to Export Table Data

® Export all or selected tables with the Export Schema (see page 152) assistant,
® Export a subset of the table data with the @export command (see page 209).

5.12 Importing Table Data

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

You can import data using the Import Table Data wizard.

® Input File Format and Other Options (see page 111)
® CSV format page (see page 112)
® Excel format page (see page 113)
® Data Formats and Data Type Per Column (see page 114)
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Matching Columns and Data Types for an Existing Table (see page 116)
Adjusting Table Declaration for a New Table (see page 118)

Importing Binary/BLOB and CLOB Data (CSV Only) (see page 120)
Saving And Loading Settings (see page 120)

Other Ways to Import Table Data (see page 121)

Known limitations (see page 121)

You can import data from a file into an existing table or to a new table. The import source can be either a CSV
file or an Excel file (. xI s or . xI sx). The steps are almost identical:

1.

Select the table node for the table you want to import to, or the Tables node if you are importing to a new
table, in the Databases tab tree,
Open the Import Table Data wizard from the right-click menu,

3. Specify the input file on the first wizard page (CSV or Excel file),

E

© N o v

[Excel only] : If the input file is an Excel file, you are asked to choose the Excel sheet to import on the
next page.

Specify file format and other options,

Specify data formats and the data type per column,

Adjust details about the destination table,

Click Import on the last page.

Instead of choosing Import Table Data from the right-click menu, you can drag and drop a file from
the operating system's file manager on the Tables node or a table node.

How many INSERT statements to execute during the import process before committing the changes can be
specified in the Properties tab for the connection, in the Transaction category.

5.12.1 Input File Format and Other Options

On the File Format page, you specify what and how the data in the source file should be imported. This includes
specifying what row to start the import from and if empty rows should be skipped.

Currently DbVisualizer supports import of CSV files and the Excel file formats ".xsl" and "xsIx".
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CSV format page

b )

Z. Import File

Delimiters

Column Delimiter: (@) Auto Detect () String | TAB v

Options
Row of Header: 1
Start Row Of Data: 2
Skip Empty Row(s):
Skip Rows Starting With: | 109
Text Quoted Between: -
Data
Grid File
EMFLOYEE_ID FIRST_MAME  LAST_MAME  EMAIL PHOME_MUMBER.  HIRE_DATE
104 "Bruce” "Ernst” "BERMET" "590.423 45687 "2007-05-210 i
105 "David” "Austin® "DAUSTINT "590.423 45697 "2005-06-250
106 “Valli® "Pataballa” “WPATABAL" "590.423 45607 "2008-02-050
107 "Diana” “Lorentz” "DLOREMNTZ" 500423 55677 "2007-02-07 0 3
108 "Mancy” “Greenberg” "MEGREEMBE® "515.124 45697 "2002-08-17 04—
109 “Daniel” “Faviet” "DFAVIET™ "516.124 4169" "2002-08-16 0
110 “John® “Chen” “JCHEMN" "516.124 42697 "2005-09-28 0
111 “lsmael” “Sciarra” ISCIARRA" "515.124 43697 "2005-09-300 =
< | 11l »
Preview Rows: |20 || Fit Column Widths
< Back ] ’ Mext = ] ’ Cancel

In the Delimiters section, define the character that separates the columns in the file. If you enable Auto Detect,
DbVisualizer tries the following characters:

¢ comma”,
* tab "TAB"

® semicolon";
® percent "%"
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You can specify any character sequence as a delimiter, but it must not contain more than four
characters.

You can use the Options area to further specify how to read the input file, for instance if certain rows should be
skipped and how text data is quoted.

The Data section at the bottom of the page shows a preview of the parsed data in the Grid tab and the original
source file in the File tab. If a row in the Grid tab is red, it indicates that the row will be ignored during the import
process. This happens if any of the Options settings result in rows not being qualified.

Excel format page

The Excel format page is very much like the CSV format page.

As Excel is from start organized in columns and rows the Column delimiter setting is not applicable to Excel
files. The Skip Rows Starting With and the Text Quoted Between options are also not supported for Excel.

As shown in the snapshot below there is no File tab for Excel files.

The Grid tab shows a preview of the data, just as in the CSV case.
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. Import File 3w
Options
Row of Header: 1
Start Row Of Data: 2|
Skip Empty Row(s):
Data
Grid
EMPLOYEE_ID  FIRST_NAME  LAST_NAME  EMAIL PHONE_NUMBER  HIRE_DATE
100 Steven King SKING 515.123.4567 2003-06-17 00:( =
101 Meena Kochhar MNKOCHHAR 515123 4568 2005-09-21 00c(
102 Lex De Haan LDEHAAM 515.123.4569 2001-01-13 00c(
103 Alexander Hunold AHUMNOLD 590423 4567 2006-01-03 00c(
104 Bruce Ernst BERMST 590.423.4568 2007-05-21 00:{| =
105 David Austin DALISTIM 590.423.4569 2005-06-25 00c(
106 Walli Pataballa YVPATABAL 590.423 4560 2006-02-05 00:(
107 Diana Lorentz DLOREMNTZ 590423 5567 2007-02-07 00:(
108 Mancy Greenberg MNGREEMBE 515124 4569 2002-08-17 00:(
104 Daniel Faviet DFAVIET 515124 41649 2002-08-16 00:(
110 John Chen JCHEM 515124 42649 2005-09-28 00:(
111 lzmael Sciarra ISCIARRA 515124 4369 2005-09-30 00c(
112 Jose Manuel Urman JMURMARM 515124 4469 2006-03-07 00 ™
< 11l r
Preview Rows: 20 | Fit Column Widths
< Back ] ’ MNext = ] ’ Cancel

5.12.2 Data Formats and Data Type Per Column

The Data Formats page is used to define formats for some data types. The first row in the preview grid contains
a data type drop-down lists. DbVisualizer tries to determine the data type for each column by looking at the
value for the number of rows specified as Preview Rows. If this data type is incorrect for a column, use the
drop-down lists to select the appropriate type.
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-

- Import File 3w

Data Formats

Date: yyyy-MM-dd w | Example: 2014-11-05
Time: HH:mm:ss | Example: 14:30:56
Timestamp: yyyy-MM-dd HH:mm:ss w | Example: 2014-11-05 14:30:56

Thousand Separator:

P

Decimal Separator:

Null Values: (null) Example: (null}, NULL, nada
Boolean True: true, yes, 1, on Bxample: true, 1, yes, on
Boolean False: false, no, 0, off Bxample: false, 0, no, off
Data
Grid File
EMPLOYE... FIRST_M... LAST_NA.. EMAI PHONE_... HIRE_DATE JOB_ID SALARY
@ Number '@ String @ String 'i;:j String '@ String @ String @ String '@ Humk =
100 "Steven” "King” "SKING" "815123.4... "2003-06-1... "TAD_PRES" 24000 |—
101 "Meana” "Waochhar®  "MKOCHH.. "515123.4. "2005-09-2.. "AD_VP" 17000 N
102 “Lex” "De Haan™ “LDEHAAN" "515123.4. "2001-01-1.. "AD_VP" 17000
103 “Alexander” “Hunold” "AHUMOLD® "590.423.4. "2006-01-0. "IT_PROG" 9000
104 “Bruce” “Ernst” "BERMST" "590423.4 . "2007-05-2. °IT_PROG" G000
105 "David” “Austin® DAUSTINT  "590423 4. "2005-06-2. "IT_PROG" 4800 R
4 1] 3
Preview Rows: 20 | Fit Column Widths

< Back ] P MNext> | ’ Cancel

. If you need to change the data type for a number of columns, e.g. set them all to String, you can Copy/
Paste the data type. First change it for one of the columns using the drop-down, select and copy that
new data type value and then select the data type for all other columns and use paste to change them

all at once. If you make a mistake, you can change the Preview Rows value to let DbVisualizer
determine the types again.

If you import to an existing table, there is yet another way to adjust the data types for the file columns, described
in the next section.
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5.12.3 Matching Columns and Data Types for an Existing Table

When you are importing to an existing table, the Import Destination page provides two options: Grid and
Current Database Table. You can use the Grid choice to import the data into a grid that is presented in its own
window in DbVisualizer if you just want to just process the data in some way without saving it in the database.

When the Current Database Table choice is selected, the page shows information about the table into which
the data will be imported in the Map Table Columns with File Columns grid shows the columns in the selected
database table and the columns in the source file.

.- 1

. Import File 3w

Import Into
Grid (@) Current Database Table Mew Database Table

Database Table
Database Connection: |Oral2C_HR

Database:
Schema: HR
Table: EMFLOYEES

Map Table Columns with File Columns

Map Columns -

Key Table Column Name Table Data T Map by Column Name

£ EMPLOYEE_ID NUMBER Map by Column Index
FIRST_MAME VARCHARZ )
LAST NAME S Map File Data Type = Table Data Type
EMAIL VARCHARZ Clear Mappings
PHOMNE_MUMBER VARCHARZ PHONE_NUMBER String
HIRE_DATE DATE HIRE_DATE String
JOB_ID VARCHAR2 JOB_ID String
SALARY MNUMBER SALARY Mumber
COMMISSION_PCT MNUMBER COMMISSION_PCT String
MAMNAGER_ID MNUMBER MANAGER_ID Mumber
DEPARTMENT_ID MNUMBER DEPARTMENT_ID Mumber

Use delimited identifiers

Settings = | < Back | | Mext = | | Cancel

DbVisualizer automatically associates the columns in the source file with the columns in the target table in the
order they appear. If the columns appear in a different order in the file than in the table, but they are named the
same, you can use the auto-mapping menu in the upper right corner of the Map Table Columns with File
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Columns grid to automatically map the columns by hame. Map by Column Name and Map by Column Index
do exactly what it sounds like. Map File Data Type = Table Data Type sets the File Data Type for each column

to the type of the corresponding table column.

If the column names are different between the file and the table and also appear in different order, you can
manually map them using the drop-down lists in the File Column Name field. Choose the empty choice in the

columns drop-down to ignore the column during import.

. Impaort File

Import Into

Database Table
Database Connection: Oral2C_HR

Database:
Schema: HR
Table: EMFLOYEES

Map Table Columns with File Columns

() Grid (@) Current Database Table New Database Table

Map Columns -

-

EX=

Key Table Column Name Table Data Type

£ EMPLOYEE_ID MNUMBER
FIRST_MAME YVARCHARZ
LAST MNAME VARCHARZ
EMAIL YVARCHARZ
PHOME_MUMBER VARCHARZ
HIRE_DATE DATE
JOB_ID VARCHARZ
SALARY NUMBER
COMMISSION_PCT MNUMBER
MAMAGER_ID MNUMBER
DEPARTMENT_ID MNUMBER

File Column Name

EMPLOYEE_ID
FIRST_NAME
LAST_MNAME -

|| use delimited identifiers

EMPLOYEE_ID
FIRST_NAME
EMAIL
PHONE_NUMBER
HIRE_DATE
JOB_ID

SALARY
COMMISSION_PCT
MANAGER_ID
DEPARTMENT_ID

File Data Type

Mumber
String
String
String
String
String
String
Mumber
String
Mumber
Mumber

Settings =

< Back ] ’ Mext =

|

Cancel

" You can use copy/paste of the values in the File Column Name and File Data Type fields to quickly

fill the selection of cells instead of manually selecting the correct data in the drop-downs.
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There is also a Use delimited identifiers checkbox. Check this box if you want the SQL statements for
importing the table to use delimited identifiers; in other words, if you want to use table and column names with
special characters, mixed case, or anything else that requires delimited (quoted) identifiers.

5.12.4 Adjusting Table Declaration for a New Table

When you are importing to a new table, the Import Destination page provides two options: Grid and New
Database Table. You can use the Grid choice to import the data into a grid that is presented in its own window
in DbVisualizer if you just want to just process the data in some way without saving it in the database.

When the New Database Table choice is selected, you are presented with a field for the table name and a
number of tabs for column and constraint declarations. The Columns tab is filled out based on the source data
and the data types from the Data Formats page.
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P "

. Import File 3w

Import Into
Grid Current Database Table (@) New Database Table
Mew Table Details
Database Connection: (Oral2C_HR

Database: -
Schema: HR -
Table: newTable

Columns |Primary Key | Foreign Keys | Unique Constraints | Check Constraints

Mame Data Type Size Scale Mullable Default ®
EMFLOYEE_ID INTEGER ar|
FIRST_MAME WARCHARZ 20

LAST_MAME VARCHARZ 20

EMAIL WARCHARZ 20

PHOME_MUMBER VARCHARZ 20

HIRE_DATE WARCHARZ 30

JOB_ID WARCHARZ 20

SALARY INTEGER

COMMISSION_PCT WARCHARZ 10 v

MANAGER_ID INTEGER o

DEFARTMENT_ID INTEGER

Drop existing table, if any Use delimited identifiers

Settings = | < Back | | Mext = | | Cancel

Note that it is not always possible to find a database specific type for the data format specified on the Data
Format page. You must then pick the correct type from the Data Type drop-down menu. The size for string
column types may also need to be adjusted. By default, the size is set to the maximum number of characters
found for the column in the number of rows specified as Preview Rows, adjusted up to the next power of ten.
You can ignore certain columns by removing them in the Columns tab. Keys and other constraints can be
created using the other tabs.

You can go back to the Data Format page and increase the Preview Rows value if you believe that it will help
DbVisualizer to pick better defaults. If you do so, you need to click the Reload button when you come back to
this page to rescan the source data and get new default values.

If you make a mistake, or if the import fails, so you have to go back and make adjustments before you import
again, make sure you enable Drop existing table, if any. It is disabled by default to prevent you from
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accidentally dropping an existing table when you intend to import to a new table, but if the import fails, the new
table may already have been created so it needs to be dropped before a new table with your adjusted input can
be created.

There is also a Use delimited identifiers checkbox. Check this box if you want the SQL statements for
importing the table to use delimited identifiers; in other words, if you want to use table and column names with
special characters, mixed case, or anything else that requires delimited (quoted) identifiers.

5.12.5 Importing Binary/BLOB and CLOB Data (CSV Only)

If you have exported data to a CSV file using DbVisualizer, use the Import Table Data feature to import it. On the
Data Format page, ensure that the format for the source file column is set to BLOB or CLOB.

Data

Grid | File

id phota

1 Fdata1-1||C\Wsers\hans\blobs\dbvis 520222837 2370417084 bin||BinaryData||noshow vi=file}s

If you have exported Binary/BLOB and CLOB data as an SQL script, you just run the script in the SQL
Commander to import it. When the SQL Commander encounters a variable that refers to a file, it reads the file
and inserts the content as the column value.

5.12.6 Saving And Loading Settings

If you often use the same settings, you can save them as the default settings for this assistant. If you use a
number of common settings, you can save them to individual files that you can load as needed. Use the Settings
button menu to accomplish this:

® Save as Default Settings
Saves all format settings as default. These are then loaded automatically when open an Export Schema
dialog
® Use Default Settings
Use this choice to initialize the settings with default values
®* Remove Default Settings
Removes the saved defaults and restores the regular defaults
®* Load
Use this choice to open the file chooser dialog, in which you can select a settings file
¢ Save As
Use this choice to save the settings to a file
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5.12.7 Other Ways to Import Table Data

If you have a script containing INSERT statements for all data, you can execute it in the SQL Commander (see
page 173).

5.12.8 Known limitations

® Excel files cannot contain CLOB/BLOB type of data (e.g. images etc). Cells with this kind of data are
imported as empty.

® There is a size limitation when importing Excel files with the . x/ s filename extension. The size limitation
is roughly 20 megabytes, depending on your configuration and how much memory is used for other
things. Increasing DbVisualizer max memory (http://confluence.dbvis.com/pages/viewpage.action?pageld=
3146118) may allow you to import larger files.

5.13 Comparing Tables

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

You can compare different aspects of a table to other tables and/or result set grids.

For instance, to compare the DDL for a table to the DDL for another table:

1. Open the DDL tab for the table,

2. Open the DDL tab for the other table,

3. Select Compare from the right-click menu in one of the DDL tabs to compare their text content (see page
256).

To compare the table data to the data of another table or a result set:

1. Open the Data tab for the table,
2. Open the Data tab for another table or execute an SQL query to open a result set tab,
3. Select Compare from the right-click menu in one of the tabs to compare their grid content (see page 258)

You can do the same for all the other Object View sub tabs containing a grid, such as the Primary Key or
Columns tab.
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5.14 Viewing Table Relationships

To see how a table is related to other tables through Foreign Keys:

Locate the table in the Databases tab tree,

Double-click the node to open its Object View tab,

Select the References sub tab,

Select Imported Keys from the drop-down list in the toolbar to see tables referenced by foreign keys in
this table,

5. Select Exported Keys from the drop-down list to see tables referencing this table by foreign keys.

A w DD

i Table: EMPLOYEES

HR.EMPLOYEES
< EMPLOYEE_ID NUWB ER(E)
FIRST_NAWE VAR CHARZ(20)
LAST_MAME AR CHARZ(25)
EMAIL AR CHARZ(25) HR.JOBS
PHONE_NUWBER  ARCHARZ(Z0)
HIRE_DATE DATE f & JoB_ID WARCHARZ(1D)
JOE_ID VARCHARZ(1D) JOB_TITLE  WARCHAR2(35)
SALARY NUWEB ER(E 2) MIN_SALARY  NUWBER(E)
COMMISSION_PCT MUWBER(Z,2) MAX_SALARY  WUMBER(E)
MANAGER_ID NUB ER(E)
DEPARTMENT_ID  NUWBER(4) HR.DEPARTMENTS
1 4" DEPARTMENT_ID NUMBER()
DEPARTMENT_NAME WARCHAR2(ID)
MANAGER_ID NUMBER(E)
LOCATION_ID NUME ER(4)

|89%||Tables: 3||References: 3|

You can select among different graph layouts in the layout drop-down list in the toolbar: Hierarchic, Organic,
Orthogonal, or Circular.

Other layout settings can be changed in the Graph Control area, which is shown or hidden with the settings
toggle button in the toolbar. For instance, you can select how much information to include for each table in the
graph: just the Table Name, the Primary Key column(s) or all Columns.

The graph can be Exported to a file in JPG, GIF, PNG, SVG or PDF or Saved as a Graph Modeling Language (
GML) file that you can then open in the yEd (http://www.yworks.com/en/products_yed_about.html) tool from yWorks
for further manipulation.
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You can control whether the table names should be qualified with the schema/catalog (see page 276) in the
graph.

5.15 Navigating Table Relationships

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

A powerful way to study database data is to navigate between the tables in a schema by following table
relationships declared by Primary and Foreign Keys. DbVisualizer includes a Navigator feature for this purpose,
visualizing the relationships graphically while making the data for each navigation case easily accessible in a
data grid.

® Opening the Navigator (see page 123)

® Navigating Realtionships (see page 124)

® Adding Context Information to the Graph (see page 128)
® Arranging the Graph (see page 129)

® Exporting and Printing the Graph (see page 130)

® Opening the Navigator from the Data tab (see page 131)

5.15.1 Opening the Navigator
To launch the Navigator:

1. Locate the table you want to start the navigation from in the Databases tab tree,
2. Double-click the table node to open its Object View tab,
3. Select the Navigator sub tab.
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8 Table: DEPARTMENTS

L Grants | ) coumnscomment | ) Constraints | () Triggers | ! Dependendes | MobL | DDLU withstorage |
!gInfo | [f]Columns | [{f|Data | E@RowcCount | 2 Primarykey | <Findexes | P Rowld | cBReferences | 3 Navigator |

BOSFRNALLILPPLEE DS

DEPARTMENT_ID
DEFARTMENT_NAME Human Resources HR .EMPLOYEES

Y

? DEPARTMENT_ID 40

HR.DEPARTMENTS DEPARTMENT_ID

U -

¥

B0 S P - GEEHEHE >y - u || g - E=
& EMPLOYEE_ID FIRST_NAME LAST_NAME EMAIL PHONE_NUMBER  HIRE_DATE  JOB_ID SALARY COMMISSION
1 103 Alexander  Humold  AHUNOLD 5904234567  1990-01-03 00-00:00 IT_PROG 9000
2 104 Bruce Ernst BERNST 5904234568  1991-05-2100:00:00 IT_PROG 6000
3 105 David Austin DAUSTIMN 590.423.4569 1997-06-25 00:00:00 IT_PROG 4800
4 106 Valli Pataballa  VPATABAL 590.423.4560 1998-02-05 00:00:00 IT_PROG 4800
5 107 Diana Lorentz  DLOREN.. 5904235567  1999-02-07 00°:00:00 IT_PROG 4200
4| m | ,
Max Rows: 1000 | Max Chars: -1 | 0.015/0.000 sec | 5/11][1-5

The Navigator tab has two parts: a graphical view and a data grid. Initially, the graphical view shows just the
selected start table, and the data grid shows the data for the start table.

The data grid is of the same type as you encounter in other parts of DbVisualizer, such as in the Data tab (see
page 92), but extended with a Related Table list and a Tag button.

5.15.2 Navigating Realtionships

Data navigation in DbVisualizer means following table relationships declared by Primary and Foreign Keys,
using a unique key value. In the example schema shown in the screen shots in this section, there is a table
named DEPARTMENTS with a primary key named DEPARTMENT _| D. Another table named EMPLOYEES has a
foreign key constraint, declaring that values in its DEPARTMENT_I D column refer to primary key values in the
column with the same name in the DEPARTMENTS table.
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B0 2 PG HERE e - B | G|RbtedTabe -

==0 e B = S R = TR RSO

w

10

4 DEPARTMENT_ID DEPARTMENT_MAME MAN:
10 Administration '
20 Marketing
30 Purchasing
40 Human Resources
A0 Shipping
o [
70 Public Relations
80 Sales
90 Executive

100 Finance

DEPARTMEMTS (MAMAGER_ID) -» EMPLOYEES (EMPLOYEE_ID)
DEPARTMENTS (LOCATION_ID) -» LOCATIONS (LOCATION_ID)
DEPARTMENTS (DEPARTMEMT_ID) <- EMPLOYEES (DEPARTMENT_IDY
DEPARTMEMTS (DEPARTMEMT_IDY) <- JOB_HISTORY (DEPARTMENT _ID)

121
103
204
145
100
108

1500
1400
2700
2500
1700
1700

-

Max Rows: | 1000 Max Chars: -1

0.125/0.001 sec || 27/4 || 1-11

If you use DEPARTMENTS as you start table, you can easily navigate to the EMPLOYEES table for different
DEPARTMENT_I Dvalues. In the data grid, select one or more columns in the row that holds the

DEPARTMENT_I D you want to use for navigation. In the figure above, the DEPARTMENT_NAME column in the row
for DEPARTMENT _| D = 60 is selected.

Next, bring up the Related Table list. It lists all tables the DEPARTMENTS table is related to through Primary and
Foreign Keys, with the key columns within parenthesis. A forward arrow (->) between the table names means
that the DEPARTMENTS table has a foreign key relation to the named table. A backward arrow (<-) means that

the named table has a foreign key relation to the DEPARTMENTS table.
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B Table: DEPARTMENTS

™ DDL with Storage |

A2 Grants | /) columns Comment | [j] Constraints | () Triggers | . Dependencies
snces | ,ﬁ'Navigator ‘

|
| ginfo | [f]coumns | [Hpata | E@RowCount | °Primarykey | <pindexes | SRowid | cHRe
BOIFPRLLTLLEHED®

>

DEPARTMENT_ID

DEPARTMENT_NAME 1T
HR .DEPARTMENTS >

VO 3 P - uEHEEHB e - o | &rarae - &
& EMPLOYEE_ID FIRST_NAME LAST NAME EMAIL PHONE_NUMBER  HIRE_DATE  JOB_ID SALARY COMMISSION
1 103 Alexander Hunold AHUMOLD 590.423.4567 1990-01-03 00:00:00 IT_PROG 9000
2 104 Bruce Emnst BERNST 5904234568  1991-05-2100:00:00 IT_PROG 6000
3 105 David Austin DAUSTIN 5904234568  1997-06-2500:00:00 IT_PROG 4800
4 106 Valli Pataballa  VPATABAL 590.423.4560 1998-02-05 00:00:00 IT_PROG 4300
5 107 Diana Lorentz DLOREN... 590.423.5567 1999-02-07 00:00:00 IT_PROG 4200
4 m | v
Max Rows: 1000 | Max Chars:|-1 | |0.015/0.000 sec | 5/11] 15 |

When you select "DEPARTMENTS (DEPARTMENT_ID) <- EMPLOYEES (DEPARTMENT_ID)" in the Related
Table list, a node is added to the graph for the EMPLOYEES table, with an arrow from the DEPARTMENTS table
node to show the navigation direction. We call this a navigation case.

The EMPLOYEES node contains the key columns (just one in this example) and their values.

The arrow between the nodes is labeled with the key column name. In addition, the arrow label also shows the
name and value of the column that you selected in the DEPARTMENTS table when you created this navigation
case, i.e., the DEPARTMENT _NAME column. If you select multiple columns when you create a navigation case, all
non-key column names and values are included in the arrow label. This can make it easier to see at a glance
what a navigation case represents.

The grid is also updated when you create a navigation case, to show all rows in the table you navigated to that
has a key value corresponding to the selected key value in the table you navigated from. In this case, it shows
all rows in the EMPLOYEES table with DEPARTMENT _| D equal to 60.
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“~ You can edit the grid values, but be aware that if you change the value of a key in the grid for a
navigation case, the row will disappear from the grid since the grid only shows rows with keys
matching the navigation case key value.

You can continue to create more navigation cases from any node in the graph. For instance, if the schema
contains a table with job history information for employees, you can navigate to the history for an employee from
the EMPLOYEES node. Or, you can select the DEPARTMENTS node in the graph to navigate to the EMPLOYEES
table for a different department. Just click on the DEPARTMENTS node, select another row in the data grid and

then the same Related Table list entry.

B Table: DEPARTMENTS

P orants | ) coumnsComment | [l Constraints | () Triggers | g Dependences | MpoL | ™ DOL with Storage |
{ginfo | [[]cokmns | [[[Data | E@Rowcount | 2 Primarykey | <pindexes | S Rowld | —BReferences | 3 Navigator |

BOSIFR PP LLEED S

DEPARTMENT_ID

DEPARTMENT_NAME Human Resources _
k.-

HR.DEPARTMENTS DEPARTMENT_ID
DEFARTMENT_NAME IT HR.EMPLOYEES

& DEPARTMENT_ID &0

T

¥

03P - |EHEE e - u|»| @[ - [
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/%, If you want to create multiple navigation cases from one table to another using the same relationship,
you can select columns in multiple rows in the first table. When you make a selection in the Related
Table list, one navigation case per row is created.
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Every time you select a node in the graph, the data grid is updated to show the corresponding data. The grid
settings for one node are independent of the settings for another node. For instance, if you define a filter for one
node, the filter is only associated with the grid for that node.

5.15.3 Adding Context Information to the Graph

The navigation node always shows the key columns and their values, but sometimes you may want to add other
columns to the node to better describe what it represents. This is called tagging the node. There are two ways to
do so: drag and drop cells from the grid to any node, or use the Tag button in the grid toolbar to tag the currently
selected node with the currently selected cells in the grid.

To drag and drop cells to a node, select one or more cells in the grid. With the left mouse button pressed and
the mouse positioned over one of the selected cells, drag the cells over a node in the graph and release the
mouse button. The cells are added to the node.

i Table: DEPARTMENTS

/™ DDL with Storage |

P orants | ) coumnscomment | [ constraints | (3 Triggers | . Dependencies
ences | ,ﬁ'Navigator ‘

|
| lgmfo | [§]Comns | “Fpata | PRowCount | P Primarykey | <Findexes | 5 Rowid

BODIFRLLTLLPEED®

&
o

DEPARTMENT_ID
DEFARTMENT_NAME Human Resources

k-
y

HR.DEPARTMENTS |

DEPARTMENT_ID
DEFARTMENT_NAME IT HR .EMPLOYEES

4 DEPARTMENT_ID &0

Y

BO |3 P - uEHEHE B oo - v W |RebedTabie - o
# EMPLOYEE_ID FIRST_NAME LAST_MAME EMAIL PHONE_NUMBER  HIRE_DATE  JOB_ID SALARY COMMISSION_
1 203 S E I suAVRIS 5151237777 1994-06-07 00:00:00 HR_REP 6500

4| ] | 3

Max Rows: 1000 |Max Chars: -1 | | 0.000/0.000 sec | /11| 1-1 |
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Alternatively, you can select the cells in the grid and click on the Tag button ( ) to add the cell values to the
currently selected node.

5.15.4 Arranging the Graph

As you add navigation cases, you may find that you need to move nodes around, remove selected nodes, zoom
and move around in the graph, etc.

You can rearrange the layout of the graph by selecting a node and, with the left mouse button pressed, drag it
around. The arrow and its label move with the node.

The toolbar for the graph offers a number of tools to help you with other tasks:

[
@

Clicking the Reload button removes all navigation cases, leaving just the node for the table you started with.

You use the Show/Hide Controls button to control the display of an Overview control, see below.

=]
—1

¢l

Fimd

The Zoom In button lets you zoom into the graph, one step per click.

(ol

The Zoom Out button zooms the graph out one step with each click.

n

The Zoom Selected Area button zoom the currently selected node.

(&

Clicking the Zoom 100% button zooms the graph so that all items are shown with their standard size.

s

Toggle the Magnifying Mode. When enabled, the content around the mouse pointer is magnified.

Use the Fit button to make all graph items fit in the graph display area.

The Relayout button lays out all graph item with standard positions, distances between items, etc.

bl
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The Remove Node button removes the selected node. It is only enabled when a navigation case node is
selected.

[
[

Toggle between Navigation and Edit Modes. With Navigation Mode enabled, you can move the graph content
with the left mouse button depressed.
The Overview control is useful for large graphs that do not fit into the display area.

sOsrRILLILLEH D@

» | Overview - Docked:

HR.JOBS
EMPLOYEE_ID ) 408 _ID .
FIRST_NAME Mo & 10810 AC Mo i
] LAST NAME  Kochir HR.JOB_HISTORY | — 108 TIME ieantig Memger
— 1 > =
| 4 EMPLOYEE_ID 101 [—
— J08_10
— L - =
&0
5
& I
[ [ T | e

The gray area in the Overview control indicates the portion of the graph that is currently shown in the display
area. You can drag the gray area around to study other portions of the graph.

To get a larger graph display area, you can put the Overview control in a separate window. Just uncheck the
Docked checkbox.

5.15.5 Exporting and Printing the Graph

You can also export the graph to an image file or print it. Use the corresponding toolbar buttons to do this:

Export the graph to a file in JPG, GIF, PNG, SVG or PDF format.

5

Print the graph

Show a preview of how the graph will be printed

When you print the graph, you are prompted for information about what to print (the Graph or the View, i.e., just

the portion visible in the display area) and how many rows and columns to split the printing over (one page is
used for each row/column).
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5.15.6 Opening the Navigator from the Data tab

Sometimes, you may realize that you want to analyze the relationships for a table when you are working with it
in the Data tab. If you have configured the Data tab to show only filtered data, sorted in a specific way, etc.
opening the Navigator tab and making all the same configurations there may be a bit of a hassle. A more
convenient way is to just pick Show in Navigator in the right-click menu in the Data tab. It opens the table in
the Navigator tab with all the same configurations as you made in the Data tab.

5.16 Viewing the Table DDL

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

To see the DDL (CREATE statement) for a table:

1. Locate the table node in the Databases tab tree,
2. Double-click the table node to open its Object View tab,
3. Select the DDL sub tab.

The DDL shown is based on metadata retrieved from the database, but it may not include some
database-specific clauses, such as storage clauses. For some databases, there is an additional sub tab named
Native DDL (or similar) that shows the DDL as generated by the database itself, including all clauses.

5.17 Filtering Tables in the Tree

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

If you have many tables in the tree, it may be hard to find the ones of most interest. You can then define a filter
so that only a few tables are shown, as described in Filtering Database Objects (see page 49).
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5.18 Showing Row Count in the Tree

You can use the Database->Show/Hide Table Row Count menu choice to see the number of rows within
parenthesis next to the table name in the Database tab tree.

. Enabling this property results in a performance degradation.

5.19 Using Permissions for Table Data Editing

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

The Permission functionality is a security mechanism, where you can specify that certain database operations
must be confirmed. You configure permissions in the Tool Properties dialog, in the Permissions category of the
General tab, per connection mode (Development, Test and Production).

You specify which connection mode to use for a connection in the Properties tab of the Object View tab for the
connection.

. The permission feature is part of DbVisualizer and does not replace the authorization system in the
actual database.

For table grid edits, you can pick the permission type from a drop-down list for each operation:

Permission Type Description
Confirm A confirmation window is displayed, and you can accept the operation or cancel it

No Confirm The SQL operation is performed without any confirmation
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Table Data Editor Permissions
Define here f insert, update and delete must be confirmed in the table data editor.

Development Test Production

INSERT: |[B» Mo Confirm | | No Confirm | | il Confirm -
UPDATE: | [ Mo Confirm | | Confirm ~ | |} confirm -
DELETE: |[B» Mo Confirm | | Confirm ~ | i} Confirm -

5.20 Scripting a Table

To open the Script Table dialog, where you can insert generated text for a table in an SQL Commander editor:

1. Select one or more table nodes in the Databases tab tree,
2. Choose Script Table from the right-click menu.

You can also launch the dialog by dragging and dropping one or more nodes of the same type in an SQL
Commander editor.

»  If you just want to insert the object names in the editor, hold down the Ctrl key (or the Alt key on Mac
OS X) while dragging and dropping. This behavior can be reversed in Tool Properties, in the SQL
Commander category, so that dropping without pressing a key inserts the names and pressing the key
launches the dialog.

The Script dialog provides a choice of which type of statement to generate, options for formatting, use of
delimited identifiers, qualified names and statement delimiters. You can also pick an open SQL Commander or a
new as the destination, and where in the SQL Commander editor to insert the text.

Page 133 of 428



= DbVisualizer 9.2 Users Guide

6 Working with Views

DbVisualizer provides many ways to work with views.

6.1 Creating a View

There is no GUI dialog for creating a view, but you can:

1. Use the Query Builder (see page 189) to create the SELECT statement graphically,

2. Load the generated SELECT statement into the SQL Editor by clicking the corresponding button in the
toolbar,

3. Add CREATE VI EW nane AS before the SELECT statement,

4. Execute the CREATE VIEW statement.

6.2 Altering a View

Views can typically not be altered; they must be dropped and recreated. You can:

Select the view in the Databases tree,

Double-click the view node to open its Object View tab,

Open the DDL sub tab,

Select Copy to New Editor from the DDL tab's right-click menu, which opens an SQL Commander tab

with the DDL,

5. Remove the CREATE VIEW part in the SQL Commander editor so you are left with just the SELECT
statement,

6. Load the SELECT statement into the Query Builder and alter it graphically,

7. Launch the Drop View assistant from the view node's right-click menu, and click Execute to drop it,

8. Create the new view (see page 134) from the altered SELECT statement.

P wbn e

6.3 Editing a View

You can edit view data the same as you edit table data (see page 92).

6.4 Exporting a View

You can export a view the same way as you export a table (see page 107).
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6.5 Viewing the View DDL

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

To see the DDL (CREATE statement) for a view:

1. Locate the view node in the Databases tab tree,
2. Double-click the view node to open its Object View tab,
3. Select the DDL sub tab.

6.6 Filtering Views in the Tree

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

If you have many views in the tree, it may be hard to find the ones of most interest. You can then define a filter
so that only a few views are shown, as described in Filtering Database Objects (see page 49).

6.7 Scripting a View

To open the Script View dialog, where you can insert generated text for a view in an SQL Commander editor:

1. Select one or more view nodes in the Databases tab tree,
2. Choose Script View from the right-click menu.

You can also launch the dialog by dragging and dropping one or more nodes of the same type in an SQL
Commander editor.

»  If you just want to insert the object names in the editor, hold down the Ctrl key (or the Alt key on Mac
OS X) while dragging and dropping. This behavior can be reversed in Tool Properties, in the SQL
Commander category, so that dropping without pressing a key inserts the names and pressing the key
launches the dialog.
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The Script dialog provides a choice of which type of statement to generate, options for formatting, use of
delimited identifiers, qualified names and statement delimiters. You can also pick an open SQL Commander or a
new as the destination, and where in the SQL Commander editor to insert the text.
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7 Working with Procedures, Functions and Other
Code Objects

Many databases offer the capability to store custom code in the database, primarily as functions and procedures
, Where a function has a return value but a procedure does not (a procedure may instead have output
parameters). In addition, some databases offer a package concept, which means that a collection of functions
and/or procedures are grouped together in one unit. A package is the interface describing the functions and
procedures, while the package body contains the implementation. Many databases also support triggers: code
that is executed when triggered by an event such as deleting a row in a table.

You can use DbVisualizer actions to create and drop procedural object of these types, and use the code editor
to browse, edit and compile these object types. Procedures and functions can also be executed in the SQL
Commander, with return values and parameters bound to DbVisualizer variables.

7.1 Creating a Function

(1) Only in DbVisualizer Pro

This feature is only available in the Pro edition. In the Free edition, please execute the corresponding
SQL in the SQL Commander (see page 155).

To create a new function:

1. Expand nodes in the tree under the connection node in the Databases tab tree until you reach the

Functions node,
2. Select the Functions node and open the Create Function dialog from the right-click menu.
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1

"
C@ Create Function in Database Connection: HR. Production
Function Owrner: .HR
Funiction Mame: myfunction

Return Data Type: WARCHAR2

Farameters

| & Create Function @

Mame Direction Type Default
VARCHARZ2

pl N
pphor wowa |

<[tlele

[] Show SQL [ Execute ][ Cancel

SOL Preview
1 CREATE
ZFUNCTION "HR".myfunction (pl IN VARCHARZ,
3 p2 IN OUT VARCHARZ)
4 RETURM WARCHARZ AS
5 BEGIN
B DBMS_OUTPUT.PUT_LIME( 'Sample output');
7 RETURN MULL;
8 END;

y

The details of the dialog depends on the database, but typically you need to:

1. Enter an object name,
2. Click the Add button in the Parameters area to add parameters,

3. Enter a name and data type for each parameter. For some databases you can also enter a direction (

typically IN, OUT, or INOUT) and a default value.

You can use the other buttons to the right of the parameter list to remove and move a parameter.

The dialog uses this information together with a simple sample body to compose a CREATE statement. For
most databases, you can not enter the real code in the action dialog. The real code is often complex and large,
so DbVisualizer provides a more powerful editing environment than would fit in a dialog via the Code Editor (see
page 142). What you create with the assistant should be seen as a template that you then complete and work

with in the editor.

For some databases the sample code is editable because there is no way to write a generic sample that
compiles. You must then modify the template to something that is syntactically correct, but we still recommend

that you finish the real code in the Code Editor instead.

Page 138 of 428



;\./\ DbVisualizer 9.2 Users Guide

Click Execute in the dialog to create the new function.

7.2 Creating a Procedure

@ Only in DbVisualizer Pro

This feature is only available in the Pro edition. In the Free edition, please execute the corresponding
SQL in the SQL Commander (see page 155).

To create a new procedure:

1. Expand nodes in the tree under the connection node in the Databases tab tree until you reach the

Procedures node,
2. Select the Procedures node and open the Create Procedure dialog from the right-click menu.
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| & Create Procedure @
Ohject Details
Database Connection: |Orade
Procedure Owner: :HF‘. -
Procedure Mame: UPDATE_STATUS
{gﬁ Parameters
Mame Direction Type Default .@. |
order_id_start
order_jd_end IM MUMBER. -1
FoY
status IM VARCHARZ 'CLOSED"
W
Show SQL Execute ] [ Cancel ]
S0L Preview
2|9 -
1 CREATE
Z PROCEDURE “HE™.TPDATE ATATIS
3 [
4 order id start IH NUMBER DEFAULT -1,
5 order _id end IH NUMEER DEFRULT -1,
& status IN VARCHAR: DEFAULT 'CLOZED')
T AS
& BEGIHN
g DEMS _OUTPUT. PUT_LINE {'Sample output'):
10 EHD ;

The details of the dialog depends on the database, but typically you need to:

1. Enter an object name,

2. Click the Add button in the Parameters area to add parameters,

3. Enter a name and data type for each parameter. For some databases you can also enter a direction (
typically IN, OUT, or INOUT) and a default value.

You can use the other buttons to the right of the parameter list to remove and move a parameter.

The dialog uses this information together with a simple sample body to compose a CREATE statement. For
most databases, you can not enter the real code in the action dialog. The real code is often complex and large,
so DbVisualizer provides a more powerful editing environment than would fit in a dialog via the Code Editor (see
page 142). What you create with the assistant should be seen as a template that you then complete and work
with in the editor.
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For some databases the sample code is editable because there is no way to write a generic sample that
compiles. You must then modify the template to something that is syntactically correct, but we still recommend
that you finish the real code in the Code Editor instead.

Click Execute in the dialog to create the new procedure.

7.3 Creating Other Code Objects

@ Only in DbVisualizer Pro

This feature is only available in the Pro edition. In the Free edition, please execute the corresponding
SQL in the SQL Commander (see page 155).

Some databases support other code object types in addition to function, stored procedure and trigger, e.g.
Package in Oracle and Module in Mimer.

To create a new database-specific code object:

1. Expand nodes in the tree under the connection node in the Databases tab tree until you reach the group
node for the code type, e.g. Packages,
2. Select the grouping node and open the Create dialog from the right-click menu.

The details of the dialog depends on the database, but typically you need to:

1. Enter an object name,

2. Click the Add button in the Parameters area to add parameters,

3. Enter a name and data type for each parameter. For some databases you can also enter a direction (
typically IN, OUT, or INOUT) and a default value.

You can use the other buttons to the right of the parameter list to remove and move a parameter.

The dialog uses this information together with a simple sample body to compose a CREATE statement. For
most databases, you can not enter the real code in the action dialog. The real code is often complex and large,
so DbVisualizer provides a more powerful editing environment than would fit in a dialog via the Code Editor (see
page 142). What you create with the assistant should be seen as a template that you then complete and work
with in the editor.

For some databases the sample code is editable because there is no way to write a generic sample that
compiles. You must then modify the template to something that is syntactically correct, but we still recommend
that you finish the real code in the Code Editor instead.

Click Execute in the dialog to create the new code object.
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7.4 Editing a Code Object

@ Only in DbVisualizer Pro

This feature is only available in the Pro edition. In the Free edition, please execute the corresponding
SQL in the SQL Commander (see page 155).

To edit the code for an object, such as a function, stored procedure or database-dependent code object:

1. Expand nodes in the tree under the connection node in the Databases tab tree until you reach the node
for the object you want to edit,

2. Double-click the node to open an Object View tab for it, and select the editor sub tab (e.g., the
Procedure Editor tab).

The editor has a toolbar with various actions to save/compile the procedure, save and load the source to/from
file and perform common editing operations. The Status indicator shows whether the procedure is valid or
invalid based on last compilation (not available for all databases).

Edit the source code and save/compile the procedure when you are happy with the code, using the Save toolbar
button.
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*" Procedure: UPDATE_STATUS

CRM Ahaa/Schemas/HR/Procedures/UPDATE_STATUS

J f Procedure Editor f Grants

{23 Status: INVALID

N ARSI =R SET LY )

1FREATE OR REPLACE PROCEDURE "HR"."UPDATE_STATUS™ - ]
2 order_id_start IN NUMBER DEFAULT -1,

3 order_id_end IN NUMBER DEFAULT -1,

4 status IN VARCHARZ DEFAULT 'CLOSED')

5 AS

& BEGIN L
7 update eders

8 set current_status = status

g where id »= order_id_start and id <= order_id_end;

18 END; il
11| s

| &7 tog |Gg DBMS Output |

[5]14:53:57 [CREATE - 0 row({s), 0.000 secs] {7:12} PL/SQL: ORA-00942: table or view does not
exist

;';._;}'14:53:5?' [CREATE - 0 row(s), 0.000 secs] {7:5} PL/5QL: 5QL Statement ignored

. 2 statement(s) executed, 0 row(s) affected, exec/fetch time: 0.000/0.000 sec [0
successful, 0 warnings, 2 errors]

| shworem 3

If errors occur, the corresponding text is underlined with a red wavy line. Hovering the mouse over the error
indication shows the corresponding error message. The right margin contains markers for each error as well,
and clicking on a marker scrolls the editor to the corresponding error. Alternatively, you can click on the icon for

an error message in the Log tab to move the caret to the error location.

If you prefer to navigate between errors using the keyboard, you can define key bindings for the Insertion Point

to Next Marker and Insertion Point to Previous Marker actions in the Tool Properties dialog, in the Key
Bindings category, in the Editor Commands group.

2= Error location information is not available for some databases. You then have to locate the incorrect
statement yourself based on the description of the error.

In addition to the Status indicator in the editor, the object icon in the tree shows a little red cross for invalid

procedures, for databases that provide this information. You can see this for the UPDATE_STATUS procedure

node in the screenshot above.
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The figure below shows the result after correcting the errors and recompiling the procedure:
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The status indicator now shows that the procedure is VALID.

7.5 Executing a Code Object

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

You can execute a code object, such as a function or stored procedure, either in the Code Editor (see page 142)
or in the SQL Commander (see page 155).

® Executing in the Code Editor (see page 145)
® Executing in the SQL Commander (see page 145)
® Using the Script Object Dialog (see page 147)
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7.5.1 Executing in the Code Editor

In the Code Editor, click the Execute button. DbVisualizer then generates a script for executing the code object,
using variables for all parameters, and executes it.

| &P CRM Ahoa UPDATE_STATUS X

bl
#" Procedure: UPDATE_STATUS

CRM AhoafSchemas/HR/Procedures/UPDATE_STATUS

J /’ Procedure Editor @9 Grants

-@|.||@E|°ﬂt@|ﬁﬁ (3 status: vALID
1 CREATE OR REPLACE PROCEDURE "[

3 order_id_start IN lﬂ Enter Data for Vanables @ it
3 order_id_end IN NUMBE

:AS status IN VARCHARZ? DE @E|@ |f"|@'@ '%|VK |Q, | )
& BEGIN Key Variable Value

7 update orders

8 set current_status = stat e

Q where id »= order_id_star ORDER_ID_END 2000

10 END; | | st | -
1:1[1] INS

J /=] Log | {igg DBMS Output - -

Processing Command:

Elapsed Time: 00:00:00 STATUS VARCHAR
Allow MULL
Command Status:
= -
Progress: | Shaw SQL I Continue ] l Cancel
S0L Preview

1@call UPDATE_STATUS(1ee®, 288@, NULL);
2

Because the script contains variables, the Variable Prompt dialog pops up. Enter values for all parameters and
click Continue to execute the procedure. The result is shown in the results area below the editor.

In the example shown in the figure, all parameters are input parameters but DbVisualizer also support execution
of procedures with output parameters and functions returning a value. In this case, the generated script includes
@cho statements to write the result in the Log tab. Please see below for more details.

7.5.2 Executing in the SQL Commander

The scripts generated and executed by the Code Editor can also be included in a script and executed in an SQL
Commander. Here's an example of a script calling a function and writing the result in the SQL Commander Log
tab:
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@al | ${STATUS| | (nul 1) || String||noshow dir=out}$ = "HR'."GET_STATUS'(1002);
@cho STATUS: ${STATUS} $;

In this example, the result value from the GET_STATUS function is assigned to a variable named STATUS. Note
that is has an option di r =out . This is a requirement for a variable that is assigned a value at runtime, whether
it is used for a return value from a function call or for an output parameter in a procedure call. It also has the
noshow option, to avoid getting prompted for a value for the variable. The value of the STATUS variable is then
written to the log using the @cho command.

You can also use the output from one function or procedure as input to another, or even as a value in a
SELECT or other SQL statement:

@al |l ${STATUS| | (null)|]|String||noshow dir=out}$ = "HR'."GET_STATUS" (1002);
@all "HR'."UPDATE_STATUS" (1000, 2000, ${STATUS||||String||noshow dir=in}$);

Note that di r =i n is specified for the STATUS variable when it is used in the UPDATE_STATUS procedure call.
When you use a variable first for output and then as input with another @al | command, you must change the
direction option like this.

More formally, the @al | command has this syntax when calling a function:

@al | <QutVariabl e> = <Functi onNane>( <Par anLi st >)

where the <FunctionName> may need to be fully qualified with a schema (and/or catalog/database) and the <
ParamList> is a comma separated list of literal values or variables. Here's an example:

@all ${return_value||(null)||String||dir=out noshow}$ = get_sone_val ue();

For a procedure, use this syntax:

@al | <Procedur eNanme>( <Par anLi st)

where the <ProcedureName> may need to be fully qualified with a schema (and/or catalog/database) and the <
ParamList> is a comma separated list of literal values or variables. Here's an example:

@all ny_process('literal input',
${var_in|| (null)]|]|String|]|dir=in}$,
${var_out|| (null)|]|String|]|dir=out noshow $,
${var_inout||'in_value'||String||dir=inout}$);
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As shown in these examples, you must use the di r option to specify how the variable is to be used (in, out or
inout) and you may use the noshow option to prevent being prompted for a value for an output variable.

You can use the @echo command (see page 208) write the value assigned to an output variable to the log.

7.5.3 Using the Script Object Dialog

Instead of writing a @al | script by hand in an SQL Commander, you can use the Script Object (e.g. Script
Procedure or Script Function) right-click menu choices for the object node in the tree.

E}(_Zg‘,a' Procedures
. -G ADD_JOB_HISTORY
P SECURE_DML

1 UPDATE_STATUS
[g Packages

: @ Open Object b
Bg Package Bod

--'ﬁ Java Source '@' Drop Procedure...

g Java Classed T4  Compile Procedure...

@ Triggers &  Export Procedure...

@ Object Type | | Script Procedure... -

@ Object Type|— L&

@ Recyde Bin Reconnect Ctrl+Shift+F.
5&.;3' Jobs Refresh Objects Tree F5

f Scheduler
.. éﬁ] Database Lin
-/, Invalid Obje

L)

Add to Favorites..,

Show/Hide Tree Filter
Show/Hide Table Row Count

Copy Mame Ctrl+C

VDBV ERE

[ gpPupu s § ISR N o P

This opens the Script Object dialog where you select that you want to generate a CALL script and can adjust
settings for using delimiters and qualifiers, as well as the destination for the generated script.
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&) Script Procedure - 1 object

Scripting Type
() CREATE () DROP @ CALL () Object Name

Options

Format S0L:

Qualify Mames: ]

Quoted Identifiers:  []

Statement Delimiter:  |; S0L Block Begin: | —f - [End: |f
Output Destination

i File Z:

(@ S0L Commander h Mew Editor v: (") AtCaret () First (@) Last |

(7 Clipboard

|| @ cp1252

“1 Replace all

y

| &= ]

ok ||

Cancel

7.6 Exporting a Code Object

@

Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

To export a code object:

1
2
3
4

. Select the object node in the Databases tab tree,

. Open the Export Object dialog (e.g. Export Procedure or Export Function) from the right-click menu,

. Select an Output Format, Output Destination, and Options,
. Click Export.

For these object types, you can select either the SQL (CREATE statement) or XML Output Format and which
delimiters to use in the Options area.

You can control whether to use delimited identifiers and/or qualified names (see page 276) in the DDL and
INSERT statements generated for the SQL format.
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7.7 Scripting a Code Object

To open the Script Function/Procedure dialog, where you can insert generated text for a code object in an SQL
Commander editor:

1. Select one or more code object nodes in the Databases tab tree,
2. Choose Script Function/Procedure from the right-click menu.

You can also launch the dialog by dragging and dropping one or more nodes of the same type in an SQL
Commander editor.

If you just want to insert the object names in the editor, hold down the Ctrl key (or the Alt key on Mac
OS X) while dragging and dropping. This behavior can be reversed in Tool Properties, in the SQL
Commander category, so that dropping without pressing a key inserts the names and pressing the key
launches the dialog.

The Script dialog provides a choice of which type of statement to generate, options for formatting, use of
delimited identifiers, qualified names and statement delimiters. You can also pick an open SQL Commander or a
new as the destination, and where in the SQL Commander editor to insert the text.
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8 Working with Schemas

DbVisualizer provides many ways to work with schemas.

8.1 Creating a Schema

To create a new schema:

Locate the Schemas node in the Databases tab tree,
Open the Create Schema dialog from the right-click menu,
Enter all required information (database dependent),

Click Execute to create the schema.

P owbd e

% This feature is only available for some databases. Please execute the corresponding SQL in the SQL
Commander (http://confluence.dbvis.com/display/UG91/Working+with+SQL) if it is not available for your
database.

8.2 Comparing Schemas

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

You can compare different aspects of a schema to another schema.

For instance, to compare the list of tables in one schema with the list of tables in another schema:

1. Double-click the schema node for the first schema to open its Object View tab and select the Tables tab,

2. Do the same for the second schema,

3. Select Compare from the right-click menu in one of the Tables tabs to compare their grid content (see
page 258).

You can do the same for all the other schema object types, such as views and stored procedures. You can also
dig deeper and compare the individual objects, such as comparing individual tables (see page 121).
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8.3 Viewing Entity Relationships

To see how a table is related to other tables through Foreign Keys:

1. Locate the Tables node in the Databases tab tree,
2. Double-click the node to open its Object View tab,
3. Select the References sub tab.

J [7] cRM Ahoa Tables  x

__i Tables

CRM Ahoa(Schemas/HR Tables
“:| Tables " é}‘ Table Commentsl =5 References |

RO TS8P LIIL PLEIEMS| M| Heach -

» | Display Options
e o _ | @ AlTables
e o= ! : :
e o | wnoowsmes — {7) Spedified Tables
L LU L T oy B —— [rep— [ = = = -
il I e B I e Referenced Only
i N P e
e e Graph Controls
= Tt WEW:W
_ e amirt | Animate Layout:
LFmme Show One Link/Column:
- . Show Link Name:
[ ) Auto Link Layout:
A = Bridge Links:
= N Lirks to Columns: [
TEs ERE e ot o<
— E— Overview - Docked: [J]
-
4 | m | 3

|3’9%||Table5: 1[J||References: 1IZ.'I|

You can select among different graph layouts in the layout drop-down list in the toolbar: Hierarchic, Organic,
Orthogonal, or Circular.

Other layout settings can be changed in the Graph Control area, which is shown or hidden with the settings
toggle button in the toolbar. For instance, you can select how much information to include for each table in the
graph: just the Table Name, the Primary Key column(s) or all Columns.
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The graph can be Exported to a file in JPG, GIF, PNG, SVG or PDF or Saved as a Graph Modeling Language (
GML) file that you can then open in the yEd (http://www.yworks.com/en/products_yed_about.html) tool from yWorks
for further manipulation.

You can control whether the table names should be qualified with the schema/catalog (see page 276) in the
graph.

8.4 Exporting a Schema

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

You can export all or selected objects in a schema using the Export Schema assistant.

® Qutput Format (see page 152)

® Qutput Destination (see page 153)

® Object Types (see page 153)

® Options (see page 153)

® Using Variables in Fields (see page 153)

® Saving And Loading Settings (see page 154)

To export a schema:

Select the schema node in the Databases tab tree,

Launch the Export Schema assistant from the right-click menu,

Select an Output Format, Output Destination, Objects to export and Options,
Click Export.

P wDn e

8.4.1 Output Format
You can export objects in one of these formats: CSV, HTML, SQL, XML, XLS (Excel), or JSON.

The CSV, HTML, XSL and JSON formats are specifically for table data and are not supported for any other type
of objects.

The SQL and XML formats can be used for all objects to export the DDL, and for tables you can also choose to
include the table data in these formats.

You can control whether to use delimited identifiers and/or qualified names (see page 276) in the DDL and
INSERT statements generated for the SQL format.

Page 152 of 428


http://www.yworks.com/en/products_yed_about.html

;\./\ DbVisualizer 9.2 Users Guide

8.4.2 Output Destination
The destination can be one of:

® afile,

® an open or new SQL Commander tab, with options for where in an open SQL Commander to insert the
result,

® to the system clipboard.

8.4.3 Object Types

In the Object Types area you select what to export. You can check the checkbox for an object type to export all
objects of that type, or expand a type node and select individual objects.

8.4.4 Options

The options depend on the selected Output Format.

For the SQL and XML formats, you can choose to export the DDL, the DDL for indexes for a table and the table
data: as INSERT statements for the SQL statement or in one of three XML formats.

For the XLS format, you can choose to export table data as either regular Binary Excel or OOXML for Excel
2007 and later.

Most formats also let you specify other options, such as delimiters, title and descriptions. Just select an Output
Format to see which options are available.

You can also adjust the Data Formats specifically for the exported table data. By default, the formats defined in
Tool Properties are used, but sometimes you need to export dates and numbers in a different format because
you intend to import the data into a different type of database.

In the Data Format Settings dialog you can also specify how to quote text data and how to handle quotes
within the text value.

8.4.5 Using Variables in Fields

You can use some of the pre-defined DbVisualizer variables (see page 221) (${ dbvi s- dat e} $, ${

dbvi s-tinme}$, ${dbvi s-ti nest anp}$, ${dbvi s-connecti on}$, ${dbvi s- dat abase-t ype}$ and ${
dbvi s- obj ect } $) in all fields that hold free text (e.g. title and description fields) and as part of the file name
field.
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Use the ${dbvis-object}$ variable as part of the filename if you want to export the DDL and/or data to a
separate file for each object. The variable is replaced with the object type and object name, e.g. ${
dbvi s_obj ect}$. sgl becomest abl e COUNTRI ES. sql for a table named COUNTRIES.

8.4.6 Saving And Loading Settings

If you often use the same settings, you can save them as the default settings for this assistant. If you use a
number of common settings, you can save them to individual files that you can load as needed. Use the Settings
button menu to accomplish this:

® Save as Default Settings
Saves all format settings as default. These are then loaded automatically when open an Export Schema
dialog
® Use Default Settings
Use this choice to initialize the settings with default values
®* Remove Default Settings
Removes the saved defaults and restores the regular defaults
* Load
Use this choice to open the file chooser dialog, in which you can select a settings file
® Save As
Use this choice to save the settings to a file

® Copy Settings to Clipboard
Use this choice to copy all settings to the system clipboard. These can then be pasted into the SQL
Commander to define the settings for the @export editor commands.

8.5 Filtering Schemas in the Tree

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

If you have many schema in the tree, it may be hard to find the ones of most interest. You can then define a
filter so that only a few schemas are shown, as described in Filtering Database Objects (see page 49).
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9 Working with SQL

With DbVisualizer, you can use a powerful SQL editor or a graphical Query Builder to create and edit your
scripts, save them as Bookmarks for easy access, and execute all or just a few of the statements, and lots more.

9.1 Selecting Database Connection, Catalog and Schema

You use the Database Connection and Database (or Catalog) lists above the editor to specify which
connection and database to use when executing the SQL in the SQL Commander. The list of connections
shows all connections as they are ordered in the Databases tab tree, except that all currently active connections
are listed first.

Database Connection Sticky Database Schema

. : . -

| [, HR Production - W HR -
—

I8, HR. Production DEA
I, HR. Test Data

I Lab

I8, Bright Future

|
If you check the Sticky box above the Database Connection, the current connection selection will not change
automatically when passing SQL statements from other parts of DbVisualizer, for instance, when opening a
Bookmark (see page 185). Consider an Bookmark defined for database connection Pr odDB. If the Sticky
checkbox is not checked (i.e., disabled), the database connection is automatically changed to Pr odDB when you
open the Bookmark in the SQL Editor. However, if the Sticky checkbox is checked (i.e., enabled), the current
database connection setting is unchanged. You can specify if you want to have Sticky enabled by default in the
Tool Properties dialog, in the SQL Commander category under the General tab.

The Database list (or Catalog) defines which catalog in the connection is the target for the execution. Since not
all databases use catalogs, this list may be disabled.

For most databases, the schema selected in the Schema list is used only to limit the tables the Auto
Completion feature shows in the completion pop-up; it does not define a default schema for tables referenced in
the SQL, because most databases do not allow the default schema to be changed during a session.

For the databases that do allow the default schema to be changed, however, the selected schema is also used
as the default schema, i.e., the schema used for unqualified table names in the SQL. Currently, the databases
that support setting a default schema are DB2 LUW, DB2 z/OS, DB2 iSeries, H2, JavaDB/Derby, Oracle,
NuoDB, PostgreSQL, and Vertica.

If you don't want the selected schema to be used as the default schema for these database, you can disable this
behavior in the Properties tab for the connection, in the SQL Commander category.
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9.2 Editing SQL Scripts

The SQL Commander contains an SQL editor, used to edit SQL scripts.

® Syntax Color Coding (see page 157)

® Charsets and Fonts (see page 159)

® | oading and Saving Scripts (see page 159)

® Drag and Drop a File (see page 160)

® Drag and Drop Database Objects (see page 160)

® | oading and Saving Bookmarks and Monitors (see page 162)
® Navigating Between History Entries (see page 162)

® Confirming Overwriting Unsaved Changes (see page 162)
® SQL Formatting (see page 162)

® Auto Completion (see page 164)

¢ Recording and Playing Edit Macros (see page 168)

® Folding Selected Text (see page 169)

® Selecting a Rectangular Area (see page 170)

® Tab Key Treatment (see page 170)

® Key Bindings (see page 170)

The editor area looks like this:

Jbz: report.sql* x|

POBROERE B¢ V- BB

Database Connection —————— D Sticky Database Schema Mz Rows Max Chars
ﬁ [ Choose Connection ] - -1 -1
1 SELECT -

2 HR.EMPLOYEES.FIRST_MAME,

3 HR.EMPLOYEES.LAST_NAME,
4 HR.EMPLOYEES.EMAIL, =
5 HR.DEPARTMENTS .DEPARTMENT_NAME,
B CASE
7 WHEN SALARY » ledaad
B THEN 'High'
9 WHEN SALARY BETWEEN Se888 AND 99999
18 THEN 'Medium’
11 WHEN SALARY < S8888 -
2:30 [37] INS @ Recording Macro Auto Commit: OFF (0/0) Encoding: Cp1252 report.sgl™®

Above the editor is a toolbar with buttons related both to execution of scripts and to editing. The editing related
buttons are covered below.

The left margin shows the line numbers.
Below the editor, you see a Status Bar. The first field shows the current caret position in the format:

<line>:<column> [<position from top>]
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The last figure, within square brackets, is the caret position from the top. This can be useful when you get an
error message executing a script that contains this information rather than a line/column location.

The next field in the Status Bar shows INS if characters you type will be inserted at the caret position or OVR if
they will overwrite the current text at the caret position. You can toggle this mode using the Toggle Typing
Mode keyboard shortcut, by default bound to the Insert key.

The next field shown in the screenshot is only visible when working with macros, described in the Recording and
Playing Edit Macros (see page 168) section.

Next comes the Auto Commit Status field, showing whether Auto Commit (see page 183) is enabled.

The last two fields show information about the file loaded in the editor, if any. First the character encoding and
then the filename. If you just type into the editor without loading a file, the filename "Untitled" is shown instead.
An asterisk after the filename indicates that there are unsaved edits.

The SQL Editor is like any editor you're used to when it comes to typing, scrolling etc. But it also offers
additional features to help you specifically with editing SQL scripts. These are described in the following sections

9.2.1 Syntax Color Coding

An SQL script consists of keywords, operators, object identifiers, quoted text, etc. It may also contain comments.
To make it easier to see at a glance what is what, the SQL Editor displays words using different font styles
depending on their classification. For instance, keywords are displayed with a bold blue font, while quoted text is
displayed with a regular type red font.

You can change how to display the different kinds of words, as well as the editor selection background color, the
current line highlight color and the editor background color, in the Tools->Tool Properties dialog, in the
Appearance/Fonts category.
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-
E] Tool Properties E@
J [7] General ||} Database
Font Settings
m General Set the fonts that are used in DbVisualizer.
& d' Appearance Grid: :Tahoma, Plain, 11 -
SQL EditorText Editor: :Consolas, Flain, 12 -
Application (Rest of UL): :Default, Plain, 12 -
\.fp Key Bindings
= [g Database Connection SQL Editor Styles
..... ﬂ. 35H Settings Use these settings to define the style and coler for the font used in the SQL editor.
W Driver Manager
- 2 permissions ?ormcal . [+ [ Bold [ Italic
ine Commen r
S ;—:EE;Z:E”Q Block Comment Em ::I = .
% Data Formats Standard Keyword Foreground: |l 255, 0,0 -
Mon-Standard Keyword E
53 Variables Client-Side Command -
] Table Data
p_g Transaction Bracketed Literal =
(7% Monitor Label T -
. Form Viewer Operator 2k
=- |:'| Grid
----- @b Binary/BLOB and CLOB Data _ _
o D 50L Commander SQL Editor Selection Background
N Auto Completion Use this setting to define the background color used for selections in the SQL editor.
*) Comments SQL Editor Selection Background: |:| 160, 179, 240 -
FH Result Sets '
[ statement Delimiters
: D SOL Formatting 5GL Editor Line Highlight
) E Align and Indent Use this setting to define the line highlight c\.obr used in the SQL editor. .
- [Z] Line Breaks SQL Editor Line Highlight: || | 255, 255, 215 -
i =| Whitespace ) )
-5 50L History
g Proxy Setting SCL Editor Background
Use this setting to define the background color used in the SQL editor.
SQL Editor Background: |[ | 255, 255, 255 -
) (e

The editor uses the Tool Properties settings from the SQL Commander/Comments category under the General

tab to detect comments.
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Comment Delimiters

=alact Id, Name.

e

*

[Thi= i= a black comment)

Addre== from Emp;

create index Carlnd (Type a=c);

Blodk Comment Begin Identifiers |/*

9.2.2 Charsets and Fonts

Specify the comment identifiers that might appear in a SQL statement. Comments are extracted
from the SOQL statement before execution.

Single Line Identifier 1: |-
Single Line Identifier 2: |/

End: ¥/

== Thi= i= a =ingle lins commeant

select Fize, 2ge from Type; ff This i= a =ingle line comment

create table Car [(Type warcharZ(£0, Color warcharZ(1l0)1);

You can also change the SQL Editor font family, which is useful and necessary in order to display characters for
languages like Chinese, Japanese, etc., in Tool Properties in the Appearance/Fonts category to set the font

for the SQL Editor.

'1 __ gk hl{-"_,l"i: ,.'I. ,-__1'-“!;;-._:. -l.“”| T
2 insert into products (id, name, type) values('l', "#Es571', "),

3insert into products (id, name, type) values('2', 'F&E', "BE{HEH');

dinsert inte products (id, name, type) values('2', 'JE[EEE', "JEE');

5insert into products (id, name, type) values('3', '&#', '#');

b |
5:62 [277] INS Auto Commit: ON Untitled®

9.2.3 Loading and Saving Scripts

The SQL editor supports loading statements from a file and saving the content of the editor to a file. Use the
standard file operations, Open, Save and Save As in the File main menu or the main toolbar to accomplish this.
Loading a file loads it into a new SQL Commander tab or activates the tab that already holds it.

The name of the loaded file is listed in the status bar of the editor, with the full file path shown in the window title.
The editor tracks any modifications and indicates changes with an asterisk (*) after the filename. When you
close the SQL Commander tab or exit DbVisualizer, you are asked what to do if there are any pending edits that

need to be saved.
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The File->Open Recent submenu lists the recently loaded files. How many recent files to keep track of can be
specified in the Tool Properties dialog, in the SQL Commander category under then General tab.

You can also use the Quick File Open feature to open recent files as well as Bookmarks and History entries. By
default, it is bound to the Ctrl+Alt+O key combination, and is also available via a main toolbar button as well as
in the main File->Quick File Open menu.

g n wewra =y = e

Search: |+|RecentFiles || Bookmarks || History || Monitors

Enter search text: 5 matches
em [+] Mew editar
Recent Files

|| e e IS L

1 . Emps group by salary.sql (Z:\Users\rogge\myprefs\Bookmarks\HR Stuff)

Bookmarks
. Emps group by dept.sgl (Z:\Users\rogge\myprefs\Bookmarks\HR Stuff)
Emps group by salary.sql (7:\Users\rogoe\myprefs\Bookmarks\HR Stuif) —
: Emps in birthday order.sgl  (7:\Users\rogge\myprefs\Bookmarks\HR Stuff)

fistory,

¢ CREATE TABLE BIO ( EMPLOYEE_ID NUMBER(6) NOT NULL, (Oracle test)

| St

9.2.4 Drag and Drop a File

You can also select a file in the platform's file browser and drop it somewhere in the DbVisualizer window. If you
drop it in an editor, the file content is inserted at the caret position in the editor. If you instead drop it in the
toolbar area, the file is opened in a new SQL Commander tab.

9.2.5 Drag and Drop Database Objects

If you want to include an object shown in the database objects tree, you can select the node and drop it in the
editor where you want it inserted. The Script Object dialog is shown where you can select exactly what you
want to insert in the editor.
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&) Script Table - 1 object £
Scripting Type

@ SELECT SELECT * IMSERT UPDATE DELETE CREATE DROP Object Mame
Options
Format SQL:

Qualify Mames:
Quoted Identifiers:

Statement Delimiter:  |;

Output Destination
File C:\Usersthans - || ¥ cp1252
@ SQL Commander |3: hr.sql « (@ AtCaret First Last Replace all
Clipboard
Ck I | Cancel

First of all, you can select to insert an SQL statement based on the dropped object, e.g. a SELECT statement or
a CREATE statement. You can also choose to just insert the object name. The choices available depends on
the type of object you drop.

In the Options area, you can opt to format the SQL before it is inserted and use qualifiers and quoted identifiers,
and even change which statement delimiter to use.

The Output Destination is set to the SQL Commander tab you dropped the object on by default, but you can
change your mind and pick another destination. If you stick with an SQL Commander as the destination, you
can tell where in the editor to insert the text.

You can also open this dialog from the Databases tab, from the object's right-click menu.

. If you just want to insert the object names in the editor, hold down the Ctrl key (or the Alt key on Mac
OS X) while dragging and dropping. This behavior can be reversed in Tool Properties, in the SQL
Commander category, so that dropping without pressing a key inserts the names and pressing the key
launches the dialog.
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9.2.6 Loading and Saving Bookmarks and Monitors

Bookmarks and Monitors are also files, but with special meaning. See the Managing Frequently Used SQL (see
page 185) for how to create and edit them in the SQL Editor.

9.2.7 Navigating Between History Entries

When you execute a script, DbVisualizer saves it as a history entry, see the Re-Executing SQL Statements (see
page 175) section for details. You can use the Previous and Next buttons in the editor toolbar to navigate
between (load) these entries.

B 1: reportsgl =

OB O®ELD D <>TE-BES

Database Connecticn I:l ot base Schema Mzt Rows Max Chars
ﬂ [ Choose Connection ] - -1 -1
1 SELECT -
2 HR.EMPLOYEES.FIRST_MNAME,

3 HR.EMPLOYEES.LAST_NAME,
4 HR.EMPLOYEES.EMaIL, Previous Next
5 HR.DEPARTMENTS . DEPARTMENT _NAME,

B CASE
7
B
g

m

WHEN SALARY > loaaas

THEN 'High®

WHEN SALARY BETWEEN 58888 AND 93999
1a THEN 'Medium®
11 WHEN SALARY < S2e88 -
1:1[1] NS Auto Commit: OFF {0/0)| Encoding: Cp1252 report.sgl

9.2.8 Confirming Overwriting Unsaved Changes

By default, you have to confirm overwriting unsaved changes in an editor, e.g. when navigating between history
entries, and when closing an SQL Commander tab with unsaved edits. You can disable these confirmation
popups in the Tool Properties dialog, under the SQL Commander category under the General tab.

9.2.9 SQL Formatting

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.
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The SQL->Format SQL menu contains four operations for formatting SQL statements.

Format Buffer formats the complete editor content and Format Current formats the current SQL (at cursor
position).

The formatting is done according to the settings defined in the Tool Properties dialog, in the SQL Editor/SQL
Formatting category under the General tab. There are many things you can configure. After making some
changes, press Apply and format again to see the result.

Here is an example of an SQL statement before formatting:

sel ect

ConmpanyNane, Contact Nane, Address,

City, Country, Postal Code from

Nor t hwi nd. dbo. Cust omers CQuterC

where CustonerID in (select top 2 InnerC. Custonerld
from Nort hwi nd. dbo. [ Order Details] OD

join Northw nd. dbo. Orders Oon OD.Orderld = O OderlD
join Northw nd. dbo. Custoners | nnerC

on O CustonerlD = InnerC. Custonerld

Where Regi on = QuterC. Region

group by Region, InnerC. Custonerld

order by sum(UnitPrice * Quantity * (1-Di scount)) desc)
order by Region

And here is the same statement after formatting has been applied with default settings:

SELECT
ConpanyNarne,
Cont act Nane,
Addr ess,

Gty,
Country,
Post al Code

FROM
Nor t hwi nd. dbo. Cust oners QuterC

VWHERE
CustomerI D in

(

SELECT
top 2 InnerC. Custonerld
FROM
Nor t hwi nd. dbo. [ ORDER Detai |l s] OD
JON
Nort hwi nd. dbo. Orders O
ON
OD.Orderld = O OderlD
JON
Nort hwi nd. dbo. Cust onmers | nnerC
ON
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O Custoner| D = I nnerC. Custonerld
VWHERE
Regi on = Qut er C. Regi on
GROUP BY
Regi on,
I nner C. Custoner I d
ORDER BY
SUM UnitPrice * Quantity * (1-Discount)) DESC)
ORDER BY
Regi on

Copy Formatted and Paste Formatted are powerful tools for copying SQL statements between programs
written in languages like Java, C#, PHP, VB, etc. and the SQL Editor. Both operations display a dialog where
you can adjust some of the formatting options, most importantly the Target SQL option and the SQL is
Between option. Target SQL can be set to a number of common programming language formats.

For instance, to copy an SQL statement and paste it as Java code for adding it to a Java StringBuffer:

Select the statement,

Choose SQL->Format SQL->Copy Formatted,

Set Target SQL to Java StringBuffer,

Click Format to place the formatted statement on the system clipboard,
Paste it into your Java code.

a s wDh e

To copy a statement wrapped in code from a program:

Select the code containing an SQL statement in your program,

Copy it to the system clipboard,

Choose SQL->Format SQL->Paste Formatted,

Check SQL is Between and enter the character enclosing the SQL statement in the code,
Click Format to extract the SQL statement and paste the formatted SQL in the editor.

a s w e

9.2.10 Auto Completion

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

Auto completion is a convenient feature used to assist you when editing SQL statements and DbVisualizer
commands.
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With the caret in any place in a statement where you can type something other than a table name or a column
name, and at least one character just before the caret, activating auto completion displays a list of keywords that
starts with the letters you have typed so far. As you continue to type, the list narrows.

2 HR.EMPLOYEES.FIRST_NAME, -
3 HR.EMPLOYEES.LAST_NAME,

4 HR.EMPLOYEES.EMAIL,

S HR.DEPARTMENTS.DEPARTMENT_NAME,

6  casf

7 FROM .

m

-Ecasc
9 INNER J0cpsE
18 HR.OcasT
11 0N

12 (
13 HR.EMPLOYEES.DEPARTMENT_ID = HR.DEPARTMENTS.DEPARTMENT_ID) ;

ADED

-

6:8 [132] INS Auto Commit: OM Encoding: Cp1252 report.sgl™
The list of keywords is database specific, selected based on the database type for the connection currently

selected in the Database Connection list above the editor.

With the caret placed where a table or view name may be typed in a supported SQL statement type, the auto
completion list shows a list of tables and views from the currently selected database connection, assuming you
are actually connected to the database. The following figure shows the completion pop up with table names.

1 SELECT * FROM

DEPARTHMENTS

EMPLOYEES HR
JOBS HR!
JOB_HISTORY HR
LOCATIONS HR
ORDERS HR!
REGIONS HR
EMP_DETAILS_VIEW HR

1:15 [15] IMS Auto Commit: OM Untitled ™

A completion pop-up showing column names is shown when the caret is placed where a column name may be
typed.
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1 SELECT * FROM HR.EMPLOYEES emp, HR.DEPARTMENTS dept
2 WHERE emp.DEPARTMENT_ID = |

7 -All Columns- .EMPLOYEES

(i ‘ég EMPLOYEE_ID [MUMBER] HR.EMPLOYEES emp
IE FIRST_NAME [VARCHARZ] HR.EMPLOYEES emp
(i LAST_MNAME [VARCHARZ2] HR.EMPLOYEES emp
IE EMAIL [WVARCHARZ] HR.EMPLOYEES emp
i PHONE_NUMBER [VARCHARZ] HR.EMPLOYEES emp
IE HIRE_DATE [DATE] HR.EMPLOYEES emp
i JOB_ID [VARCHARZ] HR.EMPLOYEES emp
" SALARY [MUMBER ] HR.EMPLOYEES emp
BE COMMISSION _PCT [MUMBER] HR.EMPLOYEES emp
§] MANAGER_ID  [NUMBER] HR.EMPLOYEES emp|
iE DEPARTMENT_ID [MUMBER] HR.EMPLOYEES emp
S -A11 Columns- HR.DEPARTMENTS dept
iE ég DEPARTMENT_ID [MUMBER] HR.DEPARTMENTS dept
" DEPARTMENT_NAME [VARCHARZ] HR.DEPARTMENTS dept
0B MANAGER_ID [MUMBER] HR.DEPARTMENTS dept
" LOCATION_ID [MUMBER ] HR.DEPARTMENTS dept

2:27 [80] INS Auto Commit: QN Untitled*

DbVisualizer provides auto completion for table and columns names for the following DML commands:

SELECT
INSERT
UPDATE
* DELETE

Auto completion for DbVisualizer commands is very similar. Activating it after a partial command name lists all
matching commands. If you activate it after a complete command name, you get a list of all valid parameters for
the command. After a parameter name, you can select from a list of valid values.

1 @export set Format= .

1:20 [20] INS Auto Commit: ON Cp1252 Untitled®

For the @xport set command, the parameter list is adapted for the specified output format after you have
entered the For mat parameter setting, for instance only showing parameters that are valid for the CSV format.
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1 @export set Format="C5V" m-

BinaryFormat=
BooleanFalseFormat=
BooleanTrueFormat=
CLOBFormat=
CsvColumnDelimiter=
CsvColumnHeaderIsColumnAlias=
CsvIncludeColumnHeader=
CsvIncludeSQLCommand= -
CsvRemoveNewlines= A

m

1:26 [26] INS Auto Commit: ON| |(Cp1252 Untitled™®

To display the completion pop-up, use the key binding Ctrl-SPACE (by default). You select an entry in the
pop-up menu with a mouse double-click, the ENTER key, or the TAB key. To cancel the pop-up, press the ESC
key.

=~ If there are several SQL statements in the editor then make sure to separate them using the statement
delimiter character (default to ";").

In order for the column name completion pop-up to appear, you must first make sure there are table
names in the statement.

All table names that has been listed in the completion pop-up are cached by DbVisualizer to make sure
subsequent displays of the pop-up is performed quickly without asking the database. The cache is
cleared only when doing a Refresh in the database objects tree or reconnecting the database
connection.

The Database and Schema lists above the editor is used to assist the auto completion feature to limit
which tables to list in the pop-up.

It is possible to fine-tune how auto completion shall work in the connection properties.

* Enable or disable the use of identifier qualifiers (i.e. qualifying table names with the schema name) in the
[Database Type]/Qualifiers category,

® Enable or disable the use of delimited identifiers (e.g. quotes around a table name) in the [Database
Type]/Delimited Identifiers category.

Sorting, when to show the popup, etc. can be configured in the Tool Properties dialog, in the SQL Editor/Auto
Completion category under the General tab.
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9.2.11 Recording and Playing Edit Macros

If you repeatedly need to run a sequence of edit operation, you can record them as a macro and play it as many
times as needed during an editing session. The editor status bar indicates when a recording is in progress and
when a macro is available to play.

As an example, suppose you have some plain text that you need to convert into INSERT statements:

12345 123456
89012 890123
45678 456789

Place the caret at the beginning of the first line and start the macro recording, using the right-click menu or the
corresponding key binding, and then type text and use key bindings (or menu items) to perform the following
operations:

Insertion Point Down

1. Typeinsert into nytable val ues(’
2. Insertion Point to End of Word

3. Type"',

4. Insertion Point to Next Word

5. Type'

6. Insertion Point to End of Word

7. Type');

8.

9.

Insertion Point to Beginning of Line

Then stop the recording. You now have a macro for converting a single line to an INSERT statement. To convert
the remaining lines, just use Play Macro for each line. The result will look like this:

insert into nytable values('12345', '123456");
insert into nmytable val ues('89012', '890123");
insert into mytable val ues('45678', '456789");

% The Find operation, by default mapped to the Find key and Ctrl-F key stroke, can not be recorded.
You must instead use Find Selection, Find with Dialog, Find Next and Find Previous. Mouse
gestures are also not recorded, only key strokes and menu selections.
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9.2.12 Folding Selected Text

If you work with a large script, it can sometimes be helpful to hide parts of it. You can do so using the Code

Folding feature.

Select the text you want to hide and then choose Toggle Fold Selection in the right-click menu. The selected

text is then replaced (visually only) with a folding marker.

Here's an unfolded script:

1 SELECT

A HR.EMPLOYEES.FIRST_MAME,

3 HR.EMPLOYEES.LAST_MAME,

4 HR.EMPLOYEES.EMAIL,

5 HR.DEPARTMENTS .DEPARTMENT_MAME,
B CASE

7 WHEN SALARY > 188888

8 THEN 'High'

£, WHEN SALARY BETWEEN 58888 AND 99999
18 THEN 'Medium’

11 WHEN SALARY < 58888

12 THEN 'Low'

13 END

14 FROM

15 HR.EMPLOYEES
16 INNER JOIN
17 HR.DEPARTMENTS

18 ON

19 (

28 HR.EMPLOYEES.DEPARTMENT_ID = HR.DEPARTMENTS.DEPARTMENT_ID) ;
1:1 [1]] [INS

And here is the same script with the CASE expression folded:

1 SELECT

2 HR.EMPLOYEES.FIRST_MAME,

3 HR.EMPLOYEES.LAST_MAME,

4 HR.EMPLOYEES.EMAIL,

5 HR.DEPARTMENTS .DEPARTMENT_MAME,
6 B

14 FROM

15 HR.EMPLOYEES

16 INNER JOIN

17 HR.DEPARTMENTS
18 ON

19 ({

28 HR.EMPLOYEES.DEPARTMENT_ID = HR.DEPARTMENTS.DEPARTMENT_ID) ;

14:5 [309] INS

-

Auto Commit: ON  Encoding: Cp1252 report.sgl

Auto Commit: OM | Encoding: Cp1252 report.sql
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You can fold more than one part of a script using the same procedure.

To unfold just one part, select the folding marker (be careful to select all of it) and then choose Toggle Fold
Selection from the menu again. To unfold all folded parts, use Expand All Foldings.

9.2.13 Selecting a Rectangular Area

In some cases, it is handy to be able to select a rectangular area in the middle of a script. Say, for instance, that
you need to copy just the first part of a few lines and paste it at the beginning of some other lines.

To do this in the SQL editor, click the mouse where you want to start the selection and then press the Alt key
while you extend the selection by dragging the mouse.

1 SELECT -
2 HR .EMPLOYEES . FIRST_MNAME, L
3 HR.EMPLOYEES . LAST_NAME, 3
4 HR .EMPLOYEES . EMAIL,
5 HR.DEPARTMENTS .DEPARTMENT_NAME ,
B CASE
7 WHEN SALARY > 188888 15
2] THEM '"Hioh'

4:17 [81] INS Auto Commit: OM Encoding: Cp1252 repart.sgl®

9.2.14 Tab Key Treatment

Pressing the TAB key in the editor inserts four space characters by default. If you instead want a TAB character
to be inserted, or want to insert another number of space characters, you can specify this in the Tool Properties
dialog, in the SQL Commander category under the General tab.

9.2.15 Key Bindings

The editor shortcuts, or key bindings, can be redefined in the Tool Properties dialog, in the Key Bindings
category under the General tab. Expand the Editor Commands node to manage all editor actions and the Main
Menu/Edit node to manage the key bindings for the edit operations in the right-click editor menu and the main
window Edit menu.

9.3 Using Editor Templates

Editor Templates can be used to easily insert text that you often use, such as code snippets, current date and
time, or anything you like.

® Using a Template (see page 171)
® Creating a new Template (see page 172)
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® Editing or Deleting a Template (see page 172)
® Changing the Expand Keybinding (see page 173)

(1) Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

9.3.1 Using a Template

A template is an Abbreviation that can easily be replaced by its Expanded Text, and it may optionally have a

Description.

To expand a template, just type a few characters that at least partially match one or more template abbreviation
and press the TAB key. This displays a list of matching templates that you can pick from, along with the

description or a part of the corresponding expanded text for each.

Ei M IEHLi

POBER-@EHE D €2 8

Distsbase Connection [] Sticky Database
% HR. Production -
l.e

@export to (CS5V template
| .exs @export to SQL template
1 .exh @export to HTML template
| .exxls @export to Excel 2887 template

When you select a template by pressing the TAB or ENTER key, its expanded text replaces the abbreviation

you typed in the editor.
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POBE-@®@EHE D €2 W |28
Diatabase Connection Sticky Database
[, HR Production -

1 @export on;

2 @export set Filename="name.csv™}
3 @export set Format="C5V";

4 select * from myTable;

S @export off;l

You can also enable Immediate Substitution to immediately expand the text if you have typed enough of the
abbreviation to match a single template when you press the TAB key:

Open Tools->Tool Properties,

Select the General/SQL Commander/Editor Templates category,
Click the Immediate Substitution checkbox in the toolbar,

Click the Apply or OK button to save the updated setting.

P wbn e

Instead of pressing the TAB key to list matching templates, you can use the Show Editor Templates entry in
the main Edit menu or the editor right-click menu.

9.3.2 Creating a new Template
DbVisualizer comes with some default templates, but you can create additional templates:

1. Open Tools->Tool Properties,

2. Select the General/SQL Commander/Editor Templates category,

3. Click the Insert button in the toolbar to add a new template, and enter an Abbreviation, Expanded Text,
and optionally a Description,

4. Check off the checkbox in the Format column if you wan the Expanded Text to be formatted by the SQL
Formatter when it is inserted in the editor,

5. Click the Apply or OK button to save the new templates.

If you want to use an existing template as a starting point, you can select it and then click the Duplicate button
instead of the Insert button. The Edit in Window button opens the selected cell in a separate window where it is
easier to work with larger templates.

9.3.3 Editing or Deleting a Template

You can edit any piece of a template or delete templates you no longer need:
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Open Tools->Tool Properties,

Select the General/SQL Commander/Editor Templates category,
To edit, double-click any cell you want to change and edit its value,

To delete a template, select any of its cells and click the Delete button,
Click the Apply or OK button to save the changes.

a s wbh e

9.3.4 Changing the Expand Keybinding

The keyboard shortcut used to expand a template, or bring up the list of matching templates if more than one, is
the TAB key. You can add other shortcuts or change the default, as described in Changing Keyboard Shortcuts (
see page 44). The shortcut is named Show Editor Templates and you find it in the Main Menu/Edit category.

9.4 Executing SQL Statements

In the SQL Commander, you can execute one or multiple statements. You can also control if the execution
should stop or continue when the execution of a statement results in a warning or error.

® Execute Multiple Statements (see page 173)
® Execute Only the Current Statement (see page 174)
¢ Control Execution after a Warning or an Error (see page 174)

9.4.1 Execute Multiple Statements

Use the SQL->Execute main menu operation to execute the SQL in the SQL Commander editor. The SQL
Commander executes the statements one by one and indicates the progress in the log area. The currently
selected Database Connection is used for all statements. The SQL Commander does not support executing
SQLs for multiple database connections in one batch.

DbVisualizer uses the delimiters specified in the Tool Properties dialog, in the SQL Commander/Statement
Delimiters category under the General tab, to separate one statement from the next.

The result of the execution is displayed in the results area based on the type of results result(s) that are returned
. If there are several results and an error occurred in one of them, the Log tab is automatically displayed to
indicate the error.

If you select a statement in the SQL editor and choose SQL->Execute main menu option, only the selected
statement is executed. This is a useful feature when you have several SQL statements in the SQL editor and
you just want to execute one or a few of the statements.

% Comments in the SQL editor are sent to the database when you use SQL->Execute, unless you have
enabled Strip Comments when Executing in the SQL Commander menu.
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9.4.2 Execute Only the Current Statement

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

The SQL->Execute Current operation is useful when you have a script with several SQL statements. It lets you
execute the statement at the cursor position without first having to select the SQL statement. The default key
binding for execute current is Ctrl-PERIOD (Ctrl-.).

Execute Current determines the actual statement by parsing the editor buffer using the standard
statement delimiters.The current statement is the statement containing the caret or that ends on the
line with the caret. This means that the caret may be after the statement delimiter as long as there is
no other statement on the same line.

If you are unsure what the boundaries are for the current statement then use Edit->Select Current
Statement. This will highlight the current statement without executing it.

9.4.3 Control Execution after a Warning or an Error

You can control whether subsequent statements should be executed when a statement results in a warning or
an error.

Open Tools->Tool Properties and select the SQL Commander category under the General tab. There you
find Stop on Error and Stop on Warning check boxes for enabling these features in all SQL Commander tabs

Alternatively, you can use DbVisualizer client side commands to enable or disable these features in a script.

@top on error;

@t op on warning;
@ontinue on error;
@ontinue on war ni ng;
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9.5 Re-Executing SQL Statements

As you execute SQL statements in the SQL Commander, DbVisualizer saves them as History entries, along with
information about the Connection, Catalog, Schema and the execution result. This makes it easy to locate
statements and scripts you have executed in the past.

® Using Previous and Next in the SQL Commander (see page 175)
® Using the SQL History Window (see page 175)

® Reusing a History Entry (see page 176)

® Saving a History Entry as a Bookmark or Other File (see page 176)
® Using Quick Load (see page 176)

9.5.1 Using Previous and Next in the SQL Commander

If you just want to go back and forth between statements you have executed recently, you can use the Get
Previous from History and Get Next from History toolbar buttons in the SQL Commander.

9.5.2 Using the SQL History Window

To look through all saved statements, you can display the History entries by clicking the SQL History toolbar
button in the main window or select the corresponding operation from the Tools menu.

=
[ 5QL Histary o |[=][=
P % E@ S5 Q] () [MaxEntries: 300 Q-
Time Seript Preview Size (Bytes) Database Type Database Connection Count Hapsed Success Errors  Rows
[Q History &
| M12-11-20 15:41:02  cal emp_report() 17 Orade ' CRM Ahoa 2 0.12 1]
DHMZ-11-70 15:90:18  oreate o replace procedure emp_report as begn db 479 Oracle ' CRM Ahoa 2 0,03 1 o 0
o 2012-11-20 15:34:48 calemp_repmu 17 Oracle W oM oahoa 1 0 0 B 0
| 2012-11-20 15:34:39  geate or replace procedure emp_report as begin db 429 Orade W crM ahoa 1 0.39 1 0
g W12-11-20 15:31:14  call emp_report() 17 Orade W) cRM Ahaa 1 003 0 B 0
2012-11-20 15:28:57 sedect ® from HR.EMPLOYEES 26 Orade u CRM Ahoa 1 0.25 1 0 107
T TEL A TI.T. SN NPT RN e T X I —— (= T —— 1 = aa ¥ o v
4710 || 19
1select * from HR.DEPARTMENTS;
2 select EMPLOYEE_ID, FIRST_MNAME, LAST_MNAME, EMAIL from HR.EMPLOYEES;
3 select * from HR.JOB_HISTORY;
4
5 --select * from HR.JOBS;
r
Flename: C:\Usersthans\.dbvis\Hestory |20 121120-154734826 2g) Encoding: Cp1252
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The entries are ordered with the most recently executed entries at the top by default, but you can reorder them
by clicking on the column headers. The complete content of the selected entry is shown below the list, unless
you disable it by clicking the Show Details toolbar button.

The columns show when the entry was executed, a part of the script/statement, the size of the complete
statement/script, and then the database type and connection it was executed for, and how long it took to
execute. The Success and Errors columns show how many of the statements in a script were executed
successfully or that caused an error. Finally, the Rows column show the number of rows retrieved or affected by
the script.

You can use the field at the top right corner in the dialog to search for entries matching a critera. Clicking on the
magnifying glass reveals a configuration menu where you can, among other things, specify which columns to
search in and if you want to search through the complete script rather than just the part of the script shown in
the Script/SQL Statement column.

In the Tool Properties dialog, in the SQL History category under the General tab, you can specify that
sequential executions of the same SQL statement/script should be collected into a single history entry. When
this feature is enabled, the Count field number is increased for each execution. In the same Tool Properties
category you can also specify rules for when not to create a history entry.

Reusing a History Entry

When you have found the entry you're looking for, you can open it in an SQL Commander by double-clicking it
or clicking the corresponding toolbar button.

You can also add the content of an entry to the current content of an SQL Editor. Select the entry in the list, drag
it with the mouse key depressed to the position in the editor where you want to add it, and drop it there by
releasing the mouse button.

Saving a History Entry as a Bookmark or Other File

If you realize that you need easy access to a History entry in the future, you can save it is as a Bookmark or
other file. Just select the entry and use the Save As operation, or just drag it to the Bookmarks tree and drop it.

You can also locate the file holding the history entry in the file system using the the Open Enclosing Directory
right-mouse menu entry or toolbar button. This opens a file chooser for the directory holding the file.

9.5.3 Using Quick Load

An alternative to locating Bookmarks in the Scripts tab and History entries in the History window is to use the
Quick Load feature, by default bound to the Ctrl+Alt+O key combination. It is also available via a main toolbar
button as well as in the File->Quick File Open menu.
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Search: |+|RecentFiles || Bookmarks || History || Monitors

Enter search text: S matches
em [+] Mew editar
| jRecent Files

1 ' Emps group by salary.sql (Z:\Users\rogge\myprefs\Bookmarks\HR Stuff)

Bookmarks
. Emps group by dept.sgl (Z:\Users\rogge\myprefs\Bookmarks\HR Stuff)
Emps group by salary.sql (7:\Users\rogoe\myprefs\Bookmarks\HR Stuif) —
: Emps in birthday order.sgl (7:\Users\rogoe\myprefs\Bookmarks\HR Stuif)

¢ CREATE TABLE BIO ( EMPLOYEE_ID NUMBER(6) NOT NULL, (Oracle test)

—
The Quick Load feature locates files with partly matching names from the categories you have selected, as you

type. You can use an asterisk ("*") as a wildcard in the search string. Use the Max field to limit the number of
matching files to display in the list.

When you see the file you're looking for, just select it and click Enter to load it into an SQL Commander editor. If
the file is already loaded in an editor, that tab is made visible instead.

9.6 Executing Complex Statements

If you need to execute a complex statement that itself contains other statements in the SQL Commander, such
as a CREATE PROCEDURE statement, you need to help DbVisualizer figure out where the complex statement
starts and ends. The reason is that DbVisualizer needs to send statements to the database for execution one by
one.

“. We recommend that you use the Create Procedure (see page 139) dialog and Procedure Editor (see
page 142) to work with procedures and similar objects, so only use the SQL Commander to run
statements like this if these features do not work for you for some reason.

® Using Execute Buffer (see page 178)
® Using an SQL Block (see page 178)
® Using the @delimiter command (see page 178)
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9.6.1 Using Execute Buffer

The SQL->Execute Buffer operation sends the complete editor buffer for execution as one statement. No
comments are removed and no parsing of individual statements based on any delimiters is made. You can use
this feature if the complex statement is the only statement in the SQL Commander editor.

9.6.2 Using an SQL Block

To tell DbVisualizer that a part of a script should be handled as a single statement, you can insert an SQL block
begin identifier just before the block and an end identifier after the block. The delimiter must be the only text on
the line. The default value for the Begin Identifier is - -/ and for the End Identifier itis /.

Here is an example of an SQL block for Oracle:

--1
script to disable foreign keys
declare cursor tabs is select table_nanme, constraint_nane

fromuser_constraints where constraint_type = 'R and owner = user;
begi n
for j in tabs |oop
execute imrediate ('alter table "||j.table_name||' disable constraint']|]|j.constraint_name);
end | oop;
end;

/

9.6.3 Using the @delimiter command

With the @delimiter command you can temporarily change the statement delimiter DbVisualizer uses to
separate the statements and send them one by one to the database. Use it before the complex statement, and
after the statement if the script contains additional statements. Here's an example:

@lelimter ++;
CREATE OR REPLACE FUNCTI ON HELLO (pl1 | N VARCHAR2) RETURN VARCHAR2
AS
BEG N
RETURN 'Hello ' || pi;
END;
++
@elimter ;++
@all ${returnValue||(null)]||String||noshow dir=out}$ = HELLO(' World");
@cho returnVal ue = ${returnVal ue}$;
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The first @delimiter command sets the delimiter to ++ so that the default ; delimiter can be used within the
function body in the CREATE statement. The ++ delimiter is then used to end the CREATE statement, and
another @delimiter command sets the delimiter back to ; for the remaining commands in the script.

9.7 Executing an External Script

If you have a very large script to execute, you may not have enough memory available to be allocated for
DbVisualizer to load it into an SQL Commander editor and generate log entries in the GUI for all statements.

For a script that is large but still small enough to load into the SQL Commander, you can save memory (and
therefore run it faster and more efficiently) by selecting to log to a file instead of the GUI:

=] Log | {jg DBMS Output

| Preprocess script Log to GUI @) Log to File |C:YWsersthans\myresult.log |_|

To save even more memory, you can use the @run command to execute it by only loading one statement at a
time, minimizing the memory requirements. A related command is the @cd command for changing the current
directory.

® @run <file> [ <variables>]

Request to execute the file specified as parameter, optionally with a list of variables
®* @cd <directory>

Change the working directory for the following @run command

Here's an example of a script using these commands:

@un createDB. sql ; -- Execute the content in the
- createDB.sql file without loading into the SQL editor.
- The location of this file is the sane as the working
- directory for DbVisualizer.

@d [ hone/ mupp; -- Request to change directory to /hone/ mupp

@d nyscripts; -- Request to change directory relative to current, i.e. to /hone/ nupp/
nmyscripts

@ un | oadBackup. sql ; -- Execute the content in the | oadBackup. sql

- file relative to current directory. This file will now be read fromthe
- [ home/ nupp/ nyscripts directory.

You can also include DbVisualizer variables (see page 221) as parameters to the @run command, with values
to be used for the corresponding variables in the script:

@ un nont hl yReport ${nont h| | 2010- 05- 05| | Dat e| | noshow} $ ${dept|| HR| | Stri ng| | noshow} $

Even though the @run command reads one statement at a time from the file, there are other parts of the
execution process that require the whole file to be read before the statements can be executed: parsing the
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script for variables, parameter markers, and restricted commands, as well as counting all statements in order to
provide progress information. When you run a script that is large enough (more than 10 MB) for these things to
potentially cause memory problems and slow down the processing, DbVisualizer gives you a chance to turn off
this preprocessing and progress reporting so that the statements instead can be executed directly as the are
read from the file, one at a time.

-

Motification Alert @

This script is very large and there may not be enough memary to process it
! L in the normal way. We recommend that you instead log to a file and execute
without the normal preprocessing to avoid potential problems.

NOTE! This means that no variables or parameter markers are substituted and
restricted commands are executed without confirmation.

Log to File: |:|

E'Cuntinuewfu Preprucessing§| | Continue Mormally | | Cancel |

To ensure that you don't have any problems running scripts this large, you must specify a file for logging. We
also strongly recommend that you click Continue w/o Preprocessing, thereby disabling all variable, parameter
and restricted commands processing. Only click Continue Normally if you know for sure that you have enough
memory available and have adjusted your installation so that DbVisualizer can use it. With the preprocessing
disabled and all logging going to a file instead of the GUI, you should be able to execute scripts of any size (we
have tested with scripts as large as 4 GB).

Another alternative for execution of large scripts is to use the DbVisualizer command line interface (see page
311) instead of the GUI application. This option is the most efficient and fastest.

Running without preprocessing is always more efficient, so if your script does not use any variables or
parameter markers and you do not use the Permissions feature, you can disable preprocessing even for scripts
smaller than 10 MB by unchecking the Preprocess script checkbox shown in the log destination screenshot
above.

9.8 Locating SQL Errors

If errors occur, the corresponding text is underlined with a red wavy line. Hovering the mouse over the error
indication shows the corresponding error message. The right margin contains markers for each error as well,
and clicking on a marker scrolls the editor to the corresponding error. Alternatively, you can click on the icon for
an error message in the Log tab to move the caret to the error location.

If you prefer to navigate between errors using the keyboard, you can define key bindings for the Insertion Point
to Next Marker and Insertion Point to Previous Marker actions in the Tool Properties dialog, in the Key
Bindings category, in the Editor Commands group.
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Error location information is not available for some databases. You then have to locate the incorrect
statement yourself based on the description of the error.

9.9 Analyzing (explain) Query Performance

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

You can analyze how a query is executed by the database, e.g. whether indexes are used or if the database has
to do an expensive full scan. To analyze a query:

1. Enter the query in the SQL Commander editor,
2. Click Execute Explain Plan button in the toolbar,
3. Look at the result in the results area.

Explain Plan is supported for Oracle, DB2 LUW, SQL Server, PostgreSQL, Mimer SQL, MySQL, and Vertica.

Explain Plan executes your query and records the plan that the database devises to execute it. By examining
this plan, you can find out if the database is picking the right indexes and joining your tables in the most efficient
manner. The explain plan feature works much the same as executing SQLSs to present result sets; you may
highlight statements, run a script or load from file. The explain plan results can easily be compared by pinning
the tabs for different runs.

DbVisualizer presents the plan either in a tree style format or in a graph. What information is shown depends on
the database you use. In the tree view, put the mouse pointer on the column header for a tooltip description
what that column represents. The following screenshot shows the SQL in the editor at top and the
corresponding explain plan as the result.
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9 HR.COUNTRIES c,
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11 WHERE
12 d.LOCATION_ID = 1.LOCATION_ID
13 AND 1.COUNTRY_ID = c.COUNTRY_ID
14 AND c.REGION_ID = r.REGION_ID
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21 WHERE
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The Graph View shows the plan as a graph. The graph can be exported to an image file or printed. Use the

menubar buttons to export and print.
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The databases use different techniques to manage their explain plan support. You can make database-specific
configurations in the Properties tab for a connection, in the Explain Plan category.

9.10 Auto Commit, Commit and Rollback

With Auto Commit enabled, all changes you make to the database data is automatically committed after the
successful execution of an SQL statement. Auto Commit is enabled for a connection by default. You can change
the default in the Options area of the Object View tab for the connection.
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You can toggle the Auto Commit setting for an open SQL Commander tab using the SQL Commander main
menu item of the corresponding button in the SQL Commander toolbar. Alternatively, you can use this command
in a script to set it:

@et autocommit on/off;

If Auto Commit is disabled, it is very important to manually issue the commit or rollback operations when
appropriate. Use the Commit and Rollback buttons in the SQL Commander toolbar or the corresponding
operations in the SQL Commander main menu to commit and rollback transactions.

Alternatively, you can use the following commands in a script executed in the SQL Commander:

@onm t;
@ ol | back;

There is an Auto-Commit: ON/OFF indicator in the editor status bar:

IHSERT INTO 5COTT.EMP (EMPNO,ENAME ,JOE,MGE, HIREDATE,3AL, COMM, DEPTHO)
VALUES (-c£1, 'Boo', 2, 1,'1999-01-02',11333,1,20):

IHSERT IWTO 5COTT.EMP (EMPNO,ENAME ,JOE,MGE, HIREDATE,SAL, COMM, DEFTHO)
VALUES (-52, 'Hoo!, 2, 1,'1999-01-19', 12333,1,20);

THSERT IMTO =COTT.EMP (EMPNO,ENAME ,JOE,MGE, HIREDATE,3AL,COMM, DEFTHO)
YALUES (-53, 'Zoo', 2, 1,'1854-01-02',1313,1,20);

up * from 3cott.emp:

o0 =1 A s L [

Statements executedsincejlastiecommity/rellback

e

Unecommitted|database updates

Commit: OFF (3/9) DUnt.itled*

The first number represents the number of records updated in the database since the last commit/rollback. The
second number shows the number of statements (except SELECTS) that has been executed since last commit/
rollback.

[ 7:3  [mns [ Auto

Having Auto Commit off for a connection should be handled with great care since transactions may lock parts of
the database (this is database dependent). To minimize the risk of forgetting uncommitted transactions, there is
an Ask when Auto Commit is OFF settings in the connection Properties tab, in the Transactions category,
that can be set to warn you when there are changes that hasn't been committed. You can set it to Always or
When Uncommitted Updates. When set to When Uncommitted Updates, you are warned when there is at
least one updated record reported by the database. For database that do not accurately report updated records,
you can set it to Always to be warned if at least one statement (other than SELECT) has been executed since
the last commit or rollback.
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There is also a Pending Transactions at Disconnect setting in the Tool Properties dialog, in the Transaction
category under the General tab. It specifies what DbVisualizer should do when you disconnect a connection that
has pending changes, and you can set it to Commit, Rollback or Ask.

9.11 Managing Frequently Used SQL

You may have a set of SQL statements that you use over and over to perform frequent tasks. You probably
have them saved in script files that you can load into an SQL Commander, but DbVisualizer Bookmarks make it
even easier to work with them. A Bookmark is a script visible in the Scripts tab in the navigation area.

® Creating, Editing and Organizing Bookmarks (see page 186)
® Executing Bookmarks (see page 187)

®* Adding a Bookmark as a Favorite (see page 188)

® Sharing Bookmarks (see page 188)

® Using Quick Load (see page 188)

You find your Bookmarks under the Scripts tab in the navigation area to the left in the main DbVisualizer window
. The content of a Bookmark is one or more SQL statements. It may also be associated with a Connection, a
Catalog and a Schema, to be used when executing the statements. This information is displayed, and can be
edited, in the lower part of the Scripts tab, along with information about the file that holds the Bookmark. If you
don't want to see these details, you can disable it with the Show Details toggle control in the right-click menu for
a node.
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e Es 700
.| Scripts
EIW Bookmarks
= ) HR Stuff
(] Hardware Inventory
| Create BIO table.sql
) Emps group by dept.sql
2 Emps in bithday order.sgl
| Selectfrom BIO.sql
[+ & Maonitors

=l File
Mame Emps group by salary.sql
Comment
Size (bytes) 245
Modified 2009-12-08 14:34:28
Path Zi\lsers\rogge\myprefs\Bookmarks'\HR ..
Encoding MacRoman
I=| Database Connection
Connection [ CRM Ahoa
Catalog

Schema E}. HR

9.11.1 Creating, Editing and Organizing Bookmarks

You can create a new Bookmark by selecting the Bookmarks node in the tree and clicking the Create File
toolbar button. This adds a new node in the tree, with the default name selected so that you can replace it with
the name you want to use. You can also rename the Bookmark later using the Rename right-click menu item.

A Bookmark can also be created from the current content in an SQL Editor. Click the Save File As toolbar
button to open a file chooser dialog, and click the Bookmarks button in the file chooser dialog to go to the
Bookmarks root directory. Enter a filename for the Bookmark and click Save.
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Sparai: | | HR Stuff - ]
= . Hardware Inventory Hidden Files:
g | | Create BIO table.sql Show
Tidigare || Emps group by dept.sql _
|| Emps group by salary.sq| EIC TR I
! |_| Emps in Birthday order.sql I Bookmarks “ Maonitors
Skrivbord Encoding:
£3 cpi252 -
E
Mina dokument
Dator Filnamn: Emps group by salary.sql Spara
‘L Filformat: SQL Script {.=gl, ddl) v Avbryt

To put some SQL statements in a new empty Bookmark or to edit the contents of an existing Bookmark, you
need to open the Bookmark in an SQL Commander. Double-click the Bookmark node in the tree or click the
corresponding toolbar button to open a new SQL Commander tab for the Bookmark, or activate the SQL
Commander that already holds the Bookmark. When you are done with your edits, use the Save toolbar button
in the SQL Editor to save them.

You can also add the content of a Bookmark to the current content of an SQL Commander editor. Select the
Bookmark node, drag it with the mouse key depressed to the position in the editor where you want to add it, and
drop it there by releasing the mouse button.

Folders can be used to organize your Bookmarks. Click the Create Folder toolbar button to create a new folder
and give it the name you want. You can then drag an existing Bookmark node to the folder, and create new
Bookmarks and subfolders in the folder by selecting it and clicking the Create File and Create Folder buttons.

. The folders and the Bookmarks within a folder are ordered alphabetically and cannot be changed
manually.

9.11.2 Executing Bookmarks

With a Bookmark opened in an SQL Commander tab, you can of course execute its statements by clicking the
Execute toolbar buttons as usual, but you can also open and execute a Bookmark directly by selecting it in the
tree and using the Open in SQL Commander and Execute operations in the right-click menu.
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9.11.3 Adding a Bookmark as a Favorite

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

If you are using a Bookmark very often, you may find it more convenient to add it to the Favorites area (see
page 272). You can drag and drop a Bookmark from the Scripts tab to the Favorites area, or via the Add to
Favorites right-click menu operation.

9.11.4 Sharing Bookmarks

It's easy to share your Bookmarks with someone else because they are stored as regular files. The files are
located in a subfolder of the DbVisualizer user preferences folder named Bookmarks. The user preferences
folder is typically a subfolder named .dbvis in your home folder.

The main Bookmark content is stored in a file with exactly the same name as the node in the Scripts tab. The
additional data associated with the Bookmark is stored in a file with the same name plus the .met extension.

To share some of your Bookmarks with someone, we recommend that you use DbVisualizer to create a
separate Bookmarks subfolder for the shared Bookmarks. You can then use any external tool to create a file
archive (e.g. a ZIP file) of that subfolder and send it to your friend or colleague. He or she can then extract the
files into the local DbVisualizer user preferences Bookmarks folder.

9.11.5 Using Quick Load

An alternative to locating Bookmarks in the Scripts tab and History entries in the History window is to use the
Quick Load feature, by default bound to the Ctrl+Alt+O key combination. It is also available via a main toolbar
button as well as in the File->Quick File Open menu.
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Search: [J|RecentFiles [V| Bookmarks History [ | Monitors

Enter search text: S matches
em [+] Mew editar
| jRecent Files

1 ' Emps group by salary.sql (Z:\Users\rogge\myprefs\Bookmarks\HR Stuff)

Bookmarks

. Emps group by dept.sgl (Z:\Users\rogge\myprefs\Bookmarks\HR Stuff)
| Emps group by salary.sgl (7:\Users\rogoge\myprefs\Bookmarks\HR Stuif) —
5 Emps in birthday order.sgl (7:\Users\rogoe\myprefs\Bookmarks\HR Stuif)

¢ CREATE TABLE BIO ( EMPLOYEE_ID NUMBER(6) NOT NULL, (Oracle test)

e

The Quick Load feature locates files with partly matching names from the categories you have selected, as you
type. You can use an asterisk ("*") as a wildcard in the search string. Use the Max field to limit the number of
matching files to display in the list.

When you see the file you're looking for, just select it and click Enter to load it into an SQL Commander editor. If
the file is already loaded in an editor, that tab is made visible instead.

9.12 Creating Queries Graphically

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

The Query Builder provides an easy way to develop database queries. The Query Builder provides a point and
click interface and does not require in-depth knowledge about the SQL syntax.

® Creating a Query (see page 190)
® Adding tables (see page 191)
® Joining Tables (see page 193)
® Setting Join Properties (see page 194)
® Removing Tables and Joins (see page 195)
® Specifying Query Details (see page 196)
® SQL Preview (see page 200)
® Testing the Query (see page 200)
® | oading a Query From the Editor (see page 201)
® Properties for the Query Builder (see page 201)
® Express joins as JOIN clause or WHERE condition (see page 202)
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® Table and Column Name qualifiers (see page 202)
® Delimited Identifiers (see page 202)
® Current Limitations (see page 203)

The Query Builder is part of the SQL Commander, alongside the SQL Editor. When you are ready to test a
query built with the Query Builder, you just load it to the SQL Editor for execution.

This document talks only about Tables even though the Query Builder supports both table and view
objects.

9.12.1 Creating a Query

To create a query, open the query builder using the SQL Commander->Show Query Builder menu choice or
click the vertical Query Builder button in the SQL Commander. Make sure that the controls in the top section of

the Query Builder are set correctly.

[® 1: HR Production Untitled

D3R | B & Eedtoewis -
Database Connection [7] sticky Database Schema Mz Rows Max Chars
[, HR Production - 4 HR v -1 -1

1oyp3 15 |

Ll
[=
@

o
m
c
o
]

Query Builder

Drag tables from the objects tree and drop hete:

Columns |Conditions Sorting

[7] Select only unigue records (DISTINCT)

Column/Expression Alias Agaregate Group By
W

@

The easiest way to jump between the Query Builder and the SQL Editor is by clicking the vertical control buttons
to the right in the SQL Commander. Clicking these buttons changes the display, but does not copy the query
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from one display to the other. To copy the current query from the Query Builder to the SQL Editor, use the
toolbar buttons at the top of the Query Builder:

B @% | [ IH [Eledtoetais -

The first button (from left) replaces the content of the SQL Editor with the query SQL and executes it,

The second button replaces the content of the SQL Editor with the query SQL, without executing it,

The third button adds the query last in the SQL Editor,

The fourth button copies the query to the system clipboard,

The fifth button opens a dialog that lets you add tables matching a search criteria,

The sixth button is a drop-down menu for selecting what to show below the diagram area: query details or
the SQL preview.

L e o

The first three buttons automatically change the display to the SQL Editor.
You can also load a query from the SQL Editor into the Query Builder, as described in detail below (see page

201).

Adding tables

To add tables using drag and drop, make sure the database objects tree and the table and/or view objects are
visible. Then select and drag nodes from the tree into the diagram area.
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Drag and Drop

To add a table, drag it from the object tree to the diagram area of the Query Builder. When the table is dropped
in the diagram area, it is shown as a window with the table name as the window title. You can select multiple
tables and/or views and drag and drop them together.

Below the title is a text field where an optional table alias can be entered. If a table alias is specified, it is used in
the Query Builder and the generated SQL statement to refer to this table.

Under the table alias field is a list of all table columns. Use the check box in front of each name to select
whether the column should be included in the query result set. Columns selected for the query result set also
appear in the Columns and Sorting details tabs.

An alternative to dragging and dropping tables into the Query Builder is to use the Quick Table Add dialog.

L g [ LTI LSS

g E Enter search text: 2 matches
]

' JOB_HISTORY (HR) I

It lists tables matching the search criteria as you type it in the search text field. An asterisk ("*") can be used as a
wildcard for any characters.
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Joining Tables

To join two tables, select the column in the source table window with the mouse, drag it to the target table
column, and drop it.

i ) i a1

HR.EMPLOYEES == HR.DEPARTMENTS (=

& | EMPLOYEE_ID el <~ B DEPARTMENT_ID

[ FIRST_MAME "] DEPARTMENT_NAME

[] LAST_NAME _ ] MANAGER_ID

[ EMAIL [] LOCATION_ID

| PHONE_NUMBER '

7] HIRE_DATE )

] JOB_ID =

[] SALARY

[T COMMISSION_PCT

[ MANAGER_ID

B DEPARTMENT ID —

F S
Calumns | Conditions | I Snrting|

[ Select only unique records (DISTINCT)

Column/Expression Alias Aggregate Group By N
[l
b

The two columns now represent a join condition, shown in the graph as a link between the columns. If more than
one join condition is needed, link additional columns in the two tables by dragging and dropping the columns in
the same way as for the first join condition. The default join type is an Inner join and the default condition is "
equal to" (=), represented as an icon with overlapping circles with the shared area shaded and an equal sign
below them.

Some database schemas declare how tables are related using primary and foreign keys. Other schemas use
column names to indicate these relationships. For instance, in the figure above, the EMPLOYEES table has a
column named DEPARTMENT _ID, which refers to the column with the same name in the DEPARTMENTS
table. The Query Builder can be configured to use both kinds of rules to automatically join the tables you add to
the query builder.

The auto-join feature is disabled by default. You can enable it in the tool properties for the database type (Tools
->Tool Properties, under the Database tab) or for a specific connection (the Properties tab in the Object View
tab for the connection).
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E’] Tool Properties EI@
|% Database

Query Builder Auto-Jain Properties

-1 MySQL A

| }J Metezza With Auto-Join enabled, columins in a table added to the Query Builder are compared to

: columns in the tables already present. If 2 match is found (either by matching FK/PK

=1 _gJ Orade declarations or matching column names, depending on the selected auto-join type). the tables

- Authentication are joined automaticalby.
~ || Delimited Identifiers
ILI_lJ: Qualifiers
E’"”_! Physical Connection (@ Match columns by FK/PK dedarations
il T 1i Auto-Join Type:
- gl_ Srtaantsel:estns () Match columns with equal names
{} Connection Hooks
-|EE| Ohjects Tree Labels
b SOL Editor Generate JOIM Clause in Query Builder

EE Specifies if joins should be generated as JOIN clauses or as conditions in the WHERE clause.

@ Data Types Generate JOIN Clause in Query Builder:
% Explain Plan
_Eﬂ Objects Tree
| & Pervasive

o) (s ) [ ]

Auto-Join Enabled:

m

In the Query Builder category, you can enable the auto-join feature and select whether to use key declarations (
FK/PK) or column names to find out how the tables are related.

When you add a new table with auto-join enabled, the Query Builder automatically joins it to the tables already
in the builder if table columns match the selected matching rule.

If columns in the table you add are related to other columns in the same table, the Query Builder creates two
windows for the table and joins them based on the matching rule. In this case, a table alias is also added for one
of the windows so that you can tell the two windows for the same table apart.

Setting Join Properties

A Join Properties dialog can be opened by double-clicking the icon or selecting Join Properties from the
right-click menu while the mouse pointer is over the join icon. The Join Properties dialog shows the source and
target table columns and the conditional operator.

You can change the join type and the conditional operator in the Join Properties dialog. The join type defines
how the records from the tables should be combined:

®* Inner
This is the most common join type as it finds the results in the intersection between the tables.
® Left
This join type limits the results to those in the left table leaving 0 matching records in the right table as
NULL.
* Right
This is the same as left join but reversed
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* Full
A full join combines the results of both left and right joins.

P =

& Join Properties @

Operataor
Table: EMPLOYEES DEPARTMENTS
Column:  DEPARTMENT_ID |i= | » | DEPARTMENT _ID
Join Type

@ Inner (§)
Left Q:"
Right ({P

Ful @

[ Apply H Cancel

»  If you have multiple join conditions (linked columns) between two tables, you can specify different
conditional operators for each join condition, but the join type is shared between all join conditions; if
you change it for one join condition, it is changed for all the other join conditions linking the two tables.
This is not a restriction in the Query Builder but rather how SQL is defined.

Here is the sample SQL generated from the previous join definition:

SELECT
*
FROM
HR. EMPLOYEES
I NNER JO N
HR. DEPARTMENTS
ON
(HR. EMPLOYEES. DEPARTMENT_I D = HR. DEPARTMENTS. DEPARTMENT_| D)

Removing Tables and Joins

A table window is removed by clicking the close icon in the window header. A join is removed by selecting
Remove Join in the right-click menu while the mouse pointer is over the join icon.
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@ Join Properties...
“4e Remove Join

Remowve All Jains

Remowve All Tables

All tables and joins may be removed via Remove All Joins and Remove All Tables.

Specifying Query Details

The Details tabs below the diagram area are used to define the various parts of the query. The tabs basically
represent the following parts of the final SQL.:

SELECT <Col unms>
FROM <Tabl es>
WHERE <Conditi ons>
GROUP BY <Col umms>
HAVI NG <G oupi ng>
ORDER BY <Sorting>

(The Tables clause is defined in the diagram, not by a tab).

Use the Columns tab to specify characteristics of the columns that are included in the query. The list is initially
empty until a column is checked in a table window or a column expression is added manually (see below).
Columns will appear in the list in the same order as they are checked but may be moved at any time with the up
and down buttons. To include all columns from a table, right-click in the column list in the table window and
choose Select All.
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2
HR.EMPLOYEES £3 HR.DEPARTMEMTS >
£ [T EMPLOYEE_ID — | & [] DEPARTMENT_ID
FIRST_MNAME DEPARTMENT _NAME
LAST MAME 7] MANAGER_ID
EMAIL [C] LOCATION_ID
] PHOME_MNUMBER -
"] HIRE_DATE @®
[C]JOB_ID =

SALARY
] COMMISSION_PCT
7] MANAGER_ID

["| DEPARTMENT_ID -

% 4
Columns | Conditions | | sorting |
[] Select only unique records (DISTINCT)

Column/Expression Alias Aggregate Group By r.
EMPLOYEES FIRST_MAME  “Férnamn™ O
EMPLOYEES.LAST_MAME  “Efternamn” |:|
EMPLOYEES.EMAIL “E-post” @
DEPARTMENTS.DEPARTH... ["Avdelning’ —-:-
EMPLOYEES. SALARY “Lén”

D

The previous screenshot shows a total of 5 checked columns in the two tables. These are presented in the
columns list by their full column identifier, qualified by either the table name or the table alias. To remove a
column from the list, uncheck the corresponding column in the table window.

The alias field is used to specify an optional alias identifier for the column. The alias is used as the identifier for
the column in the final query and also appears as the column name in the result set produced by the query.
Check the documentation for the actual database to see if the alias must be quoted since the Query Builder
does not do this for you.

The Aggregate and Group by fields are used in combination:

® The Aggregate field lists the available aggregation functions (AVG, COUNT, MAX, MIN, SUM) that may
be used for columns

® The Group By field specifies whether the column should be included in the group for which aggregate
columns are summarized

The Group By field is disabled unless an aggregate function is selected for at least one column, and once you
select an aggregate function for one column, you must set Group By for at least one of the other columns to
form a valid query. If you remove the aggregate function for all columns, Group By is automatically reset for all
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columns. Group By and Aggregate are also mutually exclusive options for one column, so when you select one
of them, the field for the other is disabled for that column.

A custom expression may be added by entering data in the empty row last in the list, e.g., col 1 + col 2 or
TO CHAR(ts_col, 'DD MON-YYYY HH24: M : SSxFF' ) . Once entered, press enter to insert a new empty
row. You can remove a custom expression by selecting it and clicking the Remove button.

You can also launch a multi-line text editor for a custom expression, to make it easier to edit a large expression
such as a CASE clause. Just double-click the expression cell, and then click on the editor launch button.

f HR.EMPLOYEES 52 ] | HRDEPARTMENTS ==
| & Text Editor (=]

CASE -
WHENM SALARY = 100000
THEN 'High'
VWHENM SALARY BETWEEM 50000 AND 99999
THEM 'Medium'
WHENM SALARY < 50000
THEM ‘Low'
EMND

ok || cancel || Reset |

Column/Expression Alias Aggregate Group By

EMPLOYEES FIRST_MAME  “Fdrmnamn”®
EMPLOYEES.LAST_MAME ~ “Efternamn”
EMPLOYEES.EMAIL “E-post”
DEPARTMENTS.DEFPARTHM... ".ﬁ.'u'delnlng

000 THEN Low ENDS —-:-

1

LA |
v

The Conditions tab is used to manage the WHERE clause for the query. A WHERE clause may consist of
several conditions connected by AND or OR. The evaluation order for each condition is defined by indentation in
the condition list. Each level in the list will be enclosed by brackets in the final SQL.

Here is an example from the Conditions tab.
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L3
[ HREMPLOVEES (= HR.DEPARTMENTS ==
Emp dept
& [ EMPLOYEE_ID — | & [ DEPARTMENT_ID
FIRST_NAME
LAST_MAME ] MANAGER_ID
EMAIL [] LOCATION_ID
[ PHONE_MUMBER -
[T HIRE_DATE @
1 JOB_ID =

[C] COMMISSION_PCT
7] MANAGER_ID
["] DEPARTMENT_ID —

F%
|_Culumns| Conditions | | Surting|

:.ﬁ.]l - :uf the conditions in this branch must match
----- emp.SALARY E] = - | 4000 E]
EI :Any - :ufthe conditions in this branch must match
EPARTMENT_NAME ||+ || = ™ -]
[ 122 ||eparTvENT NaME =] = + ||Human Resources =]

To create a new WHERE condition, press the indexed button in the list. In the menu that is displayed you may
choose to create a new condition on the same level, a compound condition or delete the current condition.

For compound conditions you may choose whether All (AND), Any (OR), None (NOT OR) or Not All (NOT
AND) conditions must be met for its sub conditions. The SQL for the Conditions tab in the figure is:

WHERE
enp. SALARY > 4000
AND

(
dept . DEPARTMENT_NAME = ' Hunan Resour ces'

OR dept. DEPARTMENT_NAME = "I T'

Next to the input field for each condition, there is a drop down button. When pressed it shows all columns that
are available in the tables currently being in the Query Builder. You can pick columns from the list instead of
typing these manually.
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[ 122 |[EPARTMENT NAME =)= + ||Human Resources (=]
emp
dept » DEPARTMEMT_ID
DEPARTMEMNT_MAME |
MAMAGER_ID
LOCATION_ID

A condition field may also contain a custom expression, and just as for a custom expression in the columns list,
you can launch a multi-line editor for the expression by selecting the field and click the editor launch button.

The Grouping tab is used to define the conditions for the HAVING clause that may follow a GROUP BY clause
in an SQL query. This tab is only enabled when at least one of the columns in the Columns tab is marked as a
Group By column.

The HAVING clause is similar to the WHERE clause, except that the HAVING clause limits what rows are
included in the groups defined by the GROUP BY clause, after the WHERE clause has been used to limit the
total number of rows to process.

You work with conditions in this tab in the same way as in the Conditions tab, with one exception regarding the
drop-down button for the fields in a condition. In the Grouping tab, the drop-down shows all columns listed in
the Columns tab, with an aggregate function expression for columns that have an aggregate function defined.
This is because (according to the SQL specification) the conditions in a HAVING clause must only refer to
columns that are being returned by the query.

Finally, the Sorting tab is used to specify how the final result set will be sorted. All columns for the tables in the
graph, plus any custom expressions created for the selection list in the Columns tab, are listed in the Sorting
tab.

SQL Preview

Select SQL Preview in the drop-down menu in the toolbar to show a preview of the final SQL. This is a
read-only view and cannot be modified.

9.12.2 Testing the Query

To test the query, simply press the appropriate toolbar button in the Query Builder to copy the SQL to the SQL
Editor. Then execute the SQL as usual in the SQL Editor. Or click the Execute button in the Query Builder
toolbar to copy and execute the SQL in one step.
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POMEROGISER D OE< > BESS

Database Connection [] sticky Database Schema Mz Rows Mae Chars
@ orace v M HR -~ 1000 |0
1 SELECT -
z enp. FIRST NAME AS "Firnamn’,
] enp. LAST NALME AS "Efternamn”, =
b} enp.EMATL AS "E-post”,
3 dept.DEFARTMENT MNAME AS "iwdelning™,
& enp. 3ALART AS "Lin”
7 FROM
g HE.EMPLOYEES enp
S THHER. JOTH HE.DEPARTMENTS dept
10 OH i
1:1 | 1ns| |aute commic: on| [untitiedx|

@ 1: SELECT emp.FIRST_NAME AS Fém...

B0 3vH =

Farmamn Efternamn  E-post Avdelning Ldn
1 [valli Pataballa VPATABAL IT 4800
2 |Susan Mavris SMAVRIS Human Resources 6500
3 |Diana Lorentz DLOREM... IT 4200
4 |David Austin DAUSTIMN 1T 4300
5 |Bruce Ernst BERMST IT G000
6 |Alexander Hunold AHUMNOLD 1T a000

0.156/0.000 sec | 6/5 || 1-6

To further refine the SQL press the Query Builder button and make the necessary changes.

9.12.3 Loading a Query From the Editor

If you have an existing SQL query that you want to modify using the Query Builder, you can load it from the SQL
Editor into the Query Builder by clicking the Load in Query Builder button in the SQL Editor toolbar.

It's important to be aware that the Query Builder does not support all features of the SQL SELECT statement,
such as comments, UNION, and database-specific keywords. If you load a query into the Query Builder that
contains unsupported constructs or keywords, they are ignored and a dialog pops up with a warning about this
fact. You can then use the SQL Preview tab in the Query Builder to compare the SQL as it is represented in the
Query Builder with the original SQL that you loaded to understand what was ignored.

9.12.4 Properties for the Query Builder

In addition to the Auto Join setting discussed above, there are a few other properties that control how the
Query Builder works and the SQL it generates. You can set these properties for the database type (Tools->Tool

Page 201 of 428



;\./\ DbVisualizer 9.2 Users Guide

Properties, under the Database tab) or for a specific connection (the Properties tab in the Object View tab for
the connection).

Express joins as JOIN clause or WHERE condition

The Generate JOIN Clause in SQL Builder property is available in the [Database Type]->Query Builder
category. Joins can be expressed either via the standardized SQL JOIN clause or a WHERE clause, using
database-specific syntax for the Left and Right join types. The database-specific WHERE clause syntax is
somewhat different between the supported databases and the Full outer join type is not supported. The default
for this property is to use a JOIN clause.

A simple inner join expressed as a JOIN clause:

FROM HR. EMPLOYEES
I NNER JO N HR DEPARTMENTS
ON (HR EMPLOYEES. DEPARTMVENT_I D = HR. DEPARTMENTS. DEPARTMENT_I D

Here is the same join expressed as a WHERE condition:

FROM HR. EMPLOYEES, HR. DEPARTMENTS
WHERE HR. EMPLOYEES. DEPARTMENT_| D = HR DEPARTMENTS. DEPARTMENT_I D

The syntax for expressing Inner and Outer joins in WHERE conditions is different between databases. Oracle,
for example, uses the "(+)" sequence to the left or right of the conditional operator to express left or right joins.
SQL Server and Sybase use "*=" or "=*" for the same purpose.

DbVisualizer automatically uses the correct join notation when generating joins as WHERE conditions for
databases that support left and right joins using WHERE conditions. For databases that do not provide syntax
for left and right joins, the join type is ignored and the WHERE condition that is generated produces an inner join
result.

Table and Column Name qualifiers

Whether to qualify table names with the schema or database name and whether to qualify column names with
the table name are defined in the [Database Type]->Qualifiers category.

Delimited Identifiers

Identifiers that contain mixed case characters or include special characters need to be delimited. Define this in
the [Database Type]->Delimited Identifiers category.
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9.12.5 Current Limitations

These are the current limitations in the Query Builder:

® Unions and sub queries are not supported.

® Not all join types are supported when joins are expressed as WHERE clause conditions. The Inner join
type is supported for all databases, but the Left and Right types are only supported for databases with
proprietary syntax to express these types, e.g., Oracle, SQL Server and Sybase. The Full type is not
supported for any database. If a join type is not supported, the setting in the Join Properties dialog is
silently ignored.

®* When importing an SQL query from the SQL Editor, comments, unsupported keywords and statement
clauses are ignored. A dialog tells you which parts of the query are being ignored when unsupported
parts are found in the imported statement.

® There is only limited support for the CASE clause, in that everything between CASE and END is treated
as uninterpreted text. This means that, as opposed to plain object references in the select list or
conditions, column names and other identifiers within a CASE clause are not affected by changes to the
Query Builder property settings, such as Delimited Identifiers and Qualifiers.

9.13 Formatting SQL

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

The SQL->Format SQL menu contains four operations for formatting SQL statements.

Format Buffer formats the complete editor content and Format Current formats the current SQL (at cursor
position).

The formatting is done according to the settings defined in the Tool Properties dialog, in the SQL Editor/SQL
Formatting category under the General tab. There are many things you can configure. After making some
changes, press Apply and format again to see the result.

Here is an example of an SQL statement before formatting:

sel ect

ConpanyNane, Contact Nane, Address,

City, Country, Postal Code from

Nort hwi nd. dbo. Cust omers CQuterC

where CustonerID in (select top 2 InnerC. Custonerld
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from Northwi nd. dbo. [ Order Details] OD

join Northw nd. dbo. Orders O on OD.Orderld = O OrderlD
join Northw nd. dbo. Custoners | nnerC

on O Customer|I D = I nnerC. Custonerld

Wher e Regi on = QuterC. Region

group by Region, InnerC. Custonerld

order by sum(UnitPrice * Quantity * (1-Discount)) desc)
order by Region

And here is the same statement after formatting has been applied with default settings:

SELECT
ConpanyNarne,
Cont act Nane,
Addr ess,

Gty,
Country,
Post al Code

FROMV
Nor t hwi nd. dbo. Cust oners QuterC

VHERE
CustonerID in

(

SELECT
top 2 InnerC. Custonerld
FROM
Nor t hwi nd. dbo. [ ORDER Detai |l s] OD
JON
Nort hwi nd. dbo. Orders O
ON
OD.Orderld = O OderlD
JON
Nor t hwi nd. dbo. Cust oners | nnerC
ON
O Custoner|I D = I nnerC. Custonerld
VWHERE
Regi on = QuterC. Regi on
GROUP BY
Regi on,
I nner C. Cust onrer I d
ORDER BY
SUMUnitPrice * Quantity * (1-Discount)) DESC)
ORDER BY
Regi on

Copy Formatted and Paste Formatted are powerful tools for copying SQL statements between programs
written in languages like Java, C#, PHP, VB, etc. and the SQL Editor. Both operations display a dialog where
you can adjust some of the formatting options, most importantly the Target SQL option and the SQL is
Between option. Target SQL can be set to a number of common programming language formats.

Page 204 of 428



;\./\ DbVisualizer 9.2 Users Guide

For instance, to copy an SQL statement and paste it as Java code for adding it to a Java StringBuffer:

Select the statement,

Choose SQL->Format SQL->Copy Formatted,

Set Target SQL to Java StringBuffer,

Click Format to place the formatted statement on the system clipboard,
Paste it into your Java code.

o s wbh e

To copy a statement wrapped in code from a program:

Select the code containing an SQL statement in your program,

Copy it to the system clipboard,

Choose SQL->Format SQL->Paste Formatted,

Check SQL is Between and enter the character enclosing the SQL statement in the code,
Click Format to extract the SQL statement and paste the formatted SQL in the editor.

ar WD e

9.14 Using Max Rows and Max Chars for Queries

DbVisualizer limits the number of rows shown in the result set tab to 1000 rows, by default. This is done to
conserve memory. If this limit prevents you from seeing the data of interest, you should first consider:

1. Using a WHERE clause in the query to only retrieve the rows of interest instead of all rows in the table,
2. Exporting the table (see page 107) to a file

If you really need to look at more than 1000 rows, you can change the value in the Max Rows field in the SQL
Commander toolbar. Use a value of O or -1 to get all rows, or a specific number (e.g. 5000) to set a new limit.

Diatabase Connection Sticky Database Schema Maxx Rowes Max Chars
[l crRM Ahoa - W Hans -1 -1

Character data columns may contain very large values that use up lots of memory. If you are only interested in
seeing a few characters, you can set the Max Chars field in the SQL Commander toolbar to the number of
characters you want to see.

You can define how to deal with columns that have more characters than the specified maximum in the Tool
Properties dialog, in the Grid category under the General tab. You have two choices: Truncate Values or
Truncate Values Visually.

®* Truncate Values truncates the original value for the grid cell to be less then the setting of Max Chars.

% This affects any subsequent edits and SQL operations that use the value since it's truncated. This
setting is only useful to save memory when viewing very large text columns.
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® Truncate Values Visually truncates the visible value only and leave the original value intact. This is the
preferred setting since it will not harm the original value. The disadvantage is that more memory is
needed when dealing with large text columns.

When the grid data is limited due to either the Max Rows or Max Chars value, you get an indication about this
in the rows/columns field in the grid status bar and in the corresponding limit field.

] Log | ig DBMS Output | [ ] 2: select EMPLOYEE_ID, FIRST_NAME... X

PO 3P - WEEEHE vy -n» EE =
w <5f‘“’ EMPLOYEE_ID FIRST_MAME LAST_MAME EMAIL
1 100 Steven King SKIMG -
z 101 Meena Kochhar MKOCHHAR
3 102 Lex De Haan LDEHAAM
4 103 Alexander Hunold AHUMOLD
5 104 Bruce Ernst BERMST
=t 1ME Cizsid Avchn Cidl 1CTThI

0.000/0.016 sec || /5", 100/4 | 1-6

Along with the highlighted field, a warning pops up close to the filed. You can disable this behavior in the Tool
Properties dialog, in the Grid category under the General tab.

9.15 Getting the DDL for an Object

You can use the @l | command in a script to get the DDL for a number of different database object types. The
command supports this general syntax:

@ldl <obj Type>="<obj1d>" [ drop="true | false" ] [ constrCrl="<constrCtrl>" ]

where <obj Type>is one of t abl e, i ndexesf ort abl e, vi ew, procedur e, f uncti on, package (Oracle
only), packagebody (Oracle only), obj ect t ype (Oracle only), obj ectt ypebody (Oracle only), sequence (
Oracle only), synonym(Oracle only), modul e (Mimer SQL only) or t ri gger, and <obj | d> is the qualified
identifier for the object (case sensitive). Here's an example:

@idl tabl e="HR EMPLOYEES";
If dr op is setto t r ue, a DROP statement is included before the CREATE statement.

The constr Ctrl parameter only applies to tables. It accepts two values: noconst r means that no constraints
should be included in the statement that can potentially cause creating the table or inserting data into it to fail (
FK and CHECK constraints), while onl yconst r means that an ALTER statement adding the remaining
constraints should be generated instead of a CREATE statement.
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9.16 Using the Log Tab

At the top of the Log tab, you can choose to log information about the execution of your SQL statements to the
GUI or to afile.

=] Log |{jg DBMS Output
Preprocess script () Log to GUL @) Log to File | C:\Usersthansimyresult.log E]

If you choose to log to file, you can enter the file path in the text field or click the button to the right of the field to
launch a file browser. By default, the log information is written to the GUI, below the log destination controls.

The Preprocess script checkbox controls preprocessing, as described in the Executing an External Script (see
page 179) page.

The log keeps an entry for each SQL statement that has been executed. It provides generic information, such as
how many rows were affected and the execution time. The important piece of information is the execution
message which shows how the execution of that specific statement ended. If an error occurred, the complete log
entry will be in red, indicating that something went wrong.

/=/14:45:18 [SELECT - 27 row(s), 0.000 secs] Result set fetched = Copy CirleC
/=/14:45:18 [SELECT - 100 row(s), 0.000 secs] Result set fetched it

/=/14:45:19 [SELECT - 10 row(s), 0.015 secs] Result set fetched i} Select Al Ctrl+A,
/=/14:45:19 [SELECT - 0 row(s), 0.000 secs] [Error Code: 342, SOL State: 42000] ORA E Save A.. Ctrl+Shift+S

/=/14:45:19 [SELECT - 19 row(s), 0.016 secs] Result set fetched .
[ /14:45:19 [SELECT - 23 row(s), 0.016 secs] Result set fatched L3¢ Clearleog Ctrl+Delete
- 6 statement(s) executed, 179 row(s) affected, exec/fetch time: 0.047 [0.000 s| Clear Success Entries
Clear Error Entries

Clear Warning Entries
Auto Clear Log
Show Message

Show 5QL

Show Success
Show Error

Show Warning

OO0 EE

The detail level in an error message depends on the driver and database that is being used. Some databases
are very good at telling you what went wrong and why, while others provide less detail.

Clicking the icon to the left of each log entry selects the corresponding SQL statement in the SQL editor. The
icon also has a right-click menu; Load SQL into Editor with submenus for where to place the SQL (at caret,
first, last or replacing the current content), and Load SQL in New Editor.

The Log tab right-click menu contains entries that let you control the log content. Use the Show entries to define
which information you want to appear in the log. The Clear entries are used to remove certain kinds of results
from an existing log.
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If you enable the Auto Clear Log control, the SQL Commander automatically clears the log between executions

9.17 Writing to the Log Tab

You can use the @echo client side command to write information to the Log tab.

@cho <nessage>

The message may contain DbVisualizer variables (see page 221), e.g. one of the predefined variables.
@cho Today is ${dbvis-date}$ and the tinme is ${dbvis-tinme}$

Variables can also be used to display values produced by executing a function or stored procedure (see page

144):

@all ${STATUS|| (null)||String||noshow dir=out}$ = "HR"'." CGET_STATUS" (1002);
@cho STATUS: ${STATUS}$;

9.18 Using the DBMS Output Tab

The DBMS Output tab is only available for Oracle databases. It is used to capture messages produced by
stored procedures, packages, and triggers. These messages are typically inserted in the code for debugging
purposes. For SQL*Plus users, the corresponding feature is enabled via the set serveroutput on command. To
enable display of DBMS messages in DbVisualizer,

1. Select the DBMS Output tab
2. Press the Enable button.

Once DBMS output is enabled, the icon in the tab header is changed. Invoking a stored procedure that produces
messages in the SQL Commander results in content similar to this in the output tab. (Each block of output is
separated with a timestamp).
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[®> 1: CRM Ahoa Untitled x

PEAEO®EBEORI¢CYBE-[E0E

Database Connection
[, cRM Ahoa
1 call emp_report()

1:1[1]] NS

[7] sticky Database

-

-/ Log (% DBMS Output

P @ [o|5¢ BufferSize: | 100000

1--- 15:41:82 ---
2 Empno  Ename

16 7654 Martin
17 7698 Blake

9.19 Comparing SQL Scripts

Salesman
Manager
Manager
Analyst
President
Salesman
Clerk
Clerk
Analyst
Clerk
Clerk
Salesman
Salesman
Manager

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

Schama
4 HR

Mzt Rows Max Chars

| |1 -1

Auto Commit: ON | Enceding: Cp1252 Untitled

You can compare a script in one SQL Commander editor to a scripts in another SQL Commander editor, or to
the original file loaded into the editor.

® To compare the script to another script, select Compare from the right-click menu in one editor and pick
the SQL Commander holding the other script in Select Object dialog to compare their text content (see

page 256).

® To compare the script to the original file, select Compare to Saved from the right-click menu.

9.20 Exporting Query Results
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@

Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

Instead of viewing query results in Result Set grids, you can export the result of one or more queries to a file.
For very large results, this may be the preferred choice due to memory constraints.

To export a query result, create a script with

A wbd e

an @export on command,
an @export set command,
one or more queries,

an @export off command.

Here is a basic example:

@xport on;
@xport set filename="c:\Backups\Orders.csv";
select * from Orders;
@xport off;

The @export set command takes a parameter name followed by an equal sign and a value. You can use the
following parameters, where only filename is required and all names are case-insensitive:

Parameter

AppendFile

BinaryFileDir

BinaryFormat

BooleanFalseFormat

BooleanTrueFormat

CLOBFileDir

CLOBFormat

CsvColumnDelimiter

CsvincludeColumnHeader

Default

false

Don't Export
false

true

Value
\t (TAB)

true

Valid Values
true, false, clear

Directory path for data files when BinaryFormat is set to
File

Don't Export, Size, Value, Hex, Base64, File
false, no, O, off
true, yes, 1, on

Directory path for data files when CLOBFormat is set to
File

Don't Export, Size, Value, File

true, false
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Parameter Default Valid Values

CsvColumnHeaderlsColumnAlias  true true, false

CsvincludeSQLCommand Don't Don't Include, Top, Bottom

Include

CvsRemoveNewlines false true, false

CsvRowCommentldentifier

CsvRowDelimiter \n \n (UNIX/Linux/Mac OS X), \r\n (Windows)

DateFormat yyyy-MM-dd  See valid formats in Changing the Data Display Format (
see page 106) document

DecimalNumberFormat Unformatted See valid formats in Changing the Data Display Format (
see page 106) document

Destination File File

Encoding UTF-8

ExcelColumnHeaderlsColumnAlias = false true, false

ExcelFileFormat binary binary (Binary Excel) or ooxml (Excel 2007)

ExcellncludeColumnHeader true true, false

ExcellncludeSQLCommand false true, false

ExcellntroText Any description

ExcelTextOnly false true, false

ExcelTitle Any title

Filename REQUIRED

Format CSsv CSV, HTML, XML, SQL, XLS, JSON

HtmlincludeSQLCommand false true, false

HtmlintroText Any description

HtmITitle Any title

JSONStyle Array Array, Rows

NumberFormat Unformatted See valid formats in Changing the Data Display Format (

see page 106) document
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Parameter Default Valid Values

QuoteDuplicateEmbedded true true, false (quote char is the same as QuoteTextData)

QuoteTextData None None, Single, Double

Settings The path to an XML file containing all settings

ShowNullAs (null)

SqlBeginldentifier Character to use to begin a quoted identifier. Note! To
specify a double-quote, you must duplicate it since
double-quote is also used to enclose the parameter value.

SqlBlockBeginDelim String to use to begin an SQL block when exporting
complex DDL statements using the @ddl command.

SqlBlockEndDelim String to use to end an SQL block

SqlDelimitedldentifiers true true, false

SqlEndldentifier Character to use to end a quoted identifier. Note! To
specify a double-quote, you must duplicate it since
double-quote is also used to enclose the parameter value.

SqlincludeCreateDDL false true, false

SqlincludeSQLCommand Don't Don't Include, Top, Bottom

Include

SqlQualifier Qualifier to use when qualifying table names. If not set,
DbVisualizer tries to determine the schema and use it as
the qualifier.

SqlQualifyTableName true true, false

SglRowCommentldentifier --

SqlSeparator ; Statement separator character.

TableName Can be set if DbVisualizer cannot determine the value for
the ${dbvis-object}$ variable

TimeFormat HH:mm:ss See valid formats in Changing the Data Display Format (
see page 106) document

TimeStampFormat yyyy-MM-dd  See valid formats in Changing the Data Display Format (

HH:mm: see page 106) document
$s.SSSSSS
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Parameter Default Valid Values
XmlincludeSQLCommand false true, false
XmlintroText Any description
XmiStyle DbVisualizer DbVisualizer, XmIDataSet, FlatXmIDataSet

Here are a few examples using some of these settings.

9.20.1 Automatic table name to file mapping

This example shows how to make the filename the same as the table name in the select statement. The
example also shows several select statements. Each will be exported in the SQL format. Since the filename is
defined to be automatically set, this means that there will be one file per result set and each file is named by the
name of its table.

@xport on;

@xport set filename="c:\Backups\${dbvis-object}$" format="sql";
select * from Orders;

sel ect * from Products;

sel ect * from Transacti ons;

@xport off;

~. There must be only one table name in a select statement in order to automatically set the filename with
the ${dbvis-object}$ variable, i.e if the select joins from several tables or pseudo tables are used, you
must explicitly name the file.

The ${dbvis-object}$ variable is not substituted with a table name if using the AppendFile="true/clear"
parameter.

9.20.2 Multiple results to a single file

This example shows how all result sets can be exported to a single file. The AppendFile parameter supports
the following values.

® true

The following result sets will all be exported to a single file
* false

Turn off the append processing
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® clear
Same as the true value but this will in addition clear the file before the first result set is exported

@xport on;

@xport set filename="c:\Backups\alltables.sql" appendfile="clear" format="sql";
select * from Orders;

sel ect * from Products;

select * from Transacti ons;

@xport off;

9.20.3 Using predefined settings

If you save settings when exporting a table (see page 107) or a schema (see page 152), you can use the
Settings parameter to reference the settings file.

@xport on;

@xport set settings="c:\tnp\htm settings.xm" filename="c:\Backups\${dbvis-object}$";
select * from Orders;

sel ect * from Products;

sel ect * from Transacti ons;

@xport off;

9.20.4 Limit the number of exported rows

You can use the @et maxr ows command in combination with the @xport command to override the Max
Rows (see page 205) field value in the SQL Commander tab toolbar.

@et maxrows 10;

@xport on;

@xport set filename="c:\Backups\alltables.sql" format="sqgl";
select * from Orders;

sel ect * from Products;

sel ect * from Transacti ons;

@xport off;

If Max Rows is set to a positive number, you can use the @et naxr ows command to set it to - 1 to export all

rows.

9.21 Using Permissions in the SQL Commander

@

Page 214 of 428



:\.3\ DbVisualizer 9.2 Users Guide

Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

The Permission functionality is a security mechanism, where you can specify that certain database operations
must be confirmed. You configure permissions in the Tool Properties dialog, in the Permissions category of the
General tab, per connection mode (Development, Test and Production).

You specify which connection mode to use for a connection in the Properties tab of the Object View tab for the
connection.

The permission feature is part of DbVisualizer and does not replace the authorization system in the
actual database.

For the SQL Commander, you can pick the permission mode type from a drop-down list for each SQL command

Permission Description

Type

Allow This permission type means that you can run the SQL statement without any confirmation
Deny This permission type means that the SQL statement is not executed at all.

Ask This permission type means that when executing an SQL statement, or a script of statements,

the SQL Commander asks you whether the actual SQL command(s) should be executed.
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SQL Commander Permissions

Define here whether the SQL Commander should allow {execute), deny [not execute) or ask
before executing the following SQLs organized per connection mode.

{The connection mode for 2 database connection i set sither in the Tool Properties->Database
tzb or in Connection Properties).

Development Test Production
SELECT: |8 Allow > B Alow ~ | B Allow -
INSERT: |9 Allow > B Alow ~ | ) Ask -
UPDATE: |8 Allow > B Alow - ) Ask -
DELETE: |[B Allow v | | Allow v | | Ask -
TRUNCATE: |[B» Allow v | Ask v | Ask -
CREATE: |[B» Allow ~ | B Alow v D Ask v
ALTER: | Allow v B Alow v D Ask v
DROP: | Allow v | & Ask v D Ask v
COMMIT/ROLLBACK: | B Allow > B Alow ~ | D Ask -

Other: b Allow 'v: ﬁ Ask v: ﬁ Ask v:

9.22 Sending Comments to the Database with Statements

Comments in an SQL script, identified by the delimiters defined in Tool Properties dialog in the SQL
Commander/Comments category under the General tab, are sent to the database by default. In some cases,
you may not want to include the comments with the statement, for instance if your database does not handle
them. You can then enable the stripping of comments using the Strip Comments when Executing toggle item
in the in the SQL Commander menu.
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9.23 Using Client-Side Commands

You can use DbVisualizer these client-side command in your scripts.

Command

@d <directory>@un <file> |

<vari abl es> ]

@xport

@elimter <new delimter>

Description

Use these command to execute an external script (see page 179).

Use this command to export the result of a query (see page 209) or
procedure call to a file.

for a complex statement (see page 177).

Use this command to temporarily change the statement delimiter
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Command

@al |

@eep

<function_or_proc>

@l eep <m | |iseconds>

@cho <text>

@ ndow i coni fy
@v ndow restore

@lesc <t abl e>

@id|

@pool

<par ans>

log <fil e_nane>

@top on error

@t op on warni ng@ontinue on

error @ontinue on warni ng

& et
& et

aut ocommt on
aut ocommt of f

@onmm t

@oll

&et
& et

& et
&et

&et

back

serverout put on
serverout put off

maxr ows <nunber >
maxchars <nunber >

resul tset name <name>

Description

Use this command to execute a function or procedure (see page
144).

Use this command to emit a been sound, e.g. to indicate a
significant point in a script.

Use this command to halt the processing the specified number of
milliseconds.

Use this command to write to the Log tab (see page 208).

Use these commands to lower (iconify) or raise (restore) the
DbVisualizer main window.

Use this command to show column information for a table. The
table name may be qualified with a schema and/or database name.

Use this command to get the DDL for a database object (see page
206).

Use this command to write log messages to the named file. When
executed in the SQL Commander, all log messages produced up to
this point are written to the file; if Log to File is selected, this
command is ignored. When executed by the pure command line
interface, all log messages produced from this point onward are
written to the file.

Use these commands to control what to do when a statement
results in a warning or an error (see page 174).

Use these commands to control the Auto Commit (see page 183)
state.

Use these commands to explicitly commit or rollback (see page 183
) updates.

Use these commands to enable or disable output to the DBMS
Output tab (see page 208).

Use these commands to adjust the Max Rows and Max Chars (see
page 205) limits for specific queries.

Use this command to name any following result set. When
executed with a following SQL statement that produces a result set
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Command Description

the tab showing this result set will be named using the <name>
supplied as a parameter to the command.

Example:

@et resultset name MyEnpl oyees;
sel ect * from EMPLOYEE;

DbVisualizer will for the example above show the result of the
select in a tab named MyEmployees

9.24 Parameterized SQL - Variables and Parameter
Markers

A useful feature in the SQL Commander is to use variables or parameter markers in SQL scripts. Variables are
used to express that certain parts of the SQL should be replaced with values when the SQL is executed. If you
use a script to perform repetitive tasks, such as creating a user and granting permissions, just insert variables
for the user name and permissions to grant in the script and DbVisualizer will prompt for the values at execution.

In addition to DbVisualizer's own variable syntax, two parameter marker syntaxes supported natively by some
databases/drivers can also be used. This makes it easier to use SQL statements from other tools or code as-is
in DbVisualizer, but you need to be aware of the limitations in how they are used compared to DbVisualizer
variables.

The following gives an overview of the different formats and how they can be used.

@ Even if DbVisualizer supports several variable formats it doesn't mean you can always copy/paste the
SQLs including the parameter markers to another application and successfully execute it. You need to
check the compatibility for the actual connector/driver/framework and even that the database itself
supports the used syntax.

The following variable syntaxes are supported by DbVisualizer:

DbVisualizer Variables

${vari abl e| | This is the most flexible syntax as it supports setting a name, default value, data type,
val ue| | type] | and other options. Check the DbVisualizer Variables (see page 221) section for details.
options}$
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DbVisualizer Variables

A DbVisualizer variable can be used anywhere in the SQL as the specified value
replaces the variable definition as a literal (unless a data type is specified; with a data
type, its behavior is exactly the same as for Named Parameter Markers).

Example

select *

from EMPLOYEE

where FIRST_NAME |ike '${First Name||Phil}$
and AGE > ${Age||20}%

The variable identifiers, ${...}$ can be modified in Tools->Tool Properties and in the
General / Variables category.

Named Parameter Markers

&nane These syntaxes are supported natively by a few databases. This format allows only a name for
- nane the parameter and no other settings, such as type or default value. The parameter name is the
:{nane}: nhame DbVisualizer shows in the prompt window.

" nane'

Named parameter values are bound at runtime with the markers in the SQL. Some JDBC
drivers/databases requires that the proper data type is set while some are more relaxed. For
named (and unnamed) parameter markers, you may chose data type in the prompt window.

Named parameter markers should only be used in contexts supported by the actual database,
usually for column values. For example, as opposed to a DbVisualizer variable, a parameter
marketer cannot be used for a table or column name.

The only difference between &name, :name, :{name} and :'name' is that the latter two, :{name
} and :'name’, allow white spaces in the name.

Example

insert into EMPLOYEE (1D, FIRST_NAME, LAST_NAME, ADDRESS, ACE)
val ues (null, &FirstNane, &lLastNanme, &Address, &Age);
insert into EMPLOYEE (I D, FIRST_NAME, LAST_NAME, ADDRESS, AGE)

values (null, :FirstNanme, :LastName, :Address, :Age);
insert into EMPLOYEE (1D, FIRST_NAME, LAST_NAME, ADDRESS, ACE)
values (null, :{FirstName}, :{LastNane}, :{Address}, :{Age});

Read more about named parameter markers (see page 228).
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Unnamed Parameter Markers

? The question marker symbol is probably the most supported parameter marker among the supported
databases. It is also the most unintuitive marker since the user has to remember the order of question
marks and the corresponding values.

Since there is no name associated with it, DbVisualizer shows these as Parameter 1, Parameter 2 and so
on in the prompt window.

There is no technical difference between how unnamed and named parameter markers are handled
internally in DbVisualizer or when processed by the database. All are bound with a prepared SQL
statement.

Example

insert into EMPLOYEE (1D, FIRST_NAME, LAST_NAME, ADDRESS, AGE)
values (null, ?, ?, ?2, ?)

Use named in favor of unnamed parameter markers if there is support in the target database based on the
easier reading of named markers. Read more about unnamed parameter markers (see page 228).

& Itis not possible to mix DbVisualizer variables and parameter markers, or named and unnamed
parameter markers, in the same script. If you do, you will only be prompted for values for one type and
the execution will fail.

For more information about the different syntaxes check Using DbVisualizer Variables (see page 221)and Using
Parameter markers (see page 228).

9.24.1 Using DbVisualizer Variables

DbVisualizer variables are used to build parameterized SQL statements and let DbVisualizer prompt you for the
values when the SQL is executed. This is handy if you are executing the same SQL repetitively, just wanting to
pass new data in the same SQL statement.

® Variable Syntax (see page 222)
* Pre-defined Variables (see page 223)
® Variable Substitution in SQL statements (see page 224)

©@ A DbVisualizer variable that doesn't specify a data type will always be replaced with the value as a
literal. This allows use of variables anywhere in an SQL statement. If a data type is specified, the
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prompted value will be bound with the SQL and variables can in this context only be used where
supported by the target database.

DbVisualizer Variables

${vari abl | |
val ue| | type]| |
options}$

This is the most flexible syntax as it supports setting a name, default value, data type,
and other options. Check the DbVisualizer Variables (see page 221) section for details.

A DbVisualizer variable can be used anywhere in the SQL as the specified value
replaces the variable definition as a literal (unless a data type is specified; with a data
type, its behavior is exactly the same as for Named Parameter Markers).

Example

sel ect *

from EMPLOYEE

where FIRST_NAME |ike '${First Nane||Phil}$
and AGE > ${Age|| 20}%

The variable identifiers, ${...}$ can be modified in Tools->Tool Properties and in the
General / Variables category.

Variable Syntax

The variable format supports setting a default value, data type and a few options as in the following example:

${Ful | Nane| | Ander sson| | Stri ng| | where pk}$

This is the complete syntax for a DbVisualizer variable:

${nane ||

Part

name

value

type

value || type || options}$
Default Description
Required Required. This is the name that appear in the prompt window. If multiple variables in a

null

none
(= literal)

script have the same name, the substitution dialog shows only one and the entered
value will be applied to all variables with that name

The default value for the variable

The type of variable: String, Boolean, Integer, Float, Long, Double, BigDecimal, Date,
Time and Timestamp. In addition DbVisualizer defines: BinaryData and TextData (for
CLOB). This is used to determine how the data should be passed between DbVisualizer
and the database server. If no type is specified, it is treated as a literal
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Part Default Description
options none The options part is used to express certain conditions. Separate these with a
whitespace
] pk

Indicates that the variable is part of the primary key in the final SQL.
Represented with a symbol in the prompt window

®* where
Defines that the variable is part of the WHERE clause. A symbol indicate this
condition in the prompt window

®* noshow
This option define that the variable should not appear in the prompt window. A
value must be set when using this option, unless it is an output variable (see dir
below)

®* nobind
Used in combination with when a type is set and defines that the variable should
be replaced as a literal in the SQL rather than being bound as a parameter
marker

® dir=in | out | inout
The direction for a variable used with the @call command (it is ignored for other
uses). A variable assigned the return value for a function must be declared as dir
=out, and a variable used for a procedure parameter must use a dir type
matching the procedure parameter direction declaration. in is the default

Pre-defined Variables

A few pre-defined DbVisualizer variables can be used anywhere in the SQL. These are replaced with actual
values just before the SQL is sent to the DB server.

. Note that none of the pre-defined variables below will show in the prompt window.

${dbvi s-date}$
${dbvis-tine}$
${dbvi s-ti nmest anp} $${ dbvi s- connecti on} $${ dbvi s- dat abase-type} $

By default, date/time variable values are formatted as defined in Tool Properties->Data Formats, but you can
also specify a custom format for a single use of the variable, e.g.

${dbvis-date||]|]|]||format=[yyyyMwid] } $
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The following variables can be used only when monitoring a SQL statement that produce a result set and the
Allowed Row Count for the monitor is > 0. The output format is seconds and milliseconds. Ex: 2.018

${dbvi s-exec-tinme}$
${dbvi s-fetch-ti nme}$

Variable Substitution in SQL statements

% For variable processing to work in the SQL Commander, make sure the SQL->Enable Parameterized
SQL main menu option is checked.

A simple variable may look like this:
${ Ful | Nane} $

A variable is identified by the start and end sequences, ${. . . } $. (These can be re-defined (http:/
confluence.dbvis.com/display/UG91/Using+DbVisualizer+Variables#
UsingDbVisualizerVariables-ChangingtheDelimiterCharacters) in Tool Properties). During execution, the SQL
Commander searches for variables and displays the prompt window with the name of each variable and an input
(value) field. Enter the value for each variable and then press Execute. This will then replace the variable with
the value as a literal and finally let the database execute the statement.

Consider the following SQL statement with variables. It is the simplest use of variables since it only contains the
variable names. In this case it is also necessary to enclose text values with quotes since the prompt window
cannot determine the actual data type for the variables.

| NSERT
| NTO
EMPLOYEES
(
EMPLOYEE_I D,
FI RST_NAME,
LAST_NAME,
EMAI L,
PHONE_NUNBER,
HI RE_DATE,
JOB_ID,
SALARY,
COVM SSI ON_PCT,
MANAGER | D,
DEPARTMENT | D
)
VALUES

(
${ EMPLOYEE_| D} $,
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${ FI RST_NAME} $,

${ LAST_NANE} $,
${EMAI L} $,

${ PHONE_NUMBER} $,
${ Hl RE_DATE} $,
${JOB_I D} $,

${ SALARY} $,

${ COMM SSI ON_PCT} $,
${ MANAGER | D} $,

${ DEPARTMENT | D} $

Executing the above SQL will result in the following prompt window:

E - Enter Data for Varial.J.Ees “

AB OO0 oe -5 vK

Key MName Value Type
EMPLOYEE_ID (null) Literal
FIRST_MAME {null) Literal
LAST_MNAME {null) Literal
EMAIL {null) Literal
PHOME_NUMBER  (null) Literal
HIRE_DATE {null) Literal
JOB_ID {null) Literal
SALARY {null) Literal
COMMISSION_PCT (null) Literal
MANAGER_ID {null) Literal
DEPARTMENT_ID (nul) Literal

1: EMPLOYEE_ID Pattern: Text

Mat MILL

1DBC: MfA, Java: Literal
oW ontinue ance

Show SQL Conti C |

Using variables with no data type defined shows these as Literal. This means that the specified value will
replace the variable as-is in the SQL statement.

The prompt window has the same look and functionality as the Form Data Editor, i.e. you can sort, filter, insert
pre-defined data, copy, paste and edit cells in the multi line editor, plus a lot of other things. In addition the
prompt window adds two new commands (leftmost in the toolbar and in the form right-click menu).

Set Default This will set each value to the default value for the variable. If a default value was not
Values specified in the variable, (null) will shown

Set the value for each variable to the values (matched by name) that was used in the
previous run (if there are no values from a previous run, this button is disabled)
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Set
Previously
Used Values

The SQL Preview area shows the statement with all variables replaced with the values.

Here is an example of a more complex use of variables utilizing default value, data type and options:

I NSERT
I NTO

EMPLOYEES

(
EMPLOYEE_|I D,
FI RST_NAME,
LAST_NAME,
EMAI L,
PHONE_NUMBER,
H RE_DATE,
JOB_I D,
SALARY,
COW SSI ON_PCT,
MANAGER | D,
DEPARTMENT_I D

)

VALUES

(
${ EMPLOYEE_| D| | 105| | Bi gDeci mal | | pk ds=7 dt =NUVERI C} $,
${ FI RST_NAME| | Davi d| | String| | nul | abl e ds=20 dt =VARCHAR} $,
${LAST_NAME| | Austin| ]| String||ds=25 dt =VARCHAR} $,
${EMAI L| | DAUSTI N| | Stri ng| | ds=25 dt =VARCHAR} $,
${ PHONE_NUMVBER| | 590. 423. 4569| | Stri ng| | nul | abl e ds=20 dt =VARCHAR} $,
${ H RE_DATE]| | 2005- 06- 25 00: 00: 00| | Ti nest anp| | ds=7 dt =TI MESTAVP} $,
${JOB_ID|I T_PROG | String||ds=10 dt=VARCHAR}$,
${ SALARY| | 4800]| | Bi gDeci mal | | nul | abl e ds=10 dt =NUVERI C} $,
${ COW SSI ON_PCT| | (nul )] | Bi gDeci mal | | nul | abl e ds=4 dt=NUVERI C}$,
${ MANAGER_| D| | 103| | Bi gDeci mal | | nul | abl e ds=7 dt =NUMVERI C} $,
${ DEPARTMENT_I D] | 60] | Bi gDeci nal | | nul | abl e ds=5 dt =NUVERI C} $

This example use the full capabilities of variables. This example is generated by the Script to SQL
Commander->INSERT COPY INTO TABLE right click menu choice in the Data tab grid. By default it generates
variables representing the actual values and the characteristics of the columns.
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E 4 Enter Data for Variables b H

STE D™ pe -5 v KK

Key Mame Value Type

4 EMPLOYEE_ID 105 BigDecimal
FIRST_MAME David String
LAST MAME Austin Siring
EMAIL DALISTIM Siring
PHOME_NUMBER  590.423.455% String
HIRE_DATE 2005-05-25 00:00:00 Timestamp
JOB_ID IT_PROG String
SALARY 4300 BigDedmal
COMMISSION_PCT (null) BigDecimal
MANAGER_ID 103 BigDecimal
DEPARTHMENT_ID o0 BigDedmal

1: EMPLOYEE_ID MUMERIC Pattern: Unformatted

Mot MULL, Key Column
IDBC: MfA, Java: BigDecimal

[ ] 5how SQL Cancel

To highlight that a variable is part of the WHERE clause in the final SQL, it is represented with a green symbol in
front of the name.

When executing an SQL statement that consist of variables, DbVisualizer replaces each variable with either the
value as a literal or as a parameter marker. Using parameter markers to pass data with a statement is more
reliable than literals. DbVisualizer will automatically generate a parameter marker if the variable has the data
type set and if there is no nobind option specified.

The following will be replaced with a parameter marker:
${Nane||rolle||String}$
These will be replaced with the value as a literal in the final SQL:

${Nane||rolle}$
${Nane| |rolle||String||nobind}$

Variables in DbVisualizer may be used anywhere in a statement as long as there is no data type specified.
Changing the Delimiter Characters

You can change which identifiers should be used as the prefix, suffix and part delimiter in a variable expression
in Tools->Tool Properties, in the General / Variables category.
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9.24.2 Using Parameter Markers

Parameter markers (also referred as bind/host variables or place holders) are commonly used in database
applications where the SQL is composed of static text combined with values represented as markers instead of
actual values. These markers are processed during the preparation of the SQL statement and values are then
bound with the markers. Each database has its recommendations for how and when to use parameter markers
so this is not further discussed here.

Named Parameter Markers (see page 228)
Unnamed Parameter Markers (see page 230)
Get Parameter Types via JDBC (see page 231)
® Database Support/Driver Support (see page 232)

DbVisualizer supports the most common syntaxes for parameter markers to comply with the supported
databases. Parameter markers are categorized as either named or unnamed markers. The following sections
explains their respective syntaxes.

& Itis not possible to mix DbVisualizer variables and parameter markers, or named and unnamed
parameter markers, in the same script. If you do, you will only be prompted for values for one type and
the execution will fail.

Named Parameter Markers

Named Parameter Markers

&narne These syntaxes are supported natively by a few databases. This format allows only a name for
. name the parameter and no other settings, such as type or default value. The parameter name is the
:{name}: name DbVisualizer shows in the prompt window.

" nane'

Named parameter values are bound at runtime with the markers in the SQL. Some JDBC
drivers/databases requires that the proper data type is set while some are more relaxed. For
named (and unnamed) parameter markers, you may chose data type in the prompt window.

Named parameter markers should only be used in contexts supported by the actual database,
usually for column values. For example, as opposed to a DbVisualizer variable, a parameter
marketer cannot be used for a table or column name.

The only difference between &name, :name, :{name} and :'name"' is that the latter two, :{name
} and :'name’, allow white spaces in the name.

Example

insert into EMPLOYEE (1D, FIRST_NAME, LAST_NAVME, ADDRESS, ACGE)
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Named Parameter Markers

val ues (null, &FirstNane, &lLastNane, &Address, &Age);
insert into EMPLOYEE (1D, FIRST_NAME, LAST_NAVME, ADDRESS, AGE)

values (null, :FirstNanme, :LastNanme, :Address, :Age);
insert into EMPLOYEE (1D, FIRST_NAME, LAST_NAME, ADDRESS, ACE)
values (null, :{FirstNanme}, :{LastNane}, :{Address}, :{Age});

Read more about named parameter markers (see page 228).

The following is a sample SQL executed in the SQL Commander:

| NSERT | NTO EMPLOYEES
(EMPLOYEE_I D, FI RST_NAME, LAST_NAME, EMAIL, PHONE_NUMBER, HI RE_DATE,
JOB_ID, SALARY, COWM SSI ON_PCT, MANAGER | D, DEPARTMENT | D)

VALUES

(: EMPLOYEE_I D, :FIRST_NAME, :LAST_NAME, :EMAIL, :PHONE_NUVBER
H RE_DATE, :JOB_ID, :SALARY, : COW SSI ON_PCT, :MANAGER | D, :DEPARTMENT |D);

The prompt window will show the markers with their respective names:

E # Enter Data for Parameter Markers “

YEBOD e -5 vK Q

Key MName Value Type
evpovee D ] 1nteger
FIRST_NAME Janne String
LAST _NAME Shouffer String
*EMAIL janne@guitarr.com String
:PHONE_NUMBER String
:HIRE_DATE 2012-12-12 Date
:J0B_ID PRO String
SALARY 1221.12 Double
{LOMMISSION PCT 14.4 Double
:MANAGER_ID 21 Integer
DEPARTHMENT_ID 2 Integer

1: :EMPLOYEE_ID NUMBER Pattern: Unformatted

Allow NULL

JDBC: Nf A, Java: Integer

[ ] show 5QL Continue Cancel

For parameter marker processing to work in the SQL Commander, make sure the SQL->Enable Parameterized
SQL main menu option is checked.
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@ 1o apply the values, close the window and continue with the execution, use key binding Ctrl+Enter (
Command+Enter on Mac OS X).

Unnamed Parameter Markers

Unnamed Parameter Markers

? The question marker symbol is probably the most supported parameter marker among the supported
databases. It is also the most unintuitive marker since the user has to remember the order of question
marks and the corresponding values.

Since there is no name associated with it, DbVisualizer shows these as Parameter 1, Parameter 2 and so
on in the prompt window.

There is no technical difference between how unnamed and named parameter markers are handled
internally in DbVisualizer or when processed by the database. All are bound with a prepared SQL
statement.

Example

insert into EMPLOYEE (1D, FIRST_NAME, LAST_NAME, ADDRESS, AGE)
values (null, 2, 2?2, 2, ?)

Use named in favor of unnamed parameter markers if there is support in the target database based on the
easier reading of named markers. Read more about unnamed parameter markers (see page 228).

This is the same SQL as used in the Named Parameter Marker section but here question marks are used as
markers:

| NSERT | NTO EMPLOYEES
(EMPLOYEE_I D, FI RST_NAME, LAST_NAME, EMAIL, PHONE NUMBER, HI RE_DATE,
JOB_ID, SALARY, COWM SSI ON PCT, MANAGER | D, DEPARTMENT | D)

VALUES
(2, 2, 2,2, 2,2, 2, 2 2 2 ?);

Since we're using the unnamed marker, ?, the name of each parameter is displayed as Parameter 1,
Parameter 2 and so on:
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E 4 Enter Data for Parameter Markers “
IJE DD pe -/ vK
Key MName Value Type
Parameter 1 S08 Integer
Parameter 2 (1) I string
Parameter 3 (null) String
Parameter 4 (null) String
Parameter 5 (null) String
Parameter & (null) String
Parameter 7 (null) String
Parameter 8 (null) String
Parameter 9 (null) String
Parameter 10 (null) String
Parameter 11 (null) String
2: Parameter 2 VARCHARZ2 Pattern: Text
Allow NULL
JDBC: NS A, Java: String
Show SQL Continue Cancel
S0QL Preview
1 INSERT INTO EMPLOYEES A
2 {(EMPLOYEE_ID, FIRST_MNAME, LAST_MAME, EMAIL, PHOME_NUMBER, HIRE_DATE,
3 J0OB_ID, SALARY, COMMISSION_PCT, MANAGER_ID, DEPARTMENT_ID)
4 WALUES
5By ¥, By P, 7y 2, 8, 02, 3, 2, 0F) w
Note: The SQL preview show the original SQL without any parameter replacement applied.

Due to the use of unnamed markers it is not very intuitive what parameter correspond to which part in the
statement. The SQL Preview may be handy to get an idea. The Type field is automatically adjusted based on
what data is entered for a value. The data type may be manually set by left-click on the type and choose another
type from the drop-down.

@ To apply the values, close the window and continue with the execution, use key binding Ctrl+Enter (
Command+Enter on Mac OS X).

Get Parameter Types via JDBC

The processing of named and unnamed parameter markers is managed by DbVisualizer. By default there is no
data type detection of the target columns identified by the markers and DbVisualizer will initially present these as
String in the prompt window. When changing the value for a parameter in the prompt window, a data analyzer is
triggered which will automatically detect the type and update the Type field accordingly.
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Some drivers (far from all) have the capability to detect the real data type for the referenced columns in the SQL
statement. To enable this processing, select the Get Parameter Types via JDBC action in the SQL
Commander menu. DbVisualizer will then show the correct types in the prompt window.

& Having Get Parameter Types via JDBC enabled while executing may decrease performance
substantially as each SQL statement in the script is then pre-processed with the database before the
prompt window is displayed.

Database Support/Driver Support

The support for parameter markers may differ between databases. Please consult the documentation for the
database to see what syntax it supports.

In some situations the database and DbVisualizer support for named parameters might be incompatible. An
example is when using the same parameter name in multiple places in the SQL. When preparing a statement
towards such a database, the database may report that the parameter is only used once. In these cases,
DBVisualizer will trust the driver and revert to generating the names visible in the form as Parameter 1 ,
Parameter 2 and so on.
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10 Working with Result Sets

You can view result sets in different ways, edit simple result sets, and export or compare them.

10.1 Viewing a Result Set

You can view a result set as a grid, as text or as a chart. Which format to use by default can be specified in the
Tool Properties dialog, in the SQL Commander/Result Sets category under the General tab. Here you can also
specify other things, like if empty result sets should be shown at all, if the SQL that produced the result set
should be shown as a tab header tooltip.

Use the buttons to the right in the grid toolbar to select the format. This is an example of the text format.

/-] Log | {ig DBMS Output | [ 1: EMPLOYEES [107] X

80 32

1 EMPLOYEE_ID FIRST_NAME

31688 Steven
4181 Neena
5182 Lex

6183 Alexander
7184 Bruce

B 185 David

9 186 Valli

18 167 Diana

11 188 Nancy

12 183 Daniel
13118 John

14 111 I=mael

15 112 Jose Manuel
16113 Luis

LAST_MNAME
King
Kochhar
De Haan
Hunold
Ernst
Austin
Pataballa
Lorentz
Greenberg
Faviet
Chen
sciarra
Urman

Pobo
I

10.1.1 Viewing as a Grid

SKING
NKOCHHAR
LDEHAAN
AHUNOLD
BERNST
DAUSTIN
VPATABAL
DLORENTZ
NGREENBE
DFAVIET
JCHEM
ISCIARRA
JMURMAN
LPOPP

PHOME_NUMBER

HIRE_DATE

m[E=

J0B_ID .

1987-86-17
1989-89-21
1993-81-13
1998-81-83
1991-85-21
1997-86-25
1998-82-85
1999-82-87
1994-88-17
1994-88-16
1997-89-28
1997-89-38
1998-83-87
1999-12-87

188 AD_PRES
1868 AD_VP

1868 AD_VP

188 IT_PROG
188 IT_PROG
188 IT_PROG
186 IT_PROG
188 IT_PROG
180  FI_MGR
180 FI_ACCOUI
180 FI_ACCOUI
180 FI_ACCOUI
180 FI_ACCOUI
(@@ FI ACCOUI ™

m

k

When you view the result set as a grid, you have access to the same features as when viewing table data (see

page 80).

10.1.2 Viewing as Text

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.
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The text format for a result set presents the data in a tabular style. The column widths are calculated based on
the length of each value and the length of the column label.

If you want to combine the text view of a number of result sets into one, select Merge Result Sets from the
result set tab right-click menu. A dialog lets you select the result sets to merge:

.~ "y

& Merge Result Sets | 22|

Merge Result Sets to Text

[Z][7] 1: DEPARTMENTS [27]
[¥][]] 2: EMPLOYEES [107]
[#][77] 3: JOB_HISTORY [10]

[] Indude 5QL Remove Original Result Set tabs

[ Merge H Cancel

10.1.3 Viewing as a Graph

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

To view the result set as a chart, use the rightmost button in the grid toolbar. Please see the Working with
Charts (see page 237) page for how you can arrange the chart.

10.2 Editing a Result Set

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.
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A result set from a query that fulfills these requirements is editable:

1. The SQL is a SELECT command,
2. Only one table is referenced in the FROM clause,
3. All current columns exist by name (case sensitive) in the identified table.

A result set like this can be edited in the same way as you can edit table data (see page 92).

. If all of the above requirements are fulfilled but the edit controls are still not shown, please try qualifying
the table name with the schema and/or database name.

If you want results to always be read-only, you can enable the Make Result Sets Read-Only setting in the Tool
Properties dialog, in the SQL Commander/Result Sets category under the General tab.

10.3 Exporting a Result Set

You can export a result set as described in Exporting a Grid (see page 247) or using the @xport client side
command (see page 217).

10.4 Comparing Result Sets

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

You can compare a result set grid to tables and/or other result set grids.
To compare the grid data to the data of a table or a another result set:

1. Open the Data tab for another table or execute an SQL query to open a result set tab,
2. Select Compare from the right-click menu in one of the tabs to compare their grid content (see page 258)
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10.5 Pinning Result Sets

Existing Result Set tabs are removed when you execute a script again. If you want to save a Result Set tab
between executions, you can "pin" it using the Pin Tab right-click menu choice for the tab header, or by simply
clicking on the tab icon. There is also a Pin All choice if you have multiple tabs you want to pin, and Unpin All
to make them all be replaced at the next execution.

Whether tabs should be pinned by default can be controlled in the Tool Properties dialog, in the SQL
Commander/Result Sets category under the General tab.

10.6 Show Result Sets in a Separate Window

Results Sets and the Log tabs are located just under editor in a SQL Commander tab. Sometimes you may
need to get the full screen height available for the editor and detach the result set tabs in its own window. To
accomplish this click the symbol at the right-most position in the tab row.

<image of result set tabs with symbol>

Clicking the button while result sets are detached will bring it back into its original location.
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11 Working with Charts

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

Result sets in the SQL Commander and in the Monitor tools can be viewed as charts.

® Charting a Result Set (see page 239)
® Selecting Category Column (see page 240)
® Selecting Series (see page 241)
® Chart Type (see page 242)
® Chart Preferences (see page 243)
® Appearance Preferences (see page 243)
® Series Preferences (see page 245)
® Zooming (see page 245)
® Export (see page 245)

The chart support in DbVisualizer presents data from any result set in a configurable chart displayed in a line,
bar, area or pie style. It offers much of the charting support you find in MS Excel and other specialized charting
tools. Charts may be exported as an image to file, printed and copied to system clipboard for easy sharing with
other tools. Charts are configured and viewed in the SQL Commander (see page 233) and in the Monitor (see
page 264) tool which is really powerful, delivering real time charts of many result sets simultaneously.

Here are some sample charts:

Brand Sales Q4 2012

125

100 7

)
2]
1

0 Africa

-1 North America
[ Europe

1 Asia

Units (K)

15
-]
|

25
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Brand Sales Q4 2012

40

w
=2

Units (K)

20

10

& & &
“JAsia | Europe ) MNorthAmerica = _JwAfrica

Brand Sales Q4 2012

J Asia

. Europe
‘NorﬁwAmerkz
O Affica

B 3 > N
AR S
Brand Sales Q4 2012

|| mazda

renault

5 honda
[ nissan
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11.1 Charting a Result Set

The basic setup of a chart is really easy. Just select one or more columns that should appear as series in the
chart and what column to use as the category (X-axis). Further refinement of the chart can be made in the chart
preferences window.

The normal output view of a result set in the SQL Commander or Monitor window is in a grid style as shown in
the following screenshot. To activate the chart view click the rightmost button in the result tab toolbar:

POABRO®ITSHEHE O +OR(¢ > S[E08
Dratabase Connection DSﬁcky Database Schema Mz Rowes Maox Chars
i mysqL v |4 test - 000 | |2
1 SELECT id, datelabel, textlabel, nl, n2, n3, nd ]
2 FROM chartdata |
2:17 [65] IMS Auto Commit; OM| Encoding: Cpl1252 Untited®
P 1: SELECT id, datelabel, textiabe... |
04>  uEHEHEve -u|» EE[E
@@ id datelabel textlabel  n1 nZz n3 nd
1 12002-07-21 13:57:13 audi 10 414 6 -
2 2 2002-07-2417:25:56 volvo 4 5 23 -8 I
3 3 2002-07-25 23:19:03 saab 19 6 54 14
4 4 2002-07-26 07:59:05 seat 23 7 3419
5 5 2002-07-27 233218 ww iy g9 23 2
] 6 2002-07-28 23:33:45 porsche 43 (null) 9|19 Show/as/Chart
7 7 2002-08-01 07:132:34 ferrari -11 10 23 it S S — E
8 8 2002-08-02 16:56:00 opel 5 11 727
9 9 2002-08-02 18:41:07 ford G 12 6 25
10 10 2002-08-02 18:45:18 mazda 43 12 39 28
11 11 2002-08-02 00:13:36 toyota 12 19 12 -4
12 12 2002-08-03 00:15:18 mercedes 22 17 7 -2
13 13 2002-08-06 04:35:08 bmw 11 23 5 B iy
14 14 2002-08-06 19:34:28 renault 45 23 9 6
15 15 2002-08-06 20:05:04 chrysler Tl 2321 7
16 16 2002-08-07 15:07:24 lexus 9 40 24 8 -

0.000/0.000 sec || 20/7 || 1-17

(] Result Set [ 1]

When switching to the chart view DbVisualizer automatically pick the first date or text column as category and
the first numeric column as serie. In the following example it is the datelabel and id columns for this specific

i

result set.
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POMRG ISEEDI+EBI¢<> B [(EDS
Datsbase Connection ———— | Sticky Database Schama Mz Rows Mase Chars
| MysQL v 14 test . < w00 |1 |

1 SELECT id, datelabel, textlabel, nl, n2, n3, nd
Z FROM chartdata

1:1[1] INS Auto Commit: ON| Encoding: Cp1252 Untitled
P 1: SELECTid, datelabel, textiabe... |
B0 & 1 P G - b datelabel - id - E =k
| | | | | h—- 'Serle(s]
20 1

(Category/

15 7

107

*id

"Eﬁ} d’“ﬁ}& \"'@P '@ﬁ@ ’ﬁfaﬁ t:.“"ﬁ

[ Result Set [ 1]

11.1.1 Selecting Category Column

To change category column click the category drop-down and pick what column to use.

Gaabd | -
id

datelabel
textlabel EJ

nl
n2
n3
nd

Let the mouse pointer stay on a column name for a second and tip will show what data type it is.
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11.1.2 Selecting Series

Click the serie button to change what series to display in the chart. This drop-down stay on screen while
de-selecting and selecting series and the changes are directly propagated in the chart. To close the list either
press the ESC button or click outside the list. If only one serie is selected then its name is listed in the button
label. If additional series are selected then the number of selected series are listed in parentheses.

ni(+1) -

[Cid
datelabel
textlabel

ni

[[]n3 R

[[na

. Tip: Press the ALT key while selecting a serie and all currently selected series will be de-selected.

This is the chart after applying category and 2 series:
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POBRG ISEE D FORI<) B[(E08

Database Connection ——————— ||| Sticky Database Schema

Mz Rows Max Chars

| MysaQL v | [ test =

~||woo | |1 |

1 SELECT id, datelabel, textlabel, nl, n2, n3, nd
2 FROM chartdata

-

-

1:1[1]] NS

| P 1:SELECT id, datelabel, textlabe... ‘

Auto Commit: OM| Encoding: Cp1252 Untitled

ﬂ.|$|@|ﬁ|ﬁ = Eﬂ|texﬂabel *~ni(+1) =

50-5
401
30-3
201
10
01

-101

= E[F]

‘nl
*nz

S ﬁqﬁ&@& & & 6@@@@@1&@@ ﬁ\ﬁ@*’ & v‘ﬁpqa@i@*f &a@

(7] Result Set [ 1]

11.1.3 Chart Type

A chart can be displayed as Line, Point, Area, Stacked Area, Bar, Stacked Bar and the Pie type. Select what

type to use in the Chart Type right-click menu or in the chart toolbar:
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! FI Eﬂ' textlabel ~ Europe (+3)
E‘El Line

I"J Point

Area |
Fﬁ_l Stacked Area

ﬁﬂ Bar

ﬁﬂ Stacked Bar

F"] Pie

Legend Box

For the Pie chart, only one Serie can be selected.

11.2 Chart Preferences

The chart preferences are used to customize the appearance of the chart such as titles, colors, legend position,
etc. It can also be used to set alternative names for the series in the chart. All appearance settings are
automatically re-used when running subsequent queries in the SQL Commander during the same DbVisualizer
session. If you save a query as a bookmark script then all appearance settings are saved with the chart. Loading
the script at a later time will also load the chart settings.

11.2.1 Appearance Preferences

Use the controls in the General tab to customize the layout and style of the chart.
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| & Chart Configuration

General | Serjes

=4 |[=] =t =t

= Chart
Chart Type
Title
Font
Top Background
Boltom Background
= Legend
Show Legend
Position
= X Axis
Title
Show Title
Labels Rotation
Show Major Grid Lines
Handle Date/Time as Text
=¥ Axis
Title
Show Title
Show Major Grid Lines
Show Minor Grid Lines

[ﬁ}j Area

Tahoma, Plain, 11
[ | 255, 255, 255
[ 1180, 180, 250

East

OFE ID&H

Mumber Format # #al
= Series
Color Scheme Scheme 1
Show Shadows
E Line & Area Chart
Line Type Straight
Line Width 2
Show Points
Show Point Labels 0
(= Bar Chart
Bar Type Raised
Bar Gap 2
Bar Group Gap 4
[= Pie Chart
Fie Type Raised
Label Type Line Labels
Handle Date/Time as Text

Chedk to handle date, time and timestamp as text. The format is specdified in

Tool Properties- =Data Formats
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&) (oo ) [ ]

Information about the selected setting in the list is displayed at the bottom of the window.

11.2.2 Series Preferences

The default serie name is the column name in the result set. In the Series tab you can set an alternative label
name and also control what series should be visible.

5 [ﬂ Chart Configuration @ —‘
=== kextiabel - Europe (+3) ~ i
Visible | Column Name | Label Name | Data Type
= lid id Long
datelabel datelabel Timestamp
textlabel textlabel String
n1 Europe Long
n2 psia[EL
n3 n3 Lang
n4 n4 Long 2 Europe
',.ﬂ.., Asia
r‘"l“ n3
2 n4

o) (v ) [omad ) NEES S PSS
|

Changes in the Series tab are propagated directly in the chart.

11.3 Zooming

Charts support zooming by selecting a rectangle in the chart area. Selecting another rectangle in that zoomed
area will zoom the chart even further, and so on. To unzoom one level, click the Zoom Out button.

11.4 Export

Charts can be exported in PNG, GIF or JPG formats.
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| & Export Chart [ == |
|”-T°*?| Export Chart Settings
QOutput Format

@ PNG ) PG () GIF

Layout
Orientation: i@ Portrait (7) Landscape
Size: :As Is v:
Width: 532
Height: 339

< Back Mext = ] [ Cancel

The default size of the exported image is the same as it appears on the screen. To change the size, either select
a pre-defined paper size in the Size list or enter a size in pixels.
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12 Exporting a Grid

You can export any grid using the Export Wizard, e.g. a result set grid, a grid showing tables in a schema, or the
Data tab for a table or view.

® Settings page (see page 247)
® Data page (see page 249)
® Generating Test Data (see page 250)
® Preview (see page 253)
Output Destination (see page 253)
® Settings Menu (see page 254)

The Export wizard is launched using the Export button in the grid toolbar ( q@ ) or from the grid's right-click
menu. If you want to export just some of the grid rows and columns instead of all data in the grid, select the data
to export and launch the wizard with the Export Selection right-click menu choice.

12.1 Settings page

The first wizard page is the Settings page, containing general properties for how the exported data should be
formatted.
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"y

| 22 |

-

| & Export Grid

Output Format

@CSV (OHTML (O TXT (9SQL (XML (I XLS () JSON Encoding: ,f'} Cp1252
Data Format

Date: yyyy-MM-dd | Bxample: 2012-11-19

Time: HH:mm:ss w | BExample: 17:19:40

Timestamp: ¥yyy-MM-dd HH:mm:ss w | Example: 2012-11-19 17:13:40

Mumber:; Unformatted » | Example: 9126183

Dedmal Mumber: |Unformatted w | Example: 9126183.531815

Boolean/BIT: truefalse -

Binary /BLOE: .'l.n'alue v. Diir:

CLOB: .'u'alue N Dir:

Mull Value: {rull}
Quote Text Data

(@ Mone () Single () Double Duplicate Embedded  Ex: O'Learys "steaks™ -» O'Leanys "steaks”
Options

Column Delimiter: TAB -

Rowe Delimiter: UMD LinuxMac OS5 X -LF

Indude Column Header: Use any Label {Alias):

Row Comment Identifier:

Remove MNewline Characters: [

Indude Original SQL: @ Dom'tIncude () Top () Bottom
< Back Mext = ] [ Cancel

Select an output format, file encoding (it is also used to set the encoding in the HTML and XML headers, if you

select one of those formats), and how to quote text data.

@ Only in DbVisualizer Pro

With the DbVisualizer Free edition, only the CSV and HTML formats are supported.
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The Options section is used to define settings that are specific for the selected output format, for instance the
column and row delimiters for the CSV format, or the Excel or Excel 2007 format for XSL.

12.2 Data page

Clicking the Next button in the wizards moves you to the Data page. Use the columns list to control which
columns to export and how to format the data for each columns. The list is exactly the same as the column
headers in the original grid, i.e., if a column was manually removed from the grid before launching the Export

Wizard, then it will not appear in this list.

| & Export Grid | 23 |
Columns
Export  Mame Label (alias) Type IsText  Value M
EMPLOYEE_ID EMPLOYEE_ID BigDecimal [ &fvalueks v
FIRST _MAME FIRST _MAME String tlvaluels
LAST_MAME LAST_MAME String &lvalue}s
EMAIL EMAIL String &lvaluels @ Add Row
PHOME_MUMBER. PHOME_MUMBER.  String &lvaluels
HIRE_DATE HIRE_DATE Timestamp Slvalue}s
JOBE_ID J0B_ID String &lvalue}s
SALARY SALARY BigDecimal [ &fvalueks
COMMISSION_PCT  COMMISSION_PCT  BigDedimal ] &valuels
MANAGER_ID MANAGER_ID BigDecimal ] &valuels
DEPARTMENT ID  DEPARTMENT_ID  BigDedmal [ &{value}s
Table Rows
Total Mumber of Rows in Grid:| 107
Mumber of Rows to Export: | 107
« Back ] [ Mext = ] [ Cancel

The Table Rows fields show you how many rows are available and let you specify the number of rows to export.
This setting along with the Add Row button is especially useful when you use the test data generation feature

described in the next section.

The columns in this page's grid can be used like this.

Column Descriptions

Export
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Column Descriptions
Defines whether the column will be exported or not. Uncheck it to ignore the column in the exported
output.

Name The name of the column. This is used if exporting in HTML, XML, XLS, JSON or SQL format.
Column headers are optional in the CSV output format.

Label ( When you export a result set grid for a SELECT statement that uses column aliases, this column

Alias) holds the alias. If you have also enabled Use any Label (Alias) in the Options section, this value
is used in place of the name.

Type The internal DbVisualizer type for the column. This type is used to determine if the column is a text
column (i.e., if the data should be enclosed by quotes or not).

Text Specifies if the column is considered to be a text column (this is determined based on the type) and
so if the value should be enclosed in quotes.

Value The default ${ val ue} $ variable is simply be substituted with the column value in the exported

output. You can enter additional static text in the value field. This is also the place where any test
data generators (see page 250) are defined.

12.2.1 Generating Test Data

The test data generator is useful when you need to add random column data to the exported output.

The Value

column in the Data page grid specifies the data to be in the exported output. By default, it contains

the ${ val ue} $ variable, which is simply replaced with the real column value during the export process. You
can also add static values before and after the ${ val ue} $ variable, to be exported as entered.

Alternatively, you can use test data generator variables in the Value column. The choices are available in the

right-click menu when you edit the Value column.

Function Name Function Call Example

Generate ${var]| | Generates a random number between 1 and 2147483647
random randomunber (1,

number 2147483647)} %

Generate ${var| | randont ext ( Generates random text with a length between 1 an 10
random string 1, 10)}$ characters

of random size

Generate

Picks one of the listed values in random order

random value
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Function Name Function Call Example

from a list of ${var| | randomenumn(

values vl, v2, v3, v4, v5

)1$
Generate ${var| | nunber (1, Generates a sequential number starting from 1. The generator
sequential 2147483647, 1)}$ re-starts at 1 when 2147483647 is reached. The number is
number increased with 1 every time a new value is generated.

Here is an example of how to use the test data generators to try out planned changes to the data. Consider this
initial data:

£ EMPNO ENAME JoB MGR HIREDATE SAL COMM DEPTHMO
1 7369 Smith  Clerk 7902 1880-12-17 00:00:00 800 (null) 20
2 7499 Allen  Salesman 7698 1981-02-20 00:00:00 1600 300 30
3 7521 Ward Salesman 7698 1981-02-22 00:00:00 1250 500 30
4 THE6 Jones Manager T8391931-04-02 00:00:00 2975 (null} 20
5 7654 Martin - Salesman 7698 1881-08-28 00:00:00 1250 1400 30
3] 7698 Blake Manager 7839 1881-05-01 00:00:00 2850 (null) 30
T T782 Clark  Manager T8391981-06-09 00:00:00 2450 (null} 10
8 7788 Scott  Analyst THEGE 1887-04-19 00:00:00 3000, (null) 20
g 7831 King  President 23 1981-11-17 00:00:00 5000 23 10
10 7844 Turner Salesman 7698 1981-09-08 00:00:00 1500 ] 30
11 7876 Adams Clerk T788 1987-05-23 00:00:00 1100, (null) 20
12 7900 James Clerk 7698 1081-12-03 00:00:00 as0  (null) 30
13 7902 Ford  Analyst THE6 1881-12-03 00:00:00 3000 (null) 20
14 7934 Miller  Clerk T7821882-01-23 00:00:00 1300, (null) 10

After the changes, the JOB column should not appear in the output and the new JOB_FUNCTION should
contain abbreviated job function codes. To test this, we simply uncheck the Export checkbox for JOB entry and
set the Value for the JOB_FUNCTION to use the Generate random value from a list of values function.
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PHOME_MUMBER ~ PHOME_MUMBER  String &lvaluels
HIRE_DATE HIRE_DATE Timestamp &hvaluels
JOB_ID J0B_ID String &lvalue}s
SALARY SALARY BigDecdmal || %{value}s
COMMISSION_PCT COMMISSION_PCT BigDecmal — []  ${value}s
MAMAGER_ID MAMNAGER._ID Bighecdmal || 4{value}s
DEPARTMENT_ID DEPARTMENT_ID BigDecdmal [| 4{value}s

| 8 Export Grid [&=2]
Columns
Export Mame Label (Alias) Type Is Text WValue &
EMPLOYEE_ID EMPLOYEE_ID Bighedmal || %{value}s
FIRST_MAME FIRST_MAME String &value}s
LAST_MAME LAST_MAME String &lvalue}s
EMAL Siring ] &{value}s @ Add Row

JDE| _CODE JOB_CODE M- %{var| [randomenum(eng, adm, fin)}%

Table Rows

Total Mumber of Rows in Grid:| 107

Mumber of Rows to Export: | 107

<Back || MNext> | [ cancel

Previewing the data (or exporting it) in CSV format results in this:
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- .y
8 Export Grid | &2 |
[ Export Grid Preview
Preview of the first 100 rows (or less)
1 EMPLOYEE_ID FIRST_MAME LAST_NAME EMATL JOE_CODE PHOME_MUMEER HIRE_DAT .
2 ________________________________________________________________________
3198 Donald OConnell DOCOMNEL adm 658 .587.9833 2887-86- | _
4199 Douglas Grant DGRANT adm 658 . 587 .9844 2088-81- |~
5 288 Jennifer Whalen JWHALEN Fin 515.125.4444 2883-89-
B 281 Michael Hartstein MHARTSTE adm 515.123.5555 2884-82-
7282 Pat Fay PFAY fin 683,123 .6066 2885-835-
& 283 Susan Mavris SMAVRIS +in 515.123.7777 2882-86-
o 284 Hermann Baer HBAER adm 515.125.8888 2882-86-
1a 285 Shelley Higgins SHIGGINS eng 515.125.8688 2882-86-
11 286 William Gietz WaIETZ adm 515.123.8181 2882-86-
12 1ae Marrisa King SKING fin 515.123.4567 2883-86-
13181 MNeena Kochhar NKOCHHAR +in 515.123.4568 2885-89-
14 182 Lex De Haan LDEHAAN eng 515.125.456%8 2eal-al-
15183 Alexander Hunaold AHUNCLD  adm 598.423.4567 2eeg-al-
16 124 Bruce Ernst BERNST adm 598.423.4568 2887-85-
17 185 David Austin DAUSTIN  adm 598.423.4569 2885-86-
18 186 Valli Pataballa VPATABAL eng 598.425.4568 2886-82-
19187 Diana Lorentz DLORENTZ eng 598.423.5567 2887-a2-
28 188 Mancy Greenberg MGREENBE adm 515.124.4568 2882-88-
21 189 Daniel Faviet DFAVIET ene 515.124.418%9 2e@z-@s- 7
i T r
< Back ] [ MNext = ] [ Cancel

12.3 Preview

The third wizard page is the Preview page, showing the first 100 rows of the data as it will appear when it is
finally exported. This is useful to verify the data before performing the export process. If the previewed data is
not what you expected, just use the back button to modify the settings.

12.4 Output Destination

The final wizard page is the Output Destination page. The destination field specifies the target destination for

the exported data, one of File, SQL Commander or Clipboard.
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& Export Grid 2|
Output Destination

@ File C:\Temp'emp.csv B
) 5QL Commander m Mew Editor = | () AtCaret (0) First @ Last (7) Replace Al
~ Clipboard

< Back Il Export I I Cancel

Click Export on this page to export the grid data to the selected destination.

12.5 Settings Menu

If you often use the same settings, you can save them as the default settings for this assistant. If you use a
number of common settings, you can save them to individual files that you can load as needed. Use the Settings
button menu to accomplish this:

® Save as Default Settings
Saves all format settings as default. These are then loaded automatically when open an Export Schema
dialog
® Use Default Settings
Use this choice to initialize the settings with default values
®* Remove Default Settings
Removes the saved defaults and restores the regular defaults
* Load
Use this choice to open the file chooser dialog, in which you can select a settings file
® Save As
Use this choice to save the settings to a file

You can also use settings saved here with the @export client side command (see page 209).
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13 Comparing Data

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.
With DbVisualizer, you can compare grids and text data, such as scripts or the DDL for two tables or procedures

® Selecting the Objects to Compare (see page 255)
® Comparing Text Data (see page 256)

® Comparing Grids (see page 258)

® Comparing Cell Values (see page 263)

13.1 Selecting the Objects to Compare

You can open the Compare Objects object chooser via Tools->Compare and select two objects available for
comparison.

e

=

|8 Compare Objects

Compare Objects of Type: @ Text () Grids

Original Object Maodified Object

&’ 1: HR Test Data Untitled* & 1: HR Test Data Untitled®

f HR Production COUNTRIES: DDL t}" HR Production COUNTRIES: DDL

f‘ HR Production COUMNTRIES: DDL with Storage ﬁ‘ HR Production COUNTRIES: DDL with Storage
System Clipboard System Clipboard

If you select Text, all SQL Commander editors and all Object View sub tabs that you have opened that contain
text, such as DDL and Procedure Editor tabs, are listed. There is also an entry for the System Clipboard,
holding the last text you copied.
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Selecting Grids lists all SQL Commander Result Set tabs and all Object View sub tabs that you have opened
that contain a grid, for instance the Data and Columns tabs for a table, or the Tables tab for a schema.

To compare two objects, select one each in the Original Object and Modified Object columns and click
Compare.

You can also open the object selection dialog from the right-click menu inside a tab that holds an object that can
be compared. The object shown in that tab is then preselected as the Modified Object so you only need to
select the Original Object in the dialog.

The right-click menu for an SQL Commander editor also contains a Compare to Saved entry. This bypasses
the object selection dialog and opens the Compare window directly, showing you how you have changed the
script since loading it into the editor.

13.2 Comparing Text Data

To compare text data, either select both text object from the Tools->Compare dialog or choose Compare from
the right-click menu in one of them and select the one to compare to. The text compare window shows you how
they differ.
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&l Compare Text e =]
K< 2%
CRM Ahoa COUNTRIES: DDL 1: Untitled™
CREATE TABLE 1 1 CREATE TABLE
COUNTRIES 2 2 COUNTRIES
( 3 3 (
COUNTRY_ID CHAR(2) NOT NULL, 4 4 COUNTRY_ID CHAR(2) NOT NULL,
| COUNTRY_NAME VARCHARZ(2@), -+ 5 5 COUNTRY_NAME VARCHAR2(188@), )|
REGION_ID NUMBER, 6 | B REGION_ID NUMBER,
CONSTRAINT COUNTRY_C_ID_PK PRIMARY KE 7 7 CONSTRAINT COUNTRY_C_ID_PK PRIMARY KEY |
CONSTRAINT COUNTR_REG_FK FOREIGN KEY 8 8 CONSTRAINT COUNTR_REG_FK FOREIGN KEY (RE
CONSTRAINT COUNTRY_ID_NN CHECK (" COUN el g CONSTRAINT COUNTRY_ID_NMN CHECK (“COUNTRY
) 1@ 1@ )
ORGANIZATION INDEX; e 11711 COMMENT ON TABLE COUNTRIES .
COMMENT ON TABLE COUNTRIES 12 12 IS
I5 13 13 ‘Country table. Contalns 25 rows. Re-’er‘encesJ
J ‘country table. Contains 25 rows. Referensy 14//14 COMMENT ON COLUMN COUNTRIES.COUNTRY_ID
COMMENT ON COLUMN COUNTRIES.COUNTRY_ID 15 15 IS
15 16 16 '"Primary key of countries table.';
"Primary key of countries table.'; 17 17 COMMENT ON COLUMN COUNTRIES.COUNTRY_NAME
COMMENT ON COLUMN COUNTRIES.COUNTRY_MAME 18 18 IS
I5 19 19 '"Country name';
'"Country name'; 28 28 COMMENT ON COLUMN COUNTRIES.REGION_ID
COMMENT OM COLUMN COUNTRIES.REGION_ID 21 21 IS
15 22 22 '"Region ID for the country. Foreign key to ¢
= 'Region ID for the country. Foreign key t 23 .f_' 23 w
< | {1 3 < | [} 3
4 changes Changed Inserted Deleted

The objects are shown side-by-side, with indications about how they differ in the divider between them. The
areas to the left of the original object and to the right of the modified object have markings that also show
sections of differences. You can navigate between the differences using the arrow buttons in the toolbar, or by
clicking the markings to the left and right.

Comparing two texts is pretty straightforward. You can see what has been changed, inserted and deleted, with
row level indications in the divider and details for changed text highlighted in the text panes. A difference may
start on one line and span over multiple lines until a match is found again.

If the modified object (right pane) is editable, you can apply the changes needed to remove the differences, one
by one or all at once.

Along with the difference indications in the divider there are small icons: arrows and cross marks. Clicking on
such an icon updates the modified object to match the original object, by inserting or deleting one or more rows
or updating the text or column values.

If you want to apply all changes needed to make the modified object match the original, you can click on the
Sync button in the toolbar (the rightmost button).

You can also edit the modified object directly in the Compare window.
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" No matter how you update the modified object, all changes are also applied to the tab where the object
was originally opened. To permanently save the changes, you need to use the Save button in that tab.

If you want to change which object should be considered the original and the modified when comparing them,
you can click the Flip button in the toolbar (the second to rightmost button). One reason for doing this may be
that you want to update the object you originally used as the original instead of the modified object.

13.3 Comparing Grids

To compare grids, either select both grid object from the Tools->Compare dialog or choose Compare from the
right-click menu in one of them and select the one to compare to. The grid compare window shows you how

they differ.
I
q Cornpare Grids [= ||E|| £2 |

iK€ > 0507

CRM Ahoa COUNTRIES: Data CRM ahoa COUNTRIES™: Data™

B # COUNTRY_ID  COUNTRY_NAME REGION_ID £ COUNTRY_ID  COUNTRY_MAME REGION_ID

AR Argentina 2| 1 1 AR Argentina 2
AL Australia 3 2 2 3 |AM Armenia 4
EE Belgium 1| 3 3 Al Australia 3
BR. Brazil 2| 4 4 |BE Belgium 1
CA Canada 2| 5 5 |BR Brazil 2

“leH Switzerland 1| & 6 |CA Canada 2
CN China 3| 7 7 |CH Switzerland 1 [
DE Germary 1| 8 3 |CN Republic of China 3
DK Denmark 1| 9 3 |DE Germany 1
EG Egypt 4110 10 DK Denmark 1
FR. France 111 11 EG Egypt 4
HK HongKong 3| 12 v 12 |FR France 1=
L Israel 413 13 L Israel 4
IM India 3|14 14 |[IN India 3
m Italy 1|15 15 | Italy 1
P Japan 3|16 1B [P Japan 3
KW Kuwait 4117 17 KW Kuwait 4
M Mexico 2 (18 18 |Mx Mexico 2
MG Migeria 4119 19 NG Migeria 4
ML MNetherlands 1|20 20 ML Metherlands 1
SG Singapore 321 21 |56 Singapore 3
LK United Kingdom 122 22 |UK United Kingdom 1
s United States of America 2|23 23 |us United States of America 2
M Zambia 4|24 24 [Zm Zambia 4
W Zimbabwe 4|25 25 2w Zimbabwe 4

3 changes Changed Inserted | Deleted | Tgnored
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Comparing grids is a bit complicated, since each row is a unit in itself, with a unique identifier in the form of a
Key. A difference can therefore not span rows. It is also important that both grids are sorted the same way and
that the column in one grid is compared to the corresponding column in the other grid, otherwise the result is
indeterminably. By default, columns are matched by name, or index if the names differ.

If the default matching is not correct, click the Column Configuration button in the toolbar to manually match
the columns, and optionally select key columns and ignore some columns.

" !

a, Column Configuration [ 22 |

Select the Right Column Name that matches the Left Column Mame and mark which
column(s) to use as a Key Column. You can also mark columns to ignore.

Left Column Name Right Column Mame Key Column  Ignored Column
COUNTRY_ID COUNTRY_ID [
COUNTRY _NAME COUNTRY_MAME [ [
REGION_ID REGION_ID [ [

Close

Use the Right Column Name drop down lists to select the column matching the Left Column Name. If a
column does not match another, just leave it blank to exclude it from the comparison.

Use the Key Column check boxes to pick the columns that should be used as the key when comparing the
grids. If you don't care about the value in some columns, e.g. a column that contains a timestamp that may vary
between the grids without being an important difference, you can check the Ignore check box for that column to
exclude it for the comparison.

It gets a bit more complicated if a key column value is changed.
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%

Q‘ Compare Grids |E||E”E|
K<2A0 w7
HR Production COUNTRIES: Data HR Production COUNTRIES*: Data™
B & COUNTRY_ID  COUNTRY_MNAME REGION_] & COUNTRY ID  COUNTRY_NAME REGION_
AR Argentina - 1 1 |AR Argentina -
AL Australia 2 2 AU Australia
BE Belgium 3 3 |BE Belgium
BR Brazil 4 4 |BR Brazil
CA Canada 5 5 |CA Canada
CH Switzerland 3] 6 |CH Switzerland
CN China 7 7 |CN China
DE Germany a8 & |DE Germany
DK Denmark E] 3 DK Denmark
EG Egypt 10 10 X |ET Egypt
FR France BT 11 |FR France 3
HK Hongkong 12 12 |HK HongKong
IL Israel 13 13 |IL Israel
I India 14 14 |IM India
IT Italy 15 15 |IT Italy
JP Japan 16 B |JP Japan
KWW Kuwait 17 17 |KW Kuwait
X Mexico 18 13 |MX Mexico
MG Migeria 19 19 NG Migeria
ML Metherlands — |20 20 |NL Metherlands b
3G Singapore 21 21 |8G Singapore
LIk United Kingdom il 22 22 |UK United Kingdom i
i B — y |3 B B T—— b
2 changes Changed Inserted | Deleted | Ignored

DbVisualizer considers a changed key value as one inserted row and one deleted row, as shown in the figure
above. If the grids do not have any declared key columns, all columns are considered to be regular, non-key
columns.

Two grids may also differ in the number of columns they contain. DbVisualizer finds columns that only exist in
one of the grids and excludes their values when comparing the grids. If the column names do not match
between the two grids, open the Column Configuration dialog to manually map the columns.
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%

[+ Compare Grids E@@

K<>AOrR

HR Production COUNTRIES: Data 1: select COUNTRY_ID, COUNTRY_COD...*

B & COUNTRY_ID  COUNTRY_MNAME REGION_] & COUNTRY ID  COUNTRY_CODE  COUNTRY_NAME
AR Argentina - 1 1 |AR B4 Argentina -
AL Australia 1l 2 2 |au 61 Australia I
BE Belgium 3 3 |BE 32 Belgium
BR Brazil 4 4 |BR 55 Brazil
CA Canada 5 5 |CA 1 Canada

“lcH Switzerland 6 6 |CH 41 Switzerland B
CH China Fomp 7 |CN 36 Republic of Chinz
DE Germany a8 & |DE 49 Germany
DK Denmark E] 3 DK 45 Denmark
EG Egypt 10 10 |EG 20 Egypt
FR France Bl 1 1 FR 33 France 3
HK Hongkong 12 12 |HK (null} HongKong
IL lsrael 13 13 |IL (null} Israel
IN India 14 14 |IM (null) India
IT Italy 15 15 |IT (null) Italy
JP Japan 16 B [P (null) Japan
KW Kuwait 17 17 |KW (rull) Kuwait
X Mexico 18 13 |MX (mull) Mexico
MG Migeria 19 19 NG (null) Nigeria
ML Metherlands — |20 20 |NL (null) Netherlands B
3G Singapore 21 21 |8G (null} Singapore
LIk United Kingdom il 22 22 |UK (null} United Kingdom
i ETee—— A B i |

1 change Changed Inserted | Deleted | Ignored

Similarly, DbVisualizer does not consider Binary/BLOB and CLOB columns when comparing, and marks them
as ignored. You can manually specify that CLOB columns should be compared in the Column Configuration
dialog.
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%

Q,, Compare Grids |E||E”E|

K<2a0 0%

HR Test Data EMPLOYEES*: Data™ HR Test Data EMPLOYEES™*: Data™

'_\"IAIL ROOM  SALARY  PHOTO MAIL ROOM  SALARY  PHOTO I
KNG (null} (null} # BINARY, 169 Bytes 1 1 fING {rull} {null) * BINARY, 169 Bytes
ROCHHAR  (null) (null) * BIMARY, 169 Bytes 2 2 RKOCHHAR (null) {null) * BIMNARY, 169 Bytes
DEHAAN (null) (nully {null) 3 3 EHAAN {rull) (rully {rull)

“HUMOLD (null) (nully {null) 4 4 HUNOLD {rull) (rully {rull) m
ERMST (null} (rull} * BIMARY, 169 Bytes L 5 ERNSTZ2 {rull} {null} * BIMARY, 169 Bytes
ALISTIN (null) (nully {null) 6 6 AUSTIN (null) (nully (null}

PATABAL (rull) (rully () 7 7 PATABAL (i) (nully (i}
LORENTZ  (null} (rully {null) 8 8 |ORENTZ  (null}) (nully (i}
GREENBE (null} (rully {null) E] 9 [BREENBE (null) (nully (i}
FAVIET (null) (rully () 10 10 FAVIET iy {rully (i}
CHEM (null} (nully {null) 11 11 HEMN {rull} (rull) {rull)
CIARRA (null) (nully {null) 12 12 CIARRA {rull) (rully {rull)
TURMARN (null) (nully {null) 13 13 URMAM {rull) (rully {rull)
POPP (null) (rully () 14 14 POPP (rull) (mully (nully
RAPHEAL  (null) (null) (null) 15 15 RAPHEAL  (null) (null) (null)
KHOO (null) (null) (null) 16 B [HOO (null) (null) (null)
BAIDA (null) (null) (nuil) 17 17 3AIDA {null) (null) (null)
4 L 4 LI 2
1 change Changed Inserted | Deleted | Ignored

If the modified object (right pane) is editable, you can apply the changes needed to remove the differences, one
by one or all at once.

Along with the difference indications in the divider there are small icons: arrows and cross marks. Clicking on
such an icon updates the modified object to match the original object, by inserting or deleting one or more rows
or updating the text or column values.

If you want to apply all changes needed to make the modified object match the original, you can click on the

Sync button in the toolbar (the rightmost button).

You can also edit the modified object directly in the Compare window.

. No matter how you update the modified object, all changes are also applied to the tab where the object
was originally opened. To permanently save the changes, you need to use the Save button in that tab.

If you want to change which object should be considered the original and the modified when comparing them,
you can click the Flip button in the toolbar (the second to rightmost button). One reason for doing this may be
that you want to update the object you originally used as the original instead of the modified object.
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13.4 Comparing Cell Values

In a Data tab or a result set tab, you can also compare the values of two selected cells.

1. Select the two cells to compare,
2. Choose Compare Selected Cells from the right-click menu.

The values are compared and shown the same way as when comparing text data, with the exception that editing
is disabled.
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14 Monitoring Data Changes

With the monitor feature, you can track changes in data over time, viewing the results of one or many SQL
statements either as grids or graphs. Typically, you configure the monitor to run the statements automatically at
certain intervals.

The monitoring feature combined with the charting (see page 237) capability in DbVisualizer Pro is really
powerful, delivering real time charts of many result sets simultaneously. For example, you can use monitoring to
spot trends in a production database, surveillance, statistics, database metrics, and so on.

Any SQL statement that produces a result set can be monitored, and when you monitor multiple statements,
different statements may use different database connections concurrently.

14.1 Creating a Monitored Query

Monitored SQL statements are managed under the Monitors node in the Scripts tab in the tree area to the left
in the main DbVisualizer window.

® Monitor table row count (see page 266)
® Monitor table row count difference (see page 268)

A monitored SQL statement is associated with information about the target database connection and (optionally)
the catalog (the JDBC term which translates to a database for some databases, like Sybase, MySQL, SQL
Server, etc) and schema. It also has a title, a maximum row count (how many results to keep track of) and a
visibility status (whether the monitored statement result should be included in the Monitors windows, discussed
below). This information is displayed, and can be edited, in the lower part of the Scripts tab, along with
information about the file that holds the monitored statement. If you don't want to see these details, you can
disable it with the Show Details toggle control in the right-click menu for a node.
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g Databases -'._; Scripts

[a Object View b SOL Commander

SESFOW POBRRGOISEHE D ROE(¢ > B[ESS [
] N (53]
'I:';DI Scripts Database Connection — |:|5t'u:ky Diatabase Schema Max Rows Max Chars |'2
'ﬁ Bookmarks B MysqL ~| [ dbvisam ~ w0 | -1 e
E=-£7 Monitors : =L - 2
- 1 SELECT —
o 2010 Q1.saql 2 YEAR(TDate) AS YEAR , i
-~ g 2010 Q2 5q] 3 MONTH(TDate) AS MONTHNUM , =
- || BIO-Row Count.sgl 4 cast(concat(YEAR(TDate), ', DATE_FORMAT(TDate, '%b')), ﬁ
:m‘ Closed.sql 5 SUM{Incidents) AS COUNT ‘%
: - & FROM =
e Incidents. sql - BugHouse 5
- g Mon Closed.sql 3 GROUP BY —
-|-] Re-opened.sqgl 9 YEAR ,
- | g Rejected.sql 18 MONTHNUM
11 ORDER BY
=l File 12 YEAR ASC,
MName Incidents.sqgl 13 MONTHNUM ASC
Comment
Size (bytes) 393
Maodified 2009-12-16 21:55:00
Path Z\Wsersirogge\myprefs\Monit...
Encoding &) cp1252
=l Database Connection
Connection B MySQL
Catalog [ 8] dbviscrm
Schema
=l Monitor
Title Incidents/Day
Visible

Max Row Count 100

9:11 [192]| NS

Auto Commit: ON| Encoding: Cp1252 Incdents.sgl®

The figure above shows the Incidents/Day monitored statement and the SQL that is associated with it.

The following is an example of the result set produced by the statement:
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|14 Incidents/Day E@
O 3 Ee=
YEAR MOMTHNURM | MONTH | COUNT
26 | 2004 8 2004 Aug 268 =«
27 | 2004 92004 Sep 467
28 | 2004 10 2004 Oct 244
29 | 2004 112004 Mov 548
a0 | 2004 12 2004 Dec 433
1 2005 12005 Jan 443 |=
32 | 2005 22005 Feb 837
33 | 2005 3 2005 Mar 593
34 | 2005 4 2005 Apr 511
a5 | 2005 52005 May 348
36 | 2005 62005 Jun 437
37 | 2005 7 2005 Jul 300
38 | 2005 8 2005 Aug 417
39 | 2005 82005 Sep 581

0.032/0.000 sec || 89/4 || 26-40

The interesting columns in the result are the Month and Count. The Year and MonthNum are there just to get
the correct ascending order of the result.

You can create and work with monitored statements in the same way as with a Bookmark. The main difference
is how they are used and a couple of additional ways monitored statements can be created. For information
about how to manually create, manage and share monitored statements, please see the Managing Frequently
Used SQL (see page 185) page. The following sections describe how you can get help creating the bookmarks
for a couple of cases that are commonly used for monitoring.

14.1.1 Monitor table row count

It is very common to want to keep track of how the number of rows in a table varies over time. The right-click
menu in the grid for a table or result set therefore has a Create Row Count Monitor operation that creates a
monitored statement for you automatically.

It creates a monitor with SQL for returning a single row with the timestamp for when the monitor was executed
and the total number of rows in the table at that time. Every time the monitor is executed, a new row is added to
the grid, up to a specified maximum number of rows. When the maximum row limit is reached, the oldest row is
removed when a new row is added. Example:

PollTime RowCount

2003-01-23 12:19:10 43123
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PollTime RowCount

2003-01-23 12:11:40 43139

2003-01-23 12:21:10 43143

2003-01-23 12:22:40 43184

The SQL for this monitor uses two variables, dbvis-date and dbvis-time. These variables are substituted with
the current date and time, formatted according to the corresponding Tool Properties settings. The reason for
using these variables instead of using SQL functions to retrieve the values is simply that it is almost impossible
to get the values in a database-independent way. Another reason is that we want to see the client machine time
rather than the database server time. You can, of course, modify the SQL any way you see fit, as long as the
PollTime and RowCount labels are not changed.

sel ect '${dbvis-date}$ ${dbvis-tinme}$' as PollTine,
count (*) as RowCount
from Conputers

DbVisualizer keeps the result for previous executions, up to the specified maximum number of rows, so that you
can see how the result changes over time. You define the maximum number of rows in the Max Row Count
field in the details area at the bottom of the Scripts tab. This property is initially set to 100 when you use Create
Row Count Monitor to create the monitor.
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T sows
S ES ¥FOR

.| Scripts

ﬁ Bookmarks

= = Monitors

g Closed.sqgl

g Incidents.sqgl

g Man Closed.sql

Re-opened.sql

g Rejected.sql

=l File
Mame BIO-Row Count.sqgl
Comment
Size (bytes) a3
Modified 2009-12-16 21:58:52
Path Z\Jsersirogge'myprefs\Monitors\BIO-Row Count.sql
Encoding €3 cp12s2

=l Database Connection
Connection [ CRM Ahoa

Catalog
Schema 8 HR
=l Monitor
Title BIO: Row Count
Visible

Max Row Count 100

You can change the value to limit or extend the number of rows that DbVisualizer should keep. Setting it to O or
a negative number tells DbVisualizer to always clear the grid between executions of monitors.

14.1.2 Monitor table row count difference

In addition to tracking the number of rows in a table over time, you may want to see by how many rows the
value changes. You can create a monitor for this purpose with the Create Row Count Diff Monitor operation,

available in the right-click menu for the grid.

In addition to the Row Count Monitor, the Row Count Diff Monitor reports the difference between the number

of rows in the last two executions:

PollTime RowCount RowCountChange

2003-01-23 12:19:10 43123 0
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PollTime RowCount RowCountChange
2003-01-23 12:11:40 43139 16
2003-01-23 12:21:10 43143 4
2003-01-23 12:22:40 43184 41

The SQL for this monitor adds a third column, named RowCountChange. It utilizes the fact that DbVisualizer
automatically creates variables for the columns in a monitor result set, holding the values from the previous
execution. The RowCountChange column is set to the value returned by the count(*) aggregate function for the
current execution minus the value from the previous execution, held by the RowCount variable. All columns in a
monitor result set can be used like this to reference values from the previous execution of the monitor.

sel ect '${dbvis-date}$ ${dbvis-tinme}$ as Poll Tine,

count (*) as RowCount,

count (*) - ${RowCount||count(*)}$ as RowCount Change
from Conputers

14.2 Running a Monitored Query

The Monitor window, launched via the Tools->Monitor menu option, is where you active monitors and look at
the results. The monitor tabs can be rearranged in the same way as all other tabs, pretty much any way you like.
Please see Getting the Most Out of the GUI (see page 32) for detalils.

The monitor results can be viewed only as grids in DbVisualizer Free, while DbVisualizer Pro adds the capability
to view them as charts or text.
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i
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I:I

Q % ED E == [j D @ Auto Reload Interval: (300 | V] Adjust

@ Incidents per Day X

YEAR MONTHMUM  MOMNTH  COUNT
10 | 2003 42003 Apr 117 -
11 2003 52003 May 210
12 | 2003 62003 Jun 193
13 | 2003 72003 Jul 135
14 | 2003 82003 Aug 214
15 | 2003 92003 Sep 186
16 | 2003 10 2003 Oct 395 3
17 | 2003 11 2003 Nov 266
18 | 2003 12 2003 Dec 224
19 | 2004 12004 Jan 182
20 | 2004 22004 Feb 41
21 2004 32004 Mar 387
22 | 2004 4 2004 Apr 349 i

0.031/0.000 sec || 32/4 || 10-22

The Monitor window has toolbar at the top with an Auto Reload Interval field and a Adjust box. The Auto
Reload Interval field is used to control how often, in seconds, to execute the monitors when auto update is
running. The specified number of seconds may be increased automatically by DbVisualizer if the total execution
time for all monitors is longer than the specified value. Check the Adjust box and the Monitor feature will
automatically increase the number of seconds so that all monitors will complete before next auto-update.

The rest of the window holds result areas for each monitored statement with the Visible attribute enabled. Each
individual monitor result tab or window may also have a toolbar with controls that apply just to that result. The
screenshot is from DbVisualizer Pro, with View buttons in the toolbar for the selected monitor; these buttons are
not included in DbVisualizer Free.

The main toolbar buttons have the following functions:

Toolbar Button Description

Close Closes the Monitor window

Reload Reloads all results (i.e., executes all monitors and updates the result sets)

Locate Current Locates and select the monitor node in the Scripts tab corresponding to the currently

selected result

Clear Current Clears the currently selected result
Clear All Clears all results
Show as Tabs Shows the results as collapsed tabs

Show as Windows  Shows the results as tiled tabs
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Toolbar Button Description

Show Grids Shows all results as grids

Show Text Shows all results as text

Show Chart Shows all results as graph in the selected chart type

Show/Hide Chart Toggle this to show/hide chart legends
Legends

Show/Hide Monitor = Toggle this to show/hide toolbars for each monitor

Toolbars

Start Monitors Starts auto-update of all monitors, repeatedly executing all statements at the intervals
specified by the Auto Reload Interval field

Stop Monitors Stops the auto-update

In the Tool Properties dialog, you can enable Show Monitor Window at Startup and Start Monitors
Automatically, in the Monitor category under the General tab.
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15 Accessing Frequently Used Objects

When you work on many different tasks, it is important to easily find and use the data and scripts you need.

DbVisualizer helps you by keeping the tabs you use open between sessions and letting you organize references
to objects and scripts.

15.1 Keeping Tabs Open Between Sessions

If you often work with the same objects and a few scripts, you can ensure that the Object View and SQL
Commander tabs for these objects remain open between DbVisualizer sessions.

1. Open Tools->Tool Properties,

2. Select the Appearance/Tabs category,

3. Enable one or both of Preserve SQL Commander tabs between Sessions and Preserve Object View
tabs between Sessions,

4. Click Apply or OK to apply the new settings.

This feature is enabled by default for SQL Commander tabs but not for Object View tabs.

The content of the SQL Commander tabs is saved at regular intervals so when you restart DbVisualizer, the
content is the same as where you left off.

For Object View tabs, you can also enable Preserve Object View tabs at Disconnect. By default, Object View
tabs for objects that belong to a connection are closed when it is disconnected.

15.2 Using Favorites

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

Navigating the Databases tab tree down to the object can be quite time consuming for database objects that
you work with often. By adding these objects to the Favorites toolbar, you have one-click access to them instead
. In addition to database objects, you can also add Bookmark (see page 185) script files to the Favorites toolbar.
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| & DbVisualizer Pro 90 E\@
File Edit View Database SQL Commander Tools Window Help
e L UIEE ] Yeqtye) s
[7] COUNTRIES [7] EMPLOYEES & ADD_JOB_HISTORY (5 Locks || Computers per Employee.sql Favorites toolbar
I [4) Datzbases "r'_; Scripts ] <'r Favorites L License Details
Product: DbVisualizer Pro
. | . | - Q- Licensed to: MNIELSEN APP DEV (TNC LLC)
p:? Favorites i License id: 36910677 [ #1
D COUNTRIES Upgrade Expiration: 2013-10-09
7] EMPLOYEES
5 ADD_JOB_HISTORY
{5 Locks
: Computers per Employee.sql
Favorites tab
Getting Started
Select Tools-=Connection Wizard menu choice to create a database connection.
Latest news, documentation and FAQs are available at http:/fwww.dbvis.com
REIETZ= |

When you click on a database object in the Favorites toolbar, the corresponding object is opened in an Object

View tab. If you're not connected to the database the object belongs to, a connection is automatically
established. Clicking on a Bookmark in the Favorites toolbar opens it in an SQL Commander tab.

You can also easily find the corresponding object in the Databases tab or Scripts tab tree using the Select
Target Object right-click menu item.

WD ﬂ"’ﬁ AMC 1D LT OTn J'ﬁ. Lmedem

[ COUNTRIES [ EMPLC - Cammibnen nor B
_ 7] EMPLOYEES
Databases || [ Sci
- B Ses | Sh @ Open Database Object k
ﬂ | a‘ . | P | @ | | Replace with Current Object Tab
y) Connections | Select Target Object Ctrl+0
-4 CRM Ahoa
E'I g Edit Favorite... f
[} 3 Schemas
Session Properties Remove
G- (EY DBA Views Create Folder

- @ MysqL I
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The easiest way to add an item to the Favorites toolbar is to select the item in the Databases tab tree or the
Script tab tree, drag it with the mouse key depressed and drop it in the Favorites toolbar by releasing the mouse
button. If you have created Favorite folders, you can also drop the item on a folder.

You can also use the Add to Favorite right-click menu operation for the database object or Bookmark. This
opens a dialog where you can add the item, at the top level or in an existing or new Favorite folder.

- y

:_ﬂ Add as Favorite: BIO @

Choose Target Favorites Folder

= ) Statistics

MName: (BIO

& [ o=

Use the Favorites tab in the navigation area to organize your favorites.

. Favorites

S0 Q
+.r Favorites
[77] COUNTRIES
[ EMPLOYEES
21 Computers per Employee.sgl
&P ADD_JOB_HISTORY
[3 Locks

Here you can add folders and drag and drop entries between them. A favorite folder works as a drop-down
menu in the Favorites toolbar. Double-click a favorite to open the target script file in the SQL Commander or
database object in the Object View.

You can also delete and rename entries here. The right-click menu for an entry also contains entry-type
dependent operations, such as executing a Bookmark and open a database object in a separate window.

To sort the favorites, select Sort from the right-click menu for any favorite. The sorting critera can be defined in
the dialog that pops up.
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| & Sort Favorites [ 22
Sort nodes for: Favorites
Sort Order Folder(s) at
i@ Ascending i@ Top
(") Descending () Bottom
(71 Mixed
Ok ] [ Cancel

15.3 Using Scripts

A script is a file with one or more SQL statements that you can edit and execute in an SQL Commander tab.
You can keep a script as an ordinary file anywhere in the file system and load it into an SQL Commander tab (
see page 159) when needed, but managing it as a Bookmark (see page 185) under the Scripts tab is more
convenient as it also keeps information about which connection you used it with last, among other things.

Page 275 of 428



;\./\ DbVisualizer 9.2 Users Guide

16 Delimited Identifiers and Qualifiers

Delimited Identifiers must generally be used for database object with names that contain special characters,
reserved words or mixed case. Qualifiers are needed when referring to an object in a different schema/catalog
than the current one. DbVisualizer uses delimited, qualified identifiers in all SQL it automatically executes in
response to user interaction, such as when loading the Data tab for a table, dropping a stored procedure or
getting metadata for a DDL statement.

For the features where DbVisualizer generates SQL that you can then execute, you can control if you want to
use delimited identifiers and/or qualified object names. In the Properties tab for a connection, or in the Tool
Properties dialog for a database type under the Database tab, you find the Delimited Identifiers and Qualifiers
categories.

In the Delimited Identifiers category you can specify which delimiter characters to use, e.q. double-quotes or
square brackets, and for which features to use them: Scripting (all SQL generating features), Auto Completion
/Query Builder, and Export.

In the Qualifiers category you can specify for which features to use them, and also if column names should be
qualified with the table name for the Scripting and the Auto Completion/Query Builder features. For database
types that supports fully qualified named (both database and schema qualifiers), you can enable fully qualified
names in the References/Navigator Graphs and for the Auto Completion/Query Builder features.
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17 Handling Transactions

Database transactions are intended to make sure operations performed simultaneously do not cause data
integrity problems.

By default, DbVisualizer commits all changes immediately but you can disable this to have full control over the
transactions. You can also set an appropriate transaction isolation level for your connections.

17.1 Changing the Auto Commit Setting

Auto Commit means that each SQL statement successfully executed in an SQL Commander is committed
automatically, permanently changing the database. This is the default for a connection, but you can change it at
different levels.

® Changing Auto-Commit for a Database Type (see page 277)

® Changing Auto-Commit for a Connection (see page 277)

® Changing Auto-Commit for an SQL Commander tab (see page 277)
® Changing Auto-Commit for a Statement Block (see page 278)

17.1.1 Changing Auto-Commit for a Database Type

Open Tools->Tool Properties,

Select the Database tab,

Expand the node for the database type, e.g. Oracle,
Select the Transaction category,

Uncheck the Auto Commit checkbox.

a s~ w DN E

17.1.2 Changing Auto-Commit for a Connection

Double-click the connection node in the Databases tab tree to open an Object View tab,
Select the Properties tab,

Select the Transaction category under the node for the database type, e.g. Oracle,
Uncheck the Auto Commit checkbox.

A wnh

17.1.3 Changing Auto-Commit for an SQL Commander tab

® Use the SQL Commander->Turn On/Off Auto Commit toggle item, or,
® Use the corresponding toggle button to the right in the SQL Commander toolbar.
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17.1.4 Changing Auto-Commit for a Statement Block

You can use the @et aut oconmi t command in a script to enable or disable auto commit for different blocks:

@et autoconmt off;

I NSERT | NTO SCOTT. EMP (EMPNO, ENAME, JOB, MGR, H REDATE) VALUES(61, 'Boo', 2, 1, '2013-06-20");
I NSERT | NTO SCOTT. EMP (EMPNO, ENAME, JOB, MGR, H REDATE) VALUES(62, 'Hoo', 2, 1, '2013-07-01');
I NSERT | NTO SCOTT. EMP (EMPNO, ENAME, JOB, MGR, H REDATE) VALUES(63, 'Zoo', 2, 1, '2013-07-04');
@et autoconmt on;

17.2 Setting Transaction Isolation

When you connect to a database that is concurrently modified by other users and processes, the Transaction
Isolation Level specifies how changes made by others will affect you and how your changes will affect others.

To set the Transaction Isolation Level for a connection,

Double-click the connection node in the Databases tree to open an Object View tab for it,
Select the Properties tab,

Select the Transaction category,

Pick an appropriate Transaction Isolation Level from the drop-down list.

A w b

The following levels are supported.

Level Transactions Dirty Non-Repeatable Phantom
Reads Reads Reads
TRANSACTI ON_NONE Not N/A N/A N/A
supported

TRANSACTI ON_READ COWM TTED Supported Prevented  Allowed Allowed
TRANSACTI ON_READ _UNCOWM TTED = Supported Allowed Allowed Allowed
TRANSACTI ON_REPEATABLE_READ  Supported Prevented Prevented Allowed
TRANSACTI ON_SERI ALl ZABLE Supported Prevented Prevented Prevented

A dirty read occurs when transaction A reading a value before transaction B has made permanent, i.e. before it
has been commited.
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A non-repeatable read occurs when transaction A retrieves a row, transaction B subsequently updates the row,
and transaction A later retrieves the same row again. Transaction A retrieves the same row twice but sees
different data.

A phantom read occurs when transaction A retrieves a set of rows satisfying a given condition, transaction B
subsequently inserts or updates a row such that the row now meets the condition in transaction A, and
transaction A later repeats the conditional retrieval. Transaction A now sees an additional row. This row is

referred to as a phantom.

The default level is database dependent.
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18 Database Connection Options

The database connection is a central concept in DbVisualizer.

Learn how to configure it to your needs, how to use special features like connecting through an SSH tunnel,
using Single-Sign-On, organizing the connections, and much more.

18.1 Setting Up a Connection Manually

To access a database with DbVisualizer, you must first create and setup a Database Connection. The easiest
way to set up a connection is to use the Connection Wizard (see page 17), but you can also do it manually.

18.1.1 Setting Up a Connection Manually

1. Create a new connection from Database->Create Database Connection and click No Wizard when
prompted. An Object View tab for the new connection is opened,
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| & DbVisualizer Personal - Untitled =E]==]

File Edit View Database Scripts SQL Tools Window Help

YSHE R g« Q0 X@

o | «Drop your favorite objects here >

| L Seripts |= [ object view [® 501 Commander

‘ S Databases | =
# - Database Connection: CRM Ahoa
0P| eSS @

Connections
i bR Production 47 Connection | [E| Pmpaﬁml i oatzbase dnfo | § 0at= Types | nSearch|

HR. Production DBA

Disconnectad

HR Test Data Settings Format: Server Info (7) Database URL
L e
MName CRM Ahoa

Database Type Oracle

Driver (JDBC) 2 Oracle Thin

Connection Type Senice

Database Semver 192.168.1.21

Database Port 1521

Senvice XE

4 Authentication

Database Userid hans

Database Password o900 00®

. Use SSH Tunnel

Auto Commit

Save Database Password

Connection Mode Development

5YS Role

Connect ] | Disconnect | [ Ping Server
Connection Message
Disconnected.

Enter a name for the connection in the Name field,

Leave the Database Type as Auto Detect,

Select an installed JDBC driver (marked with a green checkmark) from the Driver (JDBC) list (see
Installing a JDBC Driver (see page 409) for how to install a JDBC driver manually),

Enter information about the database server in the remaining fields (see below for details),

Verify that a network connection can be established to the specified address and port by clicking the Ping
Server button,

. If Ping Server shows that the server can be reached, click Connect to actually connect to the database

server.

See Fixing Connection Issues (see page 402) for some tips if you have problems connecting to the
database.
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Alternatively, you can set the Settings Format to Database URL (this is the only choice for some custom JDBC
drivers). This replaces the fields for information about the database server with a single Database URL field,
where you can enter the JDBC URL.

The information about the database server that needs to be entered depends on the which JDBC driver you use.
For most drivers, you need to specify:

Field Description

Database Server The IP address or DNS name for the server where the database runs.
Database Port The TCP/IP port used by the database.

Database Userid The database user account name. Enter (nul | ) to not send an account name.

Database Password The database user account password. Enter ( nul | ) to not send a password.

For some database such as Oracle, you may use a TNS name (see page 297) instead of specifying the server
and port. Other drivers may add more fields that are driver specific.

You may also optionally specify SSH tunneling information (see page 294) and Options, such as:

Option Description

Auto Commit Check if you want to enable auto commit in the SQL Commander by default for the
connection.

Save Database Check if you want the password to be saved (encrypted) between sessions.

Password

Connection Mode One of Development, Test or or Production to select which set of Permissions (see
page 282) to use.

Additional options are available for some JDBC drivers, such as Authentication Method (see page 298) for the
SQL Server jTDS driver.

See the Configuring Connection Properties (see page 282) page for related topics.

18.2 Configuring Connection Properties

In addition to the basic connection information (see page 17) in the Connection tab, there is also a collection
of connection properties. Which properties are available depends on the Database Type selected for the
database connection in the Connection tab. Some database types have more properties than others. Which
edition of DbVisualizer you use also affects which connection properties are available.

Properties for a connection can be defined at two different levels:

Page 282 of 428



DbVisualizer 9.2 Users Guide

® Tool Properties (Database tab)

These apply to all database connections of the specific database type.
® Connection Properties

These apply only to a specific database connection.

All supported database types (Oracle, Informix, SQL Server, DB2, MySQL, etc.) are listed in the Database tab
in the Tool Properties window. For each database type, there are a number of properties that are applied to
any database connection of that type. This means, for instance, that a database connection defined as being a
PostgreSQL database type will use the PostgreSQL properties defined in Tool Properties. The Connection
Properties can then be used to override some settings specifically for one database connection. The advantage
with this inheritance model is that property changes that apply to all connections can be made in one place,
instead of having to apply a common setting for every database connection of a specific database type.

The Connection Properties are available in the Properties sub tab in the the database connection's Object
View tab.

Actions W

-
: Database Connection: CRM Ahoa

Disconnected

s2F Connection [Z] Properties I_.::'::':-:':-e Info I ' Data Types | A Search |
| & Connection Properties
E----Dabbase Profile Permission Mode
E'"'DLWEF Properties Use this setting to define what permission mode that will be used for this database connection.
EI[‘ Use the Permission tool properties category to define the permission rules for specific features and database
-\ Authentication TrEEEE
Delimited Identifiers (@ Development () Test () Production
| L' Qualifiers
E—}-D; Physical Connection
ﬁ\i Transaction Show only default Database or Schema
| SQL Statements

¢ ¥ Connection Hooks
|| Objects Tree Labels
- [B» 5QL Editor

EE Query Builder

@ Data Types

E Explain Plan
~[g Objects Tree

Check to enable that only the default database and/or schema will appear in the Database Objects tree and throughout
the application.

Show only default Database or Schema: [

Connect when "Connect All"

Defines whether this database will be connected when the Connect All operation is selected.

Connect when "Connect All": [7]

Defaults

The Properties tab is organized basically the same way as the Tool Properties window. The main difference is
that the list contains only the categories that are applicable to this database connection. Briefly, the categories
are:
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® Database Profile
® Driver Properties
® Oracle (The current Database Type)

Authentication
Delimited Identifiers
Qualifiers
Connection Keep-Alive
Physical Connection
Transaction
Encoding

SQL Statements
Connection Hooks
Color and Border
SQL Commander
Query Builder

Data Types

Explain Plan
Objects Tree

The Database Profile and Driver Properties categories are available only in the Properties tab and not in
Tool Properties. The page explains the Database Profile and Driver Properties categories, while the other

categories are described in pages that describe feature the property applies to.

Additional categories may appear in the connection properties depending on the type of database. An example

is the category for Explain Plan for the databases where this feature is supported.

The Database Profile (see page 318) category is used to select whether a profile should be automatically
detected and loaded by DbVisualizer, or if a specific one should be used for the database connection. The

default strategy is to Auto Detect a database profile.
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: Database Connection: CRM Ahoa lﬂ/

Disconnected

g Connection m Properties I_' Databasednfo | . Data Types. | i Seanch
LE Connection Properties
Database Profiles
E----Driver Properties Diatabase profiles controks what objects appear in the objects tree, what detailed views are available for each object
E...Li[]rade type and actions used to operste on objects, Database profiles are database specific and here you can sither decide to
Authentication let DbVisualizer automatically pick (recommended) the appropriste profile or manually choose one. If manually
Delimited Identifiers choosing a profile make sure it is compatible with the database you are connecting to. The generic profile works with
i any database,
I. Qualifiers Mote: You must reconnect the database connection after changing profile.
E—]--g! Physical Connection
ﬂ Transaction i@ Auto Detect () Manually Choose (7)) "Generic™ Profile
M
- | = | SOL Statel ts
, CEHHE cﬁo:Er::oks Profile Version Date Description
| =] Objects Tree Labels db2 12547 2010-10-07 Profile for DB2 LUW -
B s0L Editor db2-zos 12273 2010-06-01 Profile for DB2 203
=g Query Builder derby 12547 2010-10-07 Profile for Apache DerbylJavaDB
@' Data Types generic 12273 2010-06-01 Generic profile for any database
-~ [ Explain Plan informix 12548 2010-10-07 Profile for Informix IDS
+[S Objects Tree mimer 12374 2010-07-13 Profile for Mimer SQL _
mysql 12374 2010-07-13 Profile for MySQL 1
neoview 11504 2009-10-30 Prafile for HP Meoview
oracle 12550 2010-10-08 Profile for Oracle
postgresgl 12273 2010-06-01 Profile for PostgreSGL
postgresqgld 12555 2010-10-12 Profile for PostgreSCIL 8+
sqlserver 12501 2010-09-16 Profile for SQL Server
1Y AEQQ an4n na 90 Droafilo far Ol Fia] my &

Defauits

/% The way DbVisualizer auto detects a profile is based on the setting of Database Type in the
Connection tab. If the Database Type is also set to Auto Detect, DbVisualizer first detects the
database type based on the JDBC information, and then detects the profile based on the database
type.

There is rarely a reason to use another setting than Auto Detect, but if you manually choose a database profile,
this choice will be saved between invocations of DbVisualizer.

The Driver Properties category is used to fine tune a JDBC driver before the database connection is
established.
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Acticns W |

Disconnected

L} Connection Properties

i-Database Profile Driver Properties

Defines IDBC Driver or JNDI specific properties that can be used to fine tune the database connection. A pre-defined

= Objects Tree Labels [ | defauNChar false

.

B3 Query Builder [ ] disableDefineColumnType false

- &} Data Types []  fixedString false

- B Explain Plan [ includeSynonyms false

~[ S Objects Tree [ internal_logon (nully
[ java.namingfactory.initial (nully
[ java.naming.provider.url (nully
[ java.naming.security. authentication (nully
[]  java.naming.security.credentials (nully
[ java.naming.security.principal (nully
|

11 |

=8 crade property is reverted to its default value when removing it while user defined propertiesare removed. The Edited flag

W authentication indicates that the property value has been edited or that the property has been added manually.

% Delimited Identifiers Edited Parameter Val &

| Q“a“_ﬁerﬂ _ [ AccumulateBatchResult true -

E'}'D_! Physical Connection [ autoCommit true [I]
- Transaction | database (uy |~
-] 5QL Statements
773 Connection Hooks [ defaultExecuteBatch 1

5QL Editor | M |defaultRowPrefetch W

Defaults

The list of parameters, their default values and parameter descriptions are determined by the JDBC driver used
for the connection. Not all drivers supports additional driver properties. To change a value, just modify it in the

list. The first column in the list indicates whether the property has been modified or not, and so,

DbVisualizer will pass that parameter and value onto the driver at connect time.

New parameters can be added using the buttons to the right of the list.

18.3 Copying an Existing Connection

whether

To copy an existing connection and use as the basis for a new:

1. Select the original connection node in the Databases tab tree,
2. Use the Database->Duplicate Database Connection to create a copy,

The Object View tab for the copied connection is opened where you can make adjustments.

18.4 Edit Multiple Database Connections

‘ =
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9 Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

There are situation when you may need to change one or several connection settings for multiple database
connections at the same time. Instead of doing this one connection at a time, the connections editor come in
handy.

To open the connections editor select multiple database connections in the Databases tab, right-click and chose
Edit Multiple Connections.

S es D Database Connections Editor
i.(nections Edit the properties you wish to update on 2 selected database connections
Property MName Update Value
Settings Format ]
Database Type | (5]
Driver (JDBC) O (1)
< Authentication
Database Userid [ myUser
Database Password |
Auto Commit ]
Save Database Password Save Belween Sessions
Permission Mode [] Test
Jbject type cannot be filt
B W E » ® O -indiates that a property have different values for the selected database connections
[] Fied Condition || | Hep | | update || Cancel

The connections editor will show only those fields that are commonly available for the database connections
being edited.

The window has the following columns:

® Update: Indicates if the value is edited. You may manually uncheck this to indicate the setting should not
be updated

® Value: Enter the new value here. Once the field is being edited its background will change and the
Update box is checked.
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18.4.1 Changing the database driver

The Driver (JDBC) setting is the main setting that controls what properties are available for a database
connection. Once Driver (JDBC) has been edited its Update checkbox cannot be unchecked.

18.5 Removing a Connection

To remove a connection,

1. Select the connection node in the Database tab tree,
2. Use the Database->Remove Database Connection menu choice to remove the connection.

18.6 Organizing Connections in Folders

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

If you work with many database connections, you can use folder objects to organize and group them in the tree.
Folder objects can have child folder objects in an unlimited hierarchy.

Use the Database->Create Folder and Database->Remove Folder menu choices to create and remove folder
objects. You can drag and drop folders and other objects to move them to a new location in the Databases tab

tree.

f_-’ Databases [ Seripts

20> SN

@ Connections
=% 9 CRM Ahoa
f’ Cracle prod

f’ Orade test

f’ Orade stage
[ Orade: $saliasss

----- W oB2LUw

..... f’ MySCL

..... & MysQLONDI)

..... f’ JavaDB/Derby

----- f’ Mimer - sysadm

----- [ Mimer - mimer_store
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18.7 Rearranging Connections and Folders

You can sort the nodes under the Connections node or a folder node in the Databases tab:

Select the Connections node or a folder node,

Open the Sort dialog from the right-click menu,

Select the sort order and where to place nestled folder,
Click OK.

AP wbd R

To move an individual connection node or folder node:

1. Select one or more nodes,
2. Drag the node(s) to the new location,
3. Drop the node.

18.8 Setting Common Authentication Options

DbVisualizer lets you handle authentication in a manner that suits your balance between security and
convenience.

Userid and password information is generally information that should be handled with great care. By default,
DbVisualizer saves both the Database Userid and Database Password (encrypted) for each database
connection. The default for SSH (see page 294) is to save the SSH Userid but not the SSH Password (or Key
Pass-phrase). You can change this behavior to fit your preferences. You specify how to handle the Database
Userid and Password in the Authentication category of the Properties tab. The same options are available for
the SSH Userid and Password in the Database Connection/SSH Settings category in the General tab of the
Tool Properties window.

The Require Userid and Require Password properties can be enabled to tell DbVisualizer to automatically
prompt for userid and/or password when a connection is to be established if they are not specified for the
connection. The following dialog is displayed if requiring both userid and password.
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Discannected

|!:-§:_-'-_ seInfo

[ﬂ' Connection Properties

-Database Profile Connection Authentication
E""DLWET Properties If Userid or Password is not entered in the connection details at connect then these settings when enabled will prompt
EI[_‘ Cracde the user for details.

% Authentication Require Userid:

Delimited Identifiers

Qualifiers

I:—}-D! Physical Connection
ﬂ Transaction

e [2) S0L Statements Database Password

_‘P Connection Hooks Specify what to do with the database connection password. For Save Between ( DbVisualizer) Sessions an

E Objects Tree Labels encryption scheme i applied to the password before saved.

- [ S0L Editor @ Save Between Sessions () Sawve During Session () Clear at Disconnect
=8 Query Builder . .

g E::a;ﬁi [_ﬂ Connect: CRM Ahoa @

[ Objects Tree

Require Password:

Establish database connection for:
CRM Ahoa

Specify additional connection details below:

Userid: |hans |

Password: |...... |

Defaults lcm”w]E

Since a password may need to be handled with great care, you can also specify for how long it should be saved,
if at all. If Clear Password at Disconnect is selected, DbVisualizer ensures that the Password field is cleared
as soon as the connection is terminated. With Save During a Session, it is cleared when you shut down
DbVisualizer. To keep the password between sessions, select Save Between Sessions. If you use Save
Between Sessions, we recommend that you also set a Master Password (see page 290).

18.9 Setting a Master Password

When you use Save Between Sessions for database passwords and SSH passwords or pass-phrases, they
are by default encrypted using a static key. The same is true for the Proxy password if you have specified one.
For better security, you can specify a Master Password that is then used instead of the static key to encrypt all
passwords and pass-phrases. This way, only you know the information needed to decrypt the data. The
algorithms used for encryption with a Master Password are also more advanced, minimizing the risk that the
data can be decrypted by brute force.
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Using a Master Password does, however, mean that if you forget it, there is no way to retrieve it and therefore
no way to decrypt the saved passwords. It also means that the encrypted passwords cannot be read by a
DbVisualizer version earlier than 9.2.

@ If you forget the Master Password, it cannot be recovered. The only way forward is to reset the Master
Password, which also clears all passwords encrypted with it.

Passwords encrypted with a Master Passwords cannot be used in DbVisualizer version earlier than 9.2
. If you set a Master Password in 9.2 and then use an earlier version, you will get "invalid password"
errors when trying to connect with a saved password. You must enter the database or SSH password
again in the earlier version, or go back to using DbVisualizer version 9.2 or later.

18.9.1 Specifying a Master Password
To use a Master Password for encoding of passwords saved between sessions:

1. Open Tools->Tool Properties and select the General/Master Password category,

2. Enter a password matching the described rules in both the New Password and Confirm New Password
fields,

3. Click Apply and then confirm that you want to do this after reading the warning about what it implies.

Master Password

When a Master Password s specified, saved databese pesswords and SSH passwords/pass-phrases are
encrypted using the Master Password as the key instead of a default key for increased security.

The new password must be at least 8 characters long.

Mew Password:

Confirm Mew Passwaord:

/1% A Master Password is not specified.

The passwords for all connections with Save Between Sessions chosen for the password are now encrypted
with the Master Password. The same goes for the SSH passwords/pass-phrases if you have selected to have
them saved between sessions, as well as the proxy password, if any.

18.9.2 Changing a Master Password
If you want to change the Master Password:

1. Open Tools->Tool Properties and select the General/Master Password category,

Page 291 of 428



\-/T DbVisualizer 9.2 Users Guide

2. Enter the current password in the Current Password field and the new password in both the New
Password and Confirm New Password fields,
3. Click Apply.

Master Password

When a Master Password is specified, saved databasse pesswords and S5H passwords/pass-phrases are
encrypted using the Master Password as the key instead of a default key for increased security.

The new password must be at least 8 characters long.
Current Password:
Mew Password:
Confirm Mew Password:

:3, A Master Password is spedified.

Reset Master Password

The saved passwords are then decrypted with the current Master Password and re-encrypted with the new.

18.9.3 Resetting the Master Password
If you have forgotten the Master Password, or simply no longer want to use one, you can reset it:

1. Open Tools->Tool Properties and select the General/Master Password category,
2. Click the Reset Master Password button and confirm that you want to do this.

& Note that all passwords encoded with the Master Password are then immediately cleared and there is

no way to recover them.

18.9.4 Connecting with a Master Password specified

When you have a Master Password specified, you will be prompted to enter it the first time within a DbVisualizer
session that you need to connect with a saved password. From then on, you can make other connections with
saved passwords without being prompted until you restart DbVisualizer.
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18.9.5 Manually Requesting the Master Password for New
Connections

You have two options to manually require being prompted for the Master Password again after entering it once
within a DbVisualizer session:

1. Select Database->Require Master Password at Next Connect,
2. Open Tools->Tool Properties, select the General/Database Connection category and enable Require
Master Password after All Connections Closed.

18.9.6 Showing the Encrypted Password in Cleartext

When you have specified a Master Password, you can view the saved database password or SSH password/
pass-phrase in cleartext.

1. Right-click on the password field label and select Show Password,
2. Enter the Master Password when prompted.

18.9.7 Declaring a Master Password Rule

A Master Password must have at least eight characters of any kind by default, but you can declare your own
rule using a regular expression in an installation configuration file:

1. Open the DBVIS-HOME/resources/dbvis-custom.prefs file,

2. Enter a regular expression as the value of the dbvi s. - Mast er Passwor dRul e property,

3. Enter a description of the rule for showing the user in Tool Properties as the value of the dbvi s. -
Mast er Passwor dRul eDescr property.

The regular expression for the default rule is . { 8, } . It is easy to change the number in this expression to any
number you want. There are regular expressions that can describe pretty much any rule you can come up with.
For instance, this rule requires at least nine characters, with at least one symbol, one digit, one uppercase
character, and one lowercase character:

(?2=.{9,1) (2= *2[ M\ W\ s]) (2= *2[0-9]) (?=. *?[A-2Z]).*?[a-z] . *

If you cannot adopt these examples to your own policy, you can search the Internet for other examples of "
regular expressions for password validations".
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18.10 Using Connection Keep-Alive

Databases can be configured to terminate sessions that have been idle for some time, and networks often does
the same with TCP/IP connection. The Connection Keep-Alive feature helps preventing connections to be
closed due to time-outs of this kind by periodically executing a simple SELECT statement.

= Network connections may be terminated for other reasons than a time-out in the database or at the
network layer, e.g due to a restart of the database or a network element. The Connection Keep-Alive
feature does not help in those cases. Also note that connections that are busy, e.g. actively used to run
a script, are not "pinged”. If a SELECT statement or stored procedure takes a very long time to
complete, it is therefore possible that a time-out happens at the network level. In this case, the network
configuration must be tuned to handle long running statements without timing out.

To enable Keep-Alive for a connection:

Open the Object View tab for the connection,

Open its Properties tab,

Select the Connection Keep-Alive category,

Enable Connection Keep-Alive and optionally change the idle time interval,
Click the Apply button.

a s WD e

The SELECT statement used for Connection Keep-Alive can also be specified in the properties pane.
For supported databases, it is set to a SELECT statement that has been verified to work for the
database type but for connections that use the Generic profile, you must specify a valid SELECT
statement in order for this feature to work. For many databases, SELECT 1 or SELECT 1 FROM

aSmal | Tabl e WHERE 1 = 0 should work.

18.11 Using an SSH Tunnel

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

A database that sits behind a firewall cannot be accessed directly from a client on the other side of the firewall,
but it can often be accessed through an SSH tunnel. The firewall must be configured to accept SSH connections
and you also need to have an account on the SSH host for this to work.
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If you need to access a database that can only be accessed vi an SSH tunnel, you need to specify additional
information in the Use SSH Tunnel area of the Connection tab.

/%, This area is only shown when the Server Info settings format is selected, and only for databases
identified by at least a Database Server and a Database Port (i.e. not for embedded databases or
when using the TNS Connections Type for an Oracle database, or similar).

Enable SSH tunneling by clicking on the checkbox. When it is enabled, five additional fields are shown.

.

-,

| 8 DbVisualizer Persenal - Untitled [==]=]

File Edit View Database Scripts 5QL Teools Window Help

eTHE N d« 800X

'ﬁ"k' | <Drop your favorite ohjects here >

s Databases Q‘ Scripts Eﬁ Object View b SOL Commander

o0 | » | &< | i : Database Connection: CRM Ahoa
D -

HR. Production

Disconnected

HR Production DBA 47 Connection | m Pmpertiesl 'Database Info | . Data Types I M 5earch |
HR. Test Data
Lab Settings Format: Server Info (7)) Database URL
Bright Future — e
- comnecon
MName CRM Ahoa
Database Type Oracle
Driver (JDBC) 7 Oracle Thin
Connection Type Semnice
Database Server 192 168.1.21
Database Port 1521
Sermvice XE =
./ Authentication
Database Userid hans
Database Password 000009
. Use SSH Tunnel
S5H Host 192 168.1.21
55H Port 2z
85H Userid hans |
S5H Password
Private Key File
.
[ Connect l | Disconnect | | Ping Server |

Connection Message

Disconnected.
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The SSH Host is the name or IP address for the host accepting SSH connections. The SSH Host is typically the
same as the Database Server. Enter the port for SSH connections in the SSH Port field. The default value is 22.

You may also enter the userid and password for your SSH host account in the SSH Userid and SSH Password
fields, but see Setting Common Authentication Options (see page 289) for other options. Alternatively, you can
enter the path to a private key file (using either the RSA or DSA algorithms) in the Private Key File field. The
SSH Password field is then replaced by a Key Passphrase field where you can enter the passphrase if the
private key is protected with one.

When SSH tunneling is enabled, a tunnel is established when you connect to the database and the connection
is then made through the tunnel by constructing a JDBC URL that uses information from both the Connection
and Use SSH Tunnel sections.

If you're familiar with using the ssh command to set up a tunnel manually, you may be interested in more details
. The tunnel corresponds to the tunnel you would set up with the ssh command like this:

ssh -p <SSHPort> -L<Local Port >: <Dat abaseSer ver >: <Dat abasePort > <SSHUser i d>@
SSHHost >

where the placeholders correspond to the fields in the Connect and Use SSH Tunnel sections, except for <
LocalPort> which is any available port, determined at connect time.

» Note that when using an SSH tunnel, the Database Server is evaluated on the SSH host. If the
database server is running on the SSH host, you can therefore set Database Server to | ocal host in
case the database only accepts local connections.

The JDBC URL is constructed using 127.0.0.1 as the Database Server portion and <LocalPort> as the
Database Port portion, e.g. like this for the Oracle Thin driver when <LocalPort> is 50538:

jdbc: oracl e:thin@?27.0.0.1: 50538/ XE

In other words, the JDBC driver connects to the SSH tunnel's local port, which then forwards all communication
to the database server.

The URL that is used for the connection is shown at the top of the Object View tab for the database connection
when a connection is established, along with a certificate icon if the connection is made through an SSH tunnel.

|G| Object View | B SQL Commander
Iﬁ % Actions

g’ Connection ﬂ Properties |!6 Database Info @ Data Types | &@ Search
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If you use the SSH Tunnel feature, you may also want to configure a few things in Tools->Tool Properties. In
the Database Connection/SSH Settings category under the General tab, you can specify an SSH Keep-Alive
Interval to minimize the risk that the tunnel is disconnected due to inactivity, and an SSH Known Hosts File so

you don't have to accept connections to known SSH hosts every time you connect.

18.12 Using Oracle TNS Names

All information for connecting to an Oracle database may be stored in a tnsnames.ora file, with each database
instance defined by a TNS alias. If you want to create a connection in DbVisualizer that uses the information
from this file, you must first tell DbVisualizer where it is stored by setting either the TNS_ADM N environment
variable to the path of the folder holding the file, or making sure it is located in the ORACLE_HOME/network/
admin folder and that the ORACLE _HOVE environment variable is set.

When this configuration is done, you can select TNS from the Connection Type list for the Oracle connection
and then pick the TNS alias from a list of all aliases found in the file.
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=

| & New Connection Wizard ==

CRM Ahoa
(Oracle Thin)

. Connection

Connection Type THS

™S Alias DWSUN42 B
dwlin 165.us.orade. com

=

Database Password
Auto Commit
Save Database Password

Connection Mode Development

SYS Role

'. Ping Server

Press the Fimish button to create and connect the new database
connection.

<Back || Finsh | | Cancel

18.13 Using SQL Server Single-Sign-On or Windows
Authentication

With Microsoft SQL Server, you can either let the database server or a Windows domain server handle the

authentication. The database server handles it by default using the database user and password you enter for
the connection.

To let a Windows domain server handle the authentication instead, you must use the SQL Server (jTDS) JDBC
driver (bundled with DbVisualizer),

If you run DbVisualizer on a Windows OS client in the same domain as the SQL Server database, leave the

Database User and Database Password fields in the Connection tab empty. This is also known as
Single-Sign On (SSO).
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% SSO only works if you installed DbVisualizer using an installer, not if you used an installation archive,
because the installer also installs the DLL files needed for SSO.

If you run DbVisualizer on another OS in a network with a Windows domain server, select Windows from the
Authentication Method list in the Options area in the Connection tab and enter the Domain name. You must
also enter the domain user and and password in the Database User and Database Password fields. The driver
then authenticates with the domain server and then uses those credentials to log in to the database server.

18.14 Using Variables in Connection Fields

Variables can be used in some of the Connection tab fields. You can use variables in the Name, Userid and
Password (both Database and SSH) fields with the Server Info settings format, or in the Database URL field
when using this settings format. This can be a useful alternative to having a lot of similar database connection
objects. Several variables can be in a single field, and default values can be set for each variable. The following
figure shows an example with variables, described in more detail in the Using DbVisualizer Variables (see page
221) page.

9

MName Oracle: ${Mame}s

Database Type Oracle

Driver (JDBC) ;3 Cracle Thin

Database URL jdbcoracleithin:@${Database Host||dbhost2||||choices=[dbhost1,dbhost2 dbhosta[}E:${Port][152115:${SID||ORCL}E

The following variables appear in the figure:

* ${Nane}$

® ${Dat abase Host| | dbhost 2| ||| choi ces=[ dbhost 1, dbhost 2, dbhost 3]} $
® ${Port]|]|1521}$

${SID | ORCL} $

All of these variables define a default value after the "||" delimiter, except for the ${ Nane} $ variable, which has
no default value. The default values appear in the connect dialog when you ask for a connection to be
established. The ${ Dat abase Host } $ variable includes the choices option, with a comma separated list of
choices that should appear in a drop-down list. The drop-down list is editable, so the user is not locked into the
choices from the list.

The following figure shows the connect dialog based on the connection definition shown above.
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Connect: Oracle: 5{Mame}s | =2
|

Establish database connection for:
Oracle: ${Name}%

Spedfy additional connection details below:

MName:

Database Host: | dbhost2 -
Part: 1521

SID: ORCL

Userid:

Password:

Connect ]l Cancel

Enter the appropriate information in the fields and then press the Connect button to establish the connection.
When the connection is established, DbVisualizer automatically substitutes the variables in the Connection tab
with the values entered in the connect dialog. At disconnect from the database, they revert back to the original
variable definitions.

18.15 Automatically Connecting at Startup

If you want to automatically connect to a database when you start DbVisualizer:

Open the Properties sub tab in the connections Object View tab,

Select the database type category in the tree, e.g. the node named Oracle for an Oracle connection,
Enable Connect when "Connect All",

Open Tools->Tool Properties and select the Database Connection category under the General tab,
Enable Run "Connect All" at Startup.

ar w e

If you enable Connect when "Connect All"* but do not enable Run "Connect All" at Startup, you can instead use
the Database->Connect All main menu choice to manually connect all connections marked this way.

18.16 Executing SQL at Connect and Disconnect

Connection hooks defines optional SQL commands that are sent to the database at connect and just before
disconnect. They are typically used to initialize the database session with custom settings and to clean up
various resources at disconnect.
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You can enter the SQL you want to execute in the Properties tab for the connection, in the Connection Hooks
category.

18.17 Using a Single Shared Physical Connection

By default, DbVisualizer uses multiple physical connections to a database. Each SQL Commander tab is
allocated its own connection. Other processes that update the database, such as saving grid edits or importing
data to a table, also use their own connections. Finally most read-only operations, such as navigating the
database objects tree, use a separate shared connection. This is normally the most efficient way to access the
database, but in certain circumstances it is important to instead use one single shared physical connection for all
operations. Some examples are:

® Only one session per account is allowed in the target database,

® [ocking issues when modifying the same table in the Data tab and in an SQL Commander (when a
pending transaction locks the whole table)

®* When using one-time passwords, new physical connections cannot be established without prompting for
a new password.

For situations like these, you can force DbVisualizer to use a single shared physical connection.

® Selecting the Single Shared Physical Connection Mode (see page 301)
® Data Manipulation with a Single Shared Physical Connection (see page 301)
® Transaction Handling with a Single Shared Physical Connection (see page 302)

18.17.1 Selecting the Single Shared Physical Connection Mode
To use a single shared physical connection:

1. Open the Object View tab for the connection node,
2. Select the Properties tab,
3. Select the Physical Connection category and enable Use a Single Shared Physical Connection.

18.17.2 Data Manipulation with a Single Shared Physical
Connection

Executing a script in an SQL Commander tab, using an Action, editing a table in a grid and importing data to a
table are all operations that (potentially) modify data in the database. When a single shared physical connection
is used, only one such operation may be performed at a time. If you try to start an operation like this while
another one is already being processed, a dialog will pop up asking you to try again later.
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18.17.3 Transaction Handling with a Single Shared Physical
Connection

If you have Auto-Commit disabled with Single Shared Physical Connection enabled, commits or rollbacks done
in one part of the GUI affect changes done in any other part of the GUI. For instance, if you have executed
UPDATE or INSERT statements in an SQL Commander tab and then edit a table in its Data tab and commit
those changes, you are also committing the changes made by the UPDATE or INSERT statements. To make
this clear, all GUI controls for transaction handling for shared physical connections are shown in a separate
Single Physical Connections window.

Z. Single Physical Connections £

When using a Single Physical Connection, all GUI elements share a single
physical connection to communicate with the database. Transaction
commands, i.e. Commit, Rollback and Auto-Commit On/Off,
therefore affect all GUI elements assodated with such a connection.

To make this dear, all transaction operations for Single Physical Connections
are initiated from this window instead of from individual SQL Commander
tabs.

[# HR Production

0| Auto Commit OM

[, HR Test Data
| 2 [ fa] Auto Commit OFF (1/1)

Close

This window pops up when you connect to a database with Single Shared Physical Connection enabled, or
when clicking any of the transaction control buttons in an SQL Commander tab for such a database. You can
also click the corresponding button in the DbVisualizer status bar to bring it up. From this window, you can
enable or disable Auto-Commit and manually commit or rollback a pending transaction.

You also get prompted to commit, rollback or continue working within the same transaction every time an
operation results in data changes. Before potentially making lots of changes, you get prompted to enable
Auto-Commit, since making lots of changes (e.g. importing lots of data) may fill up redo logs if running with
Auto-Commit disabled.
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19 Finding Database Objects and Data

DbVisualizer provides ways to find all kinds of things, from parts of a script and data in a grid to objects in a
connection tree.

19.1 Finding and Replacing Text in the Editor

The Edit main menu and the editor right-click menu contain two choices for finding text: Find and Find with
Dialog.

Find displays a Quick Find field where you can type text to look for, and use the Up and Down keys (and F3
and Shift-F3, by default) to find the next or previous occurrence. Use the Escape key to close the field.

Find with Dialog shows a dialog where you can enter what to look for, either as text or as a regular expression.
You can also limit the search to the current selection and use other options for a more precise search. You can
use Find Next and Find Previous to navigate to other matches, by default mapped to the F3 and Shift-F3 keys.

Use the Replace menu choice to show a dialog identical to Find with Dialog but with an additional field for
entering then replacement text. When you use a regular expression with group expressions in the Find what
field, you can use back references to the captured text in the Replace with field. The back reference is written
as the dollar sign plus the group number. For instance, to replace all occurrences of the words COL1 and COL2
with the same word plus the character A (COL1A and COL2A) in a text, you specify the regular expression as a
group, i.e. (COL1| COL2), and use a back reference for the first group in the replacement text plus the
additional character A, i.e. $1A.

19.2 Finding Data in a Grid

The right-click menu for a grid contains the Find Data and Find Column choices.

Find Data shows a Quick Find field where you can type text to look for, and use the Up and Down keys to find
the next or previous occurrence. Use the Escape key to close the field.

Find Column works the same, except it locates a column with the name you type.

19.3 Locating an Object in an SQL Statement

To open an Object View tab for an object named in an SQL statement (e.g. a table in a SELECT statement) in
the SQL Commander tab, place the caret in or next to the name and choose Show Object at Cursor from the
right-click menu.
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19.4 Locating an Object in the Databases tab

With a node selected in the Databases tab, typing any character shows a Quick Find field where you can type
the name of an object you want to locate. Use the Escape key to close the field.

Note that only the visible, expanded, nodes are searched. To search among all nodes for a connection,
see Searching a Connection (see page 304).

19.5 Searching a Connection

@ Only in DbVisualizer Pro

This feature is only available in the DbVisualizer Pro edition.

The Search tab in the Object View tab for a connection is used to search among the objects in the tree by
object name. The types of objects that are searchable depends on the database you are connected to. For
instance, columns are included in the tree for some databases but not for others.

Page 304 of 428



Ly
:Q\ DbVisualizer 9.2 Users Guide

[_ﬂ Object View | [B» SQL Commander

=
o Database Connection: CRM Ahoa

Connections/CRM Ahoa
| @7 Connection | [} Database Info | & Data Types| &9 Search

Search Far

Search Object Names: |JDE% | & Search

|Jse an asterix (*) to indicate a wildcard. (Only if Regular Expression is disabled)

Scope
Search From: ‘E ? CRM &hoa - ‘
Case Sensitive:
Regular Expression: [

Result

#q) $|@

Type . MName |
I:i] Column CRM AhoalSchemas/HRITables/BIOIColumns/JOB_ID (VARCHARZ) -

I:i] Column CRM AhoalSchemas/HRITables/BIQIConstraints/3YS_C009669 (Check)dJOB_ID

I:i] Column CRM AhoalSchemas/HRITables/EMPLOYEES/Columns/JOB_ID (VARCHARZ)

I:i:l Column CREM AhoalSchemas/HRITables/EMPLOYEES/Constraints/EMP_JOB_FK (Foreign KeyMJOB_ID

I:i:l Column CREM AhoalSchemas/HRITables/EMPLOYEES/Constraints/EMP_JOB_NM (Check)JOB_ID

[§] Column  CRM AhoalSchemas/HRITables/EMPLOYEES/ndexes/EMP_JOB_[X (MONUNIQUEVJOB_ID

[Fl column  CRM AhoaiSchemas/HRNiews/EMP_DETAILS _VIEWIColumnsJOB_ 1D (VARCHAR2)

(¥ column  CRM AhoaiSchemasiHRNiews/EMP_DETAILS_VIEW/Columns/JOB_TITLE (VARCHARZ2)

< Index CRM AhoalSchemas/HR/Indexes/JOB_ID_PK (HR.JOBS)

III Column CRM AhoalSchemas/SY3Views/ALL_REFRESHIColumns/JOB (NUMBER)

[¥ column  CRM Ahoa/SchemasiSYSiviews/ALL_REFRESH_CHILDREM/Columns/iJOB (NUMBER)

[¥ column  CRM Ahoa/Schemas/SYSiviews/iALL_SCHEDULER_JOB_ARGSIColumns/JOB_NAME (VARCHARZ)

[l Column  CRM Ahoa/Schemas/SYSiiews/ALL_SCHEDULER_JOB_CLASSES/ColumnsiJOB_CLASS_MNAME (VARCHARZ)
[§]Column  CRM AhoalSchemasiSYSiviews/ALL_SCHEDULER_JOB_LOG/Columns/JOB_NAME (VARCHARZ) -

1634.202sec || 70/2 | 1-15 |

Search by specifying the name of the object, or name pattern, and press the Search button. You can use
asterisk (*) as a wildcard in a pattern, or you can use a regular expression pattern if you enable it by checking
the Regular Expression checkbox. You can also specify where in the tree to start the search, and whether to
do a case sensitive search.

You can interrupt a search operation with the Stop button in the grid toolbar. Use the Show Object Path toolbar
toggle button to include or exclude a column for the complete path for each found object in the grid. This path is
the same as if navigating to each object manually in the objects tree. Other grid toolbar buttons let you export
and print the search result grid.

Shift+Click on a row to switch to the Object View to see detailed information about a specific object. Shift+
Double-click on a row to see detailed information about a specific object in a separate window.

/%, Note that if you have tree filters or any other property that limits the content of the tree enabled, the
search is performed only for those objects that match the filters.
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20 Exporting and Importing Settings

Sometimes it may be necessary to migrate all your settings for DbVisualizer and import them in second
DbVisualizer installation. This is very handy if you are migrating from one machine to another, or if you want to
setup an exact copy on your home computer, or if you would like to share you settings with other users. Another
key reason is for backup purposes. Loosing all database connection configurations can be really frustrating.

® Export Settings (see page 306)
® Import Settings (see page 308)

20.1 Export Settings

The Export Settings feature is available from the File->Export Settings main window menu choice.
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¥ Check all settings to export ﬂ

Check all settings to export
Tool Properties

[[] General

2} Key Bindings

2 Editor Styles

" Editor Templates
| f Database

Default Settings For Export

Default Settings For Schema Export
Bookmarks

Monitors

History

Favorites

Border Images

Driver Definitions

JDBC Drivers

Extensions (Database Profiles)

Database Connections
i) Connections

- [ ] Oracle Servers
CRM Ahoa

- g DB2 LUW
3

H2
- JavaDB/DERBY

Exclude: [ | Folders [ | Default Filter Sets | | Passwords
Shared Filter Sets
Table Data (WHERE) Filters
Column Visibility Definitions

Export options
Relative File Paths (import requires == DbVisualizer 7.1)

Export settings to
C:\Users\ulf\myDbVisSettings_Backup.jar

Select All Deselect All DK Cancel

The default settings ensures that all settings are exported, but you can selectively exclude certain items. Once
you've made the adjustments you want, press OK and the settings will be saved in the specified file. The
structure of this JAR file is the same as the content in your DbVisualizer preferences directory.
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% The Relative File Paths option will transform all path definitions in the exported file to be relative to the
DbVisualizer installation directory and your personal settings directory. This is useful if you will import
the settings on another machine or share it with other users. Note that the DbVisualizer version
importing relative file paths must be 7.1 or later to work properly (importing in earlier versions than 7.1
will not fail but path information will be erroneous for things such as drivers, favorites, etc.)

If Master Password (see page 290) is enabled for DbVisualizer and passwords are not excluded in the export
you must specify an export password. The export password is used to protect the passwords that are exported.
This export password is used later when importing the settings.

Enter Export Password @

Export Password:

You are about to export settings that are encoded

with 2 master password. Plezse specify a new password
that will be used oniy to encode these settings in the
exported file, This is the password you will need when

later importing the settings file.

Ok ] | Cancel

&  You should not use your master password as the export password.

20.2 Import Settings

The Import Settings dialog is launched from the File->Import Settings main window menu choice.

Import Settings is used to import settings as previously exported with Export Settings. Import examines the
content of the specified file and present the choices available.

Page 308 of 428



DbVisualizer 9.2 Users Guide

Check all settings to import
Tool Properties

[[] General

2} Key Bindings

2 Editor Styles

" Editor Templates

Bookmarks

Monitors

History

Favorites

Border Images

Driver Definitions

JDBC Drivers

Extensions (Database Profiles)
Database Connections

Import To: @ Connections

|E| @ Connections

= [#] &) Oracle Servers
[ W crRM2

&) cRM Ahoa

] & pB2 LUW

] & Ha2

. ] f’ JavaDB/DERBY

Table Data (WHERE) Filters

Column Visibility Definitions

Select all Deselect All

¥ Check all settings to import

OK

Cancel

Use the Target Location button to set where the imported database connections will appear in the objects tree.

Note how some of the databases and folders are pre-selected. DBVisualizer will automatically pre-select
databases and folders depending on the changes made since the export was done. E.g. the decorations show

how the database "CRM2" was deleted after the export was done.

If the imported data has been exported with an export password you will be prompted to enter it. You can

optionally click Cancel to clear the passwords for all the connections.
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™

Enter Password for Imperted Connections

Password: ||

You are about to import database connections that
are encoded with a password, Enter that password
or click Cancel to clear the passwords for the
imported database connections.

[ OK J [ Cancel
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21 Command Line Interface

In addition to the DbVisualizer GUI tool, there is also a pure command line interface for running scripts. We
recommend that you use this interface for tasks that you schedule via the operating system's scheduling tool, or
when you need to include database tasks in a command script for a larger job. It is also the right tool for
execution of large scripts, such as a script generated by the DbVisualizer Export Schema feature.

® Command Line Options (see page 311)
® Examples (see page 312)

® Executing single statements (see page 312)
® Executing scripts (see page 314)

® Controlling the output (see page 315)

® Combining OS scripts, the command line interface and DbVisualizer variables (see page 316)

On Windows and Linux/Unix, you find this command as a BAT file (dbviscmd.bat) or a shell script (dbviscmd.sh)
in the DbVisualizer installation directory. For Mac OS X, the shell script is located in /Application/DbVisualizer-<
Version>.app/Contents/Resources/app.

21.1 Command Line Options

The command line

Usage: dbvi scrmd

Options:
-connection <nal
-userid <userid

interface supports the following options:

-connection <name> [-userid <userid>] [-password <password>]
-sgl <statenments> | -sqlfile <filename> [-encodi ng <encodi ng>]
[-catal og <catal og>] [-schena <schena>]

[-maxrows <max>] [-maxchars <max>]

[-stoponerror] [-stoponwarni ng]

[-output all | none | log | result] [-outputfile <filename>]
[-1istconnections]

[-debug [-debugfile <filenane>]

[-prefsdir <directory>] [-help] [-version]

[ - mast er pw <passwor d>]

me> Dat abase connection nane (created with the GU)
> Userid to connect as

- password <passwor d> Password for userid

-sgl <statement
-sqglfile <filen
-encodi ng <enco
-catal og <cata

-schema <schema
- maxrows <max>

-maxchars <max>
- st oponerror

- st oponwar ni ng

s> One or nore delimted SQL statenents

anme> SQL script file to execute

di ng> Encoding for the SQ script file

og> Catalog to use for unqualified identifiers

> Schema to use for unqualified identifiers
Maxi mum nunber of rows to display for a result set
Maxi mum nunber of characters to display for a colum
St op execution when getting an error
St op execution when getting a warning
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- out put "all" (default), output both |og nmsgs and result sets

"none", suppress both | og nessages and result sets
"l og", output only |og nessages
"result", output only result sets
-outputfile <filenane> Script execution output file. Default is stdout
-listconnections Lists all database connections
- debug Wite debug nessages
-debugfile <filenane> File for debug nmessages. Default is stderr
-prefsdir <directory> Use an alternate user preferences directory
- mast er pw <passwor d> Mast er Password for encrypted dat abase passwords
-hel p Di splay this help
-version Show version info

Before you can use the command line tool, you need to create at least one database connection using the GUI
tool. You need to specify the connection to use with the - connect i on option when you run dbvi scrd. If you
have forgot the connection name, use the - | i st connect i ons option to get a list of all connection names.

21.2 Examples

21.2.1 Executing single statements

You can use the command line interface to execute a single SQL statement:

./ dbvi scnd. sh -connection "Oracle" -sql "select * fromhr.countries"
select * fromhr.countries;
INFO 14:20:31 [SELECT - 25 row(s), 0.247 secs] Result set fetched

COUNTRY_I D COUNTRY_NAME REG ON_I D
AR Argentina 2
AU Australia 3
BE Bel gi um 1
BR Brazi | 2
CA Canada 2
CH Switzerl and 1
CN Chi na 3
DE Ger many 1
DK Denmar k 1
EG Egypt 4
FR France 1
HK HongKong 3
IL | srael 4
I'N I ndi a 3
1T Italy 1
JP Japan 3
KW Kuwai t 4
MX Mexi co 2
NG Ni geri a 4
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NL Net her | ands 1
SG Si ngapore 3
UK Uni ted Ki ngdom 1
us United States of Anerica 2
M Zanbi a 4
W Zi mhabwe 4
SUMVARY: ... 1 statenent(s) executed, 25 row(s) affected, exec/fetch time: 0.247/0.002 sec

[1 successful, O warnings, O errors]

If you like to execute just a few statements, you can pass in a list of statements:

./ dbvi scnd. sh -connection "Oracle" -sql "select * fromhr.countries; select * fromhr.regions"
select * fromhr.countries;
INFO 14:23:39 [SELECT - 25 row(s), 0.012 secs] Result set fetched

COUNTRY_I D COUNTRY_NAME REG ON_|I D
AR Argentina 2
AU Australia 3
BE Bel gi um 1
BR Brazi | 2
CA Canada 2
CH Swi t zerl and 1
CN Chi na 3
DE Cer many 1
DK Denmar k 1
EG Egypt 4
FR France 1
HK HongKong 3
I'L | srael 4
I'N I ndi a 3
1T Italy 1
JP Japan 3
KW Kuwai t 4
MX Mexi co 2
NG Ni geri a 4
NL Net her | ands 1
SG Si ngapore 3
UK Uni ted Ki ngdom 1
us United States of America 2
ZM Zanbi a 4
W Zi mhabwe 4

select * from hr.regions;
INFO 14:23:39 [SELECT - 4 rowms), 0.130 secs] Result set fetched
REG ON_| D REG ON_NAME

1 Eur ope

2 Aneri cas

3 Asi a

4 M ddl e East and Africa

SUMVARY: ... 2 statenent(s) executed, 29 row(s) affected, exec/fetch time: 0.142/0.003 sec

[2 successful, O warnings, O errors]
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21.2.2 Executing scripts

If you frequently want to execute a number of statements, it's best to put them into a script file. Here's how to
execute a script that contains the two statements from the example above:

./ dbvi scnd. sh -connection "Oracle" -sqlfile "nyscript.sql"
select * fromhr.countries;
INFO 16:38:06 [SELECT - 25 row(s), 0.021 secs] Result set fetched

COUNTRY_I D COUNTRY_NAME REG ON_|I D
AR Argentina 2
AU Australia 3
BE Bel gi um 1
BR Brazi | 2
CA Canada 2
CH Switzerl and 1
CN Chi na 3
DE Cer many 1
DK Denmar k 1
EG Egypt 4
FR France 1
HK HongKong 3
IL I srael 4
I'N I ndi a 3
I'T Italy 1
JP Japan 3
KW Kuwai t 4
MX Mexi co 2
NG Ni geri a 4
NL Net her | ands 1
SG Si ngapore 3
UK Uni ted Ki ngdom 1
us United States of America 2
ZM Zanbi a 4
ZW Zi mhabwe 4

select * from hr.regions;
INFO 16:38:06 [SELECT - 4 rowms), 0.005 secs] Result set fetched
REG ON_ | D REG ON_NAMVE

1 Eur ope

2 Aneri cas

3 Asi a

4 M ddl e East and Africa

SUMVARY: ... 2 statenent(s) executed, 29 row(s) affected, exec/fetch time: 0.026/0.001 sec

[2 successful, O warnings, O errors]
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21.2.3 Controlling the output

You can use options to control how much output to generate. If you only want to see the results, use the -
out put option with the result keyword:

./ dbvi scnd. sh -connection "Oracle" -sqlfile "nyscript.sql" -output
COUNTRY_I D COUNTRY_NANME

REG ON_I D

Argentina

Australia

Bel gi um

Brazi |

Canada

Swit zerl and

Chi na

Ger many

Denmar k

Egypt

France

HongKong

| srael

I ndi a

Italy

Japan

Kuwai t

Mexi co

Ni geri a

Net her | ands

Si ngapore

Uni ted Ki ngdom

United States of America

Zanbi a

Zi mhabwe
REG ON_NAME

Asi a
M ddl e East and Africa

REG ON_I D

A BN PFP OFRMANMNDEOPRP O WOWER™ARPRFPRPOWEPDNDNNDE®WNDN

result

For other scripts, for instance a script containing INSERT statements, you may only want to see the log

messages:

./ dbvi scnd. sh -connection "Oracle" -sqlfile "nyscript.sql" -output
select * fromhr.countries;

INFO 16:52:56 [SELECT - 25 row(s),
sel ect * from hr.regions;

0. 013 secs] Result set fetched

| og
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INFO 16:52:56 [SELECT - 4 row(s), 0.002 secs] Result set fetched
SUMVARY: ... 2 statenent(s) executed, 29 row(s) affected, exec/fetch time: 0.015/0.002 sec
[2 successful, O warnings, O errors]

21.2.4 Combining OS scripts, the command line interface and
DbVisualizer variables

For more complex tasks, you can call the command line interface from a shell script, for instance a Bourne shell
script on Unix or a BAT file on Windows. You can also use DbVisualizer variables to pass information between
the shell script and the SQL script. In this example, we have a simple SQL script (cmdtest.sql) that contains a
SELECT statement with a variable in place for the table name:

cmdtest.sql

select * from ${table}$

A text file (tables.txt) contains the table names we want to execute the SQL script with:

tables.txt

hr.countries
hr. regi ons

In a command shell (Bourne or Bash), we can then execute the script using the table names from the text file:

for name in “cat tables.txt’;
do ./dbviscnd.sh -connection "Oracle" -sql "@un cndtest.sql \${table|]|$nane|]|]|]|nobind}\$; ";

done

@un /Users/hans/tnp/cndtest.sqgl ${table||hr.countries]||||nobind}$;

INFO 17:08:16 [@RUN - O rowms), 0.000 secs] Conmand processed

select * fromhr.countries;

INFO. 17:08:16 [SELECT - 25 row(s), 0.012 secs] Result set fetched

COUNTRY_I D COUNTRY_NAME REG ON_I D

AR Argentina

AU Australia

BE Bel gi um

BR Brazi |

CA Canada

CH Swi tzerl and

CN Chi na

DE Ger many

DK Denmar k

EG Egypt

FR France

HK HongKong

W Rk MR FP OFRPNMNNDEFE ®ONDN
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IL | srael 4
I'N I ndi a 3
IT Italy 1
JP Japan 3
KW Kuwai t 4
MX Mexi co 2
NG Ni geri a 4
NL Net her | ands 1
SG Si ngapore 3
UK Uni ted Ki ngdom 1
us United States of Anerica 2
M Zanbi a 4
AL Zi mhabwe 4
SUMMARY: ... 2 statement(s) executed, 25 row(s) affected, exec/fetch time: 0.012/0.002 sec

[2 successful, O warnings, O errors]

@un /Users/hans/tnp/ crdtest.sqgl ${tabl e|| hr.regions||||nobind}$;
INFO 17:08:18 [@RUN - O row(s), 0.000 secs] Command processed
select * from hr.regions;

INFO 17:08:18 [SELECT - 4 row(s), 0.013 secs] Result set fetched
REG ON_ID REG ON_NAME

1 Eur ope

2 Arrer i cas

3 Asi a

4 M ddl e East and Africa

SUMVARY: ... 2 statenent(s) executed, 4 row(s) affected, exec/fetch time: 0.013/0.000 sec

[2 successful, O warnings, O errors]

The command line interface is called with the - sgl option, specifying the client-side command @ un (see page
179). A DbVisualizer variable (see page 221) is passed to the @ un command with the value taken from the
shell variable. This DbVisualizer variable value is then available to the script executed by the @ un command.

Note that you may need to escape certain characters that the shell would otherwise interpret, like the dollar
signs that are part of the DbVisualizer variable delimiters.
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22 Database Profiles

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

A Database Profile is the foundation for database specific support in DbVisualizer. Technically the database
profile is a single XML file specifying what object types, actions and viewers/editors should be available in the
DbVisualizer user interface for a specific database.

22.1 Understanding Database Profiles

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

A database profile is, somewhat simplified, a definition of the kind of information that is presented in the
database objects tree and in the various object views for a specific database engine. In addition, the profile
defines the actions for the object types defined in the profile. DbVisualizer loads the matching database profile
when you connect to a database. If no matching profile is found, or if you are running DbVisualizer Free,
DbVisualizer uses a Generic profile with just the general database information and actions included.

DbVisualizer Pro currently offer database specific support (database profiles) for the following databases (click
links for details):

® DB2 LUW (http://www.dbvis.com/doc/db2-luw-database-support/)

® H2 (http://www.dbvis.com/doc/h2-database-support/)

® |nformix (http://www.dbvis.com/doc/informix-database-support/)

® JavaDB/Derby (http://www.dbvis.com/doc/javadb-derby-database-support/)
® Mimer SQL (http://www.dbvis.com/doc/mimer-database-features/)

®* MySQL (http://www.dbvis.com/doc/mysqgl-database-support/)

® NuoDB (http://www.dbvis.com/doc/nuodb-database-support/)

® QOracle (http://www.dbvis.com/doc/oracle-database-support/)

® PostgreSQL (http://www.dbvis.com/doc/postgresgl-database-support/)
® SQL Server (http://www.dbvis.com/doc/sqglserver-database-features/)
® SQLite (http://www.dbvis.com/doc/sglite-database-support/)
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® Sybase ASE (http://www.dbvis.com/doc/sybase-ase-database-support/)
® Vertica (http://www.dbvis.com/doc/vertica-database-support/)

The specialized database profiles define different object types, so the database objects tree may look different
depending on which database you are connected to. The structure and organization of a database profile is also
something that may impact the layout of the tree, even though the provided ones are similar in their structure.
There are two root nodes in the majority of the provided profiles:

® Schema Objects
®* DBA objects

Schema objects are, for example, tables, views, triggers, and functions, while DBA objects most often are
objects that require administration privileges in the database in order to access them. The convention in
DbVisualizer is to put all DBA objects under the DBA Views tree node. If you connect to a database using an
account with insufficient privileges to access a DBA object, you may see error messages if you try to select
nodes under the DBA Views node. The following is an example of the DBA sub tree for Oracle:

-1 (£} DBA Views

+& sers
+- 4@ Roles
+1- iy Sessions

..... Iéﬁ LDI:kS

+f';'L Recyde Bin

+ Resource Manager

+1__;H Storage

+-ff Scheduler

+-{§) Statistics

“{ [ SGA
For databases that have no specific profile, DbVisualizer uses the Generic profile. DbVisualizer supports a wide
range of databases. The nature of the databases and what they support differ from vendor to vendor, so the
appearance and structure of the tree below the database connection objects for different databases differ as
well. The generic database profile (the only profile available in DbVisualizer Free) displays objects based on
what JDBC offers in terms of database information (aka metadata information). DbVisualizer asks the JDBC
driver for all schemas, databases, tables and procedures, and then builds the tree based on what the driver
returns.

The advantage of using JDBC to get database metadata is that it is a standard way to access the information,
independent of the database engine type; the JDBC driver layer hides the proprietary details about where and
how the information is really stored. The drawback with using JDBC is that JDBC doesn't offer access to all
metadata a database may hold. While the information presented by the generic profile, with its reliance on JDBC
, is sufficient for many tasks, a database specific profile offers far more details as well as more features. If you
use DbVisualizer Free with one of the databases supported by database specific profiles, you may want to
upgrade to the DbVisualizer Pro edition.

The generic database profile when used for an Oracle connection look as follows:
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X
. B+ 4} HR (Default )
#1-{7] SYNONYM
#-{ 7] TABLE
#-f] VIEW
+ hj} Procedures
The appearance of the generic database profile may include schema objects and/or catalog objects depending
on whether the database supports these objects. The Procedures object always appear in the tree, regardless of
if the database connection supports procedures or not. There is no DBA Views node in the generic profile.

22.1.1 Affected DbVisualizer features

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

One of the most important and central features in DbVisualizer is the database objects tree, used to navigate
databases, and the object view, showing details about specific objects. The general problem exploring any
database is that they are all different with respect to the information describing what's in the database (also
called system tables or database meta data). This basically means that it's rather complex to implement a
multi-database support product, such as DbVisualizer, since each database must be handled specifically. All
databases also support different object types, apart from the most common ones, such as table, view, index, etc

The database profile framework is used to simplify the process of defining what information DbVisualizer will
display and operate on for a specific database. Technically, a database profile is an XML file with all of the logic,
structure and actions mapped to the visual components in DbVisualizer. Another great benefit of separating the
database specific logic from the implementation of DbVisualizer is that anyone with some degree of domain
knowledge can create a database profile. All that is needed is a text editor (preferably with XML support) and
some ideas of what should be the final result.

A great source for inspiration (except for related sections in the users guide) is all the existing database profiles
that comes with DbVisualizer. All database profiles that comes with DbVisualizer are stored in the DBVI S- HOVE

/ resour ces/ profil es directory (exact path is OS dependent).

The following figure illustrates which features in DbVisualizer are controlled by the database profile.

Page 320 of 428



S . - .
\—Q\ DbVisualizer 9.2 Users Guide
|8l DbVisualizer Personal - Untitled E@

File Edit View Database Scripts 50QL Tools Window Help
W5 HBea 8O OKQ
4 | []B10 []EMPLOYEES (] Statistics 4 ADD_JOB_HISTORY () Locks || Computers per Employee.sgl
ﬂ Databases .1:; Scripts la Object View p 5QL Commander
$°|?|'i|ﬁl i Table: BIO
Connections
[ CRM Ahoa
L:_Iﬁ Schemas
=4} HR ( Default )
(=[] Tables FE G R A2 p
R |s10 |
wicounmes || B O3 H
({77 DEPARTMENTS
- {77] EMPLOYEES Mame [ Value |
B-[7] J0B_HISTORY OWNER HR i
i {77 J0BS TABLE_NAME BIC
=-{7] LOCATIONS TABLESPACE_NAME USERS
ixl-{7] REGIONS || [CLUSTER_NAME (nulty
&[] Views IOT_NAME (null) L
- @ Synanyms STATUS VALID r
(- Indexes
(@9 Sequences PCT_FREE 10
i} £=3 Materialized Views PCT_USED (nulty
[+ {mg Functions INI_TRANS 1 R
[ Procedures MAX_TRANS 255
- Packages INITIAL_EXTENT 65536
- (1l Package Bodies NEXT_EXTENT (null}
- & Java Sources MIN EXTENTS 1
g:. o Closses MAX_EXTENTS 2147483645
& & Object Types PCT_INCREASE {nully
-2 Recyde Bin FREELISTS {nully
-4 Jobs FREELIST_GROUPS (nully
- Scheduler LOGGING YES
el Database Links BACKED_UP N
[}-& Invalid Objects HUM_ROWS 107
ﬂ Session Properties BLOCKS 5
[3"@ DEA Views 7| lcmanTy o1 nree n i

The red box at the left shows the database objects tree. This tree is used to navigate the objects in the
database. Selecting an object in the tree shows the object view (blue box) for the selected object type. An
object view may have several data views (green), showing object information. DbVisualizer shows these as
labeled tabs. The green box in the screenshot shows the content of the data view labeled Columns. The type of
viewer that is presenting the data in the screenshot is the grid viewer. Read more about all data viewers in the
Viewers (see page 355) section.

Common to both the database objects tree and the object view are the SQL commands that are used to fetch
the information from the database. The associated SQL is executed by DbVisualizer whenever a node in the
tree is expanded (to expose any child objects) or when a node is selected (to fill the object data views).
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Right-clicking the mouse on an object in the tree or clicking the Actions button in the object view shows a menu
with all valid actions for the selected object. These are also defined per database profile and object type. Read
more about the capabilities of actions in the definition of user actions (see page 371) section.

The mapping from the visual components in the user interface described earlier and the element definitions in
the XML file is, briefly, as follows:

®* The database objects tree (green box) is described by the ObjectsTreeDef (see page 345) root element,

® The object views (green and blue boxes) are described by the ObjectsViewDef (see page 355) root
element,
The commands used to execute the SQL to get the information for ObjectsTreeDef, ObjectsViewDef and
ObjectsActionDef definitions are defined by the Commands (see page 339) root element,

® All Actions for an object are defined by the ObjectsActionDef (see page 371) root element.

22.1.2 How a Database Profile is loaded

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

DbVisualizer automatically detect what database profile to use based on the Database Type setting for a
database connection. A database profile can also be manually specified in the connection properties.

A database profile is located using the search paths defined in Connection Properties tab and the Database
Profile category. The standard directories in the search path are:

1. PREFSDI Rl ext | profile
2. DBVI S- HOVE| resour ces\ profil es

PREFSDIR is the . dbvi s directory located in the users home directory and it keeps all user settings for
DbVisualizer. The list of paths may be reorganized and directories can be added. Profile files are searched in
the specified order.

If the actual database profile is found in the search path it is loaded and any parent profile(s) it extends are also
loaded and finally merged.

If there is no matching profile or if using the DbVisualizer Free edition then the generic profile is automatically
used. This is very basic profile and shows only rudimentary information about the objects in the database and
should support most databases with a JDBC driver.

A database profile other than the generic is built for a specific database. Manually selecting for example a
database profile for Oracle while connecting to DB2 will result in all sorts of errors.
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22.2 Creating a Database Profile

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

At a first glance creating and developing a database profile in XML may seem difficult. However, all definitions
forming the functionality for a specific database are expressed in a single file and the XML elements are well
formed. The general recommendation is to use one of the existing database profiles as base (copy/paste) and
then step-by-step modify it for the actual database. You may use an external text editor (preferably with XML
support) or the SQL editor in DbVisualizer to edit the file. Once new changes has been made, save the file,
reconnect the database connection in DbVisualizer to test the layout and functionality changes.

Creating a new database profile should only be made for databases with no database profile available. If you
are looking into changing one of the existing database profiles by adding or modifying existing functionality, it
should be extended.

@  For information where custom database profiles should be saved check the How a Database Profile is
loaded (see page 322) is section.

For more information how to create a new database profile or extending an existing database profile check
the Extending a Database Profile (see page 323) section.

22.3 Extending a Database Profile

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

* Extending Commands (see page 324)

® Extending Database Objects Tree (see page 325)
® Extending Actions (see page 329)

® Extending Object Views (see page 330)

® Remove an Element (see page 331)
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® Complete sample Database Profile (see page 331)

All database profiles must extend the generic database profile. The generic profile handles the very basic object
types in a relational database such as Tables, Columns, Indexes and Procedures. Its implementation is based
entirely on what the JDBC driver provide in terms of database meta data. Due to the tight connection between
the generic profile and the JDBC driver, the generic profile can be used to access almost any database with a
JDBC driver.

The selection on what database profile should be used is determined with the Database Type setting for the
database connection. Some of the database types that can be picked have a dedicated database profile with
extended support while others have not. For databases with no database profile available, the generic one is
used. It is also possible to manually chose the generic profile in the Connection Properties / Database
Profiles settings.

The most important area in the database profile as seen from the DbVisualizer user interface is the section
describing the database objects tree. This is the browser or navigator showing database objects. This is also
the place that connects actions used to operate on database objects and views (not database views) used to
display detailed information.

This section of the users guide is mainly focused on extending an existing database profile (not the generic
profile) rather than creating a completely new profile (which should extend the generic database profile).

@ Extending a database profile is not only about adding functionality to an existing profile but also the
process of changing and removing existing definitions in any of the profiles that are extended.

22.3.1 Extending Commands

Extending the Commands and InitCommands elements is simple as every command should be uniquely
identified. To add a Command just insert the new command.

<Commands extends="true">
<Command i d="sanpl e. get Logi nSchena" >
<SQL>
<! [ CDATA[
sel ect ' ${schena}' as schema from dual
11>
</ SQL>
</ Command>
</ Conmands>

To override the definition of an existing command in the parent profile, just make sure the id of the new
command match the id of the parent profile command. It will then be replaced.
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22.3.2 Extending Database Objects Tree

Extending or modifying the database objects tree (ObjectsTreeDef) require some attention since the
modifications must match the exact object paths as defined in the parent profile. The object path is determined
by the GroupNode and DataNode structure in the ObjectsTreeDef with the addition of the type attribute. The
following is an example of the object path to the Columns sub node for a Table node:

GroupNode[ @ ype=' Schenas' ]/ Dat aNode[ @ ype=' Scherma' ]/ G oupNode[ @ ype=' Tabl es' ]/ Dat aNode[ @ ype="' Tabl e
']/ G oupNode[ @ ype=" Col ums' ]

(The analyze database profile (see page 398) utility will report object paths in the above xpath (http://
www.w3schools.com/xpath/) format).

@ The hierarchy of GroupNode and DataNode is important when extending the database objects tree
since the exact same hierarchy must be implemented in the extended profile. This also involve any
conditional elements such as If/Else/Elself that are used in the parent profile.

Consider the following example showing the objects tree (for Oracle) with the Schemas node being expanded to
show all schemas in the database:

& anonymMous
5 APEX_040000
&l APEX_PUBLIC_USER
i APPA
g crxsys
4 FLOWS_FILES
+ ;ﬁ', HR (Default)
& MDsys
§l ouTLN
& PuBLIC
1} ROPPE
5 svs
£ SYSTEM
5 xos
5 xssnuLL
5| Session Properties
£ &) DBA Views
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Instead of showing all schema objects in the database we want to adjust so that only the default schema is
displayed at the top level (below the Oracle database connection node). The default schema node should in
addition only show table objects rather than all 20 (or so) object types being displayed in the standard Oracle
database profile.

m Oracle (sample database profile)

= GI' My Schema: HR  (Default)
7| BLOBTEST
7] couNTRIES

|| DEPARTMENTS

| EMPLOYEES

| ENCTEST

| JOB_HISTORY

| J08BS

| LOCATIONS

| PURCHASEORDER

| REGIONS

7] RONALD

[ TESTTABLE

7] ¥MLTYPE_TEST

All Schemas

5| Session Properties
#- (&) Database Administration

e .

The previous screenshot shows the new My Schema: HR node at the top while the Schemas node has been
renamed All Schemas. To accomplish the above a custom database profile has been created in the ${

dbvi s. prefsdir}/ext/profil es/sanpl e-ext-oracle.xnl file with the following content required for
the ObjectsTreeDef definition:

<!--Commands used in this profile-->
<Conmmands extends="true">
<Command i d="sanpl e. get Logi nSchena" >
<SQL>
<! [ CDATA[
sel ect '${schenma}' as schema from dual
11>
</ SQL>
</ Command>
</ Conmands>
<bj ect sTreeDef extends="true">
<I--The followi ng "Schema" definition shows the |ogin schema directly bel ow->
<l--the Database Connection for fast access. It is limted to only show->
<l--tables (by setting the "Table" DataNode to isLeaf="true")-->
<Dat aNode type="Schema" | abel ="My Schema: ${sanpl e. get Logi nSchenma. SCHEVA} "
i con="MySchema" order-before="0">
<Set Var nane="schenma" val ue="${sanpl e. get Logi nSchena. SCHEMA} "/ >
<Command i dref ="sanpl e. get Logi nSchema" >
<l nput nane="schema" val ue="${#db. | ogi nSchema}"/>
</ Commrand>

Page 326 of 428



N |
= DbVisualizer 9.2 Users Guide

<Dat aNode type="Tabl e" | abel ="${get Tabl es. TABLE_NAME} "
sort="get Tabl es. TABLE_NAMVE" |slLeaf="true">
<Set Var nane="obj ect nanme" val ue="${get Tabl es. TABLE_NAME}"/ >
<Set Var nane="rowcount" val ue="true"/>
<Set Var nanme="accept| n@" val ue="true"/>
<Command i dref="oracl e. get Tabl es">
<l nput nane="owner" val ue="${schema}"/>
<Qut put i d="get Tabl es. TABLE_SCHEM' i ndex="1"/>
<Qut put | d="get Tabl es. TABLE_NAME" | ndex="2"/>
<Filter type="Table" nane="Table">
<Col umm i ndex="TABLE_NAME" nane="Nane"/>
</Filter>
</ Command>
<!--These are needed for the viewers defined in the parent profile-->
<l--associated with the "Table" type-->
<Set Var nanme="t heTabl eNane" val ue="${obj ect nane}"/>
<Set Var nanme="t hePar ent Nane" val ue="${obj ect nane}"/>
<Set Var name="triggersCondition"
val ue="and tabl e_nane = ' ${theTabl eNane}"'"/>
</ Dat aNode>
</ Dat aNode>
<!--Renam ng the standard Schemas node to "All Schemas"-->
<G oupNode type="Schemas" | abel="All Schemas"/>
</ Obj ect sTr eeDef >

In the Commands section there is a new Command that run a dummy SQL SELECT only to create a result set
containing a single row/column with the value of the ${schema} variable. The value for the ${schema} variable
is provided in the Command element for DataNode type="Schema" using the ${#db.loginSchema} variable
value as input. This variable is maintained by DbVisualizer and contain the login schema as specified in the
connection setup. For Oracle this is the userid.

<Conmmand i dref ="sanpl e. get Logi nSchema" >
<l nput nane="schema" val ue="${#db. | ogi nSchema}"/ >
</ Commrand>

The command above is used to present the default schema as in the following DataNode declaration.

<Dat aNode type="Schema" | abel ="My Schema: ${sanpl e. getLogi nSchema. SCHEVA} "
i con="MySchema" order-before="0">
<Set Var nane="schema" val ue="${sanpl e. get Logi nSchena. SCHEMA} "/ >
<Command i dref ="sanpl e. get Logi nSchenma" >
<l nput nane="schema" val ue="${#db. | ogi nSchema}"/ >
</ Commrand>
<Dat aNode type="Tabl e">
</ Dat aNode>
</ Dat aNode>
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The label for this Schema type is label="My Schema: ${sample.getLoginSchema.SCHEMA}". The ${
sample.getLoginSchema . SCHEMA } variable name consists of two parts, the name of the command:
sample.getLoginSchema and the column name: SCHEMA in the result set the produced by the command.

As a sub node to the My Schema node there is the DataNode type="Table" definition for the Table object type.
The complete declaration for the Table element and its sub elements has been copied from the parent profile:

<Dat aNode type="Tabl e" | abel ="${get Tabl es. TABLE_NAME} "
sort="get Tabl es. TABLE_NAME" | slLeaf="true">

<Set Var nane="obj ect name" val ue="${get Tabl es. TABLE_NAME}"/ >
<Set Var name="rowcount" val ue="true"/>
<Set Var nanme="accept| n@" val ue="true"/>
<Conmmand i dref="oracl e. get Tabl es">

<l nput name="owner" val ue="${schema}"/>

<Qut put i d="get Tabl es. TABLE_SCHEM' i ndex="1"/>

<Qut put i d="get Tabl es. TABLE_NAME" i ndex="2"/>

<Filter type="Table" name="Tabl e">

<Col umm i ndex="TABLE_NAME" nane="Nane"/>

</Filter>
</ Commrand>
<l--These are needed for the viewers defined in the parent profile-->
<l--associated with the "Table" type-->
<Set Var nane="t heTabl eName" val ue="${obj ectnane}"/>
<Set Var nanme="t hePar ent Nane" val ue="${obj ect nane}"/>
<Set Var name="triggersCondition"

val ue="and tabl e_nane = ' ${theTabl eNane}"'"/>
</ Dat aNode>

The Table objects in the extended profile should not show any sub nodes such as columns or triggers and these
declarations are then removed in the copied DataNode for the Table object. The isLeaf="true" attribute
specifies that there will be no child nodes.

The new All Schemas node in the extended profile is supposed to have the exact same content and definition
as in the parent profile when it was called Schemas. The following definition will just rename the label of the
existing node.

<G oupNode type="Schemas" | abel ="All Schemas"/>

This example show adding a new Role node under all DBA / Users / User objects.

In the parent Oracle profile there are no child nodes below User. To handle this all nodes from DBA down to
User must be specified (aka the object type path). The only requirement is that the type attribute is specified and
that it match the type in the parent profile. In addition, this example specify the label attribute for some of the
nodes just to show that overridden attributes will replace any parent equvivalent node attributes.

@
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Only attributes for GroupNode and DataNode can be overridden. If you need to override for example
a SetVar in a DataNode then all of the attributes in the DataNode and all its sub elements must be
specified.

<G oupNode type="DBA" | abel =" Dat abase Admi ni strati on">
<G oupNode type="Users">
<I--The "User" type don't allow child nodes in the parent profile.-->
<I--Setting isLeaf="false" is needed to override this and allow the-->
<!--new "Rol e" child node-->
<Dat aNode type="User" islLeaf="false">
<!--Here cones the new child "Rol e" DataNode-->
<Dat aNode type="Rol e" isLeaf="true"
| abel ="${oracl e. get Grant eeRol es. GRANTED_ROLE} - ext">
<Set Var nane="obj ect nane"
val ue="${oracl e. get G ant eeRol es. GRANTED_ROLE} "/ >
<Conmand i dref="oracl e. get G ant eeRol es" >
<l nput nanme="grantee" val ue="${object nane}"/>
</ Commrand>
</ Dat aNode>
</ Dat aNode>
</ G- oupNode>
</ G oupNode>

The following are specified only to redefine the position of the Locks and Sessions nodes. One of order-before
and order-after attributes are used to either identify a type for which the node should be positioned before or
after, or an index. The index is the fixed position or 0 which means first or a somewhat high number means last.
The following will move the Sessions first among the DBA child nodes.

<G oupNode type="Sessions" order-before="0"/>
<!--The following will nove the "Locks" node before "Sessions"-->
<G oupNode type="Locks" order-before="Sessions"/>

22.3.3 Extending Actions

Extending ActionGroup and Action elements follow the same rules as for extending ObjectsTreeDef (see page
325) section. The following example show removing the oracle-schema-stringsearch action for the Schema
object type in the parent profile. A new ActionGroup: Extended Schema Actions is added with a single new
Action: sample-schema-sample-action.

<Obj ect sActi onDef extends="true">
<Acti onG oup type="Schem">
<I--Renove action fromparent profile for "Schema"-->
<Action id="oracl e-schema-stringsearch" action="drop"/>
<!--Adds an "Extended Schema Actions" sub nenu in the "Schena" actions menu-->
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<ActionG oup type="sanpl e-schema-test" | abel ="Extended Schena Actions">
<!--Sanple action that does not hing-->
<Action id="sanpl e-schema-sanpl e-action" | abel ="Sanpl e Action"
rel oad="true" resetcatal ogs="true" icon="renove">
<l nput |abel ="Text Field" nane="textField" style="text" editable="true"/>
<Comrand>
<SQ.><! [ CDATA[ Sanpl e Action "${textField}"]]></SQ>
</ Command>
<Confirnp
Real |y run Sanple Action "${textField}"?
</ Confirne
<Resul t >
Sanpl e Action "${textField}" processed!
</ Resul t >
</ Acti on>
</ Acti onG oup>
</ ActionG oup>
</ Obj ect sAct i onDef

22.3.4 Extending Object Views

Extending ActionGroup and Action elements follow the same rules as for extending ObjectsTreeDef (see page
325) section.

<Obj ect sVi ewDef extends="true">
<!--Schema is dropped in the Oracle profile. Redefine it here and show the-->
<l--dictionary views. That data is really not associated with the single schenma-->
<l--defined in this profile but is a way to have it quickly accessed from->
<!--a single node.-->
<Obj ect Vi ew t ype="Schena" >
<Dat aVi ew | d="sanpl e-schena-di ct" | abel ="Di cti onary"
i con="sanpl e-schema-dict" viewer="grid">
<Command | dref="sanple.getDict"/>
<Message>
<! [ CDATA[
<htm >
Sinmpl e viewer showing all dictionary tables with description. Easily accessed
by opening the Schema viewer since that is enpty anyway in the
parent <b>oracl e</b> profile.
</htm >
11>
</ Message>
</ Dat aVi ew>
</ Obj ect Vi ew>
</ Cbj ect sVi ewbef >

Page 330 of 428



1\

DbVisualizer 9.2 Users Guide

22.3.5 Remove an Element

Removing an object in the parent profile is easy, just add the action="drop" attribute to any of GroupNode,
DataNode, ObjectView, DataView, ActionGroup and Action elements. If there are any sub elements for the

object being dropped these are also removed.

22.3.6 Complete sample Database Profile

This document describe the different parts of a extended sample database profile for an Oracle database. Here

follow the complete sample database profile.

<?xm version="1.0" encodi ng="UTF-8" ?>
<! DOCTYPE Dat abaseProfil e SYSTEM "dbvi s-defs. dtd">

<Dat abaseProfil e desc="Sanple profile extending the Oracle profile"

ext ends="oracl e">
<!--Commands used in this profile-->
<Comands extends="true">
<Command i d="sanpl e. get Logi nSchena" >
<SQL>
<! [ CDATA[
sel ect ' ${schenma}' as schena from dua
11>
</ SQL>
</ Conmand>
<Command i d="sanpl e.getDict">
<SQL>
<! [ CDATA[
select * fromdict order by table_nane
11>
</ SQL>
</ Command>
</ Conmands>
<bj ect sActi onDef extends="true">
<Acti onG oup type="Schem">
<I--Renove action fromparent profile for "Schema"-->
<Action id="oracl e-schema-stringsearch" action="drop"/>

<!--Adds an "Extended Schema Actions" sub nenu in the "Schema"

actions nenu-->

<ActionG oup type="sanpl e-schena-test" | abel ="Extended Schena Actions">

<l--Sanpl e action that does nothing-->

<Action id="sanpl e-schema-sanpl e-action" | abel ="Sanpl e Action"

rel oad="true" resetcatal ogs="true" icon="renove">
<I nput | abel ="Text Field" nanme="textField" style="text"

<Comand>

<SQL><![ CDATA[ Sanpl e Action "${textField}"]]></SQ>

</ Command>
<Confirnp
Real ly run Sanple Action "${textField}"?

edi tabl e="true"/>
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</ Confirne
<Resul t >
Sanpl e Action "${textField}" processed!
</ Resul t >
</ Action>

</ Acti onG oup>
</ Acti onG oup>
</ Cbj ect sAct i onDef >
<Obj ect sTreeDef extends="true">
<!--The followi ng "Schema" definition shows the |ogin schema directly bel ow->
<!--the Database Connection for fast access. It is limted to only show->
<!--tables (by setting the "Table" DataNode to isLeaf="true")-->
<Dat aNode type="Schenma" |abel ="My Schema: ${sanpl e. get Logi nSchema. SCHEVMA} "
i con="MySchema" order-before="0">
<Set Var nane="schema" val ue="${sanpl e. get Logi nSchenma. SCHEMA} "/ >
<Command i dref ="sanpl e. get Logi nSchema" >
<l nput nane="schema" val ue="${#db. | ogi nSchena}"/>
</ Command>
<Dat aNode type="Tabl e" | abel ="${get Tabl es. TABLE_NAME} "
sort="get Tabl es. TABLE_NAME" | slLeaf="true">
<Set Var nane="obj ect nanme" val ue="${get Tabl es. TABLE_NAME}"/ >
<Set Var nane="rowcount" val ue="true"/>
<Set Var nanme="accept| n@" val ue="true"/>
<Conmand i dref="oracl e. get Tabl es">
<l nput name="owner" val ue="${schema}"/>
<Qut put | d="get Tabl es. TABLE_SCHEM' i ndex="1"/>
<CQut put i d="get Tabl es. TABLE_NAME" | ndex="2"/>
<Filter type="Table" nane="Table">
<Col um i ndex="TABLE_NAME" nane="Nane"/>
</Filter>
</ Comrand>
<!--These are needed for the viewers defined in the parent profile-->
<!--associated with the "Table" type-->
<Set Var nanme="t heTabl eNane" val ue="${obj ect nane}"/>
<Set Var nanme="t hePar ent Nane" val ue="${obj ect nane}"/>
<Set Var nane="triggersCondition"
val ue="and tabl e_nane = '${theTabl eNane}"'"/>
</ Dat aNode>
</ Dat aNode>
<!--Renam ng the standard Schenas node to "All Schemas"-->
<G oupNode type="Schenmas" | abel ="All Schemas"/>
<I--The main purpose with the following is to add a "Role" child DataNode -->
<!--for each "User". In the parent Oracle profile there are no child-->
<!--nodes below "User". To handle this all nodes from "DBA" down to "User"-->
<!--must be specified (aka the object type path). The only requirenent is that-->
<l--the type attribute is specified and that it match the type in the parent profile.-->
<l--1n addition, this exanple specify the |abel attribute for some of the-->
<l--nodes just to show that overridden attributes will replace any parent-->
<!l--equvival ent node attributes.-->
<G oupNode type="DBA" | abel =" Dat abase Admi nistration">
<G oupNode type="Users">
<I--The "User" type don't allow child nodes in the parent profile.-->
<l--Setting isLeaf="false" is needed to override this and allow the-->
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<!--new "Rol e" child node-->
<Dat aNode type="User" isLeaf="false">
<!--Here conmes the new child "Rol e" DataNode-->
<Dat aNode type="Rol e" isLeaf="true"
| abel ="${oracl e. get G ant eeRol es. GRANTED_ROLE} - ext">
<Set Var nane="obj ect nane"
val ue="${oracl e. get G ant eeRol es. GRANTED_ROLE} "/ >
<Command i dref="oracl e. get G ant eeRol es" >
<l nput nane="grantee" val ue="${objectname}"/>
</ Command>
</ Dat aNode>
</ Dat aNode>
</ G oupNode>
<I--The following are specified only to re-define the position of the-->
<l--"Locks" and "Sessions" nodes. One of "order-before" and "order-after" -->
<l--attributes are used to either identify a type for which the node shoul d-->
<!--be positioned before or after, or an index. The index is the fixed-->
<l--position or 0 which means first or a sonewhat hi gh nunber neans |ast.-->
<I--The following will nove the "Sessions" first anong the "DBA"-->
<l--child nodes-->
<G oupNode type="Sessions" order-before="0"/>
<!--The following will nove the "Locks" node before "Sessions"-->
<G oupNode type="Locks" order-before="Sessions"/>
</ Gr oupNode>
</ Cbj ect sTr eeDef >
<bj ect sVi ewbef extends="true">
<l--Schema is dropped in the Oracle profile. Redefine it here and show the-->
<l--dictionary views. That data is really not associated with the single schena-->
<l--defined in this profile but is a way to have it quickly accessed from->
<l--a single node.-->
<Obj ect Vi ew t ype="Schenma" >
<Dat aVi ew i d="sanpl e-schenma-di ct" | abel ="Di cti onary"
i con="sanpl e-schema-di ct" viewer="grid">
<Conmmand i dref="sanple.getDict"/>
<Message>
<! [ CDATA[
<htm >
Si npl e viewer showing all dictionary tables with description. Easily accessed
by opening the Scherma viewer since that is enpty anyway in the
parent <b>oracl e</b> profile.
</htm >
11>
</ Message>
</ Dat aVi ew>
</ Cbj ect Vi ew>
</ Obj ect sVi ewDef >
</ Dat abaseProfi | e>

22.4 Top level XML Elements
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@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

The top level XML elements in a database profile is as follows:

® |nitCommands (see page 336) (optional)
Defines SQLs that are executed before the profile is being loaded,
¢ Commands (see page 339)
Defines the SQLs for the ObjectsTreeDef, ObjectsViewDef and ObjectsActionDef,
® ObjectsActionDef (see page 371) (optional)
Defines actions for object types,
® ObjectsTreeDef (see page 345)
Defines the structure and what objects should be visible in the objects tree,
®* ObjectsViewDef (see page 355)
Defines the object views for a specific object type.

All database connections loads a database profile from an XML file and if there is no matching database profile,
the generic profile is used. This profile use standard JDBC metadata requests to obtain information about the (
some) objects in the database. The generic profile is located in DBVI S- HOVE\ r esour ces\ profi | es\
generic.xm .

22.4.1 XML template

The following show an overview of a database profile with the top level XML elements.

<?xm version="1.0" encodi ng="UTF-8"?>
<! DOCTYPE Dat abaseProfil e SYSTEM "dbvi s-defs. dtd">
<Dat abaseProfil e desc="Profile for Sybase ASE"
ver si on="$Revi si on: 16166 $"
dat e="$Date: 2013-03-05 17:25:05 +0100 (Tue, 05 Mar 2013) $"
m nver="9. 1"
ext ends="generic">
<l ni t Commands extends="true">

</ I ni t Conmands>
<Conmands extends="true">

</ Commands>
<bj ect sAct i onDef extends="true">

</ Obj ect sActi onDef >
<Obj ect sTreeDef extends="fal se">
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</ Obj ect sTr eeDef >
<oj ect sVi ewbDef extends="true">

</ (bj ect sVi ewDef >

</ Dat abaseProfi | e>

The DOCTYPE identifier at row 2 defines the DTD that is used to validate the XML.

The root element for the database profile framework is the DatabaseProfile (see page 335) element setting
various attributes. Continue to the next sections for information about XML elements forming a database profile.

22.4.2 XML element - DatabaseProfile

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

The DatabaseProfile is the root element in the XML file. It is required and have the following attributes:

<Dat abaseProfil e desc="Profile for Sybase ASE"
ver si on="$Revi sion: 16166 $"
dat e="$Date: 2013-03-05 17:25:05 +0100 (Tue, 05 Mar 2013) $"
m nver="9. 1"
ext ends="generic">

</ Dat abaseProfi | e>

Attribute Description

desc The description of the profile

version The version of the profile

date The timestamp when the profile was last modified

minver The minimum version of DbVisualizer that is required for the profile to work

extends The parent profile that is extended. In most situations at least generic should be specified

Most attributes except extends are informative and are displayed in the Database Profile list when selecting
the connection properties for a database connection:
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;..? Database Connection: Sybase ASE

Connections(Sybase ASE

@ Comnection | [ Database Info | 5 Data Types | @ Search|

tﬁ' Connection Properties
ol Database Profiles
E----Dri'u'er Properties Database profiles controls what objects appear in the objects tres, what detailed views are
Bti Sybase ASE available for each object type and actions used to operate on objects, Database profiles are
Authentication database specific and here you can either decide to let DbVisuslzer automaticaly pick
fimited Identif {recommended) the appropriste profile or manually choose one. If manually choosing 2
Delimited Identifiers profile make sure it is compatible with the database you are connecting to, The generic
~| £J Qualifiers profile works with any datsbase,
[_}.SE Physical Connection Mote: You must reconnect the database connection after changing prefile.
. Transaction B B -
S0L Statements i@ Auto Detect () Manually Choose (7 "Generic” Profile
' ' g‘;’_‘”et:hil‘_’” Ht“Esl Profile Version Date Description
quLEEdim:EE anes db2 11709  2009-12-17  Profile for DB2 LUW
=2 Query Builder db2-zos 117089 2009-12-17  Profile for DBZ z/03
derby 11709 2009-12-17  Profile for Apache Derby/JavaDB
generic 117049 20091217  Generic profile for any database
infarmix 117049 2009-12-17  Profile for Infarmix IDS
mimer 11651 2009-12-07  Profile for Mimer SCL
mysql 11708 2009-12-17  Profile for MySCL
neoview 11504 2009-10-30  Profile for HP Meoview
oracle 11709 2009-12-17  Profile for Oracle
postgresql 117049 2009-12-17  Profile for PostgreSQL
postgresgld 117049 20091217 Profile for PostgreS0L 8+
sqlsernver 11708 20091217 Profile for S0L Server
sybase-ase 117049 2009-12-17  Profile for Sybase ASE

Defaults

Properties

22.4.3 XML element - InitCommands

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the

licensed DbVisualizer Pro edition.

The InitCommands element define initialization commands (see page 339) that are executed just before the
rest of the database profile is loaded. These commands are typically used to determine characteristics of the
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target database and database session. The result of these commands are stored in variables that can be used
in conditions (see page 395) that are evaluated when the rest of the profile is loaded. A common use case is to
find out the authorization level of the current user as defined in the database. If the user have limited privileges
then some object types, views and actions should be disabled.

Multiple commands may be defined in the InitCommands element and these are executed in order.

The following sample is from the HP Neoview database profile. The main purpose with its commands is to first

determine the database version by quering a system table. Based on the database version a condition controls
which of two queries will be executed to find out another property from the database. The result of the executed
query is stored in a the METACAT variable.

<l ni t Conmands extends="true">
<Command i d="neovi ew. get DbVer si on" net hod="r unBef or eCondi ti onsEval ">
<SQL>
<! [ CDATA[
SELECT SUBSTRI NG( SYSTEM _VERSI ON FROM 10)
FROM ( GET VERSI ON OF SYSTEM V(SYSTEM VERSI ON)
11>
</ SQL>
<Qut put id="DBVERSI ON' index="1"/>
</ Command>
<Command i d="neovi ew. get Master">
<If test="#DBVERSI ON gte 2400">
<SQ.>
<! [ CDATA[
SELECT M N( SYSTEM CATALOGS) AS MASTER CAT
FROM ( GET SYSTEM CATALOGS) V( SYSTEM CATALOGS)
WHERE SYSTEM CATALOGS LI KE _| SO88591' NONSTOP_SQLMX_%
11>
</ SQL>
</If>
<El se>
<SqQL>
<!'[ CDATA[
SELECT ' NONSTOP_SQLMX_${ #dp. METACAT}'
FROM (VALUES(1)) AS T1
11>
</ SQL>
</ El se>
<Qut put id="METACAT" index="1"/>
</ Command>
</ | ni t Commands>

The extends="true" attribute specifies that the list of commands will extend the list of commands defined in the
profile being extended (see page 323).

Initialization commands are processed in two stages:
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1. First stage is to execute all commands having the attribute method="runBeforeConditionsEval" set. As
the attribute reveal, these commands are execute before any conditions are evaluated,

2. The second and last stage will execute all commands with no method="runBeforeConditionsEval" set.
This time any conditions are evaluated.

The reason for these stages is that the processing of initialization commands may also rely on conditions.

Here is an example how the new METACAT variable is used in the rest of the database profile:

<Command i d="neovi ew. get Cat al ogs" >

<SQL>
<! [ CDATA[
SELECT
TRI M CAT_NAME) AS CATALOG NAME
FROM
${ METACAT} . SYSTEM SCHEMA. CATSYS C
WHERE
CAT_NAME NOT LIKE _| SOB8591' NONSTOP_SQLMX_%
AND CAT_NAME NOT I N (_IS088591' NSMAEB', _| S088591' NVSCRI PT', _IS088591' METRI C
_1'S088591' VATRI X', _ I SO88591"' GENUSCAT', _|S088591" MANAGEABI LI TY')
ORDER BY

CATALOG_NAME
FOR READ UNCOWM TTED ACCESS

11>
</ SQL>
</ Conmand>

Here is another example for Oracle getting the instance_type property from the v$parameter table and put the
value in the INSTANCE_TYPE variable.

<l ni t Conmands extends="true">
<Command id="oracle.initCetlnstanceType" met hod="runBeforeConditionsEval ">

<sqQ>
<! [ CDATA[
sel ect value from v$paraneter where nane = 'instance_type';
11>
</ SQL>
<Cut put id="INSTANCE_TYPE" index="1"/>
</ Command>

</ 1 ni t Coomands>

Below show that only if INSTANCE_TYPE have the value RDBMS schema objects should be displayed in the
database objects tree:

<oj ect sTreeDef extends="fal se">
<If test="# NSTANCE_TYPE eq ' RDBMS' ">
<G oupNode type="Schemas" | abel =" Schemas" >
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</ G oupNode>
</lf>
<G oupNode type="Properties" |abel ="Session Properties" isLeaf="true"/>
<G oupNode type="DBA" | abel ="DBA Vi ews" >
</ G oupNode>
</ Obj ect sTr eeDef >

Click these links for more information about the command (see page 339) element and conditions (see page
395).

22.4.4 XML element - Commands

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

The Commands element is a simple grouping element for Command elements.

® XML element - Command (see page 339)
® Result Set (see page 341)
® XML element - Input (see page 343)
¢ XML element - Output (see page 344)

<Commands extends="true">
<Command id="profile.xxx">

</ Command>
</ Commands>

The extends="true" attribute specifies that the list of commands will extend the list of commands defined in the
profile being extended (see page 323).

XML element - Command

The main purpose with the Command element is to run a single SQL statement or a script of SQL statements.
In most cases, the script should return a result set with 0 or multiple rows with the exception for actions (see
page 371) which not necessarily need to return a result set, e.g., a "drop" action). The following show the
command element, its attributes and valid sub elements.
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<Conmand i d="sybase- ase. get Logi ns"
met hod="dynani c"
par sesql ="true"
continueonerror="fal se">

<SQL>
</ SQL>
<| nput >
</ | nput >
<CQut put >
</ CQut put >
<Filter>
</Filter>
</ Commrand>
Attribute Description
id The command element is identified with a unique id attribute. This id is referred in
ObjectsTreeDef (see page 345), ObjectsViewDef (see page 355) and ObjectsActionDef (see
page 371) definitions using the idref attribute. The id naming convention for command
elements is to prefix with the name of the profile and a dot. Example oracle.xxx,
sglserver.xxx, and so on.
method
®* dynamic
this is the default value and define that the SQL is a dynamic SQL statement as
opposed to setting it to JDBC which defines that the SQL is really a JDBC meta data
call
rather than SQL,
* jdbc
See description for dynamic,
* runBeforeConditionsEval
this value is only considered if the command is define in the InitCommands (see page
336) section.
parsesq|l The default behavior is that the SQL may contains multiple SQL statements each delimited

by a semi colon (":"). Set this attribute to false to disable multiple SQL statements.
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Attribute Description

If the SQL contain multiple SQL statements only one may produce a result set.

continueonerror = This attribute is only valid in combination with parseSQL="true" and if the SQL contain
multiple SQL statements. If one of SQLs fail execution will continue with the next. The
default value is false.

The following command queries login information in Sybase ASE.

<Conmand i d="sybase- ase. get Logi ns">
<SQL>
<! [ CDATA[
SELECT nanme "Nane", suid "SU D', dbnanme "Default Database", fullname "Full Nane",
| anguage "Default Language", totcpu "CPU Tine", totio "1/O Tinme", pwdate "Password Set"
FROM nmast er . dbo. sysl ogi ns ORDER BY 1

11>
</ SQL>
</ Command>

The id for this command is sybase-ase.getLogins. The reason for prefixing the id with the name of the profile is
that profiles can be extended and id's need to be unique.

@ This SQL example show a command with a SELECT statement using column aliases. If no aliases
are specified the column names should be used to refer the data.

Result Set
This is the result set for the previous query:

Name SUID Default Full Default CPU I/O Time Password Set
Database Name Language Time

jstask 3 master (null) (null) 0 10 2009-12-22 09:53:50

probe 2 subsystemdb (null) (null) 0 0 2009-12-22 08:37:35

sa 1 master (null) (null) 182 168723  2009-12-22 08:36:54

How DbVisualizer handle the result set depends on whether the command is executed as a request in the
database objects tree (ObjectsTreeDef) or in the object view (ObjectsViewDef). If executed in the database
objects tree, each row in the result set will be represented by a node in the tree. If executed in the object view, it
is the viewer component that decide how the result will be displayed.
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Another important difference between the database objects tree and the object view is that the tree is a
hierarchical structure of objects while the object view presents information about a specific object. An object that
is inserted in the database objects tree is a 1..1 mapping to a row from the result set. The end user will see
these objects (hodes) by some descriptive label, as defined in the ObjectsTreeDef. All data for the row from the
original result set is stored with the object in the tree and may be used in the label, variables, conditions, etc.
This is not the case in the ObjectsViewDef.

The following example put some light on this. Consider the previous result set and that it is used to create
objects in the database objects tree. The end user will see the following in DbVisualizer. (The label for each row

o8
E}--I_}‘] Databases
---| }J master { Default )
---| }J model
---| }J sybmamtdb
---| }J sybsystemdb
---| }J sybsystemprocs
- §| tempdb
= (£} DBA Views
e ﬁ server Info

[+-#% Database Devices
----- E m Remote Servers
-—-4ff Processes

(-4 Roles

Transactions
..... = LI:II:kS

Each of the jstask, probe and sa nodes have all their respective data from the result set associated with the
nodes. The data is referenced as commandld.columnName, i.e., sybase-ase.getLogins.Name,
sybase-ase.getLogins.Default Database, etc. All associated data for the sa node in the example is listed next:

is the name column in the result set.):

sybase- ase. get Logi ns. Name = sa

sybase-ase. getLogins.suid = 1

sybase- ase. get Logi ns. Def aul t Dat abase = master

sybase- ase. get Logi ns. Ful | Nane = (null)

sybase- ase. get Logi ns. Def aul t Language = (null)

sybase- ase. get Logi ns. CPU Tine = 182

sybase-ase. getLogins.|1/O Time = 168716

sybase- ase. get Logi ns. Password Set = 2009-12-22 08: 36:54.576

The DataNode (see page 345) element definition presenting jstask, probe and sa nodes in the previous
screenshot use the associated data for the label as follows:
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<Dat aNode type="Logi n" | abel ="${sybasease. get Logi ns. Nane}" islLeaf="true">
<Set Var nane="obj ect nane" val ue="${sybasease. get Logi ns. Nane}"/ >
<Command i dr ef =" sybasease. get Logi ns" >
<Qut put id="sybasease. getLogi ns. Nane" index="1"/>
<Qut put id="sybasease. getLogi ns. sui d" index="2"/>
</ Command>
</ Dat aNode>

XML element - Input

@ The Input sub element for a Command is only used when a command is being referred with the idref
attribute in any of ObjectsActionDef (see page 371), ObjectsTreeDef (see page 345) or
ObjectsViewDef (see page 355). It has no effect specifying it for a Command in the Commands section

There are two types of commands, with and without dynamic input. The difference is that dynamic commands
accepts input data that is typically used to form the WHERE clause in SELECT SQLs. The previous example
illustrates a static SELECT statement (without dynamic data).

To allow for dynamic input, just add variables at the positions (can be anywhere) in the SQL statement that
should be replaced with dynamic values. The following is an extension of the previous example that allows for
dynamic input.

<Conmand i d="sybase- ase. get Logi ns" >
<SQL>
<! [ CDATA[
SELECT nane "Nane", suid "SU D', dbnane "Default Database", fullname "Full Nane",
| anguage "Default Language", totcpu "CPU Time", totio "I/O Tine", pwdate "Password Set"
FROM nast er . dbo. sysl ogi ns WHERE name = '${nane}' and suid = '${suid}' ORDER BY 1
11>
</ SQL>
</ Command>

This example add two input variables: ${name} and ${suid}. Values for these variables should then be supplied
wherever the command is referred for execution via the Input element.

The following is an example from the ObjectsTreeDef that specify the Input sub elements to map values to the
variables defined in the SQL.

<G oupNode type="Logi ns" | abel ="Logi ns">
<Dat aNode type="Logi n" | abel ="${sybase-ase. get Logi ns. Nane} isLeaf="true">
<Set Var name="obj ect nane" val ue="${sybase- ase. get Logi ns. Nane}" >
<Command i dr ef ="sybase- ase. get Logi ns" >
<l nput nane="nane" val ue="sa">
<l nput nane="sui d" val ue="${sybase- ase. get Processes. sui d} ">
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</ Conmand>
</ Dat aNode>
</ Gr oupNode>

(Note that the Command element refer the command via the idref attribute which is then matched with the
corresponding id for the Command).

The ${name} variable in the SQL will be replaced with string sa.

The value for the ${suid} variable will in this case get the value of another variable,
sybase-ase.getProcesses.suid. So where is this variable defined? As explained in the Result Set (see page
341) section, all the data for a row in the result set is associated with the corresponding node in the database
objects tree. In addition, it is possible to use all the data kept by the node and even its parent nodes (as
presented in the objects tree) in the input to commands. So to evaluate the ${sybase-ase.getProcesses.suid}
variable, DbVisualizer first look for the variable in the current node. If it doesn't exist, it continues to look through
the parent nodes until it reaches the root, which is the Connections node in the objects tree. If the variable is
not found, it will be set to the string representation for null, which is (null) by default. Whenever a matching
variable is found, DbVisualizer use its value and stops searching.

XML element - Output

As mentioned earlier, a specific column value in a result set row is referenced by the name of the column and
then prefixed by the command id. Sometimes this is not desirable and the Output definition can be used to
change this behavior. The following identifies a column in the result set by its index number, starting from 1,
and then force its name to be set to the value of the id attribute.

<CQut put id="sybase-ase. get Logi ns. Nane" i ndex="1">
<CQut put id="sybase-ase. get Logi ns. sui d" index="2">

(The index attribute accepts either the name of the column or index number in the result set starting from the
first column at index 1).

The Output element can also be used to alter the structure of columns in the result set by adding, renaming
or removing columns.

<Cut put nodel acti on="add" index="TH S_|S_A NEW COLUWN' val ue="Rattle and Huni >
<CQut put nodel acti on="renane" index="2" nane="PHONE">

<Qut put nodel acti on="drop" index="MOBI LE_PHONE" >

<Qut put nodel acti on="renovei snul |l rows" index="4">

<Qut put nodel acti on="renover owsi f equal t 0" i ndex="ORDI NAL_POSI TI ON* val ue="0"/>
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modelaction Description

attribute

add Adds a new column to all rows. The value attribute accepts variables using the ${...}

notation

rename Renames a column

drop Drops the specified column

removeisnullrows Removes the row if the value in the specified column is null

removerowsifequalto Removes the row if the data in the specified column is equal to the specified value

The rename operation is primarily used when building a custom command that is supposed to be used by a
viewer that requires predefined input by specific column names. Read more in the ObjectsViewDef (see page
355) section.

22.4.5 XML element - ObjectsTreeDef

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

The ObjectsTreeDef element section controls how the database objects tree should be presented and which
commands should be executed to form its content (nodes).

¢ XML element - GroupNode (see page 348)

® XML element - DataNode (see page 349)
® XML element - Command (see page 352)
® XML element - Filter (see page 352)
¢ XML element - SetVar (see page 354)

<(bj ect sTreeDef extends="fal se">
<G oupNode type="xxx" |abel ="xxx">
<Dat aNode type="yyy" |abel ="yyy">
</ Dat aNode>
</ Gr oupNode>
</ Obj ect sTr eeDef >
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Setting the extends attribute to "true" attribute specifies that the ObjectsTreeDef will extend the

ObjectsTreeDef definition in the profile being extended (see page 323).

The mapping between the graphical representation in DbVisualizer and its ObejctsTreeDef XML is as quite

straight forward:

Representation in DbVisualizer

=B
=+| & Databases
EI---l_j master [ Default )
&[] Tables
E System Tables
m Views
a Lisers
a.. Groups
%% User Defined Data Types
-- Triggers
[+ Stored Procedures
- (£} DBA Views
[ Server Info
=144 Logins
‘.. jstask
- probe
5 sa
[+-#5 Database Devices
----- Remote Servers
f Processes

- Roles

Transactions
..... (2 Locks

XML specification

<nj ect sTreeDef extend
s="fal se">
<G oupNode type="
Dat abases" >
<Dat aNode type="
Cat al og" >
<G oupNode type=
"Tabl es" >
<Dat aNode type
="Tabl e"/>
</ Gr oupNode>
<G oupNode type=
" Syst enirabl es" >
<Dat aNode type
=" Syst enTabl e"/ >
</ G oupNode>
<G oupNode type=
"Vi ews" >
<Dat aNode type
="View'/>
</ G oupNode>
<G oupNode type=
"Users"/>
<G oupNode type=
"G oups">
<Dat aNode type
="G oup"/>
</ G oupNode>
<G oupNode type=
"Types"/ >
<G oupNode type=
"Triggers">
<Dat aNode type
="Trigger"/>
</ G oupNode>
<G oupNode type=
"Procedur es">
<Dat aNode type
="Procedure"/>
</ G oupNode>
</ Dat aNode>
</ G oupNode>
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Representation in DbVisualizer XML specification

<G oupNode type="DBA
">
<G oupNode type="
Server | nfo"/>
<G oupNode type="
Logi ns" >
<Dat aNode type="
Logi n"/>
</ G- oupNode>
<G oupNode type="
Devi ces" >
<Dat aNode type="
Devi ce"/ >
</ G oupNode>
<G oupNode type="
Renot eServers"/ >
<G oupNode type="
Processes"/ >
<G oupNode type="
Server Rol es" >
<Dat aNode type="
Server Rol e"/ >
</ Gr oupNode>
<G oupNode type="
Transactions"/>
<G oupNode type="
Locks"/ >
</ Gr oupNode>
</ Onj ect sTr eeDef >

The screenshot in the above example show all nodes representing the GroupNode definitions in the
ObjectsTreeDef. One exception is the Logins object, which has been expanded (jstask, probe and sa child
objects) to illustrate how DataNode objects look like. The ObjectsTreeDef in the example has been simplified to
show only the type attribute. (The label of the nodes as they appear in the screenshot is not listed in the
example XML). The difference between a GroupNode and a DataNode is that GroupNode represent a static
object in the tree while DataNode is dynamically created based on result sets produced by running a SQL
statement. See GroupNode as a container holding other GroupNodes and DataNodes.

The database objects tree in DbVisualizer is the core visual component and it is the place where the user open
object details and launch actions. To connect object actions (see page 371) and object views (see page 355)
with a node in the objects tree, the type attribute is used. The type should be a descriptive word for a node such
as Table, Schemas, MaterializedQueryTable, and so on. The type also map to a predefined icon (see page
393). Check the database profile utilities (see page 398) for information how to show all bundled icons and their
type mappings.
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There is no limitation on the number of levels in the objects tree expressed by nesting GroupNode and
DataNode elements. A good rule is as always to keep it intuitive, simple and clean.

XML element - GroupNode

The GroupNode element represents a static object in the tree. A GroupNode do not have any associated SQL
and appear only once where they are defined. A GroupNode is primarily used for structural and grouping
purposes. The GroupNode element have the following attributes.

<GroupNode type="SystenTabl es" |abel ="System Tabl es" isLeaf="fal se">

</ Gr oupNode>
The isLeaf attribute is optional (default is false) and controls whether the GroupNode may have any child

objects or not. It can always be set to false, the effect in the visual database objects tree is then that an expand
handle always will be visible next to the icon, even if the node don't have any child nodes.

@ IfisLeaf is set to true and there are child Group and/or Data -nodes, these will not appear. The result
may cause some frustration during the design of the database profile.

The complete set of attributes for the DataNode element:

Attribute Value Description
type The type of node
label The visual label for the node
isLeaf true/  Specifies if the node cannot have child objects
false
icon Icons are typically mapped using the type attribute with an icon name in the

icon.prefs (see page 393) file(s). The icon attribute for a GroupNode can be set
to specify an alternative icon

drop-label-not-equal Do not add the node if the label is not equal to this value or variable

action drop  drop is useful when extending another database profile to remove the
DataNode and all its child nodes

order-before Specifies the order of this GroupNode among a collection of nodes having the
same parent node. It can either be an index starting at 0 (first) or a node type.
Ex. order-before="Views" will order this GroupNode before nodes defined by
the type="Views" attribute
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Attribute Value Description
order-after Specifies the order of this GroupNode among a collection of nodes having the

same parent node. It can either be an index starting at 0 (first) or a node type.
Ex. order-after="0" will order this GroupNode after the first node definition

XML element - DataNode

The DataNode element feeds the tree with nodes produced by a Command. The example in the Command (
see page 339) section querying for all logins in Sybase ASE look as follow in the ObjectsTreeDef:

<G oupNode type="Logi ns" | abel ="Logi ns">
<Dat aNode type="Logi n" |abel ="${sybase-ase. get Logi ns. Nane}" isLeaf="true">
<Conmmand i dr ef =" sybase- ase. get Logi ns"/ >
</ Dat aNode>
</ Gr oupNode>

First, there is a GroupNode element with the purpose to group all child objects in a Logins node. The DataNode
in this example have the same attributes as the GroupNode, the type is however singular Login instead of plural
Logins (as it is for the GroupNode). This difference is important when the user decide to open one of the nodes,
since the object view will show the matching views based on the object type. For Logins a list of all logins is
displayed while opening a Login, details for that specific login is displayed.

The DataNode definition can be seen as a template, as the associated command fetches rows of data from the
database and DbVisualizer uses the DataNode definition to create one node per row in the result set.

The label attribute for the data node introduce the use a variable. The real value for the label will, in this
example, be the value in the Name column produced by the sybase-ase.getLogins command (variable names
are automatically prefixed with the command id that produced them).

The Command element uses the idref attribute to identify the command that should be executed. The
command in this case produce a result set (see page 341) with 3 rows and 8 columns. The result will be two
nodes for each row, with the label of the Name column in the result set.

Page 349 of 428



DbVisualizer 9.2 Users Guide

bﬂé

(8 Databases

---| & model
- 8 sybmgmtdb
- _ﬂ gybsystemdb

- & tempdb
= |"3} DBA Views
------ @ Server Info

I_ﬂ master [ Default )

- § sybsystemprocs

I_—_I -5 Logins
.5 jstask
.:5" probe
... 5a

--ff Processes

(-4 Roles

Transactions
----- (=4 Locks

[+-&=% Database Devices
----- Remote Servers

The label can be changed by setting it to any other valid variable, a combination of several variables or even

static text:

| abel =" ${ sybase- ase. get Logi ns. Nane} (${sybase-ase. getLogi ns. Default Database})"

The example above results in the following labels:

jstask (master)
probe (subsystendb)
sa (master)

The complete set of attributes for the DataNode element:

Attribute Value

type
label

icon

Description
The type of node
The visual label for the node

Icons are typically mapped using the type attribute with an icon name in the
icon.prefs (see page 393) file(s). The icon attribute for a DataNode can be
set to specify an alternative icon.

A condition can be specified which is used to choose an icon based on
evaluating other variables for the node.
Ex. i con="#dat aMap. get (' m ner. getl ndexes. | S_UNI QUE ).
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Attribute Value Description
equal s(' YES') ? 'uniquelcon' : (#dataMap.get ('
m nmer. getlndexes. IS UNIQUE ).equal s(' FK') ? "fklcon' : '
i ndexlcon')"
actiontype Object type used for object actions
isLeaf true/ Specifies if the node cannot have child objects
false
sort A comma separated list of names/variables used for sorting. This is useful if
you cannot get the database to properly sort the result set using a ORDER
BY clause in the SELECT statement.
drop-label-not-equal Do not add the node if the label is not equal to this value or variable
stop-label-not-equal The node will be a leaf if the label doesn't match the specified value or
variable value
warnstate A condition expression returning either true or false. For true, show a
warning overlay icon for the node.
Ex: error St at e="! #dat aMap. get (' oracl e. get Tri gger s. STATUS'
). equal s(' ENABLED )"
errorstate A condition expression returning either true or false. For true, show an error
overlay icon for the node.
Ex: error St at e="! #dat aMap. get ('
oracl e. get Obj ect sByType. STATUS' ). equal s(' VALID )"
is-empty-output continue If result set is empty, use this to control whether child GroupNode/
[stop DataNodes should be added anyway
action keep/ drop is useful when extending another database profile to remove the
drop DataNode and all its child nodes

order-before

order-after

Specifies the order of this DataNode among a collection of nodes having the
same parent node. It can either be an index starting at O (first) or a node
type. Ex. order-before="View" will order this node before nodes defined by
the type="View" attribute

Specifies the order of this DataNode among a collection of nodes having the
same parent node. It can either be an index starting at O (first) or a node
type. Ex. order-after="0" will order this DataNode after the first node
definition
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The Command definition in the example above is simple, since it doesn't use any variables in the SQL. Continue
reading the next section for details about passing input data to commands.

XML element - Command
The SQL used to generate the data used by the DataNodes are defined in the Command element.

A command is referenced by the idref attribute and that id must already be defined in the Commands (see page
339) section of the profile. For most DataNode definitions input must be supplied with the command and this is
done by adding Input elements as children to the Command.

<Dat aNode type="Logi n" | abel ="${sybase- ase. get Logi ns. Nane}" isLeaf="true">
<Command i dr ef =" sybase- ase. get Logi ns" >
<l nput nane="nane" val ue="sa">
<l nput nane="sui d" val ue="${sybase- ase. get Processes. sui d}">
</ Command>
</ Dat aNode>

The value for a variable specified in an Input element is evaluated using the syntax outlined in the result set (
see page 341) section.

@  For detailed information about the capabilities with the Command element, check the Command (see
page 339) section.

XML element - Filter

The Filter element is specific for Command elements that appear in the DataNode element. A filter define which
data for a DataNode that can be searched in filter. This filter functionality is commonly referred as the Database
Objects Tree Filtering (see page 154) in DbVisualizer. The filtering setup appears below the database objects
tree, and the following example shows that filtering may be specified for these object types:

® Catalog

® Table

® System Table
* View

® User

* Group

* Trigger

® Procedure

For each of the filter definitions, one or several columns can be included in the filtering criteria.
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Y YRR
A

=+ § Databases
Elli master ( Default )
-] Tables
Eﬁ System Tables
Eﬂ Views
a |Isers
&l Groups
User Defined Data Types
-- Triggers
-4 Stored Procedures
1| § model
J[i sybmamtdb
J[i sybsystemdb
1| & sybsystemprocs
| tempdb
E- fg DBA Views

[} Server Info
=14 Logins
5 probe
[+-#5# Database Devices
----- Remote Servers
* Processes

(- Roles

Transactions B
..... (2 Locks

Object Filter

[
[
[
[

m

4

Activate Filters: [

Catalog
Table
System Table
View
User
Group
Trigger
Procedure

<Dat aNode type="Vi ew' | abel ="${sybase-ase. getVi ews. Nane}" islLeaf="true">
<Conmmand i dr ef =" sybase- ase. get Vi ews" >
<Filter type="View' nanme="View Tabl e">
<Col umm i ndex="TABLE_NAME" nane="Nane"/>
</Filter>
</ Command>
</ Dat aNode>

Page 353 of 428



A DbVisualizer 9.2 Users Guide

The above filter definition specifies a filter for the View object type. The name attribute specifies the label of the
filter as it appears in the object type drop-down list. The nested Column element defines the index, which should
either be a column name in the result set or an index number for the column. The name attribute specifies the
name of the column as it appears in the filter pane.

Several Column elements may be specified for a Filter element.

XML element - SetVar

The SetVar element is used in the ObjectsTreeDef for GroupNode and DataNode elements. Some object types
have special meaning in DbVisualizer. Two examples are the Catalog and Schema object types. For DataNode
objects, you must use SetVar elements to identify them with the name attribute set to catalog or schema,
respectively.

<Dat aNode type="Cat al og" | abel ="${get Cat al ogs. TABLE_CAT}" >
<Set Var nane="cat al og" val ue="${get Cat al ogs. TABLE_CAT}" >
</ Dat aNode>

All DataNodes except Catalog and Schema must use SetVar to set the objectname variable:

<Dat aNode type="View' | abel ="${sybase-ase. getVi ews. Nane}" islLeaf="true">
<Set Var nane="obj ect name" val ue="${sybase- ase. get Vi ews. Nane} " >
<Set Var nanme="rowcount" val ue="true">

</ Dat aNode>

The objectname variable is used to identify the object represented by the data node, so that it can be uniformly
referenced in object views (see page 355) and object actions (see page 371). Its value should be the identifier
for the object as it is identified in the database, for example a table name or view name.

The rowcount variable is optional (default is false) and controls whether the object supports showing row count
information when Show/Hide Table Row Count (see page 132) right-click menu choice is enabled for the
database connection.

Another optional variable (nhot shown in the example above) is named acceptinQB (default is false). If set to true
, hodes of this type can be used in the Query Builder (see page 189). It should only be set to true for object
types representing tabular data that can be queried with an SQL SELECT statement, such as tables, views,
materialized views, etc.

Variables defined with SetVar are by default invisible in for example the node form viewer (see page 355). If you
want to override this behavior then add the action attribute and set its value to show. If you want to drop a
variable completely from the node simply set the action attribute to drop.
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Using SetVar for GroupNode's is used to set static values (since GroupNode's doesn't execute a Command).
This may be used to pass a static value for later use in an Action or DataView. See vertica.xml which illustrates
using SetVar for GroupNode's.

22.4.6 XML element - ObjectsViewDef

(1) Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

The ObjectsViewDef element define all views for the object types in the objects tree. These views are displayed
in the Object View (see page 33) area for the selected object. Which views should appear when selecting a
node in the tree is based on the object type for the tree node and the corresponding object view (see page 355)
definition.

® XML element - ObjectView (see page 357)
® XML element - DataView (see page 357)
® Viewers (see page 359)
®* Viewer - grid (see page 359)
® Adding custom menu items in the grid (see page 361)
® Setting initial max column width (see page 363)
®* Viewer - text (see page 363)
® Specify what column to browse (see page 364)
* Enable SQL formatting of the data (see page 364)
® Adding newline to each row (see page 364)
®* Viewer - form (see page 365)
® Viewer - node-form (see page 366)
® Hiding columns (see page 366)
* Viewer - table-refs (see page 366)
® Viewer - tables-refs (see page 367)
®* Viewer - table-data (see page 368)
® Disable data editing (see page 369)
®* Viewer - table-rowcount (see page 369)
¢ XML element - Command (see page 370)
® XML element - Input (see page 370)
® XML element - Message (see page 370)

<Chj ect sVi ewDef extends="true">
<oj ect Vi ew t ype="xxx">
<DataVi ew i d="yyy" | abel ="yyy">
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</ Dat aVi ew>
</ Obj ect Vi ew>
</ Obj ect sVi ewDef >

The extends="true" attribute specifies that this definition will extend the ObjectsViewDef definition in the

database profile being extended (see page 323).

When an object is opened in the database tree (sa in the screenshot below) a corresponding object view tab is
created (right in the sample). Each of the DataView elements in the ObjectView will appear as sub tabs in the
object view tab. The selected object and its information is passed to each of the data views for processing and
presentation. The following example show the Object View in DbVisualizer and its ObjectView element definition

Representation in DbVisualizer

°0(P (88T -
|_§| model Al
|_§] sybmgmtdb
|_§] sybsystemdb
|_§] sybsystemprocs B o
[ tempdb B ! L& SB @
MName Value
Name sa
suid 1
Default Database master
Full Name (null}
= | |Default Language (null)
% :ED“;Z::ES:”EFS CPU Time 182
@ Roles 'O Time: 168725
5____&-”3“53(‘]-0“5 - | |Password Set 2009-12-22 08:36:54 576
4 I 2

XML definition

<oj ect Vi ew t ype="Logi ns" >
<Dat aVi ew t ype="Logi ns"
| abel =" Logi ns"
viewer="grid">
<Conmmand i dref ="
sybase- ase. get Logi ns"/ >
</ Dat aVi ew>
</ Obj ect Vi ew>
<Cbj ect Vi ew type="Logi n">
<Dat aVi ew type="1nfo" | abel
=" nfo"
vi ewer =" node-form
s
<Dat aVi ew t ype="Dat abases"
| abel =" Dat abases"
viewer="grid">
<Conmmand i dref ="
sybase- ase. get Logi nDat abases"
/>
</ Dat aVi ew>
<Dat aVi ew t ype="Rol es"
| abel =" Rol es"
viewer="grid">
<Conmmand i dref ="
sybase- ase. get Logi nRol es"/ >
</ Dat aVi ew>
</ Obj ect Vi ew>
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The screenshot and the database tree show both the Logins node and its child nodes, jstask, probe and sa.
These nodes are instances of the object types Logins (labeled Logins in the screenshot) and Login (the three
sub nodes: jstask, sa and probe).

The ObjectView XML definitions above shows the data views for these two types, Logins and Login. Opening
the node labeled Logins in the tree will show the object view for the <ObjectView type="Logins"> definition
while opening the node labeled jstask, probe or sa will show the object view for the <ObjectView type="Login
s

The example shows sa being selected. Its DataView definitions displayed as tabs in the object view are (by label

):

* Info
* Databases
®* Roles

XML element - ObjectView

The ObjectView element is associated with an object type and groups all DataView elements that appear when
the object type is selected in the database objects tree. Here follows the ObjectView definition for the Login
object type.

<hj ect Vi ew t ype="Logi n">

</ Obj ect Vi ew>

The type attribute value is used when a node is clicked in the database objects tree to map with the
corresponding ObjectView definition. The following lists the attributes for ObjectView:

Attribute Value Description

type The type of the ObjectView as declared in the GroupNode and DataNode elements in the
ObjectsTreeDef section

action drop  drop is useful when extending another database profile to remove the ObjectView and all
its child views

XML element - DataView

The DataView element is comparable with the DataNode (see page 355) element in the ObjectsTreeDef. It
defines what SQL (command) should be executed, labeling, viewer type (presentation form) and other
characteristics. The following is the DataView definitions for the Login object type. (The ObjectView element is
part of the sample just for clarification).
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<hj ect Vi ew t ype="Logi n">
<Dat aVi ew t ype="sybasease-| ogi n-i nfo" icon="Info" |abel="Info" viewer="node-forni/>
<Dat aVi ew t ype="sybasease-| ogi n- dat abases" icon="Dat abases" | abel ="Dat abases" vi ewer="grid">
<Command i dr ef ="sybase- ase. get Logi nDat abases"/ >
</ Dat aVi ew>
<Dat aVi ew type="sybasease-| ogi n-rol es" icon="Rol es" | abel ="Rol es" viewer="grid">
<Command i dr ef =" sybase- ase. get Logi nRol es"/ >
</ Dat aVi ew>
</ Obj ect Vi ew>

All three DataView elements have a viewer attribute identifying how the data in the view should be be presented
, €.0., as a grid or a form. See the next sections for a list of viewers. The following lists all attributes for
DataView:

Attribute Value Description

id Every DataView element must have a unique id which is not only unique in the
current profile but also with all id's in extended profiles

@ To make sure the id is unique use the following recommended format:
profileName-objectViewType-viewerLabel.
Ex: sybasease-login-databases

(The id should not contain any empty space or special characters
other than dash ("-")).

label The label for the viewer as it will appear in the tab
icon The icon as defined in the icons.prefs (see page 393) file(s)
viewer One of: grid, text, form, node-form, table-refs, tables-refs, table-date,

table-rowcount, message, navigator, ddl, ProcedureViewer. See the viewers
section in this document for more information

drop-label-not-equal Drop the viewer if its label is not equal to the value of this attribute

class Used to specify a custom Java class used as the viewer

classargs Used to pass arguments to a custom viewer

action drop  drop is useful when extending another database profile to remove the
DataView

doclink Relative HTML link to the related chapter in the users guide
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Attribute Value Description
order-before Specifies the order of this DataView among a collection of viewers having the
same parent ObjectView. It can either be an index starting at 0 (first) or a node
type. Ex. order-before="sybasease-login-databases" will order this DataView
before viewers defined by the id="sybasease-login-databases" attribute
order-after Specifies the order of this DataView among a collection of viewers having the
same parent ObjectView. It can either be an index starting at 0 (first) or a node
type. Ex. order-after="sybasease-login-databases" will order this DataView
after viewers defined by the id="sybasease-login-databases" attribute
Viewers

The viewer attribute for a DataView define how the data for the viewer should be presented. The following
sections walk through the supported viewers.

The following sample illustrates the viewer attribute.

<hj ect Vi ew t ype="Logi n">
<Dat aVi ew type="Info" |abel ="Info" viewer="node-forn/>
</ Obj ect Vi ew>

DataView definitions may be nested and the viewers are then presented with the nested DataView in the lower
part of the screen.

Viewer - grid

The grid viewer presents a result set in a grid with standard grid features such as search, copy, fit columns,
export and so on. The result set is presented exactly as it is produced by the associated Command and any
optional Output processing.

Here is a sample of the XML for the grid viewer:

<Dat aVi ew type="or acl e- col utms- col ums" i con="Col utms" | abel =" Col utms" vi ewer="gri d">
<Command i dref =" or acl e. get Col ums" >
<l nput nane="owner" val ue="${schema}"/>
<l nput nane="tabl e" val ue="${obj ectnane}"/>
</ Command>
</ Dat aVi ew>

And here is a screenshot of the standard grid viewer created from the above definition.
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O Sy

COLUMN_ID OWNER TABLE_NAME COLUMN_MNAME DATA_TYPE DATA_LENGTH DATA_PRE[{]
1HR BIO EMPLOYEE_ID MUMBER 22 >
2HR BIO FIRST_MAME YARCHARZ 20
3HR BIO LAST_MAME YARCHARZ 25
4 HR BIO EMAIL YARCHARZ 25
5HR BIO FHOME_MUMBER. VARCHARZ 20
6 HR BIO HIRE_DATE DATE 7
THR BIO JOB_ID YARCHARZ 10
8 HR BIO SALARY NUMBER 22
OHR BIO COMMISSION_PCT NUMBER 22
10HR BIO MAMAGER_ID MUMBER 22
11 HR BIO DEPARTMENT_ID MNUMBER 22
12HR BIO FHOTO BLOB 4000
12 HR BIO RESUME CLOB 4000
] m b

0.125/0.016 sec || 13/31 || 1-13

The nesting capability for grid viewers is really powerful, as it can be used to create a drill-down view of the
data. Consider the scenario with a grid viewer showing all Trigger objects. Wouldn't it be nice to offer the user
the capability to display the trigger source when selecting a row in the list? This is easily accomplished with the
following definition:

<DataView i d="oracl e-tabl e-triggers" icon="Trigger" |abel="Triggers" viewer="grid">
<Command i dref="oracl e. get Tri ggers" >
<l nput nanme="owner" val ue="${schema}"/>
<l nput nane="condition" value="${triggersCondition}"/>
</ Command>
<Dat aVi ew i d="oracl e-tabl e-tri ggers-source" icon="Source" |abel="Source" viewer="text">
<l nput nane="dat aCol um" val ue="text"/>
<l nput nanme="format SQL" val ue="true"/>
<Command i dref ="oracl e. get Tri gger Sour ce" >
<l nput nanme="owner" val ue="${OMER}"/ >
<l nput nane="name" val ue="${TRI GGER_NAME}"/ >
</ Commrand>
</ Dat aVi ew>
<Dat aVi ew i d="oracl e-tabl e-triggers-info" icon="Info" |abel="1nfo" viewer="node-forn/>
</ Dat aVi ew>

® The first DataView element define the top grid viewer labeled Triggers and the command to get the result
set for it

®* The next DataView is the nested text viewer labeled Source, specifying various input parameter for the
viewer along with the command to get the source for the trigger. The difference here is that the input
parameters for this command reference column names in the top grid. Since this viewer is nested, it will
automatically be notified whenever an entry in the top grid is selected
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® The third DataView labeled Info is presented as a tab next to the Source viewer, and presents additional
information about the selected trigger

The following screenshot illustrates the above sample:

B0 3YH Q

OWHNER TRIGGER_MAME TRIGGER_TYPE TRIGGERING_EVEMNT TABLE|:]

SECURE_EMPLOYEES |BEFORE STATEMENT |INSERT OR UPDATE OR DELETE
HR UFDATE_JOB_HISTORY AFTER EACHROW  UPDATE HR

| 0.328/0.000 sec || 2/13 || 1-2 |

835 =9-

1 TRIGGER secure_cmployees

& BEFORE THSERT OR UPDATE OR DELETE OH ewployees
3 BEGIH

4 gecure_dml:

3 EHD secure_employees:

| 0.063/0.000 sec || 5/2 |

Adding custom menu items in the grid

The grid right-click menu contain a lot of standard actions. Custom commands can be defined in the DataView
element and these will appear last in the menu.

<l nput name="nenulten’ val ue="Cpen in New Tab...">
<l nput name="action" val ue="open-object-in-newtab-comand ${schena| | ONNER} ${ obj ect | | TABLE_NAVME}
">
</ | nput >
<l nput narme="nenul ten val ue="Open in Floating Tab...">

<l nput nanme="action" val ue="open-object-in-floating-tab-comand ${schema| | OMNER} ${ obj ect | |
TABLE_NAVE} "/ >
</ | nput >

<l nput name="nenul tenm val ue="Script: SELECT ALL">

<l nput nanme="command" val ue="select * from ${schena| | ONNER} ${ obj ect | | TABLE_NAME} "/ >
</ | nput >

<l nput nanme="nenul ten val ue="Script: DROP TABLE">

<l nput nane="command" val ue="drop table ${schema|| OMNER} ${ obj ect | | TABLE_NAVE} "/ >
</ | nput >

The <Input name="menultem"> element define a menu item entry that should appear in the grid right-click
menu. The value for the menultem is the label for the item as it will appear in the menu while the child Input
element with name="command" is the SQL command that should be produced for all selected rows when the
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menu item is selected. Invoking a custom menu item will not execute the produced SQL directly but rather
copy the statements to a SQL Editor. In the SQL Editor you will then need to manually execute the script and
track the result.

The name="action" attribute declare that the value is a pre-defined action. Valid actions are:

® open-object-in-new-tab-command
® open-object-in-floating-tab-command

Any variables in the SQL statement should identify column names in the result set. The user may select any
cells in the grid and choose a custom menu item. It is only the actual rows that are picked from the selection as
the columns are predefined by the menultem declaration.

The variables specified in these examples starts with ${schema=...} and ${object=...}. These define that the
first variable represents a schema variable while the second defines an object. This is needed for DbVisualizer
to determine whether delimited identifiers should be used and if identifiers should be qualified, as defined in the
connection properties for the database.

Here is a sample:
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B0 3y

HR
HR
HR
HR
HR
HR
HR
HR

OWNER | TABLE_MAME TABLESPACE_MNAME CLUSTER_MAME IOT_MNAME STATUS

Script: SELECT ALL

BIO LSERS (mull} (null} "MLID
CoUNTRIES QIR (null) (null} VALID
_'_'_'_E Select All Crl+A
J0B HisToRy| #H  Select Row(s) Ctrl+Skift+)
JDEI; 3 Copy Selection Ctrl+C
LOCATIONS 3 Copy Selection (With Colurmn Header) Ctrl+H
REGIONS ._-% Export... Ctrl+Alt+E

G Export Selection...

@ Print...

,5? Print Selection...

@ Print Preview..,

= Ctrl+Skift+5

® Reload Ctrl+R

& Find.. Ctrl+F

=

|,

m Describe Data...

Aggregation Data for Selection... Ctrl+Skift+C

B

pr

Script: DROP TAELE

Setting initial max column width
Some result sets may contain wide columns. The following parameter sets an initial maximum width for all
columns in the grid.

<l nput name="col umWw dt h"* val ue=""/>

Viewer - text

The text viewer presents data from one column in a result set in a text browser (read only). This viewer is
typically used to present large chunks of data, such as source code, SQL statements, etc. If the result set
contain several rows, the text viewer reads the data in the column for each row and present the combined data.

Here is a sample of the XML for the text viewer:

<Dat aVi ew i d="oracl e-tabl e-tri ggers-source" icon="Source"
<l nput nane="dat aCol um" val ue="text"/>
<l nput nane="format SQL" val ue="true"/>

| abel =" Sour ce"

vi ewer ="t ext ">
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<l nput nanme="new i ne" val ue""/>
<Command i dref ="or acl e. get Tri gger Sour ce" >
<l nput nane="owner" val ue="${ ONNER} "/ >
<l nput nanme="nane" val ue="${TRI GGER_NANE}"/ >
</ Command>
</ Dat aVi ew>

And here is a screenshot of the Source tab based on the previous definition.

Y Y- IR

1 ~
2 CREATE TABLE "HR"."EMPLOYEES"
5 i "EMPLOVEE ID" NUMBER(G,0),
4 “FIRST NAME™ VARCHARZ (Z0),
5 "LAST NAME™ VARCHARZ(Z5) COMSTRAINT "EMP LAST NAME NN” HOT HULL ENAE:
& "EMATL" VARCHARZ (25) COMSTRAINT "EMP EMATL NN” HOT HULL ENAELE, |
7 “PHONE NUMEER™ VARCHARZ (20, 3
& "HIRE DATE™ DATE CONSTRAINT "EMP HIRE DATE NN” HOT HULL ENABLE,
a “J0E_ID" VARCHARZ(10) CONSTRAINT "EMP JOE NN” HOT HULL ENAELE,
10 "SALARY" NUMBER(S,2),
11 "COMMIZSION PCT™ NUMBER(Z,Z),
1z "MANAGEE_ID" NUMBER(G,0),
13 "DEPARTMENT ID” NUMEER(4,0],
14 COMSTRATHT "EMP SALARY MINT CHECK (salary > () ENAELE,
15 CONSTRATHT “EMP EMAIL UK UHIQUE (“EMAIL")
16 USING INDEX PCTFREE 10 INITRANS 7 MAXTRANS 255 NOLOGGING COMPUTE STATISTIC
17  STORAGE (INITIAL 65536 HEXT 1045576 MINEXTENTS 1 MAXEXTENTS 2147483645
18 PCTINCEEASE 0 FREELISTS | FREELIST GROUPS 1| EUFFER_PO0L DEFAULT )
19  TABLESPACE "EXAMPLE” ENAELE, il
2N OMMTTODATHET "AFMT FMD Th DT DOTMADW TEY ("M DT AWRERRE T
L L1 F

2,407/0.000 sec || 1/1

Specify what column to browse

By default, the text viewer uses the data in first column. This behavior can be controlled by using the
dataColumn input parameter. Simply specify the name of the column in the result set or its index (starting at 1
from the left).

<l nput name="dat aCol um" val ue=""/>

Enable SQL formatting of the data

The text viewer have the SQL Formatting function, which when invoked formats the SQL buffer in the viewer.
The formatSQL input parameter is used to control whether formatting should be made automatically when the
data first displayed. If formatSQL is not specified, no initial formatting is made.

<l nput name="fornmat SQL" val ue=""/>

Adding newline to each row
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For a result set containing multiple rows and all rows should be displayed in a text viewer, the newline
parameter define the character(s) that should separate the rows in the viewer. A \n somewhere in the value will
be converted to a platform dependent newline sequence in the viewer. By default there is no newline sequence
between multiple rows.

<I nput name="new i ne" val ue="\n"/>

Viewer - form
The form viewer displays row(s) from a result set in a form. If several rows are in the result, they are presented
in a list. Selecting one row from the list presents all columns and data for that row in a form.

Here is a sample of the XML for the form viewer:

<Dat aVi ew i d="oracl e-tabl e-i nfo" icon="Info" |abel ="Info" viewer="forn' order-before="0">
<Command i dref ="or acl e. get Tabl e" >
<l nput nane="owner" val ue="${schema}"/>
<l nput nane="tabl e" val ue="${obj ect nane}"/>

</ Command>
</ Dat aVi ew>

And here is a screenshot of the Info tab based on the previous definition.

B0 3y

Mame WValue
OVWHNER HR -
TABLE_NAME EMPLOYEES
TABLESPACE_MAME EXAMPLE
CLUSTER_NAME (nully =
IOT_MAME (nully
STATUS WVALID
PCT_FREE 10
PCT_USED (nully
INI_TRANS 1
MAX_TRANS 255
INITIAL_EXTENT 65536
NEXT_EXTENT (nully
MIN_EXTENTS 1
MAX_EXTENTS 2147483645
PCT_INCREASE (null}
FREELISTS (nully
FREELIST_GROUPS (nully
LOGGING MO i
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Viewer - node-form
The node-form viewer presents all data associated with the selected DataNode (variables). Here is a sample of
the XML for the node-form viewer:

2O 3K
Mame Yalue
OWHNER HR -
TABLE_HAME EMFPLOYEES
CONSTRAINT_NAME EMP_EMAIL_MM
CONSTRAINT_TYPE Check
DDL_TYPE COMETRAINT
SEARCH_CONDITION  "EMAIL™ 1S MOT MULL
R_OWHNER (rull}
R_CONSTRAINT_NAME (null)
DELETE_RULE (rull)
STATUS EMABLED =
DEFERRABLE MOT DEFERRABLE
DEFERRED IMMEDIATE
VALIDATED VALIDATED
GENERATED USER MNAME
BAD (null}
RELY (null}
LAST_CHANGE 2009-11-26 11:45:31
INDEX_OWHNER (rull)
INDEX_MAME (rull}
INVALID (rull) i

Hiding columns

There may be data associated with the object that you don't want to present in the node form. The hidecolumn
input parameter control what data for the object that should be invisible and you may repeat this option as many
times you like to handle multiple variables that shouldn't be displayed.

<l nput name="hi decol umm" val ue="or acl e. get Keys. TABLE_OMNER"/ >

Viewer - table-refs
The table-refs viewer shows the references graph for the current object (this must be an object supporting
referential integrity constraints, such as a Table),

Here is a sample of the XML for the table-refs viewer:

<Dat aVi ew i d="generi c-tabl e-references" icon="References" |abel ="References" viewer="table-refs"/>

And here is a screenshot of the References tab based on the previous definition.
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BO QSR LL_LPLHEHIE M@ @ | teardic -
EMPLOYEES
& EMPLOYEE_ID M LILIE ER(i)
FIRST_MAWE WAR CHARZ(20)
LAST_MAME WAR CHARZ(2E)
EMAIL WAR CHARZ(2E) JOBS
PHOME MUMBER  'WARCHARZ(20)
HIRE_DATE DATE 4,—» 4 JOB_ID WARCHARZ(1D)
JOBID VAR CHARZ(ID) JOB_TITLE WARCHARZ(IE)
LT NUMB ER(8.2) MIN_SALARY  MUKMBER(E)
COMMISSION_PCT  MUMBER(2,2) MAX_SALARY NUMBER(S)
MANAGER_ID MLIIB ER()
DEPARTMENT_ID  MUWEBER(#) DEPARTMENTS
_|—)- & DEPBRTMENT_ID MUNEBER(4)
DEPARTMENT_MAME WJARCHARZ(30)
MANAGER_ID MUNEBER(E)
LOCATION_ID MUNEBER(4)

90% || Tables: 3| References: 3

Viewer - tables-refs

The tables-refs viewer shows the references graph for several tables in the result set (the result set must
contain objects supporting referential integrity constraints, such as a Table). Here is a sample of the XML for the
tables-refs viewer:

<Dat aVi ew i d="or acl e-t abl es-references" icon="References" |abel ="References" viewer="tabl es-refs">
<Cormmand i dr ef =" or acl e. get Tabl es" >

<l nput name="owner" val ue="${schema}"/>

<Qut put nodel acti on="renane" index="OMER' nanme="TABLE_ SCHEM'/ >

<Qut put nodel acti on="renane" index="TABLE_NAVE"' nanme="TABLE_NAME"/>
</ Command>

</ Dat aVi ew>

And here is a screenshot of the References tab based on the previous definition.
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Viewer - table-data
The table-data viewer shows the data for a table in a grid with various features such as filtering and editing (if

licensed) functionality.

@ Information presented in the grid is obtained automatically by the viewer via a standard SELECT *
FROM table statement, i.e., the object type having this viewer defined must be able to support getting

a result set via this SQL statement.

It is important that the Database Type in the connection setup is properly set to match the database
being accessed. The reason is that the identifiers (schema, database, table) are delimited
automatically. Delimiters are database specific and if having the wrong database type set it may result

in an error getting the result.

Here is a sample of the XML for the table-data viewer:

<Dat aVi ew i d="oracl e-vi ew-data" icon="Data" |abel ="Data" viewer="tabl e-data"/>

<l nput nane="di sabl eEdit" val ue="fal se"/>
</ Dat aVi ew>
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And here is a screenshot of the Data tab based on the previous definition.

BO 29 P QO HEEE e - >
4" EMPLOYEE_ID FIRST_NAME LAST_MAME EMAIL = PHONE_MNUMBER HIRE_C[7]
1 104 Bruce Ernst BERNST 500423 4568 1991-05-21 =
2 106 Valli Pataballa ~ VPATABAL 5904234560 1998-02-05 | _
3 102 Lexe DeHaan  LDEHAAN 5151234589 1993-01-13 |
4 %
5 198 Donald OConnell  DOCON.. 650.507.9833 1999-06-21
B 200 Jennifer Whalen JWHALEN 515123 4444 1987-09-17
7 4 200 Jennifer Whalen JWHALEN 515123 4444 1987-00-17
8 202 Pat Fay PFAY 603.123 6666 1997-08-17
g 7 203 Susanne TETE sMAVRIS 5151237777 1994-06-07
10 204 Hermann  Baer HBAER  515.123.8888 1994-06-07
11 205 Shelley Higgins SHIGGING 515.123.8080 1994-06-07
12 206 William Gietz WGIETZ  515.123.8181 1994-06-07
13 101 MNeena Kochhar ~ NKOCHH.. 515123 4568 1989-09-21
14 105 David Austin DAUSTIN 590423 4569 1997-06-25
15 107 Diana Lorentz DLOREM... 530.423 5587 1999-02-07
16 108 Nancy Greenberg NGREEM.. 515124 4569 1994-08-17 -
4 I I
Max Rows: | 100000 |Max Chars: |0 0.032/0.109 sec || 108/13 || 1-17

Disable data editing
The default strategy for the table-data viewer is to automatically check whether the data can be edited or not. If
editing is allowed a few related buttons will appear in the toolbar. However, sometimes you may want to disable

editing completely for the table-data viewer. Do this with the following input element:

<l nput name="di sabl eEdit" val ue="true"/>

Viewer - table-rowcount

The table-rowcount viewer shows the row count for a (table) object.

©@  The row count is obtained automatically by the viewer via a traditional SELECT COUNT(*) FROM
table statement, i.e., the object type having this viewer defined must be able to support getting a result

set via this SQL statement.

It is that the Database Type in the connection setup is properly set to match the database being
accessed. The reason is that the identifiers (schema, database, table) are delimited automatically.
Delimiters are database specific and if having the wrong database type set it may result in an error

getting the result.

Here is a sample of the XML for the table-rowcount viewer:
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<Dat aVi ew i d="generi c-tabl e-rowcount" icon="RowCount" | abel ="Row Count" vi ewer="tabl e-rowcount"/>

And here is a screenshot of the Row Count tab based on the previous definition.

®

Number of rows: 107

XML element - Command
Check the commands (see page 339) section for more information.

XML element - Input
The Input element is supported for some of the data viewers. Check the viewer sections for more information.

XML element - Message

The Message element is very simple as it just define a message that should appear at the top of the viewer.
The text in the message may contain HTML tags such as <b> (bold), <i> (italic), <br> (line break), etc.

Here is a sample of the XML for using the message element in a grid viewer:

<hj ect Vi ew t ype="Recycl eBi n" >
<Dat aVi ew i d="or acl e-recycl ebi n-recycl ebi n" icon="Recycl eBi n" | abel ="Recycl e Bi n" viewer="grid">
<Conmand i dref ="oracl e. get Recycl eBi n">
<l nput nanme="schema" val ue="${schema}"/>
<l nput nane="I| ogi n_schema" val ue="${dbvi s-def aul t Cat al ogOr Scherma}"/ >
</ Commrand>
<Message>
<! [ CDATA[
<ht m >
These are the tables currently in the recycle bin for this schema. Right click on a bin
table in objects tree to restore or permanently purge it.<br>
<b>Not e: The recycle bin is always enpty if not |ooking at the bin for your
I ogin schema (default).</b>
</htm >
11>
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</ Message>
</ Dat aVi ew>
</ Obj ect Vi ew>

And here is a screenshot of the Recycle Bin tab based on the previous definition.

== These are the tables currently in the recycle bin for this schema. Right dick on a bin table in objects tree to
restore or permanently purge it.
== Mote: The recycle bin is always empty if not looking at the bin for your login schema (default).

B0 3y Q

OBJECT_MAME ORIGINAL_MAME OFPERATION | TYFE TS_MNAKME CREATEEI
BiMNE3AlucxwhTbOgHcaFoBJ+5w==80 EMP DROP TABLE USERS  2007-10-15: »
] 1] b

|0.266/0.000 sec || 1/15 | 11

22.4.7 XML element - ObjectsActionDef

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

® |ntroduction (see page 372)
® Variables (see page 373)
® XML element - ActionGroup (see page 376)
® XML element - Action (see page 376)
¢ XML element - Input (see page 381)
® Style - text (single line) (see page 384)
® Style - text-editor (multi line) (see page 384)
® Style - number (see page 384)
® Style - password (see page 384)
® Style - list (large number of choices) (see page 385)
® Style - radio (limited number of choices) (see page 386)
® Style - check (true/false, on/off, selected/unselected) (see page 386)
® Style - separator (visual divider between input controls) (see page 386)
® Style - grid (configurable multi row/columns input) (see page 387)
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® XML element - SetVar (see page 389)

® XML element - Confirm (see page 391)

¢ XML element - Result (see page 391)

® XML element - Command (see page 391)

®* XML element - Message (see page 392)

® Action showing just a message (see page 392)

Introduction

Objects actions (ObjectsActionDef) define what operations are available for the object types defined in the
ObjectsTreeDef. Object actions are powerful, as they offer an extensive number of features to define actions for
almost any type of object operation.

In DbVisualizer, the object actions menu is accessed via the right-click menu in the objects tree or via the
Actions button in the object view:

i Table: BIO

@ Ao

Alter Table...
Rename Table...
Empty Table...
Drop Table...

@ &%

Copy Table... k.
Comment Table...

Grant Privilege...

Import Table Data...

Export Table...

Create Index...

Create Trigger...

Analyze Table...

Script Object to SOL Editor

Script Object to Mew SQL Editor  #

k

Connections/CRM Ahoa/Schemas/HR/ Tables/EI0
Constraints | Triggers | g Dependences |
_ =9 References ,ﬁ' Mavigator ﬁ@ Grants
lgInfo | [flcomns | FHpata | EProwcount | 2 i
RO SHFH
Mame | H
OWHNER HR
TABLE_NAME BIC
TABLESPACE_MAME LISERS
CLUSTER_NAME (nully
IOT_NAME (null)
STATUS YALID
PCT_FREE 10
PCT_USED (nul}
INI_TRANS 1
MAX_TRANS 285
INITIAL_EXTENT 65536
MEXT_EXTENT (nully
MIN_EXTENTS 1
MAX_EXTENTS 2147483645
PCT_INCREASE (nully
FREELISTS (nully

[EREEILIET cRONIDS

il
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All of the operations for the current Table object in the figure above are expressed in the ObjectsActionDef
section in the database profile. The implementation for these actions are either declared entirely in XML via
standard definitions, or via custom definitions. (The Java API for action handlers is not yet documented). The
following screenshot shows the dialog appearing when executing an action via a standard XML definition:

|" .l
8 Create Trigger | 22 |
~
Object Details
Database Connection: (CRM Ahoa
Schema: HR.
Trigger:
Trigger Time: BEFORE (@ AFTER INSTEAD OF
Trigger Event: DELETE @ INSERT UPDATE
E Trigger Type: @ STATEMENT ROW E
Table: LOCATIONS
Source
1 -
2 -— Insert your own trigger code here
3 -
4 LEM: OUTPUT.PUT LINE|'Zample output'):
Show SQL Execute ] | Cancel |

The first field in the dialog, Database Connection, is always present and shows the alias of the database
connection the current object is associated with. At the bottom, there is a Show SQL control that, when checked
, displays the final SQL for the action. The bottom right buttons are used to run the action (the label of the button
may be Execute or Script based on the action mode), or to Cancel the action completely.

Variables

Variables are used to reference data for the object for which the action was launched, and the data for all its
parent objects in the objects tree. Variables are also used to reference input data specified by the user in the
actions dialog. Variables are typically used in the Command, Confirm, Result and SetVar elements.

Variables are specified in the following format:

${variableName}
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(

The following is an example for a Rename Table action. It first shows the name of the database connection (
which is always present) with information about the table being renamed. The last two input fields should be
entered by the user and identify the new name of the table. The New Database component is a list from which
the user should select the name of the new database. The new table name should be entered in the New Table
Name field.

If the Show SQL control is checked, you will see any edits in the dialog being reflected immediately in the final
SQL Preview.

- y

& Rename Table | 22 |

Object Details
Database Connection: |MyS0L

Database: test
E Table: Driver
Mew Database: :test -
Mew Table Name: Drajver
Show QL Execute ] [ Cancel
SOL Preview

SELE

FENAME TABLE “test’, 'Driver” TO “tezt’. Drajver’

The complete action definition for the previous Rename Table action is as follows:

<Action id="nysqgl -tabl e-renanme" |abel =" Renanme Tabl e" rel oad="true" icon="renane">
<l nput | abel =" Dat abase" style="text" editable="fal se">
<Def aul t >${ cat al og} </ Def aul t >
</ | nput >
<l nput | abel ="Tabl e" style="text" editable="fal se">
<Def aul t >${ obj ect nane} </ Def aul t >
</ | nput >
<l nput | abel =" New Dat abase" nane="newCat al og" style="list">
<Val ues>
<Command><SQL><! [ CDATA[ show dat abases] ] ></ SQL></ Conmand>
</ Val ues>
<Def aul t >${ cat al og} </ Def aul t >
</ | nput >
<l nput | abel ="New Tabl e Nane" nane="newTabl e" style="text"/>
<Conmmand>
<SQL>
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<! [ CDATA[
rename table “${catal og} . ${objectnane}  to "${newCatal og} . ${newTabl e}"
11>
</ SQL>
</ Command>
<Confirnp
<! [ CDATA[
Confirmrenane of ${catal og}. ${objectname} to ${newCatal og}. ${newTabl e} ?
11>
</ Confirnp
<Resul t >
<! [ CDATA[
Tabl e ${catal og}. ${obj ect name} renaned to ${newCat al og}. ${ newTabl e}!

11>
</ Resul t >
</ Acti on>

First, there is the Action element with some attributes specifying the label of the action, icon and whether the
objects tree (and the current object view) should be reloaded after the action has been executed.

The next block of elements are Input fields defining the data for the action. As you can see in the example,
there is a ${catalog} variable in the Default element for the Database input and an ${objectname} variable in
the Default element for the Table input. The values for these variables are fetched from the current object in the
objects tree (GroupNode or DataNode). Variables are evaluated by first checking if the variable is in the scope
of the action dialog (i.e., another input field), then if the variable is defined for the object for which the action was
launched, and then if it is defined for any of the parent objects until the root object in the tree (Connections
node) is reached. If a variable is not found, its value is set to (null).

In the XML sample, the value of the ${catalog} variable is the name of the database in which the table object is
stored. The ${objectname} is the current name of the table (these variables are described in the
ObjectsTreeDef (see page 345) section).

The New Database input field is a list component showing a list of databases based on the result set of the
specified SQL command. The Default setting for the database will be the database in which the table is
currently stored based on the ${catalog} variable.

The New Table Name input field is a simple text field in which the user may enter any text (the new table name)
Both the New Database and New Table Name fields are editable and should be specified by the user. This

data is then available via the variables specified in the name attribute, i.e., newCatalog and newTable.

The Command element declares the SQL statement that should be executed by the action. In this example, the
SQL combines static text with variables.
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XML element - ActionGroup

The ActionGroup element is a container and groups a collection of ActionGroup, Action and Separator
elements. It is used to define what actions should be present for a particular object type. It also define in what
order the actions should appear in the menu and where any separators should be located. ActionGroup
elements can be nested and these will be displayed as sub menus in DbVisualizer.

<Acti onG oup type="Tabl e">
<Action id="xxx">

</ Acti on>

</ Acti onG oup>

The attributes for an ActionGroup are:

Attribute

type

label

action

order-before

order-after

Value

drop

Description

This defines what object type the ActionGroup is mapped to. This attribute is required
and valid only for top level ActionGroup elements (not nested ActionGroup elements).
An example is the Table object type, the corresponding <ActionGroup type="Table">
will only be displayed when the current object is a Table

This attribute is required for nested ActionGroup elements and is the label displayed in
the sub menu. (This attribute have no effect on top level ActionGroup elements)

drop is useful when extending another database profile to remove the ActionGroup and
all its child elements

Specifies the order of this ActionGroup among a collection of ActionGroup elements
located at the same level. It can either be an index starting at O (first) or a node type. Ex
. order-before="Views" will order this ActionGroup before ActionGroup elements
defined by the type="Views" attribute

Specifies the order of this ActionGroup among a collection of ActionGroup elements
located at the same level. It can either be an index starting at O (first) or a node type. Ex
. order-after="Views" will order this ActionGroup after ActionGroup elements defined
by the type="Views" attribute

XML element - Action

The Action element defines the characteristics of the action. The following show the complete definition of the
Drop Table action in Oracle.

<Action id="oracl e-tabl e-drop" | abel ="Drop Tabl e" rel oad="true" icon="renove">
<l nput | abel ="Schema" style="text" editable="fal se">
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<Def aul t >${ schema} </ Def aul t >
</ | nput >
<Input |abel ="Table" style="text" editable="fal se">
<Def aul t >${ obj ect nane} </ Def aul t >
</ | nput >
<Input |abel ="Drop Referential Integrity Constraints" name="cascade" styl e="check"
tip="Enable this to drop all referential integrity constraints
that refer to primary and uni que keys in the dropped table">
<Val ues>cascade constrai nt s</ Val ues>
</ | nput >
<If test="#dm get Dat abaseMaj or Version() gte 10">
<l nput | abel ="Purge Space" nane="purge" styl e="check"
tip="Enable this if you want to drop the table and
rel ease the space associated with it in a single step">
<Val ues>pur ge</ Val ues>
</ | nput >
</If>
<El se>
<Set Var name="purge" val ue=""'""/>
</ El se>
<Conmand>
<SQL>
<! [ CDATA[ drop table "${schena}"."${objectnane}" ${cascade} ${purge}]]>
</ SQL>
</ Command>
<Confirnp
Real |y drop table ${schena}. ${obj ect nane}?
</ Confirnmp
<Resul t >
Tabl e ${schena}. ${ obj ect name} has been dropped!
</ Resul t >
</ Acti on>

The available attributes for the Action element:

Attribute Value (bold = default)

id

icon

Description

Every Action element must have a unique id
which is not only unique in the current profile but
also with all id's in extended profiles.

@  The recommended format is
profileName-actionGroupType-action

Ex: oracle-table-drop
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Attribute Value (bold = default) Description

The name of the icon that should be displayed
next to the label in the actions menu

label The label for the action as it should be displayed
in the list of actions and in the actions dialog

reload true/false Specifies if the parent node (in the objects tree)
should be reloaded after successful execution.
This is recommended for actions that change the
visual appearance of the object, such as remove,
add or name change

mode Specifies how the action will be prepared and

® execute displayed
show the action dialog,

process user input and
execute the final SQL
within the scope of the
action window

® script
show the action dialog,
process user input and
send the final SQL to the
SQL Commander

® script-immediate
will not show the action
dialog but instead pass
the final SQL directly to
the SQL Commander

processmarkers
® true

IN parameter markers in
the SQL are processed
with the JDBC driver. Not
all drivers supports this

* false
(default) parameter
markers are not be
processed
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Attribute Value (bold = default) Description
resulttype Oracle only. Specifies what kind of result is

resultaction

® resultset

this is the default and
indicates that the result is
a standard result set
produced by a SQL
SELECT statement or
stored procedure
dbmsoutput

this is specific for Oracle
databases only and
specifies that the output is
produced by the
DBMS_OUTPUT stored
procedure

ask

if the action produced a
result according to the
setting of resulttype, ask
the user whether the
result should be displayed
in a window or copied as
text to the SQL
Commander

show

if the action produced a
result according to the
setting of resulttype, show
it in a window. resulttype
="resultset" shows the
result in a grid while for
dbmsoutput the result is
displayed in a text viewer
showtext if resulttype="
resultset” this will show
the result set in a text
viewer rather than in a
grid which is default

produced by the action

Is only valid in combination with mode="execute
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Attribute Value (bold = default) Description

® script
if the action produced a
result according to the
resulttype, copy it to the
SQL Commander

hideif There may be situations when an action should
be dropped due to a condition. The hideif
attribute is used to express a condition which is
evaluated when the list of actions is created.
Example: hideif="#dataMap.get('actionlevel’)
neq 'toplevel™

resetcatalogs truef/false Setting this attribute to true will reset any cached
databases for the actual database connection.
Useful when for example the action create,
rename or delete a database

resetschemas true/false Setting this attribute to true will reset any cached
schemas for the actual database connection.
Useful when for example the action create,
rename or delete a schema

supportsmultipleobjects true/false An action support processing multiple objects if
the style attribute for all input elements is one of:

® check

® Jist

® radio

® gseparator

® read-only text

The supportsmultipleobjects="true" attribute
is used to disable multi object processing even if
the previous criteria is satisfied

class Used to specify a custom Java class used as the
action

classargs Used to pass arguments to a custom action

doclink Relative HTML link to the related chapter in the
users guide
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Attribute Value (bold = default) Description
action drop drop is useful when extending another database

order-before

order-after

XML element - Input

profile to remove the Action

Specifies the order of this Action among a
collection of Action elements located at the same
level. It can either be an index starting at O (first)
or a node type. Ex. order-before="View" will
order this Action before Action elements defined
by the type="View" attribute

Specifies the order of this Action among a
collection of Action elements located at the same
level. It can either be an index starting at O (first)
or a node type. Ex. order-after="View" will
order this Action after Action elements defined by
the type="View" attribute

An Input element specifies the characteristics of a field component in the actions dialog. The label attribute is
recommended and is presented to the left of input field. If a label is not specified, the input field will occupy the
complete width of the action dialog. All input fields are editable by default. The name attribute is required for
editable fields and should specify the name of the variable in which the user input is stored.

Attribute Value (bold = Description
default)
label The label for the input component
name For editable input this should be the name of the variable holding the value

specified by the user

tip Message displayed when hovering over the component

editable  true/false

linebreak true/false

Enables or disables editing of the component

If set to true, no line break will be made after the input component. This is

useful when for example having multiple <Input style="check"> elements

in a single row

style list, radio, text,
check, password,
number, text-editor,
grid, separator

The style of the input element. See following sections for more details
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Attribute Value (bold = Description

default)
hideif There may be situations when an Input element should be dropped due to a

condition. The hideif attribute is used to express a condition which is
evaluated when the action is initialized. Example: hideif="#dataMap.get(’

actionlevel') neq 'toplevel

This is a minimal definition of an input field. It will show a read-only text field control labeled Size.

<l nput | abel ="Si ze" editabl e="fal se"/>

If the input field is changed to be editable, the name attribute must be used to specify the identifier for the
variable name.

<l nput | abel =Si ze" editabl e="true" nane="theSi ze"/>

Any input element may contain the tip attribute. It is used to briefly document the purpose of the input field and
is displayed as a tooltip when the user hover the mouse pointer over it.

<Input | abel =Si ze" editable="true" name="theSize" tip="Pl ease enter the size of the new xxx"/>

The hideif attribute is useful to limit what input fields should appear for an action. The condition specified in the
hideif attribute have the same syntax as described in the <SetVar> section. Example:

<l nput |abel ="Unit" hideif="#dataMap.get (' actionlevel') neq 'toplevel'">

Input fields can be aligned on a single row with the linebreak attribute. The default behavior is that every input
field is displayed on a single row. Use the linebreak="false" attribute to define that the next input field will be
arranged on the same line. To re-start the automatic line breaking feature you must use the linebreak="true"
attribute.

<I nput nanme="si ze" |abel ="Si ze" style="nunber" |inebreak="fal se">
<Def aul t >10</ Def aul t >

</ | nput >

<l nput name="unit" label="Unit" style="list" |inebreak="true">

<Label s>KB| MB</ Label s>

<Val ues>K| M/ Val ues>

<Def aul t >M</ Def aul t >
</ | nput >
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The previous example show the use of the linebreak attribute. The Size number field and the Unit list will
appear in the same row.

Specifying the default value as a result from an SQL statement is a trivial task:

<l nput | abel =Si ze" editable="true" nanme="theSi ze">
<Def aul t >
<Command>
<SQ.>
sel ect size from systables where tabl ename = ' ${obj ect nane}"
</ SQL>
</ Commrand>
</ Def aul t >
</ | nput >

The Default definition above will execute a SQL statement, it will automatically pick the value in the first row's
first column and present it as the default value for the input component. SQL may be specified in the Default
element for all styles while SQL in Values and the Labels elements are valid only for list and radio styles. In
some rare situations it may not be possible to express a SQL statement that will return a single column that
should be displayed for Values, Labels and Default. An example is when data is collected via a stored procedure
. To solve this problem specify the column attribute. Its value must be one of the actual column name or
column index:

<l nput | abel =Si ze" editabl e="true" nanme="theSi ze">
<Def ault col um="2">
<Conmmand i dr ef =" get Si ze" >
<l nput nane"obj ect nane" val ue="${obj ect nane}"/>
</ Comrand>
</ Def aul t >
</ | nput >

or by column name:

<I nput | abel =Si ze" editable="true" nanme="theSi ze">
<Default col um="THE_SI ZE>
<Command i dr ef ="get Si ze" >
<l nput nane"obj ect nane" val ue="${obj ect nane}"/>
</ Commrand>
</ Def aul t >
</ | nput >

An alternative to embedding the SQL in the element body, as in one of the previous examples, is to refer to a
command (see page 339) via the standard idref attribute:

<I nput | abel =Si ze" editable="true" nane="theSi ze">
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<Def aul t >
<Conmand i dr ef =" get Si ze" >
<l nput nane"obj ect nane" val ue="${obj ect nane}"/ >
</ Comrand>
</ Def aul t >
</ | nput >

Instead of having duplicated SQLs in multiple actions, consider using <Command idref="xxx"> elements
instead.

@ Referring commands in actions via the idref attribute is recommended when the same SQL is used in
several actions. Use Input elements for the Command to pass parameters to the command.

The following sections presents the supported styles that can be used in the Input element.

Style - text (single line)
The text style is used to present single-line data in a text field.

<l nput | abel ="Enter your userid" nane="userid" style="text">
<Def aul t >agnet a</ Def aul t >
</ | nput >

* The optional Default element is used to define a default value for the field. Variables, static text and
Command elements can be used to define the default value.
® Atextinputis editable by default. To make it read only specify editable="false"

Style - text-editor (multi line)
A text-editor field is the same as the text style except that it presents a multi-line field.

<l nput | abel ="Description" nane="desc" style="text-editor" editable="true" args="hei ght=50"/>

The args="height=50" attribute define the height (in DLU) for the text-editor. The default height is 30 DLU's.

Style - number
A number style is the same as text except that it only accept number values.

<l nput | abel ="Size" nane="size" style="nunber" editable="true"/>

Style - password
A password field is the same as text except that it masks the value as ***,
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<| nput | abel ="Password" nane="pw' styl e="password" editable="true"/>

Style - list (large number of choices)
The list style displays a list of choices in a drop-down component. The list can be editable, meaning that the
field showing the selection may be editable by the user. Here is a sample XML for the list style.

<l nput | abel ="Sel ect index type" name="type" style="list">
<Val ues>Pi zza| Past a| Bur ger </ Val ues>
<Def aul t >Past a</ Def aul t >

</ | nput >

The Values element should, for static entries, list all choices separated by a vertical bar (|) character. A Default
value can either list the name of the default choice or the index number (first choice starts at 0). In the example
above, setting Default to {2} would set Burger to the default selection.

It is also possible to use the Labels element. If present, this should list all choices as they will appear in the
actions dialog. Consider the following example and the labels shown to the user, while Values in this case
should list the choices that will go into the final SQL via the variable.

<Input | abel ="Sel ect index type" name="type" style="list">
<Val ues>Pi zza| Past a| Bur ger </ Val ues>
<Label s>Pi zza the French styl e|] Pasta Bol ognese| Texas Burger </ Label s>
<Def aul t >Past a</ Def aul t >

</ | nput >

If the users selects Texas Burger then the value for variable type will be Burger.

The following show how to use SQL to feed the list of values:

<I nput | abel =" New Dat abase" nane="newCat al 0og" style="list">
<Val ues>
<Command>
<SQ>
<! [ CDATA[
show dat abases
11>
</ SQL>
</ Command>
</ Val ues>
<Def aul t >${ cat al og} </ Def aul t >
</ | nput >

Here a Command element is specified as a sub element to Values. The result of the show databases SQL will
be presented in the list component.
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To make the list editable, specify the attribute editable="true".

Style - radio (limited number of choices)
The radio style display a list of choices organized as button components. The only difference between the radio
and list styles are:

® All choices for a radio style are displayed on the screen (better overview of choices but suitable only for a
limited number of choices)
® The args="vertical" attribute can be specified for radio style to present the radio choices vertically

See the list style for complete capabilities of the radio style.

Style - check (true/false, on/off, selected/unselected)
The check style is suitable for yes/no, true/false, here/there types of input. Its checked state indicates that the
Value for the input will be set in the final variable. If the check box is unchecked, the variable value is blank.

<l nput | abel ="Cascade Constraints" nanme="cascade" style="check">
<Val ues>conpact </ Val ues>
</ | nput >

® This will create a check component with the label Cascade Constraints

® Checking the check box will set the value of the variable identified by name (cascade) to the value of
Value, which is compact

® |f the check box is unchecked, the variable value will be blank

Style - separator (visual divider between input controls)

The separator style is not really an input element but is used to visually divide input components in the in the
action dialog. If the label attribute is specified, it will be presented to the left of the separator line. If no label is
specified, only the separator is displayed.

<I nput | abel ="Paraneters" style="separator"/>

The separator is a useful substitute for the standard label presented to the left of every input field. Here is a
sample:
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. "
ﬂ Create Function [ 3|

-~
Ohiject Details
Database Connection: |Mimer - sysadm
Schema: SYSADM
Function: MyFunc
Spedfic Name:
Return Data Type: nvarchar({20) -
Deterministic: (@ NOT DETERMIMISTIC () DETERMIMISTIC
Access Option: 'READS SGL DATA -
Parameters
.
tj{i} Mame Type | .;t_g. =
P1 nivarchar({20) -
L5
P2 nvarchar({20)
M
F3 BOOLEAN
a4
Source
1 --
2 —-— Insert your own function code here
3 —_
4 declare war nwarchari(z20);
5 et var = n'ahc';
& return wvar:
[] Show 5QL Execute ] [ Cancel

The figure shows the use of separators and two fields that extend to the full width of the action dialog. The
separators for Parameters and Source are here used as alternatives to labels for the fields below them.

Style - grid (configurable multi row/columns input)

The grid input style is presented as a grid with user controls to add, remove and move rows. The columns that
should appear in the grid are defined by using any of the primitive styles: text, number, password, check, list
and radio. The grid style is useful for data that allows the user to define multiple entries. Examples are, defining
columns that should appear in a table index, setup data files for a tablespace or databank.

This example show a grid style definition that will ask the user for parameters that will be part of a create
procedure action.

<l nput name="paraneters" style="grid">
<Arg nanme="out put" val ue="${direction} ${nane} ${type}${_default}"/>
<Arg nanme="new i ne" val ue=", "/>
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<l nput nanme="nane" | abel ="Nane" style="text">
<Def aul t >par nx/ Def aul t >
</ | nput >
<l nput nane="direction" |abel="Direction" style="list">
<Val ues>| N | NOUT| QUT</ Val ues>
<Def aul t >| N</ Def aul t >
</ | nput >
<l nput name="type" | abel ="Type" style="text">
<Def aul t >nvar char ( 20) </ Def aul t >
</ | nput >
</ | nput >

Here is the result:

. =)

[ﬂ Create Procedure

¢

[ »

Object Details

Database Connection: |Mimer - sysadm

Schema: SYSADM
Procedure:
Spedfic Name:
Deterministic: (@) NOT DETERMINISTIC (7)) DETERMIMISTIC
Access Option: READS SQL DATA v
Parameters
—
a Mame | &
M
b
Solrce
1 -
Z —-- Insgert your own procedure code here
3 -
4 declare warl integer;
5 set warl = 10;
[] Shiow SQL [ Execute ] [ Cancel

The sub elements for the grid style is different from the other input styles as it accepts nested Input elements.
These input styles define what columns should appear in the grid and the first input style will appear to the
leftmost and the last in the rightmost column.
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This example doesn't specify the label attribute as we want the grid to extend the full width of the actions dialog.
The grid style use the Arg elements to customize the appearance and function of the field. The following
arguments are handled by the grid style:

* output
Defines the output format for each row in the grid. The value may contain variables and static text. To
create conditional output check the SetVar element below

®* newline
Defines the static text that should separate every row in the grid. A "\n" somewhere in the value will be
converted to a newline sequence in the final output

* rowprefix
Specifies any prefix for every row in the grid

® rowsuffix
Specifies any suffix for every row in the grid

The resulting parameter list is created automatically by the control and is available in the variable name
specified in the example to be parameters.

The SetVar element in the context of a grid style is used to process the data that will appear as defined by the <
Arg name="output"> element. It is used to process the data for every row in the grid. Let's say that the output
must contain the word " default " if the value in a column named Default is entered. SetVar is used to handle
this:

<Set Var name="_default" val ue='#defaul t.equal s("") 2?2 "" : " default " + #default'/>

The #default input value is here evaluated and if it is not empty the " default " text s prefixed to the value of the
#default value. The result is stored in the _default variable which is also refered in the output argument above.

XML element - SetVar

The SetVar element is used to do conditional processing and create new variables based on the content of
other variables or static text.

Consider an SQL statement for creating new users in the database:

create user 'user' identified by 'password'

In this case it is quite easy to map the user field to an Input element for the action since it is a required field.
The question arise for password which is optional. The identified by clause should only be part of the final SQL
if the password is entered by the user. The solution for this scenario is to use the SetVar element. Here is the
complete action definition:

<Action id="nydb-user-create" |abel="Create User" reload="true" icon="add">
<l nput | abel ="Userid" name="userid" style="text"/>
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<l nput | abel ="Password" nanme="password" styl e="password"/>
<Set Var nane="_password" val ue=' #password. equal s("") ? "" : " identified by \"" + #password + "\
s
<Conmand>
<SQL>
<! [ CDATA[
create user ${userid} ${_password}
11>
</ SQL>
</ Command>
</ Acti on>

The SetVar element accepts three attributes:

Attribute Description
name The name of the new variable

value Should contain the expression that will be evaluated. The expression is based on the OGNL (http:/
commons.apache.org/proper/commons-ognl/) toolkit. This is an expression library that mimics most of
what is being supported by Java. Variables are referenced as #variableName

action This attribute is optional and can have any of the following values:

®* show - default and indicates that the variable (and its value will appear in node-form
viewers)

® hide - the variable will not display in node-form viewers

® drop - the SetVar element is not evaluated when actions is being processed

® runwheninit - runs the SetVar only during initialization of the action (before window is
displayed)

The expression in the example above checks whether the password variable is empty. If it is empty, a blank
value is being assigned to the _password variable. If it is not empty, the value for _password will be set to
identified by theEnteredPassword.

The SQL in the Command element now refer the new ${_password} variable instead of the original ${
password}.

© Itis recommended that variables produced via SetVar elements are prefixed with an underline () to
highlight were they come from.
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XML element - Confirm

The Confirm element is displayed to the user when a request to Execute the action is made. If there are only
read-only input fields in the action, this message is displayed in the body of the action dialog. Otherwise the
message is displayed in a confirmation dialog.

<ConfirnmpReal |y drop table ${table}?</Confirnp

@ Note that the message text can be composed of HTML tags such as <b>, <i>, <br>, etc.

XML element - Result
The Result element is optional and if specified, it is shown in a dialog after successful execution.

@ Result elements are currently not displayed in DbVisualizer. It is however recommend that you specify
these as they will most likely appear in some way or another in a future version. If you want to test the
appearance of Result elements then open the DBVIS-HOME/resources/dbvis-custom.xml file in a text
editor and make sure dbvis.showactionresult is set to true.

<Resul t >Tabl e ${tabl e} has been dropped! </ Resul t >

®* The Result message will be displayed in a dialog after successful execution.
® If the execution fails, a generic error dialog is displayed and the Result is not displayed.

XML element - Command
The Command element specifies the SQL code that is executed by the action.

<Comrand>
<SQ.>
<! [ CDATA[
drop table ${table} node ${node} including constraints ${includeconstraints}
11>
</ SQL>
</ Comrand>

For more information about the Command element check the XML element - Commands (see page 339) section
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XML element - Message
The Message element can be used to specify a highlight message that will appear at the top of the action
window.

<Message>

<! [ CDATA[
This action will be <b>deprecated</b> in a future version as it use database calls that has been
decl ared by the database vendor as <b>extrenely bad perform ng</b>.

11>

</ Message>

You may use simple HTML tags in the message content.

Action showing just a message

There may be situations when an action should show a message in a simple dialog with just an OK button. One
scenario when this is useful is when a condition is evaluated for an action requiring certain DB privileges to run it
. If proper authorization is missing a message should be displayed.

This is accomplished by having a single Confirm element for the Action element. The following illustrates an
example:

<If test="#SUPERUSER' >
<Action id="vertica-tabl e-anal yze-workl oad" |abel =" Anal yze Wirkl oad For Tabl e" resultaction="
show' >
<l nput | abel ="Schema" style="text" editabl e="fal se">
<Def aul t >${ schema} </ Def aul t >
</ | nput >
<l nput | abel ="Tabl e" style="text" editable="fal se">
<Def aul t >${ obj ect nane} </ Def aul t >
</ | nput >
<Command>
<SQ.>
<! [ CDATA[ SELECT anal yze_wor kl oad(' ${ schema}. ${obj ect nane}' )]]></ SQ.>
</ Command>
<Confirnme
Real Iy Anal yze Workl oad on ${schena}. ${obj ect nane} ?
</ Confirne
</ Acti on>
</If>
<El se>
<Action id="vertica-tabl e-anal yze-workl oad-1 NFO' | abel =" Anal yze Workl oad For Tabl e">
<Confirnme
<! [ CDATA[
This feature requires the <b>super user</b> authorization.
11>
</ Confirm
</ Acti on>
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22.5 lcons

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

22.5.1 Introduction

Icons related to functionality defined in a database profile are displayed in the database objects tree, actions and
object viewers. Icons are declared by mapping a logical name with the file name for the icon. For database
profiles provided with DbVisualizer, the type="xxx" attribute for GroupNode and DataNode elements map the
XXX with a matching icon file name. Icons are normally of minor interest until you decide to build your own
database profile or extend an existing one.

The following show the use of the icon attribute for a DataNode element. A condition control what icon to use
based on the value of getCatalogs. TABLE_CAT.

<Dat aNode type="Catal og" | abel ="${get Cat al ogs. TABLE_CAT}"
i con="#dat aMap. get (' get Cat al ogs. TABLE_CAT' ) . equal s(' sales') ? 'sal eslcon'
(#dat aMap. get (' get Cat al ogs. TABLE_CAT' ) . equal s(' support') ? 'supportlcon
nul l)">
</ Dat aNode>

The following sections explain how icons are handled and what choices you have to add your own icons.

22.5.2 icons.prefs file

Icons are defined in a simple text file with each row in the format: name=iconFileName. In DbVisualizer there is
a icons.prefs file provided with the installation and it maps all icons used not only in database profiles but for all
features. Here is a sample of the icons.prefs file.

Physi cal St andby= server_certificate
Pl an= FI X_execut e_expl ai n
Pri mar yKey= key

Privileges= key

Procedur e= gears

Procedur es= gears
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Process= cpu
Processes= cpu
Pr ogr ame hat _green
Prograns= hat _green
Properties= control _pane
Publ i cDat abaseLi nks= FI X_public_link
Publ i cDat abaseLi nk= FI X_public_link

The first name is the logical name used in the database profile. For all object types such as Table, Column,
View, Source and so on these names are defined in the icons.prefs file. For non object types icons are named
with the name the icon represents such as cut, copy, paste, open and so on. The value for each logical name
is the file name without the extension .png.

@ The object type may refer grouping objects (GroupNode) such as Tables, Views, Procedures and
specific a objects (DataNode) such as Table, View, Procedure. The general recommendation is to
name the object type for a GroupNode in a plural form and in singular form for DataNode objects. The
icon representing for example Tables and Table is in most cases the same, still there must be two
definitions in the icons.prefs file.

22.5.3 Icons Search Path

The database profile search path defined in Tool Properties / General / Database Connection / Database
Profile not only define what directories are searched for profiles but also icons. These are the default folders
searched:

${dbvis.prefsdir}/ext/profiles
${dbvi s. hone}/resources/profiles

${dbvi s. pref sdi r} is replaced with the setting directory for DbVisualizer on the platform being used. On
Windows this is C:\Users\<user>\.dbvis while ${ dbvi s. hone} is the installation directory for DbVisualizer. If
there is a icons.prefs file available in the searched directories the actual icon files bust be available in the
images/16x16 and images/24x24 sub directories such as ${ dbvi s. prefsdir}/ext/profil es/i mages/
16x16. The 16x16 directory should contain a 16 by 16 sized icon and the 24x24 a 24 by 24 sized icon.

This is an example of the ${ dbvi s. prefsdir}/ext/profil es/icons. prefs file:
sanpl e- schene- di ct =di ct

The actual icon represented by the dict file name is located in:
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${dbvis.prefsdir}/ext/profiles/inmges/16x16/dict.png
${dbvis.prefsdir}/ext/profiles/imges/24x24/dict.png

22.6 Conditional Processing

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

® Introduction (see page 395)
® Conditional processing when database connection is established (see page 396)
® Conditional processing during command execution (see page 397)

22.6.1 Introduction

Conditional processing simply means that a profile can adjust its content based on certain conditions. A few
examples:

® Which version of the database is being accessed

® The format of the database URL

® The client environment i.e Java version, vendor, etc.
® User properties

® Database connection properties

Conditional processing is especially useful when adapting the profile for different versions of the database (and/
or JDBC driver). Another use is to replace generic error messages with more user friendly messages.

If you have some programming skills conditions are expressed using if, else if and else statements.

There are two phases when conditions are processed:

1. Conditional processing when database connection is established
If, Elself and Else elements can be specified almost everywhere in the profile

2. Conditional processing during command execution
The OnError element is used to define a message that will appear in DbVisualizer if a command fails.
Conditions are used to control what message should appear

DbVisualizer uses the type attribute to determine which If elements should be executed in which of the two
phases. If this attribute is set to the value runtime, it will be processed in the second phase. If it is not specified,
it will be processed in the first phase.
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22.6.2 Conditional processing when database connection is
established

The following example shows the use of conditions that are processed during connect of the database
connection.

<Conmand i d="sybase- ase. get Logi ns">
<If test="#Dat abaseMet aDat a. get Dat abaseMaj or Version() Ite 8">
<SQL>
<! [ CDATA[
sel ect name from naster. dbo. sysl ogi ns
11>
</ SQL>
</If>
<El sel f test="#Dat abaseMet aDat a. get Dat abaseMaj or Version() eq 9">
<SQL>
<! [ CDATA[
sel ect name, suid from naster. dbo. sysl ogi ns
11>
</ SQL>
</ El sel f>
<El se>
<SQL>
<! [ CDATA[
sel ect name, suid, dbname from master. dbo. sysl ogins
11>
</ SQL>
</ El se>
</ Command>

The above means that if the major version of the database being accessed is less then or equal to 8, the first
SQL is used. If the version is equal to 9, the second SQL is used, and the last SQL is used for all other versions.
The test attribute may contain conditions that are ANDed or ORed. Conditions can contain multiple evaluations,
combined using parenthesis. The If, Elself and Else elements may be placed anywhere in the XML file.

Here is another example that controls whether certain nodes will appear in the database objects tree or not.

<l-- Getting Table Engines was added in WSQL 4.1 -->
<If test="(#dm get Dat abaseMj or Versi on() eq 4 and #dm get Dat abaseM nor Version() gte 1)
or #dm get Dat abaseMpj or Version() gte 5">
<G oupNode type="Tabl eEngi nes" | abel ="Tabl e Engi nes" isLeaf="true"/>
<l-- "Errors" was added in WSQ 5 -->
<If test="#dm get Dat abaseMaj or Version() gte 5">
<G oupNode type="Errors" label ="Errors" isLeaf="true"/>
</If>
</[If>
<Commands>
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<OnError>
<l-- The ORA-942 error neans "the table or view doesn't exist" -->
<l-- It is catched here since these errors typically indicates -->
<l-- that the user don't have privileges to access the SYS and/or -->

<l-- V$ tables. -->
<If test="#result.getErrorCode() eq 942" context="runtinme">
<Message>
<! [ CDATA[
You don't have the required privileges to view this object.
11>
</ Message>
</1f>
<El self test="#result.getErrorCode() eq 17008" context="runtime">
<Message>
<! [ CDATA]
Your connection with the database server has been interrupted!
Pl ease <a href="connect" action="connect">reconnect</a> to re-establish the connection.
11>
</ Message>
</ El sel f>
</ OnError >

</ Commands>
As you can see, this example contains nested uses of If.

22.6.3 Conditional processing during command execution

Using conditional processing to evaluate any errors from a Command may be useful to rephrase error
messages to be more user friendly.

<Conmmands>
<OnError>
<!-- The ORA-942 error neans "the table or view doesn't exist" -->
<l-- |t is catched here since these errors typically indicates -->
<l-- that the user don't have privileges to access the SYS and/or -->

<l-- V$ tables. -->
<If test="#result.getErrorCode() eq 942" context="runtine">
<Message>
<! [ CDATA[
You don't have the required privileges to view this object.
11>

</ Message>

</If>
<El self test="#result.getErrorCode() eq 17008" context="runtinme">
<Message>
<! [ CDATA[

Your connection with the database server has been interrupted!
Pl ease <a href="connect" action="connect">reconnect</a> to re-establish the connection.

11>
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</ Message>
</ El sel f>
</ OnError>

</ Commands>

The OnError element can be used in Commands and Command elements. If used in Commands element, its
conditions are processed for all its commands. If it's part of a specific Command, it is processed only for that
command.

22.7 Database Profile Utilities

@ Only in DbVisualizer Pro

This document and the Database Profile Framework in general is appropriate only when using the
licensed DbVisualizer Pro edition.

In the Database Profiles list in Connection Properties there is a right-click menu with various commands to
process the database profile and list of profiles. These

commands are useful while developing a database profile. Read the following sections for more details about
each command.

®* Analyze Database Profile (see page 398)

¢ Show All Type and Icon Attributes (see page 399)
® Show Available Icons (see page 400)

® Export Merged Profile (see page 400)

® Configure Search Path (see page 400)

®* Reload Database Profiles List (see page 400)

22.7.1 Analyze Database Profile

This command verify the loaded database profile and perform various consistency checks and may report:

Check
GroupNode and DataNode elements with no matching ObjectView (by "type" attribute)
ObjectView elements with no matching GroupNode or DataNode (by "type" attribute)

ActionGroup elements with no matching GroupNode or DataNode (by "type" attribute)
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Check
DataView elements located in the same ObjectView having same "label" attribute

No matching icon for these elements (by the "type" or "icon" attributes)

22.7.2 Show All Type and Icon Attributes

This command examine the loaded profile and report all used icons (logical name) as referenced by the object
type and specific icon attributes. The following is an example doing running this command with the MySQL
profile loaded.

These are all "type" and "icon" references in the profile
add
cat al og
col um

col ums
dat a

dat abases
dba

edit
errors
export
function
functions
i mport

i ndex

i ndexes
info

login

navi gat or
pri marykey
procedure
procedur es
process
processes
ref erences
renove
rename
role

rol es
roncount
row d
schema
scri pt obj ect
source
sour ceedi t or
st at us
tabl e
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t abl eengi ne

t abl eengi nes
tabl eprivil eges
tabl es

trigger
triggers

users

vari abl es

Vi ew

Vi ews

22.7.3 Show Available Icons

This will show a window with all available icons, their name, icon file name and an indicator if the icon is used in
the loaded database profile.

22.7.4 Export Merged Profile

This will export the currently loaded profile. If the profile has been merged using the extend (see page 335)
attribute the exported profile file is the complete and processed profile.

22.7.5 Configure Search Path

This will open Tool Properties / General / Database Connection / Database Profile pane used to configure
the search path for database profile loading.

22.7.6 Reload Database Profiles List

This will reload the list of database profiles in case a new profile has been added (or renamed) since last launch
of DbVisualizer.
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23 Troubleshooting

Even though we make our very best to ensure the quality of DbVisualizer, you may run into problems of different
kinds. The runtime environment for DbVisualizer is rather complicated when it comes to tracking the source of a
problem, since it's not only DbVisualizer that may cause the problem but also the JDBC driver, or even the
database engine.

There are a few things that you can try before reporting a problem, depending on the nature of the problem:

1. Make sure you are using the latest version of Java (http://www.java.com/) available for your platform (Java
6 or later),

2. Make sure you are using a version (http://www.dbvis.com/doc/database-drivers/) of the JDBC driver that we've

tested DbVisualizer with, or a later, production quality version,

Read the DbVisualizer FAQ (http:/confluence.dbvis.com/display/FAQ),

Check the online Forums (http://www.dbvis.com/forum/),

Read the DbVisualizer Users Guide (http://confluence.dbvis.com/display/UG/Users+Guide),

... the last resort is to post a question via the problem report form (see page 406) or send an email to

support@dbvis.com (mailto:support@dbvis.com). (Note that we generally love detailed reports as well as

screenshots when possible)

oo AW

23.1 Debugging DbVisualizer

The Tools->Debug Window is useful to see what is going on in DbVisualizer and the JDBC driver(s). The
checks at the top control what parts of DbVisualizer should be debugged. The Debug JDBC Drivers option will
enable debug of the current JDBC driver. Note that the amount of output is determined by the JDBC driver.
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. L
_ﬂ Debug Window [ =2

Debug DbVisualizer [ | Debug JDBC Drivers

=R Y 22M of 254M L=l
e R e I T [ o e e e e LT R T 3= e
18:57:55 [DEBUG Thread-19% ProfileManager.proce3slfElements] match: If "#dm.getDatabass
18:57:55 [DEBUG Thread-13% ProfileManager.proce3slfElement3] match: If "#dm.getDatabass
18:57:55 [DEBUZ Thread-19 Database.getProfileManager] Using profile: cracle

[

7
7
7
7:55 [DEBUG Thread-1% CommandExecutor.execute] CommandId: getSchemaMames

T7:55 [DEBUG Thread-21 TreeExpanderExecutor.createNodes] elementName: '"Grouplode' labs
7:55 [LEBUE Thread-21 TreeExpanderExecutor.createlodes] elementName: '"Grouplode' labs
7
7
7
7
7

[

[

:55 [DEBUG Thread-21 TreeExpanderExecutor.createNodes] elementName: "GroupMNode' labs
:55 [DEBUG Thread-19% JODBCExecutor.runGetSchemas] DbConnecticon: Oracle test

:535 [DEBUG pool-4-thread-l JDBCMetaDataHandler.dolnvoke] RootConnection: OracleDatal
:55 [DEBUG Thread-19 CommandExecutcor.execute] Total rows/columns: 37/1. Rows after |

:55 [DEBUG AWI-Ewent{Queue-1 Command.cloneCommand] Beturning cloned generic Command 17
i F

[Erp - [
0 0 OO 0O 0 0B 00 OO0 00 OO OO

- -

Log Destination: @ Debug (this) Window Auto Popup
“) File

) Consale

The Save and Copy buttons in the toolbar prepare the log with information about the DbVisualizer version you
are using and the connected database connections.

The log is automatically truncated to preserve memory when the log destination is set to Debug Window. The
Console and File destinations have no such limitation.

23.2 Fixing Connection Issues

There may be many reasons for why you cannot connect to a database, but some of the most common are:

® Incorrect values for the Database Server or Database Port fields in the Object View tab for the
connection,

®* TCP/IP access is not enabled in the database server,

* A firewall between the client and the database server blocks connections to the database port,

® A syntax error in a manually entered JDBC URL,

® The user account is not authorized to connect from the client where you run DbVisualizer,

® Native libraries for a JDBC driver are not found.

The first three problems usually results in a somewhat cryptic message about I/O errors or a time-out. You can
use the Ping Server button to make sure that the a TCP/IP network connection can be established to the
specified server and port. If this test fails, please ask your system or database administrator for help.
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JDBC syntax errors typically result in one of two error messages:

® "The selected Driver cannot handle the specified Database URL. The most common reason for this error
is that the database URL contains a syntax error preventing the driver from accepting it. The error also
occurs when trying to connect to a database with the wrong driver. Correct this and try again.”

* “java.sql.SQLException: lo exception: Invalid number format for port number lo exception: Invalid number
format for port number"

In both cases, we recommend using the Server Info settings format instead of the Database URL format for the
connection, and let DbVisualizer build a valid JDBC URL for you. If you must enter a JDBC URL manually, make
sure that you replace possible placeholders enclosed with "<" and ">" in a template you have copied, such as <
1521>, and look for other syntax errors. Also verify that the JDBC driver is installed (see page 409) correctly.

Authorization problems are usually described by more straight forward messages. Ask you database
administrator to help you get it resolved.

If you get a message about native libraries not being found, e.g. " no ocijdbc11 in java.library.path” or similar, it
is because you have not installed these in a location where DbVisualizer can read them. Unless you have a very
good reason for using a JDBC driver that requires native code, we recommend that you use a pure Java JDBC
driver (a Type 4 driver) instead, like the "Oracle Thin" driver for Oracle.

If none of this helps, please contact us using the Help->Contact Support form. Most of the information we can
gather about the problem is typically already filled in, but please add any additional details that may help us
figure out what is wrong.

23.3 Handling Dropped Connections

All tasks that may potentially take a bit of time to perform or that may not finish at all because a database
connection has dropped are executed in the background so that you can still do other things. You can see that
background tasks are running by looking at an indicator icon in the status bar.

|76M of 434M T

If there are tasks running, the indicator icon is animated, showing a spinning pattern.

You can see exactly which tasks are running by clicking on the icon. This opens the Task Manager window.
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9

| 8 Background Task Manager

Executing

n @

Executing SQL on "CRM Ahoa's SELECT * FROM "HR™."COUNTRIES" WHERE COUNTRY_MAME like “%%a%’
References

iCollecting tables for "CRM Ahos’

Close

You can abort a long running task by clicking the Stop button next to the progress bar.

If the task did not complete because the connection dropped, you also need to reconnect to the database. If this
happens frequently, you can enable Connection Keep-Alive (see page 294) to send a dummy SELECT
statements to the database occasionally to prevent time-outs.

23.4 Handling Memory Constraints

DbVisualizer has a fixed amount of memory available, and things may go bad if you load so much data that
you're getting close to this limit. The most common effect is that the GUI becomes very unresponsive or freezes
completely.

To minimize the risk of this happening, DbVisualizer keeps track of the memory usage when you load tables or
files and similar tasks that consume memory. If you're getting so close to the limit that problems are likely to
begin to show, all memory consuming background tasks are suspended and the High Memory Usage window

pops up.
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- y

[ £ High Memery Usage Detected | 22|
You are running out of memory.
Flease close tabs and stop tasks listed below until you have freed up enough memaory to
continue. You may also need to dick the garbage bin icon to the left of the memory usage

bar to force release of memaory.

To see how you can avoid this problem in the future, please open Help-=0nline Resources
and choose the FAQ page. It explains how you can increase the memory available to

Dbvisualizer.
Current Tabs
[ 2: 200000 selects.sql wzome 4
... MySQL regdownloads oi7ve 9=
CRM Ahoa COUNTRIES 0.00 MB x
D 1: Computers per Employee.sql 0.00 MB x -
Current Tasks
Executing "
" @

Memory Usage

450M of 434M |

/1, Continue ] ’ Shutdown DbVisualizer ] ’ Create Heap Dump ]

All open tabs are listed along with an estimate for how much memory each tab uses. All background tasks are
also shown. You need to resolve the high memory usage problem before you can continue working with
DbVisualizer. Click on the red cross next to tabs that use lots of memory to close them and stop tasks that
consume memory.

When you have released enough memory to get below the critical level, the icon in the Continue button changes
to a green checkmark. Click it to close the window and continue to work.

If you often see this window, first consider using features that minimizes the memory usage, such as using the @
r un command to execute your script (see page 179) and the @xport command to write query results to a file (
see page 209). As a last resort, you can increase the amount of memory DbVisualizer can use. Please see the
FAQ page (http://confluence.dbvis.com/pages/viewpage.action?pageld=3146118) on out web site for how to do so.

In rare cases, closing tabs and stopping tasks do not release enough memory to continue, possibly due to

memory leaks in the DbVisualizer code. If this happens, you can click the Create Heap Dump button. The heap
dump file is named heap.bin and stored in the preferences folder, typically the .dbvis folder in your home folder.
It may help us find memory leaks and fix them, so please send it to us with a description of what you were doing
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when you ran into this problem. The file can be huge, so please compress it (e.g. using the zip command)
before mailing it to us.

If you cannot release enough memory to continue, you can use the Shutdown DbVisualizer button to shut
down and start fresh.

23.5 Reporting Issues

You can use either the Help->Contact Support form or our forums and web contact forms to report problems
and ask for help. We recommend the former, as it gathers information about your settings and connections that

help us provide you with better analysis of the problem without having to get back to you and ask for additional
information.

P

| 8] Contact Support

5

Application Properties

Version: DbVisualizer Pro 9.1 [Build #2837]
05: Windows 7

05 Version: 6.1 B
05 Arch: x36

Java Version: 1.7.8_25

Java VM MName: Java HotSpot(TM) Client WM

Java VM Vendor: Oracle Corporation

Look and Feel: WindowslLookandFeel

l#** MNatashara Dennaertior fkdddddrrrdddkrrrrrrrrfddEEs

Specify your support request

m
J

i

()

Jesripaon

Copy to System Clipboard and Report on our Website
Your Contact Information

Your First Mame Your Last Mame Your Email Address Remember

Proxy Settings Send ] [ Cancel

If you encounter an error that causes an error alert dialog to pop up, please click the Report Problem button to
open the contact form with the details of the error filled in.
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|| DbVisualizer Pro 9.1 22 |

An internal error occurred in: [ Report Problem... ]
[ Copy to Clipboard ]
[ Save As... ]

java.lang.MullPointerException

The error may have affected the application state.
Please report problem to vendor, [ Mare Details ]

Shutdown Dbvisualizer Close Window

23.6 Using special characters in passwords

Passwords entered for connections etc. can optionally be saved between sessions by DbVisualizer. Passwords
containing special characters such as can not be saved when the default encoding for passwords is used. More
specifically DbVisualizer only supports characters in the 8859-1 character set with the default encoding; other
characters are corrupted when saved.

To be able to save passwords containing any characters, you need to enter a Master Password. Please see the
section Setting a Master Password (see page 290) for more information.
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24 Reference Material

Here you find details about areas that are not covered elsewhere.

24.1 GUI Command Line Arguments

As an alternative to start DbVisualizer via the menu items and icons created by the installer, you can also start
DbVisualizer from a shell (terminal) on all operating systems using the following scripts:

# DbVi sualizer GU on Wndows:

DBVI S- HOVE\ dbvi sgui . bat

# DbVi sualizer GU on Linux/UN X:

DBVI S- HOVE/ dbvi sgui . sh

# DbVisualizer GU on Mac OS X

DbVi sual i zer. app/ Cont ent s/ j ava/ app/ dbvi sgui . sh

The scripts supports a number of command line arguments. These are also listed in the Help->About menu
choice, under the Command Line tab, in DbVisualizer.

Usage: dbvisgui [-connection <nane>] [-userid <userid>] [-password <password>]
[<fil ename>] [-encoding <encodi ng>]
[-prefsdir <directory>]
[-windowtitle <title>]
[-hel p] [-version]
CGeneral Options:

-connecti on <nane> Dat abase connection name (created with the GU)
-userid <userid> Userid to connect as

-password <password> Password for userid

<fil enane> SQL script file to load into editor

-encodi ng <encodi ng> Encoding for the SQL script file

-prefsdir <directory> Use an alternate user preferences directory
-windowtitle <title> Additional windowtitle

-hel p Di splay this help

-version Show version info

& Please note that these scripts use the first Java version that is found in the PATH. The result may be
that a non supported Java version is used.

Page 408 of 428



N |
= DbVisualizer 9.2 Users Guide

24.2 Installation Structure

The installer and launcher for DbVisualizer is based on the install4jTM product (http://www.install4j.com (http:/
www.install4j.com/)). The structure of the installation directory (referred as DBVIS-HOME throughout the Users
Guide) contains the following. (The exact content may differ between platforms):

.install4j/
doc/

editor/

jdbc/

lib/
resources/
wrapper/
dbvis.vmoptions
dbvis.exe
README.txt
uninstall.exe

The dbvis.exe file is used to start DbVisualizer. The remaining files and directories are only of interest if you
need to do nonstandard customization. For information on how to increase the memory for the Java process that
runs DbVisualizer, and also on how to modify the Java version being used, please read the online FAQ (http:/
confluence.dbvis.com/display/FAQ) for the latest information.

24.3 Installing a JDBC Driver

DbVisualizer bundles JDBC drivers for most common databases, so typically you do not need to install a JDBC
driver.

®* What is a JDBC Driver? (see page 410)
® Get the JDBC driver file(s) (see page 410)
® Driver Manager (see page 411)
® JDBC Driver Finder (see page 411)
® | oading and Configuring Drivers Manually (see page 413)
® Setup a JDBC driver (see page 415)
® JDBC drivers that requires several JAR or ZIP files (see page 417)
®* The JDBC-ODBC bridge (see page 418)
® Errors (why are some paths red?) (see page 418)
® Several versions of the same driver (see page 419)

This page describes the way JDBC drivers are managed in DbVisualizer. If a JDBC driver for your database is
bundled with DbVisualizer, see Driver Info on the Supported Databases (http://www.dbvis.com/doc/database-drivers/
) page, you typically do not need to read this chapter.
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If, however, any of the these things apply to you, keep on reading:

® want to learn how the Driver Manager in DbVisualizer works,
® need to have several versions of the same JDBC driver loaded simultaneously,
® need to add a Driver that does not exist in the list of default drivers .

24.3.1 What is a JDBC Driver?

DbVisualizer is a generic tool for administration and exploration of databases. DbVisualizer does not deal
directly with how to communicate with each database type. That job is done by a JDBC driver, which is a set of
Java classes. All JDBC drivers conform to the JDBC specification and its standardized Java programming
interfaces. This is what DbVisualizer relies on. A JDBC driver implements all details for how to communicate
with a specific database and database version, and there are drivers available from the database vendors
themselves as well as from third parties. To establish a connection to a database, DbVisualizer loads the driver
and then gets connected to the database through the driver.

It is also possible to obtain a database connection using the Java Naming and Directory Interface (JNDI). This
technique is widely used in enterprise infrastructures, such as application server systems. It does not replace
JDBC drivers but rather adds an alternative way to get a handle to an already established database connection.
To enable database "lookup's" using JNDI, an Initial Context implementation must be loaded into the
DbVisualizer Driver Manager. This context is then used to lookup a database connection.

The following sections describe the steps for installing a JDBC Driver, and also how to configure DbVisualizer to
use JNDI to obtain a database connection.

24.3.2 Get the JDBC driver file(s)

DbVisualizer comes bundled with all commonly used JDBC drivers that have licenses that allow for distribution
with a third party product. Currently, drivers for DB2, H2, JavaDB/Derby, Mimer SQL, MySQL, NuoDB, Oracle,
PostgreSQL, SQLite, Vertica as well the JTDS driver for SQL Server and Sybase, are included with DbVisualizer
. If you only need to connect to databases of these types, you can skip the rest of this chapter and jump straight
to the Creating a Connection (see page 17) page, because by default, DbVisualizer configures all these drivers
automatically the first time you start DbVisualizer.

If you need to connect to a database that is not supported by a bundled JDBC driver, you must get a JDBC
driver that works with your database type and version. The following web page contains an up-to-date listing of
the database/driver combinations we have tested:

http://www.dbvis.com/doc/database-drivers/
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To find a JDBC driver for your database, go to the database vendor's website or search for the name of the
database plus the word JDBC.

(http://www.dbvis.com/doc/database-drivers/)

Download the driver to an appropriate directory. Make sure to read the installation instructions provided with the
driver. Some drivers are delivered in ZIP or JAR format but need to be unpacked to make the driver files visible
to the Driver Manager. The Databases and JDBC Drivers (http://www.dbvis.com/doc/database-drivers/) web page
describes where you can download some drivesr and also what additional steps may be needed to install and
load the driver in DbVisualizer.

» Drivers are categorized into 4 types. We're not going to explain the differences here, just give you the
hint that the "type 4," aka "thin," drivers are the easiest to maintain, since they are pure Java drivers
and do not depend on any external DLL's or dynamic libraries. Even though DbVisualizer works with
any type of driver, we recommend that you get a type 4 driver if there is one for your database.

When you have downloaded the JDBC driver into a local folder (and unpacked it, if needed), you can go ahead
and create a database connection with the Connection Wizard, as described in the Creating a Connection (see
page 17) page. You will then be asked to load the driver files when the wizard needs them. Alternatively, you
can move (or copy) the JDBC driver files to the DBVIS_HOME/jdbc folder, where they will be picked up and
loaded automatically by the JDBC Driver Finder (see page 411) the next time you start DbVisualizer.

24.3.3 Driver Manager

The Driver Manager in DbVisualizer is used to define the drivers that will be used to communicate with the
databases. You can manually locate the JDBC driver files and configure the driver, or you can use the JDBC
Driver Finder to do most of the work for you, either on demand or automatically.

JDBC Driver Finder

The JDBC Driver Finder is a very powerful part of the Driver Manager that automates most of the driver
management work. Given the folders where JDBC drivers are located, it loads and configures new drivers (if any
) every time you start DbVisualizer. You can configure the JDBC Driver Finder in Tools->Tools Properties, in
the Driver Manager category under the General tab.
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E] Tool Properties

m General [E Database

(= &=

m General

=-¢f Appearance
- ofA Fonts
-2 Key Bindings
----- [_ Database Connection
¥
2 permissions
A Time Zong
4= File Encoding
- ffy Data Formats
Table Data

=B sQL Editor
-3 Statement Delimiters
= =| 5QL Formatting
{=| align and Indent
i =| Line Breaks
. | Whitespace
- I Auto Completion

/2] Comments
::S Variables

S0L History
----- Proxy Setting

Binary/BLOB and CLOBE Data

JDBC Driver Finder Settings

Controks whether the IDBEC driver finder should run automatically at start of DbVisualizer, If
disabled, use the Tools->Driver Manager to sstup JDEC drivers,

Run JDBC Driver Finder at Startup:
Replace Driver Files:

Display when Mew Files:

Display on Errar: [

Driver Finder Paths

This list defines directory paths that the driver manager will use to automatically find JDEC
drivers. Each listed directory will be searched recursively for JAR files, For optimal result,
organize related JAR files in one directory per driver.,

Search Path

S{dbwvis prefsdirjjdbc
F{dbvis.home}jdbc

<>l

S{dbvis.home} = ¥:\Users|rogge\work\swnltrunk)pureit\appsidbvis
S{dbvis.prefsdir} = C:\Users\rogge!, dbvis

Excluded File Mame Patterns

List of file name patterns that should be excluded by the IDBEC driver finder feature, A
pattern can list an explicit JAR file name or a regular expression,

File Mame or Paltern

Flmysgl.*bin-gi.jar

Jg.d

joonn3d.jar -

ok J[ meely ][ concel |
Use the following properties to specify the finder behavior:
Property Description
Run If enabled, the finder will run automatically every time you start DbVisualizer. If it finds any new
JDBC driver files, it will automatically load and configure them.
Driver
Finder at
Startup
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Property Description

Replace If enabled, the driver files are replaced for the matching driver even if the driver already has
Driver proper driver files.
Files

Display If enabled, the finder window pops-up if it finds any new files when you start DbVisualizer.
When Otherwise the finder runs invisibly in the background.

New

Files

Display If enabled, the finder window pops up if it encounters any errors loading and configuring new

on Error  drivers. Otherwise it is silent about errors and you have to launch the Tools->Driver Manager to
see which drivers are not loaded successfully. Enabling this property is only meaningful if you
have disabled Display When New Files.

You can also specify the folders the JDBC Driver Finder will search. By default, it will search folders named jdbc
in the DbVisualizer installation directory (${ dbvi s. honme} ) and the DbVisualizer preferences folder (${
dbvi s. pref sdi r}). These folder paths are shown under the list of Driver Finder Paths.

Finally, you can specify regular expression patterns for filenames that the finder should ignore. This can be
useful if you need to store other files besides driver files in the designated folders.

If you let the JDBC Driver Finder load all drivers for you, all you need to do to install a new driver is to put the
driver files in one of the folders specified for the finder in Tool Properties and then restart DbVisualizer.

. The Driver Finder is always activated when upgrading from an older DbVisualizer version.

Loading and Configuring Drivers Manually

You can also load and configure JDBC drivers manually using the Driver Manager. If you use JNDI to provide
access to the database, you must use this option, since the JDBC Driver Finder does not handle JNDI. Start the
Driver Manager dialog using the Tools->Driver Manager menu choice.

The left part of the driver manager dialog contains a list of driver names with a symbol indicating whether the
driver has been configured or not. The right part displays the driver configuration for the selected driver in terms
of the following:

®* Name
A driver name in the scope of DbVisualizer is a logical name for either a JDBC driver or an Initial Context
in JNDI. This is the name shown in the Connectiontab when selecting which driver to use for a Database
Connection
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URL Format

The URL format specifies the pattern for the JDBC URL or a JNDI Lookup name. Its purpose is to assist
the user in the Connection tab when entering URL information or a lookup name. See Using Variables in
Connection Fields (see page 299) for more about how you can make it really easy to create Database
Connections for this driver later on.

Driver Class

Defines the main class for the JDBC driver, used for connecting to the database.

Driver Version

Shows the version for a loaded driver.

Web Site

Link to the DbVisualizer web site, where you can get up-to-date information about how to download the
drivers for many databases.

Driver File Paths

Defines all paths to search for JDBC drivers or Initial Contexts when connecting to the database. The
Driver File Paths area is composed of two tabs: the paths in the User Specified tab are used for
dynamically loaded JDBC drivers or Initial Context classes, and the System Classpath tab lists all paths
that are part of the Java system class path.

The System Classpath tab is only of interest for the JDBC-ODBC driver.
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;’ Driver Manager
Driver Edit  View

BRERIIZNGEAVY G

(=& ]=]

Ciriver Mame

DB2 (Databirect)
(3 DB2 for AS/400 (JTOpen)
(3 Firebird
@ FrontBase

HP Meowiew

3 HSQLDB embedded
(3 HSQLDE server
-g Informix

Informix {DataDirect)
@ JavaDB/Derby embedded
(3 JavaDB/Derby server
3 IDataStore
{3 JDBC/ODEC Bridge

9 MaxDB
3 McKoi
@ Mirmer
3 MysqL

Metezza

Orade (DataDirect)
3 Orade OCI
@ Oracle Thin
@ Pervasive

a Pointhase server

& Pointbase embedded

m

4 Driver Settings
>
Mame: |Cache
URL Format: |jdbc:Cache:/f<server >: <port1972=/<namespace =

Driver Class: EF com.intersys.jdbc. CacheDriver -

Driver Version: 5.2
Web Site: http:/fwww. dbvis.com

¥ - 10BC Driver & - INDI Lookup

Driver File Paths

User Spedfied | System Classpath

"-\_r__‘_,T‘ Z:work'svnitrunk\pureitjdbci\drivers'cache\CacheDE. jar
EF com.intersys.jdbc.CacheDriver

Ad208

L]

Show Full Path | |

E = Custom Driver

Initially, the driver list contains a collection of default drivers. They are not fully configured, as the paths to
search for the classes need to be identified. You can edit the list, i.e., create, copy, remove and rename drivers.
A driver is ready to use once a driver class has been identified, which is indicated with a green check icon in the
list. Drivers that are not ready for use are shown without an icon, or with a red cross icon if an error has been

detected (such as a missing file) .

Setup a JDBC driver

The recommended way to setup a driver is to pick a matching driver name from the list and then simply load the
JAR, ZIP or directory that keeps the driver class(es). For instances, if you are going to load the JDBC driver for
Oracle, select the Oracle driver in the list . You can also create a new driver or copy an existing one.

Check the following online web page with the most current information about the tested databases and drivers:
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It lists which databases and drivers we have tested

Download links to JDBC drivers

® |nformation about which files to load in the driver manager for each JDBC driver
Information about which Driver Class to choose

When you have selected the driver to configure, you need to load the driver files. Click the Load button to the
right of the User Specified paths tree to show the file chooser and load the driver JAR, ZIP or individual files.

- y

8@ Oppna =1
letai: | | 1L2.0.10 - FeeEaE
I |5 ojdbch Hidden Files:
e Wt | xdb [ Show
Tidigare =] xrlparserv
Skrivbord
&
Mina dokument
Dator
Q_L\ Filnarn: ojdbca.jar Oppna
ahia Filformat: :Ja'u'a Archive File (.jar) -

A JDBC Driver implementation typically consists of several Java classes. If they are packaged in a JAR or a ZIP
file, you don't have to worry about the details; just select and load the JAR or ZIP file. For instance, in the
example above, use the ojdbcé6.jar file.

If the driver classes are not packaged, it is important to select and load the root folder for the JDBC Driver. Java
classes are typically organized using a package name structure. Example:

oracl e.jdbc.driver. O acl eDriver

Each package part in the name above (separated by ".") is represented by a folder in the file system. The root
folder for the driver is the folder named by the first part, i.e., the oracle directory in this example. The class files
are stored in the oracle/jdbc/driver sub folder. When the driver classes are located in a folder structure like this,
you must select and load the root folder, so that the Driver Manager gets the complete package structure.
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When a connection is established in the Connection tab, DbVisualizer searches the selected drivers path tree's
in the following order:

1. User Specified
2. System Classpath

The paths are searched from the top of the tree, i.e., if there are several identical classes in, for example, the
dynamic tree, the topmost class will be used. Loading several paths containing different versions of the same
driver in one driver definition is not recommended, even though it works (if you do this, you must move the driver
you are going to use to the top of the tree). The preferred method for handling multiple versions of a driver is to
create several driver definitions.

When you load files in the User Specified paths list, DbVisualizer analyzes each file to find the classes that
represent main driver classes. Each such class is listed under the path where it was found in the User Specified
paths lists, and it is also added to the Driver Class list in the Driver Settings area above. If there is more than
one class in the list, make sure you select the correct Driver Class from the list. Consult the driver
documentation (or the Databases and JDBC Drivers (http://www.dbvis.com/doc/database-drivers/) page) for
information about which class to select.

JDBC drivers that requires several JAR or ZIP files

Some drivers depend on several ZIP or JAR files, or directories. One example is if you want XML support for an
Oracle database. In addition to the standard JAR file for the driver, you then also need to load two additional
JAR files. These are not JDBC driver files but adds functionality the driver needs to fully support XML.

Simply select all JARs at once and press Open in the file chooser dialog. The Driver Manager will then
automatically analyze each of the loaded files and present any JDBC driver classes or JNDI initial context
classes it finds.
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The JDBC-ODBC bridge

The JDBC-ODBC driver is bundled with most Java installations, but not all (e.g., it is not included with Java for
Max OS X). The JdbcOdbcDriver class is included in a JAR file that is commonly named rt.jar, stored
somewhere in the Java directory structure. DbVisualizer automatically identifies this JAR file in the System
Classpath tree. To locate the JdbcOdbcDriver, simply press the Find Drivers button to the right of the System
Classpath tree. When it is found, make sure the sun. j dbc. odbc. JdbcGdbcDri ver is selected as the Driver
Class in the Driver Settings area.

. The JDBC-ODBC bridge driver is not intended for production use and is known to be limited and
unreliable. Use it only if there is no pure JDBC driver for your database.

Errors (why are some paths red?)

A path in red color indicates that the path is invalid. This may happen if the path has been removed or moved
after it was loaded into the driver manager. Simply remove the erroneous path and locate the correct one.
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Several versions of the same driver

The Driver Manager supports loading and using several versions of the same driver concurrently. We
recommend that you create a unique driver definition per version of the driver and name the driver definitions
properly, e.g., Oracle 9.2.0.1, Oracle 10.2.1.0.1, etc.

24.4 Setting Up a JNDI Connection

Initial Context classes are needed to get a handle to a database connection that is registered with a JNDI lookup
service. In DbVisualizer, these context classes are similar to JDBC driver classes in that an Initial Context
implementation for a specific environment is required.

» Remember that the appropriate JDBC driver classes must be loaded into the Driver Manager even if
the database connection is obtained using JNDI.

To load Initial Context classes into the Driver Manager, simply follow the steps outlined for installing a custom
JDBC driver (see page 409). The difference is that you will load paths containing Initial Context classes instead
of JDBC drivers. When you load a path, DbVisualizer locates all Initial Context classes in the path and lists them
in the User Specified paths list.
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When you create a database connection using a JNDI Lookup driver, the Properties sub tab in the connection's
Object View tab always contains then same driver properties.
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Constant that holds the name of the environment property for specifying configuration information for the
service provider to use. The value of the property should contzin 2 URL string (=.g.
"ldap:/{somehost: 3857), This property may be specified in the environment, an applet paramster, a system
property, or a rescurce file. If it i not specified in any of these sources, the default configuration is
determined by the service provider,

sefas

The list of options for INDI lookup is determined by the constants in the j avax. nam ng. Cont ext class. To
change a value, just modify the value of the parameter. The first column in the list indicates whether the property
has been modified or not, and so, whether DbVisualizer will pass that parameter and value onto the driver at
connect time.

New parameters can be added using the buttons to the right of the list. Be aware that additional parameters do
not necessarily mean that the InitialContext class will do anything with them.

24.5 Special Properties

DbVisualizer utilizes a few special properties that you can use to modify characteristics of the application. These
properties are available in the DBVIS-HOME/resources/dbvis-custom.prefs file.

Property Description
dbvis.-AutoSaveRuninterval=30 The number of seconds between auto-saving open SQL editors.

dbvis.disabledataedit=false
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Property Description

Specifies if table data editing should be completely disabled, i.e. the form
and inline editors. Note: This has an effect only when used with a
licensed edition.

dbvis.driver.ignore.dir=lib: Specify directories from DBVIS-HOME that should not be listed in the
resources:.install4j Driver Manager "System Classpath" list. Directories are separated with ":"

Accepted values: one or several directory names starting from
DBVIS-HOME.

dbvis.grid.encode=false Specifies if encoding of data in result set grids will be performed or not. If
set to true then make sure the dbvis.grid.fromEncode and/or
dbvis.grid.toEncode are also set.

dbvis.grid.fromEncode= Encoding used when translating text data that is fetched from the
1ISO8859 1 database
dbvis.grid.toEncode=GBK Encoding used when translating data that will appear in the result set grid

dbvis.removepartialresultsets=  Defines whether the result set(s) should be removed when interrupting an
false ongoing execution in the SQL Commander.

dbvis.savedatacolumns=false Column layout changes such as reordering and/or visibility are saved for
all grids in the Objects Views *except* for the "Data" grid. This property
can be used to also include the layout in the "Data" grid. Note: This will
result in DbVisualizer saving the layout for each table that is displayed in
the Data grid = huge XML file...

dbvis.showactionresult=false This defines whether the result for all actions should be displayed or only
failures (default).

dbvis.sglwarning.maxrows= Defines the number of SQL Warning rows that should be processed
5000 before truncating.
dbvis.usegetobject=false Specifies if the generic ResultSet.getObject() method in JDBC will be

used in favor of the data type specific get methods or not. Default is false.

dbvis.usestandardgridfit=false  Enable this property and DbVisualizer will use an accurate but slow
method to automatically resize grid columns. "Accurate" since it does a
real calculation of the columns width. If leaving this property disabled then
column widths are determined much faster but depending on what grid

font is used some columns may be truncated with "...". This property has
an effect only if Tool Properties->Grid->Auto Resize Column Widths is
enabled

Page 422 of 428



;\./\ DbVisualizer 9.2 Users Guide

Property Description

dbvis.-ConnectionTestTimeout  The timeout in seconds for the "Ping Server" feature.
=20

dbvis.<database>. Ignore the Max Rows setting for statements other than SELECT. MS SQL
IgnoreMaxRowsForNonSELECT = Server applies Max Rows also to DELETE, INSERT and UPDATE (upto
=true and including SQL Server 2008).

dbvis.<database>.- Backward compatibility setting used to specify that the SQL command will
RemoveNewLineChars=false be trimmed of all whitespaces, tabs and newlines just before it is

executed by the DB server.

locale=en,us Use this to specify an alternate Locale

% You rarely need to modify these properties, as the default values are sufficient for most usage. Also
note that these properties may change in future versions of DbVisualizer. Some are also experimental
and may be removed or instead introduced in the DbVisualizer GUI.
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